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Часть 1. 
Линейный статический, модаль-
ный расчеты и расчет устойчиво-
сти  

Предисловие 
О данном Руководстве  

Руководство по Основной Системе КЭ-расчета предоставляет подробное описание 
процедур выполнения линейного статического расчета напряжений, расчета устой-
чивости, собственных частот и форм мод. Руководство построено на том принципе, 
что хорошая иллюстрация заменяет несколько параграфов объяснений. Используя 
удобные формат и стиль, Руководство предоставляет независимые темы в различных 
главах. Эти темы служат основой для применения метода конечных элементов в бо-
лее сложных практических задачах. В данном Руководстве сделана попытка объяс-
нить большинство тем с использованием большого количества примеров. 

ПРИМЕЧАНИЕ: Описание процедуры установки пакета COSMOS/M, конфигурации 
оборудования, и другая информация, специфичная для различных компьютеров не 
приводится в данном Руководстве; обратитесь к Приложению A Руководства пользо-
вателя COSMOS/M (Том 1). 

Использование данного Руководства  
Руководство по Основной Системе разделено на 13 глав и 4 приложения. Модульность 
является основой программ COSMOS/M, и она отображается в данном Руководстве. 
Большинство глав модульны, и могут быть изучены независимо от других. Ниже 
приведено краткое описание всех глав. 

Глава 1  Об основной системе КЭ-расчета: здесь приводятся важные 
особенности моделирования и расчета линейных статических, 
модальных задач и на устойчивость. 

Глава 2  Математические основы: предоставляет краткое описание тео-
рии конечных элементов применительно к Основной Системе. 

Глава 3  Приступая к работе: в данной главе представлено подробное 
описание примера линейного статического расчета с подробны-
ми объяснениями и иллюстрациями. 

Глава 4  Требования к исходным данным: здесь приводится информа-
ция и подготовке полных исходных данных для расчета. 



 10

Глава 5  Библиотека элементов: в главе описываются доступные типы 
элементов и их использование в Основной Системе. Также в 
главе исходные данные для задания свойств элементов и доступ-
ные нагрузки. 

Глава 6  Свойства материала, сечения и другие физические свойства: 
предоставляет подробное описание свойств материала и сечения 
для всех элементов, доступных в Основной Системе. 

Глава 7  Нагрузки и граничные условия: здесь описывается приложе-
ние нагрузок и граничных условий в различных вариантах рас-
чета. 

Глава 8  Советы по моделированию: в главе представлены рекоменда-
ции и советы по моделированию, чтобы облегчить вам подго-
товку модели к расчету. 

Глава 9  Выполнение расчета: предоставляет информацию о различных 
командах и процедурах для выполнения расчета, включая ис-
пользование данных из других расчетных модулей COSMOS/M. 
Также здесь приводится информация по устранению неполадок. 

Глава 10  Постпроцессинг: предоставляет информацию о различных воз-
можностях постпроцессинга, доступных в Основной Системе. 

Глава 11  Примеры моделирования и расчета: здесь приведены подроб-
ные примеры расчета линейных статических задач, задач на рас-
чет собственных частот и устойчивость. Описаны все важные 
шаги создания модели, указания настроек расчета и интерпрета-
ции результатов. 

Глава 12  Междисциплинарный расчет: глава, описывающая взаимодей-
ствие других модулей COSMOS/M с Основной Системой, на-
пример, в магнитно-конструкционных, жидкостно-
конструкционных и термально-конструкционных задачах. В этой 
главе приведены примеры, иллюстрирующие использование ре-
зультатов расчета из модулей ESTAR, HSTAR и FLOWSTAR в 
Основной Системе. 

Глава 13  Неосесимметричная нагрузка и формы мод: данная глава опи-
сывает упрощенное моделирование задач с несимметричной на-
грузкой. Для расчета перемещений, напряжений и форм мод ис-
пользуются ряды Фурье и принцип суперпозиции. 

Приложение A  Единицы измерения: в данном приложении приведена инфор-
мация о различных системах единиц измерения, и их использо-
вании в Основной Системе. Также предлагаются совместимые 
наборы единиц измерения систем FPS, MKS и СИ. 

Приложение B  Сводка команд: в данном приложении приведено краткое опи-
сание команд, связанных с моделированием и расчетом в Основ-
ной Системе. 

Приложение C  Краткое описание теоретических основ для оценки кода 
ASME: здесь приводится краткое изложение теории для оценки 
кода ASME. 

Приложение D  Литература: здесь приводится список литературы, использо-
ванной при создании Руководства. 
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Проверочные задачи  
Во второй части данного Руководства приведено более 100 проверочных задач на ли-
нейный статический расчет, расчеты собственных частот и устойчивости. Файлы ис-
ходных данных для этих задач находятся в директории COSMOS/M. Более подробная 
информация по использованию этих задач приведена во введении и Части 2. 

Другие Руководства  
Существует два набора Руководств по COSMOS/M. Один набор для версий для PC 

DOS и Apple Macintosh, другой � для версий для  Unix, Windows NT и Windows 95. 
Кроме Руководства по Основной Системе, вам могут понабиться следующие Руково-
дства: 

Руководство пользователя COSMOS/M (Том 1) 

Руководство предоставляет информацию об установке программы, начале работы с 
ней и о большинстве возможностей и концепций COSMOS/M. Руководство пользова-
теля начинается с описания структуры программы, после чего изложен подробный 
пример, позволяющий сразу же приступить к работе.  Затем в Руководстве описаны 
возможности GEOSTAR по созданию модели, генерации КЭ-сети, приложению на-
грузки и граничных условий, выполнению расчета, проверке и постпроцессингу ре-
зультатов, взаимодействию с CAD-системами и другими КЭ-программами, исполь-
зованию нового командного языка и многому другому. Отдельная глава посвящена 
подробному описанию обширной библиотеки элементов COSMOS/M для конструк-
ционных, термальных, жидкостных и электромагнитных задач. Также в Руководстве 
приводятся примеры моделирования и выполнения расчета. Для вашего удобства в 
Руководство включены такие подробности, как единицы измерения исходных вели-
чин, файлы базы данных, описание команд, рекомендации по устранению неполадок 
и заметки об улучшениях, сделанных в версии COSMOS/M 1.75. 

Справочник команд COSMOS/M (Том 2) (доступно только в печатном варианте) 

В данном Справочнике приведено подробное описание команд, их функций, синтак-
сиса и аргументов. Там, где это необходимо, приводятся примечания, примеры и ил-
люстрации. 

Руководство по расширенным модулям COSMOS/M (Том 4) 

Руководство по расширенным модулям COSMOS/M состоит из восьми разделов, соот-
ветствующих расширенным расчетным модулям COSMOS/M: 

ASTAR  Расширенная динамика  

HSTAR  Теплоперенос 

NSTAR  Нелинейный статический и динамически конструкционный расчет  
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FSTAR  Расчет усталости 

ESTAR  Электромагнетизм  

FLOWSTAR  Расчет течения жидкости  

OPTSTAR  Оптимизация конструкций  

В каждом разделе приведены: необходимые теоретические основы, описание возмож-
ностей, информация о главных командах, а также подробные примеры и провероч-
ные задачи. 

Руководство пользователя COSMOS/FFE (Том 5) 

Данное Руководство содержит информацию о Термальном и Статическом расчетных 
модулях COSMOS/FFE. 

Теоретические основы COSMOS/M  

В первом издании Теоретических основ COSMOS/M освещены темы, связанные с ли-
нейным статическим, модальным и термальным расчетами. Особое внимание было 
уделено выводу уравнений для линейных конструкционных задач и теоретическому 
описанию некоторых основных типов элементов. Другие особенности и варианты 
расчета будут рассмотрены в будущих изданиях этой книги.  

Руководство пользователя COSMOS/M HFESAP 

В этом руководстве описывается применение COSMOS/M для высокочастотных элек-
тромагнитных задач, включающих разработку и расчет пассивных микроволновых и 
цифровых схем. Пакет HFESAP состоит их двух главных модулей: HIFIS (Высоко-
частотный интегрированный симулятор (High Frequency Integrated Simulator)) и 
MICAV (Микроволновые полости (Microwave Cavities)). HIFIS предоставляет воз-
можности рассчитывать линии передач и волноводные конструкции, MICAV дает 
возможность проектировать и рассчитывать полости (cavities), диэлектрические ре-
зонаторы, измерители частот, соединители, фильтры полостей и осцилляторы.  

Другие продукты  

Кроме программ COSMOS/M и COSMOS/FFE, Structural Research предоставляет ин-
женерные программы, полностью интегрированные с AutoCAD и другими CAD про-
граммами: 

COSMOS/M DESIGNER 

Эта программа � инструмент механического проектирования с помощью компьютера 
(MCAE) для расчетов конструкции в среде AutoCAD. Программа разработана для 
выполнения частотных, термальных расчетов и расчетов напряжений конструкции и 
устойчивости, разработанных в AutoCAD, не покидая среды программы AutoCAD. 
Трехмерный вариант позволяет инженеру создавать и рассчитывать трехмерные КЭ-
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модели.  

COSMOS/M DESIGNER II 

Законченная система моделирования и КЭ-расчета, совмещающая возможности моде-
лирования сплошных тел программы MicroStation Modeler компании Bentley systems 
с расчетными возможностями систем COSMOS/M и COSMOS/FFE. 

Интерфейс COSMOS/M � CAD 

Эта программа � КЭ-расчетная связь с различными CAD-программами. Пользователь 
может использовать CAD-программу для генерации геометрии модели, а затем ис-
пользовать COSMOS/M для выполнения оптимизационных, частотных, термальных, 
нелинейных, расширенных динамических расчетов и расчетов напряжений и устой-
чивости.  

COSMOS/WORKS 

Законченная система расчета конструкций, которая использует программу Solid/Works 
для моделирования сплошных тел и модули COSMOS/M для подготовки модели к 
расчету, выполнения расчета и постпроцессинга результатов.  

Где получить информацию  
Для внесения предложений и комментарием по данному Руководству и получения ин-
формации о COSMOS/M DESIGNER, COSMOS/M DESIGNER II и COSMOS/M CAD 
Interface, или любых других продуктах и услугах, предлагаемых Structural Research, 
свяжитесь с местным продавцом, или со Structural Research по одному из нижеприве-
денных адресов: 
Corporate Headquarters/Western Regional Office: 
Structural Research and Analysis Corporation 
12121 Wilshire Blvd., 7th Floor 
Los Angeles, CA 90025 USA 
Tel: (310) 207-2800 Fax: (310) 207-2774 
Eastern Regional Office: 
Structural Research and Analysis Corporation 
5000 McKnight Road, Suite 402 
Pittsburgh, PA 15237 USA 
Tel: (412) 635-5100 Fax: (412) 635-5115 
European Headquarters: 
Structural Research and Analysis Corporation 
Seestrasse 78, 8703 Erlenbach 
Zurich, Switzerland 
Tel: 01.911.06 94 Fax: 01.911.08 31 

Условные обозначения  
Все имена команд (сокращенные и полные, включая путь) в тексте приводятся шриф-
том Arial, размером 10 пунктов, полужирным начертанием (например, A_STATIC 
(Analysis > STATIC > Static Analysis Options)). Приглашения программы приводятся 
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шрифтом Times, размером 10 пунктов, а соответствующие данные выделены полу-
жирным начертанием: 
Control Panel: Propsets > Material Property 
Material property set >1 
Material Property Name >EX; Elasticity modulus 1st dir 
Property value >15.5E6 

Если после какого-либо приглашения не указано значение, то это означает, что вам 
необходимо нажать клавишу �Enter�. Более подробная информация по использова-
нию GEOSTAR приведена в Руководстве пользователя COSMOS/M. 

Данные, выводимые в GEOSTAR, а также примеры из файлов вывода в основном при-
водятся  шрифтом Courier размером 10 пунктов в рамке, как показано ниже (для ко-
манды MPLIST (Edit > LIST > Material Props)): 
Label Name Temp/BH_Cr Value  
A 1 EX 1 3.000000e+07  
... ...  
A 1 KX 0 5.370000e-03 

Примеры из файлов вывода могут приводится шрифтом Courier размером 8 пунктов, 
если длина строки превышает 80 символов: 
S T R E S S E V A L U A T I O N FOR S T A T I C A N A L Y S I S  
 
          STRESS OUTPUT FOR ELEMENT GROUP 1 CASE NO. 1 
  
           ELEMENT NUMBER 1  
 
            NX        NY             NXY    MX           MY              MXY  VX  VY  
 
      0.00E+00 0.00E+00 0.00E+00 -6.25E+01 -9.36E+00 5.89E-15 -1.65E+02 -8.99E-14  
  
LAYER (ECS:-1)    SIGMA-X      SIGMA-Y         SIGMA-XY      TAU-XZ           TAU-YZ       HILL NUMBER  
 
 3 TOP    -8.180E-01 -1.225E-01 7.718E-17 -2.733E+01 -1.489E-14 4.73364E+01 
 
 BOTTOM -6.597E-01 -9.876E-02 6.225E-17 -2.733E+01 -1.489E-14 4.73343E+01 
 
 (INTER LAMINAR SHEAR STRESSES) -5.850E+00 -3.187E-15 

ПРИМЕЧАНИЕ: Описание, приводимое в таком формате, используется для обозна-
чения предупреждений, исключений и другой важной информации. Это не означает, 
что информация в других форматах менее важна, просто в данном формате приво-
дятся в основном исключения, а не правила. 
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Глава 1. 
Об основной системе КЭ-расчета  
Введение 

COSMOS/M � это законченная, модульная, автономная система КЭ-расчета, разрабо-
танная компанией Structural Research and Analysis Corporation для персональных ком-
пьютеров и рабочих станций. В программу входят модули для решения линейных и 
нелинейных статических и динамических конструкционных задач, а также для реше-
ния задач в областях оптимизации конструкций, теплопереноса, механики жидкостей 
и электромагнетизма. Также существуют модули для решения особых задач, таких 
как задачи на усталость. Система находится в постоянном развитии с использовани-
ем современных методик и современных возможностей оборудования. Система раз-
работана для удовлетворения нужд пользователей. Модульность системы облегчает 
ее обновление по мере роста потребностей пользователя. 

Основная система КЭ-расчета состоит из трех модулей: GEOSTAR для создания моде-
ли и отображения результатов, STAR для линейного статического расчета, и DSTAR 
для модального расчета и расчета устойчивости. Интегрированная система позволяет 
моделировать, выполнять расчет и оценивать результаты в одной графической среде. 

В этой главе представлены некоторые из основных особенностей КЭ-моделирования и 
расчета применительно к Основной Системе. Математические основы некоторых 
особенностей расчета, приведенных в этой главе, излагаются в следующей главе. Для 
сохранения ясности в представлении, документация по GEOSTAR приводится в двух 
отдельных частях: в Руководстве пользователя COSMOS/M (Т. 1) и Справочнике ко-
манд COSMOS/M (Т. 2). 

ПРИМЕЧАНИЕ: Термины Основная система КЭ-расчета или Основная система, 
используемые в данном Руководстве, обозначают только линейный статический рас-
чет и расчеты собственных частот и устойчивости. 

Структура COSMOS/M  
Система COSMOS/M состоит из пре- и постпроцессора, различных расчетных моду-
лей, интерфейсов, трансляторов и вспомогательных средств, показанных  на рис. 1-1. 
Основная Система является одной из наиболее часто используемых КЭ-программ для 
линейного статического расчета, расчета устойчивости и собственных частот и форм 
мод в отрасли. 
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Рис. 1-1. Модули и трансляторы COSMOS/M  

Модуль GEOSTAR является пре- и постпроцессором КЭ-системы COSMOS/M. Он яв-
ляется ядром системы COSMOS/M, предоставляющим пользователю графический 
интерфейс (GUI) для моделирования геометрии и КЭ-расчета. В типичном сеансе ра-
боты с COSMOS/M, сначала вы войдете в GEOSTAR, построите модель с использо-
ванием различных инструментов создания геометрии и генерации КЭ-сети, приложи-
те нагрузки и граничные условия и передадите модель на расчет. В этот момент вы 
автоматически выйдете из GEOSTAR и запустится необходимый расчетный модуль 
COSMOS/M. По завершении расчеты программа автоматически вернется в графиче-
скую среду GEOSTAR для постпроцессинга. 

GEOSTAR это интерактивная, полностью трехмерная, CAD-подобная среда модели-
рования геометрии, генерации КЭ-сети и мощный инструмент для пре- и постпро-
цессинга КЭ-расчета. Пользователь может создать модель, ввести всю информацию, 
необходимую для расчета, выбрать вариант расчета, просмотреть, отобразить и рас-
печатать результаты, не покидая экран GEOSTAR. Программа интуитивно понятна и 
легка в освоении. Средний пользователь моет научиться создавать и решать практи-
ческие задачи после нескольких часов тренировки. 

Программа GEOSTAR, как показано на рис. 1-1, управляет расчетными модулями и 
предоставляет им среду для взаимодействия. Эти модули приведены в таблице 1-1: 

Таблица 1-1. Функции модулей COSMOS/M  

Основная система STAR  
DSTAR  

Линейный статический расчет  
Расчет устойчивости, частот и форм мод  

Расширенные мо-
дули  

ASTAR  
ESTAR  
FLOWSTAR  
FSTAR  
HSTAR  
NSTAR  
OPTSTAR  
HFESAP  

Расширенный динамический линейный расчет  
Электромагнитный расчет  
Расчет течения жидкости  
Расчет усталости  
Расчет теплопереноса  
Нелинейные статический и динамический расчеты  
Оптимизация конструкций  
Высокочастотный электромагнитный расчет  
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FLOWPLUS  Расчет турбулентного течения жидкости  

Кроме этого, GEOSTAR может переносить данные между COSMOS/M и другими 
CAD- и КЭ-пакетами, как показано на рис. 1-1. Эти программы приведены в таблице 
1-2: 

Таблица 1-2. CAD- и КЭ-трансляторы COSMOS/M  

CAD-пакеты IGES  
DXF 

КЭ-пакеты ABAQUS  
ANSYS  
NASTRAN  
PATRAN  
SINDA  
TEAP 

Модули основной системы  
Основная Система состоит из двух основных модулей: STAR и DSTAR, и подмодуля 

STRESS, выполняющего расчет напряжений. Эти модули взаимодействую друг с 
другом как показано на рис. 1-2: 

 

Рис. 1-2. Модули Основной Системы  

Модуль линейного статического расчета (STAR) использует линейную теорию конст-
рукций, основанную на предположении о малых перемещениях, для расчета дефор-
маций конструкций. Для многих конструкций (например, рамные) вычисление на-
пряжений не требуется. Для обеспечение такой гибкости расчет напряжений 
выполняется в отдельном подмодуле, который называется STRESS. Модуль STAR 
вызывает подмодуль STRESS для расчета напряжений в узлах и элементах для боль-
шинства элементов. Модуль DSTAR рассчитывает собственные частоты и соответст-
вующие формы мод системы. Также этот модуль рассчитывать нагрузки устойчиво-
сти и соответствующие формы мод. В модальном расчете подмодуль STRESS также 
рассчитывает виртуальные напряжения в узлах и элементах для большинства эле-
ментов, основываясь на результатах, полученных в DSTAR. 
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Модуль линейного статического расчета (STAR) 

Для расчета деформации конструкций модуль STAR использует линейную теорию 
конструкций, основанную на предположении о малых перемещениях. Как было упо-
мянуто ранее, модуль STAR вызывает подмодуль STRESS для расчета напряжений. 
Подмодуль STRESS рассчитывает напряжения в узлах и элементах для большинства 
элементов на основе результатов, полученных в модулях STAR и DSTAR (только для 
модального расчета). Напряжения для нескольких вариантов нагрузки рассчитыва-
ются за один проход, и на стадии постпроцессинга эти напряжения можно скомбини-
ровать. Напряжения могут быть получены в любой заранее определенной координат-
ной системе. Модуль STRESS поддерживает все особенности STAR. 

В типичном линейном статическом расчете напряжений вы определяете напряжения, 
перемещения, деформации и реакции в КЭ-модели. Расчет считается линейным, если 
нелинейности от различных источников могут быть сведены к линейностям или иг-
норированы. Результаты линейного расчета включают узловые перемещения, напря-
жения в узлах и элементах, силы, реакции и т.д. Эти результаты могут быть отобра-
жены графически или просмотрены в файле вывода. 

Ниже приведены основные особенности модуля линейного статического расчета на-
пряжений STAR: 

! Обширная библиотека элементов (см. Главу 5, Библиотека элементов). 

! Изотропные, ортотропные, анизотропные и составные свойства материала. 

! Свойства материала, зависящие от температуры. 

! Критерий отказа для составных элементов. 

! Предписанные перемещения, с/без других нагрузок. 

! Зависимые степени свободы и уравнения ограничений. 

! Термальная, гравитационная и центробежная нагрузки. 

! Балочные нагрузки. 

! Плоские эффекты при оценке жесткости (геометрическая или дифференциальная 
жесткость). 

! Расчет нескольких вариантов нагрузки за один проход. 

! Вариант мягкой пружины для предотвращения нестабильностей. 

! Возможность создания подконструкций (для больших задач), чтобы создавать и 
рассчитывать выбранные суперэлементы с помощью процедур сжатия и восста-
новления. 

! Взаимодействие твердых тел с жидкостями. 
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! Задачи с использованием элементов GAP с учетом сил трения. 

! Баланс стеки сил (grid-force) и расчет сил реакции. 

! Несимметричная нагрузка в осесимметричных моделях. 

! Расчет энергии деформации и ошибки. 

! Варианты двух- и трехмерного элемента трещины: программа рассчитывает фак-
торы интенсивности напряжений для всех трех мод трещины. 

! Адаптивные P-, H- и HP-версии МКЭ, включая трехмерные задачи с использова-
нием четырехгранных элементов. 

! «Скрепление» (или соединение) несовместимых частей на общих границах в од-
ной модели, даже если узлы и типы элементов не совпадают. Можно скреплять 
сплошное тело со сплошным телом, тело с оболочкой и оболочку с оболочкой, 
указав геометрический примитив интерфейса. «Скрепление» можно использовать 
для соединения несовместимых сетей КРИВАЯ-КРИВАЯ, КРИВАЯ-
ПОВЕРХНОСТЬ и ПОВЕРХНОСТЬ-ПОВЕРХНОСТЬ; см. Главу 8, Советы по 
моделированию. На рисунке показан пример, в котором применяется функция 
«скрепления». Модель состоит из четырехгранных сплошных элементов в корпу-
се ракеты, к которому присоединяются стабилизаторы, состоящие из элементов 
оболочки. 

 

Рис. 1-3. Скрепление несовместимых КЭ-сетей  

! Комбинирование результатов статического и динамического расчетов: вы можете 
связать результаты расширенного динамического расчета (выполняемого в моду-
ле ASTAR) на любом временном или частотном шаге с результатами статическо-
го расчета во время постпроцессинга; см. Главу 10, Постпроцессинг. 

! Связывание результатов расчета: вы можете связать результаты расчета из других 
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модулей COSMOS/M, таких, как расчет теплопереноса, течения жидкости и элек-
тромагнитного расчета, чтобы использовать их в качестве нагрузок для расчета 
напряжений и деформаций в одном направлении (см. Глава 12, Междисциплинар-
ный расчет) для выполнения расчета взаимодействия как показано на рис. 1-4. 

! Подконструкции:  
После выполнения расчета с использованием относительно грубой КЭ-сети вы 
можете определить области, в которых напряжения, возможно, были рассчитаны 
неточно из-за острых углов, геометрической неоднородности и/или сосредоточе-
ния нагрузок, как подконструкции. С использованием подконструкций, вам необ-
ходимо рассчитать только эти области. Использование подконструкций ускоряет 
процесс получения точных результатов в местах сосредоточения напряжений.  

! Многотермальные варианты нагрузки: 

a. Для каждого первичного варианта нагрузки можно задать пользовательские 
узловые температуры. 

b. Первичному варианту нагрузки можно также назначить результаты расчета 
переходного теплопереноса, при это профиль температуры считывается непо-
средственно из результатов термального расчета. После этого рассчитываются 
результаты для всех вариантов нагрузки, как обычно. 

! Проверка напряжений ASME:  
Формулируется оценка результатов расчета напряжений в форме, подходящей для 
с равнения с требованиями секции III кода ASME. Формулировки разработаны 
для расчета мембранных, изгибающих и пиковых интенсивностей напряжений в 
произвольных поперечных сечениях. 

! Сохранение разложенной матрицы жесткости:  
Разложенная матрица жесткости из статического, частотного расчетов или расче-
та устойчивости сохраняется для последующего использования другими модуля-
ми, чтобы сэкономить время и усилия, считав матрицу, а не рассчитывать ее зано-
во. 

! Поддержка программ ADAMS:  
Между STAR и ADAMS существует прямой интерфейс. ADAMS, программа 
Mechanical Dynamic Inc., является ведущей программой кинематических и дина-
мических расчетов. Интерфейс позволяет смоделировать реальные рабочие усло-
вия для ваших моделей, включив эффекты изгиба и кинематики. Можно экспор-
тировать нагрузки из ADAMS в COSMOS/M. 
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Рис. 1-4. Взаимодействие других расчетных модулей с Основной Системой  

Модуль частотного расчета и расчета устойчивости (DSTAR) 

Модуль DSTAR рассчитывает собственные частоты и соответствующие формы мод 
системы (модальный расчет). Также модуль может рассчитывать нагрузки устойчи-
вости и соответствующие формы мод в задачах на устойчивость с собственными 
значениями. 

В типичном расчете на устойчивость рассчитываемые величины включают критиче-
ские нагрузки, при которых конструкция становится неустойчивой и соответствую-
щие формы мод устойчивости. В задачах на устойчивость с собственными значения-
ми практическое значение имеют несколько первых мод. Моды устойчивости могут 
быть отображены или анимированы во время постпроцессинга. 

Модальный расчет, определяющий собственные частоты и соответствующие формы 
мод, является важным этапом разработки многих конструкций. Как и в расчете ус-
тойчивости, в модальном расчете вычисляются собственные значения, и DSTAR пре-
доставляет несколько методик извлечения собственных значений. Моды вибрации 
могут быть отображены или анимированы на экране.  

! Различные методики извлечения собственных значений: 

- Подпространственная итерация, 
- метод Ланцоша, 
- метод Якоби, 
- обратная степенная итерация (только для одной пары), 
- редукция по методу Ги. 

! Расчет комплексных собственных значений. 

! Сдвиг частоты для расчета собственных значений на указанном диапазоне или 
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для рассмотрения моделей с модами жесткого тела. 

! Последовательность Стурма для проверки на пропущенные моды. 

! Матрицы сосредоточенных и консистентных масс для представления массы кон-
струкции. 

! Плоскостное воздействие на жесткость. 

! Мягкая пружина для рассмотрения моделей с модами жесткого тела. 

! Модальный расчет пьезоэлектрических материалов: рассчитывает собственные 
частоты и формы мод с использованием шестигранных элементов SOLID для уче-
та зависимостей между упругим и электрическим полями пьезоэлектрических ма-
териалов. 

! Извлечение неосесимметричных мод для осесимметричных моделей. 

! Редукция по методу Ги: 
Во время разработки, при внесении изменений, редукция по методу Ги позволит 
сэкономить значительное время. Редукция позволяет аналитику осуществлять не-
который контроль над процессом извлечения, выборочно игнорируя те моды, ко-
торые имеют малое или нулевое значения для некоторого расчета сложной моде-
ли. 

Ограничения Основной Системы  
На модуль пре- и постпроцессинга GEOSTAR, расчетные модули STAR и DSTAR, со-
ставляющие Основную Систему, наложены ограничения, приведенные в нижесле-
дующих таблицах. Эти ограничения действительны только для полной версии. 

Таблица 1-3. Ограничения на размер модели в GEOSTAR 

Величина Ограничение Величина Ограничение 
Препроцессинг   Разное  
Узлов 64,000*  Последовательных увеличений масшта-

ба  
10 

Элементов 64,000*  Списков выбора на примитив  10 
КЛЮЧЕВЫХ ТОЧЕК 8000  Сохраненных проекций  10 
КРИВЫХ 8000  Текстовых сообщений  100 
ПОВЕРХНОСТЕЙ 4000 Функциональных клавиш 50 
ОБЪЕМОВ 2000  Окон 4 
КОНТУРОВ 1000  Цветов 256 
ОБЛАСТЕЙ 1000  Длина имени файла (включая путь)  40 
МНОГОГРАННИКОВ 100  Длина имени параметра (переменная, 

массив, функция)  
10 

Частей 100  Параметрических массивов  20 
Координатных систем 500  Пользовательских параметрических 

функций:  
- Длина имени аргумента функции  
- Аргументов в функции  
- Длина параметрического выражения 
функции  

200  
 
10  
20  
200 

КРИВЫХ в КОНТУРЕ  250 Длина имени макроса  10 
КОНТУРОВ в ОБЛАСТИ 20  Аргументов макроса  10 
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ПОВЕРХНОСТЕЙ/ОБЛАСТЕ
Й в МНОГОГРАННИКЕ  

1600  Локальных пользовательских перемен-
ных в макросе  

50 

МНОГОГРАННИКОВ в 
ЧАСТИ  

60  Локальных пользовательских функций 
в макросе  

50 

Целевых поверхностей для 
«скрепления»  

20  Локальных массивов в макросе  10 

Наборов «скрепления»  100  Строк, начинающихся с символа «#» в 
файле сессии или макросе  

500 

Наборов свойств материала  90   
Наборов действительных 
констант  

5000   

Групп элементов  20   
Величина Ограничение   
Постпроцессинг    
Изоплоскостей  12   
Плоских сечений  12   
Число кривых на XY-графике 
в одном окне  

6   

* Возможно установить версию, поддерживающую до 15,000 узлов. 
 

Таблица 1-4. Ограничения расчета в Основной Системе  

Величина Ограничение 
Степеней свободы 100,000 
Первичных вариантов нагрузки 50 
Вторичных вариантов нагрузки 50 
Зависимых степеней свободы 1500 
Уравнений ограничения  1500 
Элементов GAP  300 
Температурных кривых 
- точек в температурной кривой  

100  
5000 

Суперэлементов  
- Суперузлов в суперэлементе  
- Степеней свободы, связанных с суперэлементом  

99  
180  
2000 

Сил реакции  3000 
Предписанных ненулевых перемещений  3000 
Сосредоточенных сил в балочной нагрузке  5 
Распределенных нагрузок в балочной нагрузке  3 
Число собственных пар  
- метод Ланцоша  
- метод подпространственных итераций  

 
150  
100 

ПРИМЕЧАНИЕ: Ограничения моделирования и расчета, приведенные в таблицах 
могут быть различны для разных компьютеров. Более подробная информация приве-
дена в Руководстве пользователя COSMOS/M (Т. 1). 
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Глава 2. 
Математические основы  
Введение  

В предыдущей главе были представлены некоторые из особенностей расчета и моде-
лирования в Основной Системе. В этой главе приводятся математические основы не-
которых важных особенностей. Программа COSMOS/M была специально разработа-
на для решения КЭ-задач с большим числом степеней свободы. Во всех аспектах 
разработки учитывались нужды аналитика. Однако, с учетом широкого диапазона 
возможных приложений программы во многие части программы была внесена высо-
кая степень общности и гибкости. Информация, приведенная в данной главе, может 
не покрывать все аспекты применения Основной Системы. 

ПРИМЕЧАНИЕ: В данной главе описываются только некоторые теоретические кон-
цепции, применимые в Основной Системе. Подробное изложение теории конечных 
элементов находится в книге «Теоретические Основы». 

Математические основы  
Варианты расчета, выполняемые в Основной Системе, включают: 

! Линейный статический расчет  

! Расчет устойчивости с собственными значениями  

! Расчет собственных частот и форм мод. 

В нижеследующих разделах приведено краткое изложение теоретических основ этих 
вариантов расчета. 

Линейный статический расчет  
В статическом расчете рассчитываются перемещения и напряжения, вызванные ста-
тическими нагрузками. Под статическими нагрузками понимаются нагрузки, не вы-
зывающие эффектов инерции или демпфирования, достаточно значимых для их рас-
смотрения в расчете. Статический расчет является линейным, если нелинейности от 
пластичности, больших отклонений, больших деформаций, плоскостных эффектов, 
контактных поверхностей, эффектов текучести и релаксации, и других источников 
могут быть сведены к линейностям или полностью проигнорированы. Процедура 
выполнения статического линейного расчета, а также советы по моделированию, 
приведена в Главе 8, Советы по модулированию и Главе 4, Требования к исходным 
данным. 
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Формулировка для решения линейной статической задачи методом перемещений пол-
ностью описывается матричным уравнением: 

[K]{U}= {F}= {Fa}+ {Fc}  (2-1) 

где [K] � конструкционная (собранная) матрица жесткости, {U} � вектор неизвестных 
узловых перемещений а {F} � вектор нагрузки. Вектор нагрузки {F} состоит из ме-
ханической, термальной и гравитационной нагрузок (см. Главу 7, Нагрузки и гранич-
ные условия). Вектор нагрузки {F} может быть выражен как сумма приложенных уз-
ловых нагрузок {Fa} и сил реакции (или ограничений в точке) {Fc}. 

В линейном статическом расчете каждый из этих векторов является суперпозицией 
механической, термальной и гравитационной нагрузок: 

{Fa}= {Fm}+ {Fth}+ {Fgr}  (2-2) 

Вектор механических нагрузок {Fm} рассчитывается как сумма приложенных узловых 
сил и моментов и распределенных нагрузок на элементах: 

 (2-3) 

где {Fnd} � вектор узловой нагрузки а {Fe
pr} � вектор распределенной нагрузки на эле-

менты. Векторы термальной и гравитационной нагрузок рассчитываются следующим 
образом: 

 (2-4) 

где {Fnt} � вектор узловых температур, {Fe
th} � вектор термальной нагрузки на элемен-

ты, [Me] � матрица массы элементов а {a} � вектор ускорения. 

Если используются уравнения ограничений (также называемые многоточечными ог-
раничениями), задающие отношения между перемещениями в узлах, то уравнение (2-
1) разделяется и решается для избавления от некоторых неизвестных, как будет из-
ложено ниже. Для заданных граничных условий (одноточечных ограничений) и 
предписанных перемещений матрица жесткости имеет следующий вид: 

 (2-5) 

где индекс f означает свободные степени свободы, а s обозначает степени свободы с 
казанными значениями. Уравнение (2-5), таким образом, описывает поведение  кон-
струкции, подвергающейся действию сил и фиксированных и/или предписанных пе-
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ремещений. 

Уравнения ограничений (Многоточечные ограничения) 

Уравнения ограничений или зависимостей, также называемые многоточечными огра-
ничениями, задают линейные отношения между перемещениями в двух или более уз-
лах. Уравнения ограничений представляют один из подходов к моделированию зави-
симых степеней свободы, которые определяются как линейная комбинация других 
степеней свободы. Второй подход к моделированию зависимых степеней свободы � 
использование жестких связей (например, элемент RBAR). В COSMOS/M в уравнении 
ограничений учитываются только выбранные компоненты степени свободы, а осталь-
ные компоненты степеней свободы в этих узлах остаются неизменными. 

В COSMOS/M уравнение ограничений выражается как гомогенное линейное уравне-
ние, выражающее зависимую степень свободы через независимые: 

ui = a1u1 + a2u2 + a3u3 + ... + anun  (2-6) 

где ui представляет зависимую степень свободы, u1�un � независимые (сохраняемые) 
степени свободы, а a1�an � коэффициенты ограничений, предоставляемые пользова-
телем. Символьно уравнение (2-6) может быть представлено в следующем виде: 

{Um}= [Cm]{Un}  (2-7) 

где {Um} � вектор зависимых степеней свободы, {Un} � вектор независимых степеней 
свободы, а [Cm] � матрица уравнений ограничений. Эти уравнения подставляются в 
уравнение (2-1) после разделения обеих частей уравнения (2-1) на зависимые и неза-
висимые степени свободы. Кроме этого, исходя из условий равновесия, необходимо 
внести в уравнение (2-1) силы ограничений перед исключением {Um}. 

Использование уравнений зависимостей имеет множество преимуществ; более под-
робная информация приведена в Главе 8, Советы по моделированию, и Главе 11, при-
меры расчета. 

Плоскостные эффекты в статическом расчете � увеличение жесткости от напря-
жений  

Во многих узких конструкциях с плоскостным нагружением мембранные силы могут 
изменять жесткость на изгиб. Когда сжимающие мембранные силы уменьшают же-
сткость до нуля для кинематически допустимой моды деформации, происходит на-
рушение устойчивости. Однако, если мембранные силы имеют обратное направление 
(растягивающие вместо сжимающих), то, соответственно, жесткость на изгиб увели-
чивается. Таким образом, конструкция становится более жесткой под растягивающей 
плоскостной нагрузкой, демонстрируя эффект увеличения жесткости от напряжений 
Эффекты увеличения и уменьшения жесткости от напряжений могут также учиты-
ваться при расчете собственных частот; см. раздел Плоскостные эффекты в модаль-
ном расчете. Устойчивость описана в отдельном разделе. 

Для таких конструкций жесткость является функцией одновременно от статических 
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нагрузок и деформации формы. В то время, как точное решение можно получить, ис-
пользуя геометрически нелинейный методики расчета, можно получить достаточную 
точность решения, используя подход дифференциальной жесткости. В данном под-
ходе предполагается, что геометрически нелинейные задачи можно аппроксимиро-
вать добавлением матрицы геометрической жесткости KG (также называемой матри-
цей напряжений, начальных напряжений, дифференциальной жесткости или 
матрицей коэффициентов стабильности) к обычной матрицы конструкционной жест-
кости. Перемещения рассчитываются относительно начальной конфигурации конст-
рукции, а изменения в геометрии отражаются только в матрице геометрической же-
сткости. Также предполагается, что величина и направление нагрузок остаются 
неизменными во время движения конструкции, а точки их приложения перемещают-
ся вместе с конструкцией. 

Поскольку матрица геометрической жесткости зависит от перемещений, линейный 
конструкционный расчет производится в два этапа. На первом этапе рассчитываются 
перемещения {ui}, исходя из обычной матрицы жесткости [K]. На втором этапе на 
основе рассчитанных перемещений {ui} составляется матрица геометрической жест-
кости [KG(Ui)], и добавляется к обычной матрице жесткости [K] для расчета новых пе-
ремещений {ui+1}. КЭ-система уравнений для линейного статического расчета с уче-
том плоскостных эффектов записывается следующим образом: 

([K] + [KG(Ui)]){ui+1}= {F}  (2-8) 

В идеале, перемещения {ui+1} должны быть использованы для расчета новой матрицы 
геометрической жесткости [KG(Ui+1)] и нового вектора перемещений {ui+2}, и так да-
лее.  Итерации можно повторять, пока решение не будет точными с указанным до-
пуском. Однако, если приложенная плоскостная (сжимающая) нагрузка близка к на-
грузке устойчивости, то итерации могут расходиться, указывая на нестабильность. 
Это служит основанием для использования расчета устойчивости, описанного в сле-
дующих разделах. В COSMOS/M плоскостные эффекты учитываются выполнением 
только одной итерации. Более гибкие настройки ля этих итераций предлагаются при 
использовании модуля нелинейного расчета NSTAR. 

Матрица геометрической жесткости в COSMOS/M совместима, она составляется на 
основе тех же функций формы, которые используются для составления обычной мат-
рицы жесткости. Матрица симметрична, но в отличие от обычной матрицы жестко-
сти, не содержит членов с модулями упругости. Матрица зависит от геометрии эле-
ментов, поля перемещений и состояния напряжений. Матрица геометрической 
жесткости KG в общем случае неопределенна, и таким образом, не может быть обра-
щена. При использовании расчета устойчивости общая матрица жесткости конструк-
ции, составленная из матриц нормальной и геометрической жесткости, вырождается 
в единичную относительно форм устойчивости. 

ПРИМЕЧАНИЕ: Плоскостные эффекты в линейном статическом расчете напряже-
ний могут быть рассмотрены только в одном варианте нагрузки. 

Учет мод жесткого тела в статическом расчете � добавления мягкой пружины  

Мода жесткого (свободного) тела конструкции представляет движение без внутренних 
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деформаций. В конструкционном расчете моды жесткого тела возникают от несуще-
ствующих либо недостаточных ограничений, наложенных на конструкцию. Однако 
существует много задач, в которых введение ограничений нежелательно, однако де-
формационное поведение конструкции под приложенными нагрузками представляет 
интерес. Например, можно столкнуться с такой задачей на расчет напряжений, где 
равновесие поддерживается приложенными нагрузками, не требуя ограничений. 
Обычно программа не сможет рассчитать такие задачи, выдав сообщение о единич-
ной матрице жесткости. Однако, если вы укажете вариант добавления мягкой пружи-
ны, то программа автоматически добавить небольшую жесткость к диагональным 
членам матрицы конструкционной жесткости, обеспечив численную стабильность 
решения: 

 (2-9) 

где kss обозначает жесткость, добавленную с введением мягкой пружины. Мягкую 
пружину можно использовать во всех вариантах расчета в Основной Системе, и она 
указывается с помощью команд расчета (например, A_STATIC (Analysis > STATIC > 
Static Analysis Options), и т.д.); более подробная информация приведена в Главе 9, 
Выполнение расчета. 

Единичные матрицы жесткости также встречаются если задача была неправильно 
сформулирована, например в модели есть недостаточно или слишком непропорцио-
нальные модули упругости или свойства сечения. Из-за методики расчета, использо-
вание мягкой пружины обязательно для задач с использованием элементов GAP, ре-
шаемых в Основной Системе. 

Моды жесткого тела в расчете собственных частот могут учитываться двумя способа-
ми: с использованием мягкой пружины или указанием опции сдвига (shift)  при из-
влечении собственных значений. Эти методы изложены в разделе Модальный рас-
чет. 

Использование подконструкций  

При расчете очень больших КЭ-моделей в COSMOS/M можно использовать подкон-
струкции, при этом большая модель разделяется на меньшие части, которые рассчи-
тываются по отдельности. После расчета всех подконструкций получаются данный 
для последней операции «слияния» в которой получается решения для составленной 
конструкции. При это подробное решения для любой конструкции может быть вос-
становлено за несколько шагов. 

В COSMOS/M каждая подконструкция называется суперэлементом. Каждый супер-
элемент это законченная конструкция, не пересекающаяся с другими, и которую 
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можно соединить с главной конструкцией и/или другими суперэлементами. Сущест-
вуют ограничения, накладываемые на число суперэлементов и их граничных узлов. 
Возможно соединить несколько суперэлементов для создания псевдосуперэлемента; 
это называется многоуровневыми подконструкциями. 

Статический расчет напряжений для модели с подконструкциями выполняется в три 
этапа. На первом этапе рассчитывается каждый суперэлемент для нахождения описа-
ния его поведения а граничных узлах. На втором этапе найденные матрицы для каж-
дого суперэлемента составляются с матрицей главной конструкции и рассчитывают-
ся. На третьем этапе завершается расчет отдельных суперэлементов для 
восстановления перемещений и напряжений в каждом узле. Ниже приведено краткое 
описание этих операций. 

Предположим, что для суперэлемента КЭ-система уравнений записывается следую-
щим образом s: 

[K]{U}= {F}  (2-10) 

В процессе расчета с использованием подконструкций это уравнение разделяется для 
получения частичного решения. После этого частичное решение «вливается» в общее 
решение. Для суперэлемента это уравнение имеет следующий вид (индекс I обозна-
чает внутреннюю часть, B � граничную): 

 (2-11) 

где UI обозначает перемещения во внутренних узлах, а UB � перемещения в граничных 
узлах. Уравнение (2-11) может быть разделено на: 

 (2-12) 

Решение для внутренних перемещений приводит к: 

{UI}= [KII]-1{FI}- [KII]-1[KIB]{UB}  (2-13) 

Первый член в правой части уравнения является решением, полученным при ограни-
чении граничных степеней свободы и приложении внешних нагрузок к внутренним 
узлам. То есть это является частичным решением для внутренних узлов. Оставшийся 
компонент решения для внутренних узлов находится приложением второй части 
правой части уравнения (2-12), дающим частичное решение от перемещений гранич-
ных узлов: 

[[KBB] - [KBI][KII]-1[KIB]]{UB}= {FB}- [KBI][KII]-1{FI} 

то есть 

[KBB]*{UB}= {FB}*  (2-14) 
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где  

[KBB]* = [KBB] - [KBI][KII]-1[KIB]  (2-15) 

{FB}* = {FB}- [KBI][KII]-1{FI} 

Эти уравнения могут быть последовательно применены к различным суперэлементам. 
Полная матрица жесткости системы получается следующим образом: 

 (2-16) 

где nel � число элементов в главной конструкции, а nsel � число суперэлементов, со-
единенных с главной конструкцией. После того как рассчитаны перемещения на гра-
ничных узлах суперэлементов можно рассчитать перемещения, а, следовательно, и 
напряжения для отдельных суперэлементов из уравнения (2-12). 

Циклическая симметрия  

Существуют конструкции, такие как импеллеры в газовой турбине, котлы под давле-
нием и многие другие, составленные из идентичных сегментов, но не имеющие плос-
костей симметрии. Даже если существует ось симметрии, такие конструкции не мо-
гут быть рассчитаны как осесимметричные, поскольку их геометрия не может быть 
описана телами вращения. Такой тип геометрии называется циклически симметрич-
ной, секториально симметричной или угловой периодичностью. Вместо расчета всей 
конструкции можно смоделировать и рассчитать одну подконструкцию. 

 

Рис. 2-1. Конструкция с циклической симметрией  

Для типичной подконструкции границами интерфейса A и B, показанной на рисунке, 
уравнение равновесия имеет следующий вид: 

 (2-17) 
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где {DA} и {DB} содержат степени свободы вдоль AA и BB, соответственно, а {DI} 
представляет внутренние степени свободы. Векторы нагрузки {RA} и {RI} представ-
ляют нагрузки, приложенные к подконструкции, а векторы нагрузки {FA} и {FB} яв-
ляются результатом упругих деформаций от соседних подконструкций и приложены 
вдоль AA и BB. Поскольку все подконструкции идентичны, то {DB} = {DA} и {FB} = 
-{FA}. Уравнение (2-17) приводится к виду: 

 (2-18) 

Линейно упругая механика трещин  

В Основной системе можно рассчитывать двух- и трехмерные задачи с линейно упру-
гой механикой трещин. Существуют три основные моды открытия трещины, пока-
занные на рисунке. Мода I представляет открытие трещины от растягивающей на-
грузки, приложенной перпендикулярно плоскости трещины, мода II описывает 
решение около трещины от поперечной нагрузки, приложенной параллельно граням 
трещины (плоскостная поперечная). Мода III описывает решение около трещины от 
поперечной нагрузки, приложенной перпендикулярно граням трещины (антиплоско-
стная поперечная). 

 

Рис. 2-2. Координаты и моды деформации края трещины  

Для моды I поля напряжений и деформаций около трещины в координатах края тре-
щины имеют следующий вид (Irwin, 1961): 

 (2-19) 

 (2-20) 

В этих уравнениях KI приводится как фактор интенсивности напряжений для моды от-
крытия. Каждая мода трещины имеет фактор интенсивности напряжений, зависящий 
от геометрии трещины и приложенной нагрузки. Факторы интенсивности напряже-
ний не связаны с факторами сосредоточения напряжений. Факторы интенсивности 
напряжений не только описывают поля перемещений и напряжений около края тре-
щины, но также определяют скорости высвобождения энергии упругости G, связан-
ные с трещиной. Связь между факторами K и G имеет вид: 
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G = (1 - ν2)(KI
2 + KII2)/E + KIII

2/E  (2-21) 

Линейно упругий расчет трещин с использованием факторов интенсивности напряже-
ний указывается в подменю Analysis > STATIC > CRACK. 

Модальный расчет  
Вычисление собственных частот и форм мод называется модальным расчетом или 
расчетом нормальных мод. Система КЭ-уравнений для динамических систем имеет 
следующий вид: 

 (2-22) 

где [M] � матрица масс а [C] � матрица демпфирования. При свободных вибрациях 
уравнение принимает вид: 

 (2-23) 

Когда недемпфированная линейно упругая конструкция подвергается начальному пе-
ремещению до какой-либо формы, то она будет неопределенно колебаться с той же 
формой моды, но с различными амплитудами. Формы колебания называются модами 
формы, а соответствующие частоты � собственными частотами. При рассмотрении 
собственных частот и форм мод в данном Руководстве используется термин модаль-
ный расчет. Для недемпфированных линейно упругих конструкций уравнение при-
нимает вид: 

 (2-24) 

Если не приложено никаких внешних нагрузок, то конструкция предполагается сво-
бодно вибрирующей по гармоническому закону: 

U(t) =φsin(ωt +θ)  (2-25) 

что позволяет вывести задачу о собственных значениях: 

[[K] - ω2[M]]{φ}= {0}  (2-26) 

где ω � собственная частота, а φ � соответствующая форма моды конструкции. 

Методы извлечения собственных значений в модальном расчете  

В Основной Системе используются четыре метода вычисления собственных значений: 

! Метод подпространственных итераций  

! Метод Ланцоша  
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! Метод Якоби  

! Обратная степенная итерация  

Полное описание этих методов приведено в книге Теоретические основы COSMOS/M. 

Рассмотрение мод жесткого тела в модальном расчете � сдвиг  

Сдвиг можно рассматривать как смещение точки отсчета при отображении собствен-
ных значений. Правильно выбрав точки сдвига можно обеспечить сходимость итера-
ций к любым или ко всем модам (включая моды жесткого тела) конструкции. Ско-
рость сходимости можно увеличить сдвигом близко к искомому корню, поэтому 
рекомендуется осуществлять сдвиг на интервалах итерационного процесса. Сдвиг 
применим к методам подпространственной и обратной степенной итерации. 

Рассмотрение мод жесткого тела в модальном расчете � добавление мягкой пру-
жины  

В дополнение или вместо сдвига, COSMOS/M позволяет использовать мягкую пружи-
ну для расчета собственных частот и форм мод конструкций с модами жесткого тела. 
Так же, как и в статическом расчете, жесткость мягкой пружины прибавляется к диа-
гональным членам матрицы жесткости. Однако рассчитываемые частоты зависят от 
величины жесткости мягкой пружины. Кроме этого, собственные частоты, рассчиты-
ваемые при использовании сдвига, или мягкой пружины, или и того и другого, могут 
отличаться в каждом случае, в зависимости от указанных величин сдвига или жест-
кости пружины; более подробная информация приведена в Главе 9, Выполнение рас-
чета. 

Плоскостные эффекты в модальном расчете � увеличение/уменьшение жестко-
сти от напряжений  

Эффект увеличения жесткости от напряжений в линейном статическом расчете был 
описан выше. Ниже приведено продолжение этой же темы для задач на свободную 
вибрацию. Чтобы рассматривать действие плоскостных эффектов на собственные 
частоты конструкции, сначала необходимо нагрузить и ограничить конструкцию для 
расчета матрицы геометрической жесткости. То есть, статический расчет напряжений 
предшествует вычислению собственных частот, если учитываются плоскостные эф-
фекты. Плоскостные нагрузки вызывают эффекты увеличения/уменьшения жестко-
сти в вибрационном поведении конструкций. Растягивающие мембранные силы уве-
личивают собственные частоты, а сжимающие � уменьшают. Аналогично 
статическому расчету с учетом плоскостных эффектов, расчет нормальных мод с 
учетом этих эффектов выполняется в два этапа. На первом этапе рассчитываются пе-
ремещения {ui} для нагруженной и ограниченной матрицы [K]. На втором этапе, на 
основе рассчитанных перемещений {ui} составляется матрица геометрической жест-
кости [KG(Ui)], добавляется к обычной матрице жесткости [K], и решается вместе с 
матрицей массы, собственными частотами ω и соответствующим виртуальными пе-
ремещениями (собственными векторами) {ψi+1}. С включение плоскостных эффектов 
система КЭ-уравнений для вычисления собственных частот и форм мод принимает 
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вид: 

([K] + [KG(Ui)] - ω 2[M]){ψi+1}= {0}  (2-27) 

где [KG(Ui)] � матрица геометрической жесткости, составленная на основе {ui}, [M] �
матрица массы, ω  � собственная частота, а {ψi+1} представляют собственные векто-
ры, описывающие собственные моды конструкции. 

Включение плоскостных эффектов в расчет собственных частот указывается в коман-
де A_FREQUENCY (Analysis > FREQUENCY/BUCKLING > Frequency Options). 

Расчет устойчивости с собственными значениями  
Нарушение устойчивости � неожиданная деформация, происходящая когда накоплен-
ная мембранная энергия переходит в изгибающую энергию без изменения внешней 
нагрузки. Нарушение устойчивости происходит когда полная матрица жесткости 
становится единичной: 

[K - λKG]{q}= {0}  (2-28) 

где KG � матрица геометрической жесткости (также называемая матрицей жесткости 
напряжений или матрицей дифференциальной жесткости), независимая от свойств 
материала конструкции, в отличие от обычной матрицы жесткости. λ представляет 
коэффициент, на который надо домножить приложенную нагрузку, чтобы произошло 
нарушение устойчивости. Вычисление множителей нагрузки устойчивости является 
задачей на собственные значения, к которой применимы все методы, описанные в 
разделе Модальный расчет. 

Модальный расчет пьезоэлектрических материалов  
Электромеханические составляющие уравнения для линейного поведения записыва-
ются в следующей форме: 

{σ}= [D]{ε}- [e]{El}  (2-29) 

{Dl}= [e]T{ε}+ [εd]{El} 

где {σ} � вектор напряжений, {DL} � вектор плотности электрического потока, [D] � 
матрица коэффициентов упругости в постоянном электрическом поле, {ε} как и ра-
нее, представляет механические деформации, [e] � матрица пьезоэлектрических 
свойств, {EL} � вектор, представляющий электрическое поле, и [εd] � матрица ди-
электрических свойств при постоянной механической деформации. Упругие, диэлек-
трические и пьезоэлектрические свойства материала и процедуры их задания полно-
стью описаны в Главе 6, Свойства материала, сечения и другие физические 
свойства. Без члена зависимости [e] эти уравнения представляют составляющие 
уравнения для упругостатических и электростатических задач. 

Система КЭ-уравнений для расчета собственных частот и форм мод имеет ту же фор-
му, что и в модальном расчете. Для извлечения собственных значений в пьезоэлек-
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трическом модальном расчете используются те же методы, что и в модальном расче-
те. 

Редукция по методу Ги  
В очень больших задачах вычисление собственных значений и векторов требует много 
времени и вычислительных ресурсов. Однако, моно значительно уменьшить число 
степеней свободы, ускорив тем самым процесс вычисления, если применить сжатие в 
виде редукции по методу Ги. В COSMOS/M редукцию по методу Ги можно исполь-
зовать совместно с методами подпространственной итерации и Якоби, где число 
уравнений уменьшается удалением менее важных степеней свободы. Пусть Dm пред-
ставляет более важные или ведущие степени свободы, а Ds � менее важные или под-
чиненные. Тогда уравнения движения можно записать так: 

 (2-30) 

Главным предположением в редукции по методу Ги является предположение о том, 
что в модах с более низкими частотами силы инерции в подчиненных степенях сво-
боды имеют намного меньшее значение, чем силы упругости, передаваемые ведущи-
ми степенями свободы. Это является критерием при определении, ведущей или под-
чиненной будет данная степень свободы. Учитывая это предположение, нижняя 
часть матрицы масс может быть отброшена и, из нижней части матрицы: 

{Ds}= -Kss-1 Kms
T Dm  (2-31) 

После исключения подчиненных степеней свободы из набора уравнений получаем: 

([Keq] - ω2[Meq]){Dm}= {0}  (2-32) 

где 

Keq = Kmm - Kms Kss
-1 Kms

T  (2-33) 

Meq = Mmm - Mms Kss
-1 Kms

T  (или сосредоточенная масса в ведущих степенях свободы) 

Из вышеприведенного уравнения можно заключить, что Keq и Meq в общем случае яв-
ляются полными матрицами, то есть m (число ведущих степеней свободы) должно 
быть значительно меньше общего числа степеней свободы, чтобы было целесообраз-
но применение редукции по методу Ги. Если матрица конструкции имеет малые диа-
пазоны, то более выгодным будет не применять сжатие. 

Использование редукции по методу Ги в COSMOS/M 

a. Создайте модель обычными методами. 

b. Выберите ведущие степени свободы командами подменю LoadsBC > 
STRUCTURAL > MASTER DOF. 
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c. Создайте элементы MASS в точках расположения ведущих степеней свободы ко-
мандами M_PT (Meshing > PARAMETRIC MESH > Points) или EL (Meshing > 
ELEMENTS > Define Element). Если вы используете команду  EL, то в качестве свя-
занного геометрического примитива необходимо использовать КЛЮЧЕВЫЕ 
ТОЧКИ. Оцените связанные массы, и введите эту информацию в команде RCONST 
(Propsets > Real Constant). 

d. В команде A_FREQUENCY (Analysis > FREQUENCY/BUCKLING > Frequency 
Options) укажите редукцию по методу Ги вместе с методом Якоби (GJ) или подпро-
странственной итерации (GS). 

e. Выполните частотный расчет командой R_FREQUENCY (Analysis > 
FREQUENCY/BUCKLING > Run Frequency). Частоты и формы мод будут сохранены 
в базе данных. Проверочная задача F27A.GEO иллюстрирует последовательность 
команд, необходимую для использования редукции по методу Ги. 

Оценка напряжений секции III кода ASME  
Формулируется оценка результатов в форме, допускающей сравнение требованиями с 
секции III кода ASME. На основе произвольно заданного поперечного сечения рас-
считываются результирующие, мембранные, изгибающие, пиковые напряжения и 
интенсивности напряжений. 

Критерий отказа  в типичном КЭ-расчете включает пиковое напряжение. Допустимые 
напряжения Sm, 1.5 Sm, и 3.0 Sm, указанные секцией III кода ASME основаны на из-
быточных сил и моментов вдоль сечения, связанного с конструкцией типа оболочки 
(Gordon, 1976). В формулировке, используемой здесь (Kroenke, 1974), напряжения 
линеаризуются вдоль «линии классификации напряжений» (или  так называемом 
«сечении») в осесимметричной модели и рассчитываются первичное и вторичное пи-
ковые напряжения (в двух концах сечения) в форме, допускающей сравнения с до-
пустимыми напряжениями (то есть Sm, 1.5 Sm и 3 Sm), указанными в коде ASME и 
согласно с (Gordon, 1976) и (Kroenke, 1974).  

Плоскостной изгибающий момент, мембранные и поперечные силы, а также внепло-
скостные мембранные силы и изгибающие моменты сначала рассчитываются вдоль 
первого сечения, из которого рассчитываются пиковые напряжения для двух типов 
моделей: задач с плоскими напряжениями/деформациями и осесимметричных задач. 

Сечение определяется линией, проходящей по толщине, и задается двумя узлами на 
его концах. 
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Рис. 2-3. Сечение, проходящее по толщине и соответствующие координаты сечения  

Сечение должно представлять рациональную плоскость изгиба, которая в большинст-
ве случаев будет перпендикулярна обеим поверхностям и средней плоскости. Для 
большинства конструкций с параллельными поверхностями, таких как трубы, обо-
лочки и внешние насадки, этот критерий легко удовлетворяется. Однако в непра-
вильных областях, таких как кривизна в месте соединения оболочек, рациональные 
плоскости изгиба могут быть указаны перпендикулярными средней  плоскости и 
имеющими тот же угол равный углу между сечением и поверхностями на обеих сто-
ронах. Линеаризованные напряжения в двух концах рассчитываются как сумма мем-
бранных (первичных) напряжений, которые постоянны вдоль сечения, и изгибающих 
напряжений, изменяющихся вдоль сечения. Эти напряжения рассчитываются из 
внутренних сил и моментов в сечении. Процедура вычисления этих напряжений опи-
сана в Приложении C. 

 

Рис. 2-4. Рассчитанные напряжения (действительные напряжения) и линеаризованные напряжения 
вдоль сечения  

Пиковое значение напряжения в точке вдоль сечения определяется как разность между 
действительным напряжением, рассчитанным программой и линеаризованным на-
пряжением. Таким образом, пиковые напряжения в концах и центре сечения опреде-
ляются из: 

σp
i1 = σi1 - σm

i - σb
i1 (в конце 1)  (2-34) 
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σp
i2 = σi2 - σm

i - σb
i2 (в конце 2) 

σp
ic = σic - σm

i 

где i соответствует i-му компоненту напряжения, σm
i соответствует постоянному мем-

бранному напряжения вдоль сечения, а σb
i1 и σbi2 соответствуют изгибающим напря-

жениям в концах сечения. Заметьте, что изгибающие напряжения в центре сечения 
принимаются равными нулю. 
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Глава 3. 
Приступая к работе  
Введение  

В предыдущих главах были описаны некоторые из особенностей КЭ-расчета в Основ-
ной Системе и их математические основы. В этой главе будет описан пример, иллю-
стрирующий линейный статический расчет. Данное руководство построено на прин-
ципе, что хорошая иллюстрация может заменить несколько параграфов объяснений, 
и данная глава не исключение. Кроме этого, вы увидите простоту создания и расчета 
моделей в COSMOS/M. Для иллюстрирования линейного статического расчета была 
выбрана модель с простой геометрией, использующая как совместимую КЭ-сеть, так 
и несовместимую для иллюстрации возможности «скрепления». 

Линейный статический расчет напряжений  
На рисунке показана геометрия модели для расчета с приложенными нагрузками и 
граничными условиями. Задача представляет балку со ступенчатым поперечным се-
чением, которая будет смоделирована с использованием плоских элементов 
PLANE2D для демонстрации некоторых особенностей модуля STAR. Иначе, эту за-
дачу можно точно смоделировать с использованием балочных элементов. 

 

Рис. 3-1. Задача для расчета  

Для начала запустите GEOSTAR и укажите имя задачи для данного примера. Чтобы 
приступить к созданию геометрии выполните следующие шаги для установки проек-
ции и рабочей плоскости. Нажмите на кнопку выбора проекции (с изображением би-
нокля) и выберите вторую иконку для установки проекции на плоскость XY. Затем из 
меню Geometry > GRID выберите команду Plane и введите в диалоговом окне сле-
дующие значения (в данном случае � значения по умолчанию):  
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Control Panel: Geometry > GRID > Plane 
Rotation/Sweep Axis >Z 
Offset on Axis >0.0 
Grid Line style >Solid 

Из меню Geometry > SURFACES выберите команду Draw w/ 4 Coord (для создания 
ПОВЕРХНОСТИ указанием четырех координат на сетке или вводом их в окне диало-
га). Введите следующие значения (можно использовать мышь или окно диалога): 
Control Panel: Geometry > SURFACES > Draw w/ 4 Coord 
Surface >1 
Keypoint 1 XYZ-Coordinate value >55,0,0 
Keypoint 2 XYZ-Coordinate value >60,0,0 
Keypoint 3 XYZ-Coordinate value >60,20,0 
Keypoint 4 XYZ-Coordinate value >55,20,0 

Аналогично создайте ПОВЕРХНОСТИ 2 и 3 использую следующие значения: 
Surface >2 
Keypoint 1 XYZ-Coordinate value >50,20,0 
Keypoint 2 XYZ-Coordinate value >65,20,0 
Keypoint 3 XYZ-Coordinate value >65,100,0 
Keypoint 4 XYZ-Coordinate value >50,100,0 
Surface >3 
Keypoint 1 XYZ-Coordinate value >55,100,0 
Keypoint 2 XYZ-Coordinate value >60,100,0 
Keypoint 3 XYZ-Coordinate value >60,120,0 
Keypoint 4 XYZ-Coordinate value >55,120,0 

Для верхней и нижней частей, имеющих одинаковые размеры, КЭ-сеть будет сгенери-
рована с использованием одинакового числа элементов. 

Нажмите на кнопку автоматического изменения масштаба (SCALE;) для правильного 
представления созданных ПОВЕРХНОСТЕЙ на экране. В данной задаче будут ис-
пользованы элементы PLANE2D для учета плоскостного поведения под нагрузкой. 
Поскольку толщина верхней и нижней ПОВЕРХНОСТЕЙ отличается от толщины 
средней, понадобится использовать два набора вещественных констант. При генера-
ции КЭ-сети созданные элементы связываются с активными группой элементов и на-
бором вещественных констант. Для задания группы элементов, свойств материала и 
первого набора вещественных констант выполните следующие команды. Из меню 
Propsets выберите команду Element Group (EGROUP) и укажите элемента PLANE2D  в 
группе номер 1. В следующем диалоговом окне примите все значения по умолчанию. 
Из меню Propsets выберите команду Pick Material Lib (PICK_MAT) и примите все зна-
чения по умолчанию. Для набора свойств материала номер 1 будет выбран сплав ста-
ли (A_STEEL) в системе единиц FPS. Затем из того же меню выберите команду Real 
Constant (RCONST), примите значения по умолчанию в первых двух окнах диалога и в 
последнем введите значение толщины: 
Control Panel: Propsets > Real Constant 
Associated element group >1 
Real constant set >2 
Start loc. of real const. >1 
No. of real const. to be entered >2 
RC1: Thickness >0.15 
RC2: Material Angle (Beta) >0.0 

Теперь можно приступить к генерации КЭ-сети для верхней и нижней 
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ПОВЕРХНОСТЕЙ. Из меню Meshing > PARAMETRIC MESH выберите команду 
Surfaces (M_SF) и введите следующие значения: 
Control Panel: Meshing > PARAMETRIC MESH > Surfaces 
Beginning surface >1 
Ending surface >3 
Increment >2 
Number of nodes per element >4 
Number of elements on 1st curve >4 
Number of elements on 2nd curve >8 
Spacing ratio for 1st curve >1.0 
Spacing ratio for 2nd curve >1.0 

Перед генерацией КЭ-сети для средней ПОВЕРХНОСТИ необходимо задать второй 
набор вещественных констант командой Real Constant, и ввести следующие значения: 
Control Panel: Propsets > Real Constant 
Associated Element Group >1 
Real Constant set >2 
Start loc. of real const. >1 
No. of real const. to be entered >2 
RC1: Thickness >0.016667 
RC2: Material Angle (Beta) >0.0 

Затем сгенерируйте КЭ-сеть для средней ПОВЕРХНОСТИ. Из меню Meshing > 
PARAMETRIC MESH выберите команду (M_SF) и укажите следующие значения: 
Control Panel: Meshing > PARAMETRIC MESH > Surfaces 
Beginning surface >2 
Ending surface >2 
Increment >1 
Number of nodes per element >4 
Number of elements on 1st curve >12 
Number of elements on 2nd curve >36 
Spacing ratio for 1st curve >1.0 
Spacing ratio for 2nd curve >1.0 

На рисунке показаны ПОВЕРХНОСТИ и созданная КЭ-сеть  

 

Рис. 3-2. ПОВЕРХНОСТИ и сгенерированная КЭ-сеть  
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Ограничения по перемещениям вводятся следующим образом: в верхней опоре огра-
ничивается x-компонент перемещений, а в нижней и x- и y-компоненты. Эти гранич-
ные условия в узлах вводятся следующим образом. Из меню LoadsBC > 
STRUCTURAL > DISPLACEMENT выберите команду Define Nodes (DND) и укажите 
следующие значения: 
Control Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define Nodes 
Beginning node >88 
Displacement Label >UX; X translation 
Value >0.0 
Ending node >88 
Increment >1 

В следующем окне диалога примите значения по умолчанию. Заметьте, что переход 
между окнами диалога рекурсивен, что означает что вы также можете ввести гранич-
ные условия для узла 3: 
Beginning node >3 
Displacement Label >UX; X translation 
Value >0.0 
Ending node >3 
Increment >1 
Displacement Label >UY; Y translation 

После того как вы примете последнее значение UY, вы снова увидите первое диалого-
вое окно задания граничных условий по перемещениям. Нажмите на Cancel для за-
вершения команды. 

Приложенные граничные условия показаны на рис. 3-3. 

 

Рис. 3-3. Приложенные граничные условия и нагрузки  

Вертикальная нагрузка прикладывается к КРИВОЙ 10, как показано на рисунке. Из 
меню LoadsBC > STRUCTURAL > PRESSURE выберите команду Define Curves (PCR) 
и укажите следующие значения: 
Control Panel: LoadsBC > STRUCTURAL > PRESSURE > Define Curves 
Beginning curve >10 
Pressure Magnitude >1 
Ending curve >10 
Increment >1 
Pressure at the end of direction >1 
Pressure Direction >Normal Direction 
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Как и предыдущая команда, эта также рекурсивна. То есть после того как вы примете 
вышеприведенные значения, нажмите на Cancel чтобы завершить команду. 

Поскольку для каждой ПОВЕРХНОСТИ КЭ-сеть генерировалась независимо от со-
седних, то будут присутствовать дублирующиеся узлы на общей границе. Для обес-
печения совместимости эти узлы необходимо «слить». Из меню Meshing > NODES 
выберите команду Merge (NMERGE) и примите все значения по умолчанию. Разрывы 
в нумерации узлов, получающиеся в результате «слияния» удаляются командой Edit 
> COMPRESS > Nodes (NCOMPRESS). В данной задаче будет «сжато» 10 узлов. 

Теперь КЭ-модель готова для расчета. Используйте команду R_STATIC (Analysis > 
STATIC > Run Static Analysis) для выполнения линейного статического расчета на-
пряжений. Результаты расчета будут записаны в файл вывода с расширением OUT. 

График деформированной формы модели можно отобразить командой DEFPLOT 
(Results > PLOT > Deformed Shape). Вы можете наложить на график КРИВЫЕ для 
лучшего отображения деформированной формы командой CRPLOT (Edit > PLOT > 
Curves). 

Для отображения контурных графиков напряжений и перемещений используйте сле-
дующие команды: в меню Results > PLOT выберите команду Stress (ACTSTR и 
STRPLOT) и в меню Results > PLOT выберите команду Displacement (ACTDIS и 
DISPLOT), соответственно. Когда вы выполните эти команды, то будут отображены 
графики напряжений по фон Мизесу и результирующих перемещений. 

На нижеприведенном рисунке показаны контурные графики результирующих пере-
мещений и напряжений по фон Мизесу, а также графики деформированной формы 
модели. Графики в левой части рисунка относятся к только что выполненном расче-
ту. Графики в правой части отображают результаты расчета, полученные с использо-
ванием функции «скрепления» (см. Главы 8 и 11), в котором узлы на общих 
КРИВЫХ были намеренно созданы несовпадающими с целью проверки. Как можно 
заметить, результаты двух расчетов практически одинаковы. 

 

Рис. 3-4. Графики деформированной формы и контурные графики для моделей с совместимой и несо-
вместимой КЭ-сетями  
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Вы можете попробовать применить другие возможности постпроцессинга. Мы отобра-
зим график изменения напряжений по фон Мизесу вдоль центральной линии от низа 
до верха. Для начала необходимо деактивировать отображение графиков. Из меню 
Results > PLOT выберите команду Path Graph (LSECPLOT) и выберите узлы сверху 
донизу вдоль центральной линии модели. Выбрав последний узел, кликните на нем 
дважды для завершения команды. Заметьте, что может понадобиться использовать 
кнопку смещения для отображения контурного графика отдельно от XY-графика. 
Как видно из нижеприведенного рисунка, вы получите график изменения компонен-
та результата вдоль только что указанной линии. 

 

Рис. 3-5. График изменения напряжений по фон Мизесу вдоль пути  
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Глава 4. 
Требования к исходным данным  
Введение  

Для успешного расчета необходимо, чтобы все данные при моделировании и выборе 
варианта расчета были указаны верно. Независимо от варианта расчета (конструкци-
онный, термальный, жидкостный и т.д.), численное решение по методу конечных 
элементов требует полной информации о рассматриваемой модели. КЭ-модель, пере-
даваемая на расчет все данные, необходимые для каждого шага расчета численного 
моделирования � геометрию, элементы, нагрузки, граничные условия, решение сис-
темы уравнений, вывод результатов и т.д. В данной главе сделана попытка проиллю-
стрировать концепции процедуры построения законченной модели для трех вариан-
тов расчета, которые можно выполнять в Основной Системе � линейный 
статический, расчет устойчивости и модальный расчет. 

Поскольку основная часть времени при создании КЭ-модели уходит на создание гео-
метрии, эта тема здесь обсуждаться не будет. Руководство пользователя COSMOS/M 
(Том 1) содержит полное описание процедур построения модели и постпроцессинга в 
GEOSTAR. В этой главе описаны команды, относящиеся к расчету в Основной Сис-
теме. В Главе 10 приведена информация о постпроцессинге применительно к Основ-
ной Системе. 

ПРИМЕЧАНИЕ: Полное описание всех команд приведено в Справочнике команд 
COSMOS/M (Том 2). 

Процесс моделирования и расчета в Основной Системе  
Основные этапы КЭ-расчета имеют вид: 

! Создание геометрии модели. 

! Генерация КЭ-сети для геометрии с использованием соответствующих элементов. 

! Приложение ограничений к КЭ-модели. 

! Задание нагрузок на модель. 

! Задание свойств материала и сечения. 

! Передача законченной КЭ-модели на расчет. 

! Анализ и интерпретация результатов. 

Эти шаги могут быть схематически отображены на рисунке. 



 46

 

Рис. 4-1. Этапы КЭ-моделирования и расчета  

Препроцессинг обозначает операции, выполняемые до передачи модели на расчет, та-
кие как создание геометрии модели, генерацию КЭ-сети, приложение нагрузок и гра-
ничных условий и другие. Термин расчет обозначает стадию задания настроек рас-
чет и выполнения собственно расчета. Постпроцессинг обозначает манипулирование 
результатами расчета для лучшего из представления в графической среде. 

Как было описано в Главе 1, каждый вариант расчета в Основной Системе имеет мно-
жество особенностей. Построение КЭ-модели для конкретной задачи, таким образом, 
зависит от использования этих особенностей оптимальным и эффективным способом 
для получения наиболее точного решения для КЭ-модели. 

Схемы и команды для расчета в Основной Системе  
Ниже приведены схемы и таблицы команд для каждого варианта расчета для наиболее 
эффективного создания вашей модели. 
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Линейный статический расчет  

 

Рис. 4-2. Схема линейного статического расчета в Основной Системе  

Важные команды для линейного статического расчета  

Команды, приведенные в таблице, используются для задания групп элементов, 
свойств материала и сечения, нагрузок и граничных условий, настроек расчета и вы-
вода. 

Таблица 4-1. Важные команды для линейного статического расчета  

Функция Меню COSMOS/M  Команда (краткая) * 
Задание свойств Propsets  EGROUP, MPROP, RCONST, 

PICK_MAT, USER_MAT, PICK_SEC, 
BMSECDEF, EPROPSET, 
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EPROPCHANGE 
Нагрузки LoadsBC  

 > STRUCTURAL  
  > DISPLACEMENT  
  > FORCE  
  > PRESSURE 
  > GRAVITY  
THERMAL  
 > TEMPERATURE  

. . .  

. . .  
D_ команды для перемещений  
F_ команды для сил  
P_ команды для распр. нагрузки  
Команды грав. нагрузки  
. . .  
NT_ команды для температур  

Граничные условия LoadsBC  
 > STRUCTURAL  
  > DISPLACEMENT  
  > COUPLING  
  > BONDING  

. . . 

. . .  
D_ команды для перемещений 
CP_ команды для зависимостей  
BOND_ команды для «скрепления»  

Проверка модели Meshing  
 > ELEMENTS  
Analysis  

. . .  
ECHECK  
DATA_CHECK, R_CHECK 

Указание настроек рас-
чета  

Analysis  
 > STATIC  

. . .  
LCSET, ADAPTIVE, P_ORDERLABS, 
A_STATIC, A_STRESS, STRESS 

Указание настроек вы-
вода  

Analysis  
 > OUTPUT OPTIONS  

. . .  
PRINT_OPS 

Выполнение линейного 
статического расчета  

Analysis  
 > STATIC 

 . . .  
R_STATIC, R_STRESS 

Постпроцессинг  Results  Подробная информация приведена в Руко-
водстве Пользователя COSMOS/M (Т.1). 

* Для нахождения команды в меню по краткому имени см. Приложение B, Свод-
ка команд. 
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Расчет устойчивости  

 

Рис. 4-3. Схема расчета устойчивости в Основной Системе  

Важные команды для расчета устойчивости  

Команды, приведенные в таблице, используются для задания групп элементов, 
свойств материала и сечения, нагрузок и граничных условий, настроек расчета и вы-
вода. 

Таблица 4-2. Команды для расчета устойчивости 

Функция Меню COSMOS/M  Команда (краткая) * 
Задание свойств Propsets  EGROUP, MPROP, RCONST, 

PICK_MAT, USER_MAT, PICK_SEC, 
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BMSECDEF, EPROPSET, 
EPROPCHANGE 

Нагрузки LoadsBC  
 >STRUCTURAL  
  > DISPLACEMENT  
  > FORCE  
  > PRESSURE  
  > GRAVITY  
 > THERMAL  
  > TEMPERATURE  

. . .  

. . .  
D_ команды для перемещений  
F_ команды для сил  
P_ команды для распр. нагрузки  
Команды грав. нагрузки  
. . .  
NT_ команды для температур  

Граничные условия LoadsBC  
 > STRUCTURAL  
  > DISPLACEMENT  

. . . 

. . .  
D_ команды для перемещений 

Проверка модели Meshing  
 > ELEMENTS  
Analysis  

. . .  
ECHECK  
DATA_CHECK, R_CHECK 

Указание настроек рас-
чета  

Analysis  
 > FREQUENCY/BUCKLING  

. . .  
A_BUCKLING 

Указание настроек вы-
вода  

Analysis  
 > OUTPUT OPTIONS  

. . .  
PRINT_OPS 

Выполнение расчета  Analysis > 
FREQUENCY/BUCKLING  

. . .  
R_BUCKLING 

Постпроцессинг  Results  Подробная информация приведена в 
Руководстве Пользователя 
COSMOS/M (Т.1). 

* Для нахождения команды в меню по краткому имени см. Приложение B, Свод-
ка команд. 
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Модальный расчет  

 

Рис. 4-4. Схема модального расчета в основной системе  

Важные команды для модального расчета  

Команды, приведенные в таблице, используются для задания групп элементов, 
свойств материала и сечения, нагрузок и граничных условий, настроек расчета и вы-
вода. 
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Таблица 4-3. Важные команды для модального расчета  

Функция Меню COSMOS/M  Команда (краткая) * 
Задание свойств Propsets  EGROUP, MPROP, RCONST, 

PICK_MAT, USER_MAT, PICK_SEC, 
BMSECDEF, EPROPSET, 
EPROPCHANGE 

Нагрузки LoadsBC  
 > STRUCTURAL  
  > DISPLACEMENT 
  > FORCE  
  > PRESSURE  

. . . 

. . .  
D_ команды для перемещений  
F_ команды для сил 
P_ команды для распр. нагрузки 

Граничные условия LoadsBC  
 > STRUCTURAL  
  > DISPLACEMENT  
  > MASTER DOF  
  > COUPLING  
  > BONDING 

 . . .  
. . .  
D_ команды для перемещений 
MD_ команды для редукции по Ги  
CP_ команды для зависимых СС  
BOND_ команды для СС «скрепления» 

Проверка модели Meshing  
 > ELEMENTS  
Analysis 

. . .  
ECHECK  
DATA_CHECK, R_CHECK 

Указание настроек рас-
чета  

Analysis  
 > FREQUENCY/BUCKLING 

. . .  
A_FREQUENCY 

Указание настроек вы-
вода  

Analysis 
 > OUTPUT OPTIONS 

. . .  
PRINT_OPS 

Выполнение расчета   Analysis  
 > FREQUENCY/BUCKLING 

. . .  
R_FREQUENCY 

Постпроцессинг  Results  Подробная информация приведена в 
Руководстве Пользователя 
COSMOS/M (Т.1). 

* Для нахождения команды в меню по краткому имени см. Приложение B, Свод-
ка команд. 

Проверка исходных данных модели  
Одним из трудных моментов в решении и больших и маленьких задач является избе-
жание ошибок в исходных данных модели. Некоторые из ошибок могут быть обна-
ружены отображением модели в различных проекциях, просмотром связности эле-
ментов, свойств материала и сечения, отображением и просмотром нагрузок и 
ограничений и другими способами. В маленьких задачах часто бывает легче выпол-
нить такие проверки правильности задания данных. Однако можно пропустить неко-
торые трудноопределяемые ошибки. В таких ситуациях, а также для больших задач, 
рекомендуется выполнять проверки модели автоматически. COSMOS/M предостав-
ляет мощные инструменты для проверки правильности КЭ-модели, созданной в 
GEOSTAR, автоматически. В нижеприведенной таблице описаны команды, которые 
вы можете использовать для проверки модели, и их функции. 

Таблица 4-4. Команды проверки исходных данных модели  

Команда (краткая)  Меню Функция 
ECHECK  Meshing > ELEMENTS  Проверяет соотношение сторон указанных элементов. 

Команда автоматически удаляет вырожденные элемен-
ты из модели. Команда также проверяет связность эле-
ментов. 

DATA_CHECK  Analysis  Проверяет наличие группы элементов, набора свойств 
материала и набора вещественных констант для каждо-
го элемента в модели. 

R_CHECK  Analysis  Выполняет тщательную проверку модели на правиль-
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ность и законченность исходных данных для указанно-
го варианта расчета. 

Как видно из таблицы, команда Data Check является подмножеством команды Run 
Check. Но хотя команда Run Check определяет элементы с плохой геометрией, удале-
ние вырожденных элементов выполняется командой ECHECK (Meshing > ELEMENTS 
> Check Element). 

ПРИМЕЧАНИЕ: Настоятельно рекомендуется выполнять команду Run Check и вно-
сить изменения в модель до выполнения любого расчета. 

Заметьте, что команда Run Check является общим инструментом проверки модели. Вы 
все равно можете обнаружить ошибки, не найденные этой командой. В большинстве 
случаев сообщения, выводимые на экран или в файл вывода, предоставят информа-
цию о причине ошибки и способах ее устранения. 
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Глава 5. 
Библиотека элементов  
Введение  

Основная Система предоставляет обширную библиотеку элементов для КЭ-
моделирования и расчета всех типов практических задач. Элементы моделируют по-
ведение одно- двух- и трехмерных задач в линейном статическом, модальном расче-
тах и расчете устойчивости. Некоторые из элементов можно использовать как адап-
тивные конечные элементы для h-, p- и hp-методов расчета.  

Полное описание всех элементов приведено в Руководстве Пользователя COSMOS/M 
(Т. 1). В этой главе приведено краткое описание доступных элементов и их использо-
вание в моделировании и расчете.  

ПРИМЕЧАНИЕ: Во второй части данного Руководства, Проверочные задачи, приве-
ден список проверочных задач по типу элемента. Вы можете рассмотреть эти приме-
ры для понимания применения различных типов элементов, доступных в Основной 
Системе. 

Библиотека элементов Основной Системы  
В таблице приведены команды задания групп элементов и управления связанными 
свойствами элементов. 

Таблица 5-1. Команды задания, изменения и вывода групп элементов  

EGROUP  
(Propsets > Ele-
ment Group)  

Задает группу элементов и связанные опции 
элемента для расчета.  

Максимальное допустимое число групп 
элементов в модели � 20. 

EPROPSET  
(Propsets > New 
Property Set)  

Назначает существующие группу элементов, 
набор свойств материала и набор вещест-
венных констант, а также координатную 
систему элемента вновь созданным элемен-
там. 

 

EPROPCHANGE  
(Propsets > 
Change El-Prop)  

Изменяет связь между группами элементов, 
наборами вещественных констант и набора-
ми свойств материала. 

 

EGLIST  
(Edit > LIST > 
Element Groups)  

Выводит на экран указанные группы эле-
ментов и связанные опции.  

Листинг на экране может быть перена-
правлен в текстовый файл с помощью ко-
манды Control > MISCELLANEOUS > List 
Log.  
Более подробная информация о создании и 
изменении групп элементов приведена в 
Главе 5. 

EGDEL  
(Edit > DELETE > 
Element Groups)  

Удаляет указанные группы элементов и свя-
занные опции. 
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Ниже приведено графическое представление элементов, доступных в Основной Сис-
теме. В Главе 4 Руководства Пользователя COSMOS/M (Т. 1) приведено подробное 
всех элементов. 

ПРИМЕЧАНИЕ: Если не указано иначе, все команды, упоминаемые в этой главе на-
ходятся в меню Propsets и Edit. 

Элементы для линейного статического, модального расчетов и расчета устойчивости  
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Элементы для линейного статического, модального расчетов и расчета устойчивости (Продолжение) 
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Элементы для линейного статического, модального расчетов и расчета устойчивости (Продолжение) 
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Задание групп элементов и связанных опций  
Для задания номера группы элементов, типа элемента и связанных опций моделирова-
ния и расчета используется команда EGROUP (Propsets > Element Group). Всего в мо-
дели может быть задано до 20 групп элементов. 

В команде указывается номер группы элементов и тип элемента из разрешенных имен 
элементов. В Таблице 5-2 приведены все иена элементов, разрешенные в команде Ele-
ment Group. Также указана доступность элементов в Основной Системе. 

Для вывода данных, заданных  в команде Element Group, используется команда EGLIST 
(Edit > LIST > Element Groups). По умолчанию эта информация также записывается в 
файл вывода после выполнения расчета. Командой EGDEL (Edit > DELETE > Element 
Groups) можно удалить существующую группу элементов и связанные опции. 

Таблица 5-2. Разрешенные имена элементов в команде Element Group  

Имя элемента Описание Доступность 
в Основной 
Системе 

BEAM2D  Двухмерная упругая балка � 
BEAM3D  Трехмерная упругая балка � 
BOUND  Граничный элемент  � 
BUOY  1-узловой сферический элемент, погруженный в жидкость 

(обычно используется с элементом IMPIPE)  
N/A 

CLINK  Конвекционный соединитель  N/A 
ELBOW  Упругая изогнутая труба  � 
ELINK  Электрический соединитель  N/A 
FLOW2D  Двухмерный элемент жидкости  N/A 
FLOW3D  Трехмерный элемент жидкости  N/A 
GAP  Элемент GAP � 
GENSTIF  Численное задание жесткости  � 
HLINK  Гидравлический соединитель  � 
IMPIPE  Труба/кабель, погруженная в жидкость  N/A 
MAG2D  Двухмерный магнитный элемент  N/A 
MAG3D  Трехмерный магнитный элемент N/A 
MASS  Численное задание массы  � 
PIPE  Упругая прямая труба  � 
PLANE2D  4-8-узловой плоский/осесимметричный элемент  � 
RBAR  Жесткий брус � 
RLINK  Радиационный соединитель N/A 
SHELL3  3-узловой элемент тонкостенной оболочки  � 
SHELL3L  3-узловой элемент составной оболочки � 
SHELL3T  3-узловой элемент толстостенной оболочки � 
SHELL4  4-узловой элемент тонкостенной оболочки  � 
SHELL6  6-узловой элемент тонкостенной оболочки  � 
SHELL4L  4-узловой элемент составной оболочки � 
SHELL4T  4-узловой элемент толстостенной оболочки � 
SHELL9  9/8-узловой элемент оболочки � 
SHELL9L  9/8-узловой элемент составной оболочки � 
SHELLAX  Элемент осесимметричной оболочки  � 
SOLID  8-20-узловой объемный элемент  � 
SOLIDL  8-узловой составной объемный элемент  � 
SOLIDPZ  8-20-узловой объемный пьезоэлектрический элемент  � 
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SPRING  Элемент пружины � 
TETRA10  10-узловой четырехгранный объемный элемент  � 
TETRA4  4-узловой четырехгранный объемный элемент � 
TETRA4R  4-узловой четырехгранный объемный элемент с угловыми 

степенями свободы  
� 

TRIANG  3-9-узловой плоский/осесимметричный элемент  � 
TRUSS2D  Двухмерный стержень � 
TRUSS3D  Трехмерный стержень � 

Каждый элемент имеет различные опции моделирования и расчета (всего семь), обо-
значенные OP1, �, OP7. Когда вы выполняете команду Element Group, выводится 
подсказка о физической интерпретации опций, зависящая от выбранного элемента. 
Некоторые из опций не используются в Основной Системе. 

В таблице 5-3 приведена сводка опций элементов в Основной Системе. В Таблице 5-4 
приведены координатные системы для вывода результатов для всех элементов. Более 
подробная информация об элементах приведена в Главе 4 Руководства Пользователя 
COSMOS/M (Т. 1). 

Таблица 5-3. Опции моделирования и расчета для элементов  

 Опции элемента 
Элемент OP1  OP2  OP3  OP4  OP5  OP6  OP7 
TRUSS2D  не исп.  не исп.  не исп.  не исп.  по умолч.  по умолч.  по умолч. 
TRUSS3D не исп.  не исп.  не исп.  не исп.  по умолч.  по умолч.  по умолч. 
BEAM2D  не исп.  не исп.  не исп.  по умолч.  по умолч.  по умолч.  не исп. 
BEAM3D  Тип сечения  

0=симметр.  
1=несимм.  
2=симм. 
сужающееся  

не исп.  не исп.  по умолч.  по умолч.  по умолч.  не исп. 

RBAR  нет 
SPRING  Тип пружи-

ны  
0=прод.  
1=угл.  
2=оба  

по умолч.  не исп.  не исп.  по умолч.  по умолч.  не исп. 

PIPE  нет 
ELBOW  нет 
GAP  Обновление 

поверхности  
0=зафикс. 
1=подвижн.  

Трение  
0=без трения 
1=трение без 
скольжения  
2=трение со 
скольж.  

по умолч.  по умолч.  по умолч.  Измерение 
сжимаемого 
зазора  
0=пользоват
ельское  
1=авто 

по умолч. 

MASS  нет 
BOUND  Тип границы  

0=прод. 
пруж. 
1=угл. пруж.   
2=оба  

не исп.  не исп.  не исп.  не исп.  не исп.  не исп. 

PLANE2D  Тип элемен-
та  
0=констр./те
рм..  
1=жидкость  

Квадратура  
0=сокр. инт..  
1=QM6  
2=полн. инт. 

Тип задачи  
0=пл. напр.  
1=осесимм.  
2=пл. деф.  
3=осесимм..  

Вывод напр.  
0=глоб. CS  
1=ECS  

по умолч.  по умолч.  по умолч. 

TRIANG  не исп.  не исп.  Тип задачи  
0=пл. напр.  
1=осесимм.  
2=пл. деф. 

Вывод напр.  
0=глоб. CS  
1=ECS  

не исп.  не исп.  не исп. 

SHELL3  не исп.  Вар. расчета  
0=оболочка 
1=мембрана  
2=срез. па-
нель  

Вывод напр.  
0=центр. 
элем  
1=+узл. 
силы  

Напр. узл. 
напр.  
0=глоб. CS  
1=лок. CS  

по умолч.  по умолч.  не исп. 
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2=+узл. 
напр. str.  

SHELL4  Тип элем. 
0=QUAD2  
1=QUAD4  
2=QUAD  

Вар. расчета  
0=оболочка 
1=мембрана  
2=срез. па-
нель  

Вывод напр.  
0=центр. 
элем  
1=+узл. 
силы  
2=+узл. 
напр. str.  

Напр. узл. 
напр.  
0=глоб. CS  
1=лок. CS  

по умолч.  по умолч.  не исп. 

SHELL6  не исп.  Тип интегр.  
0=сокращ. 
1=полное 

не исп.  Напр. узл. 
напр.  
0=глоб. CS  
1=лок. CS  

не исп.  не исп.  не исп. 

SHELL3T  не исп.  Вар. расчета  
0=оболочка 
1=мембрана  
2=срез. па-
нель  

Вывод напр.  
0=центр. 
элем  
1=+узл. 
силы  
2=+узл. 
напр. str.  

Напр. узл. 
напр.  
0=глоб. CS  
1=лок. CS  

по умолч.  по умолч.  не исп. 

SHELL4T  Тип элем. 
0=QUAD2  
1=QUAD4  
2=QUAD  

Вар. расчета  
0=оболочка 
1=мембрана  
2=срез. па-
нель  

Вывод напр.  
0=центр. 
элем  
1=+узл. 
силы  
2=+узл. 
напр. str.  

Напр. узл. 
напр.  
0=глоб. CS  
1=лок. CS  

по умолч.  по умолч.  не исп. 

SHELL3L  не исп.  Число слоев Напр. узл. 
напр.  
0=глоб. CS  
1=лок. CS  
2=мат. CS  

Номер слоя 
для вывода 
напр.  

по умолч.  по умолч.  Ввод  
0=по слоям  
1=бутерброд 

SHELL4L  Тип элем. 
0=QUAD2  
1=QUAD4  
2=QUAD  

Число слоев Напр. узл. 
напр.  
0=глоб. CS  
1=лок. CS  
2=мат. CS  

не исп.  по умолч.  по умолч.  Ввод  
0=по слоям  
1=бутерброд 

SHELL9  Число узлов  
0=9 узлов  
1=8 узлов  

Квадратура  
0=γ-φ метод 
1=сокр. инт..  

не исп.  Напр. узл. 
напр.  
0=глоб. CS  
1=лок. CS  

не исп.  не исп.  не исп. 

SHELL9L  Число узлов  
0=9 узлов  
1=8 узлов  

Квадратура  
0=γ-φ метод 
1=сокр. инт..  

Число слоев Номер слоя 
для вывода 
напр.  

Напр. узл. 
напр.  
0=глоб. CS  
1=лок. CS  

не исп.  не исп. 

SHELLAX  нет 
TETRA4  N/A  не исп.  не исп.  Вывод напр.  

0=глоб. CS  
1=ECS  

не исп.  не исп.  не исп. 

TETRA4R  N/A  не исп.  не исп.  Вывод напр.  
0=глоб. CS  
1=ECS  

не исп.  не исп.  не исп. 

TETRA10  N/A  не исп.  не исп.  Вывод напр.  
0=глоб. CS  
1=ECS  

не исп.  не исп.  не исп. 

SOLID  Тип элем. 
0=объемн. 
1=жидкость  

Квадратура 
0=сокр. инт.. 
1=гибрид. 
2=полн. инт. 

не исп.  Вывод напр.  
0=глоб. CS  
1=ECS  

по умолч.  по умолч.  по умолч. 

SOLIDL  Квадратура 
0=сокр. инт.. 
1=гибрид. 
2=полн. инт.  

Число слоев Напр. узл. 
напр.  
0=глоб. CS  
1=лок. CS  
2=мат. CS  

Номер слоя 
для вывода 
напр.  

не исп.  не исп.  не исп. 

SOLIDPZ  Тип интегр.  
1=гибрид. 
2=полн. 

не исп.  Напр. узл. 
напр.  
0=глоб. CS  
1=лок. CS  
2=мат. CS  

Вывод напр.. 
0=верх и низ  

не исп.  не исп.  не исп. 

GENSTIF  нет 
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Таблица 5-4. Координатные системы вывода элемента  

Имя элемента  Локальная координатная система элемента  
(ECS=-1, или 1)  

Глобальная  
(ECS=0) 

 
 
 
 
 
 
 П

о 
ум
ол
ча
ни
ю

 

Д
ек
ар
то
ва

 

Ц
ил
ин
др
ич
е-

ск
ая

 

С
ф
ер
ич
ес
ка
я  

TRUSS2D  -1 0 1 2 0 
TRUSS3D  -1 0 1 2 0 
BEAM2D  -1 0 1 2 0 
BEAM3D  -1 0 1 2 0 
RBAR  -1 0 1 2 0 
SPRING  -1 0 1 2 0 
PIPE  -1 0 1 2 0 
ELBOW  -1 0 1 2 0 
GAP  -1 0 1 2 0 
MASS  -1 0 1 2 0 
BOUND  -1 0 1 2 0 
PLANE2D 4-узловой  -1 0 1 2 0 
PLANE2D 8-узловой  -1 0 1 2 0 
PLANE2D 4-узловой (осе-
симметричный)  -1 0 1 2 0 

PLANE2D 8-узловой (осе-
симметричный) -1 0 1 2 0 

TRIANG 3-узловой -1 0 1 2 0 
TRIANG 6-узловой -1 0 1 2 0 
TRIANG 3-узловой (осе-
симметричный) -1 0 1 2 0 

TRIANG 6-узловой (осе-
симметричный) -1 0 1 2 0 

SHELL3  -1 0 1 2 0 
SHELL6  -1 0 1 2 0 
SHELL4  -1 0 1 2 0 
SHELL3T  -1 0 1 2 0 
SHELL4T  -1 0 1 2 0 
SHELL3L  -1 0 1 2 0 
SHELL4L  -1 0 1 2 0 
SHELL9  -1 0 1 2 0 
SHELL9L  -1 0 1 2 0 
SHELLAX  -1 0 1 2 0 
TETRA4  -1 0 1 2 0 
TETRA4R  -1 0 1 2 0 
TETRA10  -1 0 1 2 0 
SOLID  -1 0 1 2 0 
SOLIDL  -1 0 1 2 0 
SOLIDPZ  -1 0 1 2 0 
GENSTIF  -1 0 1 2 0 

Задание свойств для элементов  
Свойства материала и сечения для элементов задаются командами меню Propsets. В 
таблице 5-5 описаны функции команд этого меню.  
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Таблица 5-5.  Команды для задания свойств (меню Propsets и Edit) 

Команда Описание Примечание 
MPROP  
(Propsets > Material 
Property)  

Задает набор свойств материала и устанавли-
вает значения свойств (см. Таблицу 6-2).  

Всего можно задать до 90 наборов 
свойств материала. 

PICK_MAT  
(Propsets > Pick 
Material Lib)  

Выбирает материал из встроенной библиоте-
ки материалов.  

Во встроенной библиотеке материалов 
находятся 14 материалов. 

USER_MAT  
(Propsets > User 
Material Lib)  

Выбирает материал из пользовательской биб-
лиотеки материалов.  

Пользовательская библиотека материа-
лов должна иметь то же формат, что и 
встроенная библиотека и должна хра-
ниться в файле с именем 
USERMAT.LIB в директории 
COSMOS/M. 

R_MATLIB  
(Propsets > Material 
Browser)  

Запускает отдельную программу просмотра 
материалов в библиотеке  

Для использования программы ее не-
обходимо сначала приобрести.  

MPLIST  
(Edit > LIST > Mate-
rial Props)  

Выводит на экран свойства, заданные в ука-
занном наборе.  

Можно перенаправить вывод с экрана в 
файл. 

MPDEL  
(Edit > DELETE > 
Material Props)  

Удаляет свойства материала из указанных 
наборов. 

 

RCONST  
(Propsets > Real 
Constant)  

Задает свойств сечения и значения свойств 
(см. Таблицу 6-11) для элемента в этом набо-
ре.  

Максимальное число наборов вещест-
венных констант �1000. До выполнения 
этой команды должна быть установле-
на группа элементов. 

PICK_SEC  
(Propsets > AISC 
Sect. Table)  

Выбирает указанное сечение AISC из встро-
енной библиотеки сечений и соответствую-
щие свойства сечения.  

Более подробная информация по стан-
дартным сечениям приведена в Спра-
вочнике AISC. 

RCLIST  
(Edit > LIST > Real 
Constants)  

Выводит набор и заданные в нем свойства 
сечения на экран.  

Можно перенаправить вывод с экрана в 
файл. 

RCDEL  
(Edit > DELETE > 
Real Constants)  

Удаляет свойства сечения и другие физиче-
ские свойства из указанных наборов. 

 

В следующей главе приведено полное описание свойств элементов в Основной Систе-
ме. В Таблице 5-6 приведена сводка свойств материала и сечения, доступных в Ос-
новной Системе. В таблице 5-7 приведены материалы и сечения, доступные в биб-
лиотеках для элементов. 

Таблица 5-6. Сводка свойств элементов в Основной Системе  

Свойства материала  Масса  Нагрузки на элемент  

Имя элемента в 
COSMOS/M 

И
зо
тр
оп
ны
е 

О
рт
от
ро
пн
ы
е 

А
ни
зо
тр
оп
ны
е 

Т
ер
м
ал
ьн
ы
е 

П
ье
зо
эл
ек
тр
ич
ес
ки
е 

К
он
ст
ан
т 
се
че
ни
я 

 

С
ос
ре
до
то
че
нн
ая

 

Ра
сп
ре
де
ле
нн
ая

 

М
ех
ан
ич
ес
ка
я 

те
рм
ал
ьн
ая

 

Гр
ав
ит
ац
ио
нн
ая

 

TRUSS2D �   �  2 � �  � � 
TRUSS3D  �   �  2 � �  � � 
BEAM2D  �   �  7 � � � � � 
BEAM3D  �   �  от 14 до 27 � � � � � 
RBAR  N/A N/A N/A N/A N/A 1 � � N/A N/A N/A 
SPRING  N/A N/A N/A N/A N/A 2 � � N/A N/A N/A 
PIPE  �  �   3 � � � � � 
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ELBOW  �  �   4 � � � � � 
GAP  N/A N/A N/A N/A N/A 2 N/A N/A    
MASS  N/A N/A N/A N/A N/A 7 �  N/A N/A N/A 
BOUND  N/A N/A N/A N/A N/A 2 N/A N/A    
PLANE2D 4-
узловой 

� �  �  2 � � � � � 

PLANE2D 8-
узловой 

� �  �  2 � � � � � 

PLANE2D 4-
узловой (осесим-
метричный) 

� �  �  1 � � � � � 

PLANE2D 8-
узловой (осесим-
метричный) 

� �  �  1 � � � � � 

TRIANG 3-узловой � �  �  2 � � � � � 
TRIANG 6-узловой � �  �  2 � � � � � 
TRIANG 3-узловой 
(осесимметричный) 

� �  �  1 � � � � � 

TRIANG 6-узловой 
(осесимметричный) 

� �  �  1 � � � � � 

SHELL3  �   �  3 � � � � � 
SHELL4  �   �  3 � � � � � 
SHELL6  � �  �  2 � � � � � 
SHELL3T  �   �  3 � � � � � 
SHELL4T  �   �  3 � � � � � 
SHELL3L  � �  �  2+3NL* � � � � � 
SHELL4L  � �  �  2+3NL* � � � � � 
SHELL9  �   �  1 � � � � � 
SHELL9L  � �  �  2+3NL* � � � � � 
SHELLAX  �   �  1 � � �  � 
TETRA4  � �  �  N/A � � � � � 
TETRA4R  � � � �  N/A � � � � � 
TETRA10  � � � �  N/A � � � � � 
SOLID  � � � �  9** � � � � � 
SOLIDL  � �  �  2+6NL* � � � � � 
SOLIDPZ  � � � N/A � N/A � �    
GENSTIF  � � � N/A � N/A � � N/A N/A N/A 
* зависит от числа слоев (NL)  
** только для задания ориентации ортотропных свойств материала  

Таблица 5-7. Библиотеки материалов и сечений для элементов в Основной Системе  

Имя элемента Библиотека материалов Библиотека сечений 
 Встроенная Пользовательская COSMOS/M AISC 

TRUSS2D  • •   
TRUSS3D  • •   
BEAM2D  • • • • 
BEAM3D  • • • • 
RBAR  N/A N/A N/A N/A 
SPRING  N/A N/A   
PIPE  • •   
ELBOW  • •   
GAP  N/A N/A N/A N/A 
MASS  N/A N/A N/A N/A 
BOUND  N/A N/A N/A N/A 
PLANE2D 4-узловой • •   
PLANE2D 8-узловой • •   
PLANE2D 4-узловой (осе-
симметричный) 

• •   

PLANE2D 8-узловой (осе-
симметричный) 

• •   

TRIANG 3-узловой • •   
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TRIANG 6-узловой • •   
TRIANG 3-узловой (осесим-
метричный) 

• •   

TRIANG 6-узловой (осесим-
метричный) 

• •   

SHELL3  • •   
SHELL4  • •   
SHELL3T  • •   
SHELL6  • •   
SHELL4T  • •   
SHELL3L  * *   
SHELL4L  * *   
SHELL9  • •   
SHELL9L  * *   
SHELLAX  • •   
TETRA4  • •   
TETRA4R  • •   
TETRA10  • •   
SOLID  • •   
SOLIDL  * *   
SOLIDPZ  N/A N/A   
GENSTIF  N/A N/A   
* Каждому слою могут быть назначены различные материалы (см. Главу 6) 

Элементы для адаптивных методов  
В Основной Системе реализован автоматизированный подход к улучшению КЭ-сети 
на основе уменьшения ошибок от дискретизации сети. В h-версии МКЭ сходимость 
достигается при последовательном уменьшении размера элементов, а в p-версии 
адаптивно улучшается степень полинома. Комбинированный подход называется hp-
версией. 

В Таблице 5-8 приведены элементы, которые можно использовать с адаптивными ме-
тодами. 

Таблица 5-8. Элементы для адаптивных методов в Основной Системе  

Адаптивный метод Элементы 
h-версия TRIANG, SHELL3, SHELL3T, TETRA4, TETRA4R, TETRA10 
p-версия 6 узлов  TRIANG, 8-узловой PLANE2D, SHELL9L, TETRA10 
hp-версия 6 узлов  TRIANG, TETRA10 

Более подробная информация по адаптивным  методам приведена в Руководстве 
Пользователя COSMOS/M (Т. 1). 
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Глава 6. 
Свойства материала, сечения и 
другие физические свойства  
Введение 

В КЭ-расчете элементы образуют пространственную аппроксимацию геометрии моде-
ли, а математические модели физических свойств образуют физическое представле-
ние. Известно, что точность КЭ-расчета зависит от точности этих аппроксимаций. 
Точное описание свойств материала, таким образом, является важным аспектом КЭ-
моделирования. Всесторонняя программа КЭ-расчета должна предоставлять все воз-
можности для точного описания физической природы материалов в модели. 
COSMOS/M подходит под это определение, поскольку он предоставляет подробные 
и обширные, но легкие в использовании возможности описания свойств материала, 
сечения и других физических свойств вашей КЭ-модели.  

В Основной Системе свойства материала включают упругие, термоупругие, пьезо-
электрические свойства и свойства массы. Свойства массы требуются, когда для рас-
чета необходима информация о массе. Например, при расчете собственных частот и 
упругостатическом расчете с учетом инерциальной нагрузки требуется ввод плотно-
сти. Свойства материала также включают допустимые напряжения для расчета ин-
дексов отказа в составных материалах. Свойства сечения и другие физические свой-
ства включают площадь поперечного сечения, момент инерции, глубину или 
толщину, периметр, градиенты температуры по толщине, концевые закрепления и 
другую информацию для расчета матриц элементов. Сюда также входят константы 
пружин и коэффициенты трения. 

Чтобы численно рассчитать поведение КЭ-моделей свойства материала подставляются 
а различные математические модели, называемы составляющими отношениями. 
Примером составляющего отношения является закон Гука, задающий линейное от-
ношение между напряжениями и деформациями. В этой главе представлено полное 
описание различных свойств материала, необходимых для расчета в Основной Сис-
теме, и соответствующих составляющих отношений. Также приводятся команды и 
процедуры задания свойств материала, сечения и других физических свойств. Опи-
сания сопровождаются большим количеством иллюстраций и примеров. 

Задание свойств в COSMOS/M 
Задание типа элемента, который будет использоваться в расчете, а также связанных 
свойств материала и сечения осуществляется с помощью команд меню Propsets, Con-
trol > MEASURE, Edit > LIST, и Edit > DELETE. В таблице 6-1 описаны функции всех 
команд этих меню. 
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Таблица 6-1. Функции команд меню Propsets, Control > MEASURE, Edit > LIST, и Edit > DELETE  

Команда Описание Примечание 
MPROP (Propsets > 
Material Property)  

Задает набор свойств материала и устанав-
ливает значения свойств (см. Таблицу 6-2).  

Всего можно задать до 90 наборов 
свойств материала. 

PICK_MAT (Propsets 
> Pick Material Lib)  

Выбирает материал из встроенной библио-
теки материалов.  

Во встроенной библиотеке материалов 
находятся 45 материалов. 

USER_MAT (Prop-
sets > User Material 
Lib)  

Выбирает материал из пользовательской 
библиотеки материалов.  

Пользовательская библиотека материа-
лов должна иметь то же формат, что и 
встроенная библиотека и должна хра-
ниться в файле с именем 
USERMAT.LIB в директории 
COSMOS/M. 

MPLIST (Edit > LIST 
> Material Props)  

Выводит на экран свойства, заданные в ука-
занном наборе.  

Можно перенаправить вывод с экрана 
в файл. 

MPDEL (Edit > 
DELETE > Material 
Props)  

Удаляет свойства материала из указанных 
наборов. 

 

RCONST (Propsets > 
Real Constant)  

Задает свойств сечения и значения свойств 
(см. Таблицу 6-11) для элемента в этом на-
боре.  

Максимальное число наборов вещест-
венных констант �1000. До выполне-
ния этой команды должна быть уста-
новлена группа элементов. 

PICK_SEC (Propsets 
> AISC Sect Table)  

Выбирает указанное сечение AISC из встро-
енной библиотеки сечений и соответствую-
щие свойства сечения.  

Более подробная информация по стан-
дартным сечениям приведена в Спра-
вочнике AISC. 

RCLIST (Edit > LIST 
> Real Constants)  

Выводит набор и заданные в нем свойства 
сечения на экран.  

Можно перенаправить вывод с экрана 
в файл. 

RCDEL (Edit > 
DELETE > Real Con-
stants)  

Удаляет свойства сечения и другие физиче-
ские свойства из указанных наборов. 

 

MASSPROP (Control 
> MEASURE > Find 
Mass Property)  

Вычисляет длину, радиус, площадь, объем, 
массу, центр тяжести, момент инерции, ра-
диус инерции, направляющие косинусы, и 
т.д. для выбранных элементов и выводит их 
на экран.  

Листинг на экране может быть перена-
правлен в текстовый файл с помощью 
команды Control > MISCELLANEOUS 
> List Log. 

EGROUP (Propsets > 
Element Group)  

Задает группу элементов и связанные опции 
элемента для расчета.  

Максимальное допустимое число 
групп элементов в модели � 20. 

EPROPSET 
(Propsets > New 
Property Set)  

Назначает существующие группу элементов, 
набор свойств материала и набор вещест-
венных констант, а также координатную 
систему элемента вновь созданным элемен-
там. 

 

EPROPCHANGE 
(Propsets > Change 
El-Prop)  

Изменяет связь между группами элементов, 
наборами вещественных констант и набора-
ми свойств материала. 

 

EGLIST (Edit > LIST 
> Element Groups)  

Выводит на экран указанные группы эле-
ментов и связанные опции.  

Листинг на экране может быть перена-
правлен в текстовый файл с помощью 
команды Control > MISCELLANEOUS 
> List Log.  
Более подробная информация о созда-
нии и изменении групп элементов при-
ведена в Главе 5. 

EGDEL (Edit > 
DELETE > Element 
Groups)  

Удаляет указанные группы элементов и свя-
занные опции. 

 

BMSECDEF 
(Propsets > Beam 
Section)  

Выбирает стандартное поперечное сечение 
балки из встроенной библиотеки сечений.  

В библиотеку включено 10 стандарт-
ных сечений. Также можно создавать 
пользовательские сечения произволь-
ной формы. 

BMSECLIST (Edit > 
LIST > Beam Section)  

Выводит на экран выбранное стандартное 
поперечное сечение балки. 

 

В данной главе представлена полная информация по заданию свойств материала, се-
чения и других физических свойств. Также приведено краткое изложение теоретиче-
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ских концепций и математических основ (более подробное изложение теории приве-
дено в Теоретическом Руководстве COSMOS/M). Вы научитесь применять эти мате-
матические модели в COSMOS/M и предоставлять необходимые исходные данные. 
Также в этой главе описана процедура вычисления свойств массы и инерции коман-
дой MASSPROP (Control > MEASURE > Find Mass Property). 

Для сохранения ясности изложения описание задания групп элементов, соответст-
вующих опций и изменения этих данных приведены в Главе 5, Библиотека элемен-
тов. 

ПРИМЕЧАНИЕ: Если не указано иначе, все команды, упоминаемые в этой главе на-
ходятся в меню Propsets, Control > MEASURE, Edit > LIST, и Edit > DELETE. 

Почти все команды упоминаются в этой главе с использованием кратких имен,  кото-
рые в действительности интерпретируются командой. Расширенные имена команд, 
видимые на экране, служат только для повышения читаемости графического интер-
фейса. 

Примечание по единицам измерения  

В COSMOS/M можно использовать любую систему единиц измерения, включая стан-
дартные и нестандартные. Однако единицы должны быть совместимыми и вы долж-
ны интерпретировать результаты соответственно используемым единицам. В При-
ложении A приведено подробное описание совместимых единиц измерения 
применительно к Основной Системе. Также в этом приложении приведены коэффи-
циенты перевода единиц их одной системы в другую, и другая полезная информация. 

Если вы используете встроенную библиотеку материалов COSMOS/M (команды 
PICK_MAT (Propsets > Pick Material Lib) или USER_MAT (Propsets > User Material Lib)), то 
следует соблюдать осторожность с единицами измерения. Свойства материала в этих 
библиотеках доступны в системах FPS, MKS и СИ. Однако хранимые в библиотеках 
значения не являются точными версиями единиц этих систем. Единственным исклю-
чением является система СИ. 

ПРИМЕЧАНИЕ: Хотя в системе FPS единицей измерения длины является фут (foot), 
во встроенной библиотеке материалов используется дюйм (inch). Это было сделано 
для практического использования вместе с доминирующими стандартами отрасли. 

ПРИМЕЧАНИЕ: Аналогично, в системе MKS во встроенной библиотеке в качестве 
единицы измерения длины используется сантиметр вместо метра. Это следует иметь 
ввиду при создании КЭ-модели. 

Свойства материала в COSMOS/M 
Все свойства материала в COSMOS/M задаются командой MPROP (Propsets > Material 

Property). Эта команда назначает номер набора свойств материала, под которым вы 
можете задать более пятидесяти различных свойств материала. Назначенный номер 
набора свойств материала может быть связан с одной или несколькими группами 
элементов. В таблице 6-2 приведены разрешенные имена свойств материала, которые 
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можно использовать при задании свойств. Некоторые из свойств материала в этой 
таблицы не применяются в Основной Системе. 

Все свойства в Таблице 6-2 могут быть использованы в одном наборе. Каждое свойст-
во задается одним или более значениями (до 21 значения). Команды PICK_MAT (Prop-
sets > Pick Material Lib) и USER_MAT (Propsets > User Material Lib) также могут быть ис-
пользованы для создания набора свойств материала и выбора свойств из встроенной 
или пользовательской библиотек материалов для этого набора. Свойства, выбранные 
из библиотек могут быть позже дополнены командой MPROP (Material Property). 

Командой MPDEL (Edit > DELETE > Material Props) можно удалить набор свойств ма-
териала. Если необходимо только изменить или удалить некоторое свойство из набо-
ра, то необходимо повторно выполнить команду MPROP (Material Property) и указать 
либо ноль, либо другое необходимое значение для этого свойства. Более подробная 
информация об изменении свойств материала приведена в разделе Изменение, ото-
бражение и вывод свойств материала. 

Команда MPLIST (Edit > LIST > Material Props) выводит все свойства, связанные с набо-
ром на экране. Если предварительно в команде PRINT_OPS (Analysis > OUTPUT 
OPTIONS > Set Print Options) был указан подробный вывод, то свойства материала 
будут записаны в файл вывода (имя_задачи.OUT) после выполнения расчета. 

Для задания свойства материала выполните команду MPROP (Material Property) и ука-
жите имя свойства из Таблицы 6-2. После ввода значения снова появится приглаше-
ние, в котором необходимо ввести имя свойства (и значение, если вы указали имя), 
всего 21 раз. Если необходимо задать больше 21 свойства материала в одном наборе, 
то необходимо повторно выполнить команду MPROP (Material Property). Значение 21 
выбрано потому, что именно столько значений необходимо для ввода коэффициен-
тов упругости для анизотропных материалов. Большинство других материалов с изо-
тропными и ортотропными свойствами могут быть адекватно описаны меньшим чис-
лом констант. Ниже показан пример использования команды MPROP (Material 
Property): 
Control Panel: Propsets > Material Property 
Material property set >1 
Material Property Name >EX; Elasticity modulus 1st dir 
Property value >20E6 

Таблица 6-2. Имена свойств материала в COSMOS/M 

Имя свойства Описание Основная 
Система 

Единицы из-
мерения 

ALPH1, ALPH2, 
ALPH3, ALPH4  

Первый, второй, третий и четвертый силовые коэф-
фициенты модели материала Огдена  

N/A  

ALPX, ALPY, 
ALPZ  

Коэффициенты термического расширения по на-
правлениям материала x, y и z  

• Деформация 
/Температура 

BETA  Коэффициент объемного расширения  N/A  
C  Удельная теплота N/A Тепло-

та/(Масса·Градус
) 

COHESN  Когезивная сила N/A Сила/Площадь 
CREEPC  Константы ползучести для классического закона 

ползучести (необходимо ввести три константы)  
N/A нет 
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CREEPX  Константы ползучести для экспоненциального зако-
на ползучести (необходимы семь констант)  

N/A нет 

DAMP  Коэффициент демпфирования материала  N/A Си-
ла·Время/Длина 

DCij  Коэффициенты диэлектрической матрицы (необхо-
димы шесть констант)  

•  

DENS  Плотность  • Масса/Объем 
ECONX, 
ECONY, 
ECONZ  

Электропроводность по глобальным Декартовым 
направлениям X, Y и Z  

N/A Ток/Потенциал 

EMIS  Эмиссивность (Излучение)  N/A нет 
ETAN  Касательный модуль упругости  N/A Сила/Площадь 
EX, EY, EZ  Модули упругости по направлениям X, Y и Z  • Сила/Площадь 
FRCANG  Угол трения N/A Градусы 
G1 � G8  Модули поперечной релаксации (для вязкоупруго-

сти)  
•  

GAMMA  Отношение удельных теплот  N/A  
GXY, GXZ, 
GYZ  

Поперечный модуль по направлениям XY, XZ и YZ  • Сила/Площадь 

HC  Коэффициент пленочной конвекции  N/A Тепло-
та/(Время·Площа
дь·Градус) 

K1 � K8  Модули релаксации массы (для вязкоупругости) N/A  
KX, KY, KZ  Теплопроводность по глобальным Декартовым на-

правлениям X, Y и Z  
N/A Тепло-

та·Длина/(Время·
Площадь·Градус) 

MCij  Модули анизотропной упругости (необходима два-
дцать одна константа)  

 Сила/Площадь 
или Пло-
щадь/Сила 

MOONEY_A, 
MOONEY_B, 
MOONEY_C, 
MOONEY_D, 
MOONEY_E, 
MOONEY_F  

Первая, вторая, третья, четвертая, пятая и шестая 
константы материала для модели гиперупругого 
материала Муни-Ривлина  

N/A нет 

MPERM  Магнитная проницаемость N/A Индуктив-
ность/Длина 

MU1 � MU4  Первая, вторая, третья и четвертая константы моде-
ли материала Огдена  

N/A  

NUXY Отношение Пуассона, деформация по второму на-
правлению материала, вызываемая деформацией по 
первому направлению  

• нет 

NUXZ  Отношение Пуассона, деформация по третьему на-
правлению материала, вызываемая деформацией по 
первому направлению  

• нет 

NUYZ  Отношение Пуассона, деформация по третьему на-
правлению материала, вызываемая деформацией по 
второму направлению  

• нет 

PCij  Коэффициенты матрицы пьезоэлектрического мате-
риала (необходимо восемнадцать констант)  

•  

PERMIT  Диэлектрическая постоянная N/A Фарад/Длина 
PMAGR, 
PMAGT  

Коэрцитивность постоянного магнита по радиаль-
ному и касательному направлениям глобальной 
цилиндрической координатной системы  

N/A Ампер/Длина 

PMAGX, 
PMAGY, 
PMAGZ  

Коэрцитивность постоянного магнита по глобаль-
ным Декартовым направлениям X, Y и Z  

N/A Ампер/Длина 

REFTMP  Температура стекловидного перехода для вязкоуп-
ругости  

N/A  

SIGXC  Прочность материала на сжатие по направлению 
материала x  

• Сила/Площадь 

SIGXT  Прочность материала на разрыв по направлению 
материала x  

• Сила/Площадь 
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SIGXY  Прочность на срез в плоскости материала xy • Сила/Площадь 
SIGYC  Прочность материала на сжатие по направлению 

материала y  
• Сила/Площадь 

SIGYLD  Напряжение текучести N/A Сила/Площадь 
SIGYT  Прочность материала на разрыв по направлению 

материала y  
• Сила/Площадь 

TAUG1 � 
TAUG8  

Время, связанное с модулями поперечной релакса-
ции G1 � G8 (для вязкоупругости)  

N/A  

TAUK1 � 
TAUK8  

Время, связанное с модулями релаксации массы K1 
� K8 (для вязкоупругости) 

N/A  

VC1, VC2  Константы уравнения Вильяма-Ландела-Ферри (для 
вязкоупругости)  

N/A  

VISC  Динамическая вязкость N/A Си-
ла·Время/Площа

дь 

В линейном статическом расчете напряжений используются упругие, термоупругие, 
пьезоэлектрические свойства и свойства массы. В упругие свойства входят различ-
ные модули упругости и отношения Пуассона. Если упругие свойства зависят от 
температуры, то при описании материала следует использовать термоупругие свой-
ства, включающие коэффициент термического расширения и зависимости модулей 
упругости и отношений Пуассона от температуры. Описание пьезоэлектрического 
материала включает упругие, диэлектрические и пьезоэлектрическое свойства, кото-
рые необходим для электроупругого расчета. Свойства массы включают плотность, 
которая также может зависеть от температуры. 

Свойства материалов, упомянутые ранее, могут быть применены ко всем элементам в 
Основной Системе, с единственным исключением: пьезоэлектрические свойства 
применимы только к элементу SOLIDPZ. Типы свойств материалов, применимые ко 
всем элементам Основной Системы приведены в Таблице Table 6-3. Заметьте, что 
свойства массы применимы ко всем элементам в таблице, за исключением элементов 
BOUND, GAP, GENSTIF, RBAR и SPRING. 

В описание упругих свойств входит определение изотропных, ортотропных и анизо-
тропных свойств и описание процедуры их ввода в COSMOS/M. Следующий раздел 
посвящен описанию термоупругих. В отдельном разделе описаны свойства слоистых 
составных материалов и доступные критерии отказа, после чего следует раздел с 
описанием диэлектрической и пьезоэлектрической матриц и процедуры их ввода для 
электростатического расчета. Также приводится раздел с описанием свойств массы и 
демпфирования. В отдельном разделе полностью описано использование встроенной 
библиотеки материалов. 

Таблица 6-3. Свойства материалов для элементов в Основной Системе  

Имя элемента в 
COSMOS/M  

Линейно упругие 
свойства  

Термоупругие свойства Пьезоэлектрические 
свойства 

 Изо Орто Анизо Изо Орто Анизо  
TRUSS2D  •   •    
TRUSS3D  •   •    
BEAM2D  •   •    
BEAM3D  •   •    
RBAR  N/A N/A N/A N/A N/A N/A N/A 
SPRING  N/A N/A N/A N/A N/A N/A N/A 
PIPE  •   •    
ELBOW  •   •    
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GAP  N/A N/A N/A N/A N/A N/A N/A 
MASS  N/A N/A N/A N/A N/A N/A N/A 
BOUND  N/A N/A N/A N/A N/A N/A N/A 
PLANE2D 4-узловой • •  • •   
PLANE2D 8-узловой • •  • •   
PLANE2D 4-узловой 
(осесимметричный) 

• •  • •   

PLANE2D 8-узловой 
(осесимметричный) 

• •  • •   

TRIANG 3-узловой • •  • •   
TRIANG 6-узловой • •  • •   
TRIANG 3-узловой 
(осесимметричный) 

• •  • •   

TRIANG 6-узловой 
(осесимметричный) 

• •  • •   

SHELL3  •   •    
SHELL4  •   •    
SHELL3T  •   •    
SHELL4T  •   •    
SHELL3L  • •  • •   
SHELL4L  • •  • •   
SHELL6  • •  •    
SHELL9  •   •    
SHELL9L  • •  • •   
SHELLAX  •   •    
TETRA4  • • • •  •  
TETRA4R  • • • •  •  
TETRA10  • • • •  •  
SOLID  • • • • • •  
SOLIDL  • •  • •   
SOLIDPZ  • • • N/A • N/A • 
GENSTIF  • • • N/A N/A N/A • 
В таблице Изо означает изотропные, Орто � ортотропные и Анизо � анизотропные 
свойства. 

Упругие свойства материала  
Поведение материала называется упругим, если перемещения линейно пропорцио-
нальны приложенной нагрузки и отсутствует остаточная деформация при прекраще-
нии нагрузки. Для упругих материалов напряжения прямо пропорциональны дефор-
мации: 

{σ}= [D] {ε - εt}  (6-1) 

где [D] матрица упругости материала (изотропного, ортотропного или анизотропного) 
или матрица жесткости материала, {σ} � полный вектор напряжений, {ε} � полный 
вектор деформации а {εt} � вектор термальной деформации. Эта формула является 
приближенной, и применима только если деформации невелики для некоторых мате-
риалов. Обратная форма этого уравнения может быть записан так: 

{ε - εt}= [C] {σ}  (6-2) 

где [C] представляет матрицу податливости упругого материала, являющуюся обрат-
ной матрице упругости материала [D]. Уравнения 6-1 и 6-2 также называются со-
ставляющими уравнениями, принимающими простую форму для линейно упругих 
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материалов. Однако для нелинейных материалов (доступных в NSTAR), составляю-
щие отношения могут быть очень сложными. 

В COSMOS/M при задании анизотропных материалов можно вводить коэффициенты 
как матрицы [C], так и [D]. однако для изотропных или ортотропных материалов 
можно вводить только матрицу [D]. Задание изотропных, ортотропных и анизотроп-
ных материалов описано в нижеследующих разделах. 

Чтобы вы лучше поняли линейно упругие составляющие отношения и соответствую-
щие исходные данные, в Таблице 6-4 приведены компоненты перемещений, векторы 
напряжений и деформаций, встречающиеся в одно-, двух- и трехмерных задачах. 

Таблица 6-4. Компоненты перемещений, векторы напряжений и деформаций в упругостатическом расче-
те  

Тип задачи Компоненты пе-
ремещений Вектор деформаций {ε}T Вектор напряжений {σ}T 

Стержень  u [εx] [σx] 
Балка w [θx] [Mx] 
Плоские напряжения u,v [εx εy γxy] [σx σy τxy] 
Плоские деформа-
ции 

u,v [εx εy γxy] [σx σy τxy] 

Осесимметричная  r,θ,z [εr εθ γrθ εz] [σr σθ τrθ σz] 
Трехмерная u,v,w [εx εy εz γxy γyz γzx] [σx σy σz τxy τyz τzx] 
Изгиб плиты w [θx θy θxy] [Mx My Mxy] 
Обозначения εx = u,x εy = v,y  γxy = u,y + v,x  

θx = -w,xx θy = w,yy θxy = 2w,xy 

Изотропные упругие свойства  

Если свойства материала не зависят от направления, то они называются изотропными. 
Таким образом, изотропные материалы обладают одинаковыми модулями упругости, 
отношениями Пуассона, коэффициентами термического расширения, теплопровод-
ностью и т.д. по все направлениям. Для обозначения материалов без предпочтитель-
ных направления для коэффициентов термического расширения используется термин 
изотермальные.  

Чтобы задать изотропные упругие свойства, необходимо ввести любые два из сле-
дующих коэффициентов: модуль упругости Ex, отношение Пуассона νxy  и попереч-
ный модуль Gxy. Третий, не введенный коэффициент, рассчитывается по формуле: 

E = 2G(1 + ν) 

Матрица [C] или [D] для изотропного материала содержат только два независимых ко-
эффициента. Таким образом, упругие свойства (включая коэффициент термического 
расширения) для изотропного материала можно ввести так: 
Control Panel: Propsets > Material Property 
Material property set >1 
Material Property Name >EX; Elasticity modulus 1st dir 
Property value >3.5E6 
Material Property Name >NUXY; Poisson ratio 2nd to 1st 
Property value >0.15 
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Material Property Name >ALPX; Therm expansion coeff 1st dir 
Property value >0.00015 

или: 
Control Panel: Propsets > Material Property 
Material property set >1 
Material Property Name >EX; Elasticity modulus 1st dir 
Property value >3.5E6 
Material Property Name >GXY; Shear modulus 1st & 2nd 
Property value >1.52E6 
Material Property Name >ALPX; Therm expansion coeff 1st dir 
Property value >0.00015 

или: 
Control Panel: Propsets > Material Property 
Material property set >1 
Material Property Name >GXY; Shear modulus 1st & 2nd 
Property value >1.52E6 
Material Property Name >NUXY; Poisson ratio 2nd to 1st 
Property value >0.15 
Material Property Name >ALPX; Therm expansion coeff 1st dir 
Property value >0.00015 

Заметьте, что числовые значения в этом примере вводились так, чтобы удовлетворять 
вышеприведенной зависимости между модулем Юнга и поперечным модулем. 

ПРИМЕЧАНИЕ: Если вы не укажете числовое значение отношения Пуассона, то 
программа предполагает его равным 0.3.  

В нижеследующих разделах описаны изотропные отношения напряжения-деформации 
в двух- и трехмерных задачах, а также в осесимметричных телах с учетом действия 
термальных деформаций. 

Двухмерные изотропные отношения напряжения-деформации  

Для задач с нагрузкой в плоскости КЭ-расчет часто выполняется с использованием 
плоских элементов, в которых действуют двухмерные отношения напряжения-
деформации. Состояния деформации в двух измерения могут быть либо плоскими 
напряжениями, либо плоскими деформациями, и для любого из этих состояний рас-
сматриваемая плоскость (обычно плоскость xy) должна быть плоскостью упругой 
симметрии. 

Плоские напряжения  

Плоские напряжения представляют состояние, преобладающее в плоской плите, рас-
положенной обычно в плоскости xy, нагруженной только в своей плоскости и не ог-
раниченную по направлению z, так что z-компоненты напряжений равны нулю. Для 
изотропного материала отношение напряжения-деформации с учетом термальных 
эффектов в состоянии плоских напряжений имею вид: 
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 (6-3) 

Составляющие уравнения плоских упругих напряжений применимы только к элемен-
там PLANE2D и TRIANG. После задания этих элементов в команде EGROUP 
(Propsets > Element Group) необходимо указать условие плоских напряжений в треть-
ей опции, OP3; более подробная информация приведена в Главе 5, Библиотека эле-
ментов. 

Плоские деформации 

Плоская деформация представляет собой состояние деформации, при котором z-
компоненты деформаций равны нулю. Перемещения в плоскости xy являются функ-
цией только от x и y, но не от z. Для изотропного материала отношение напряжения-
деформации с учетом термальных эффектов в состоянии плоских деформаций имеют 
вид: 

 (6-4) 

z-компонент напряжений σz не присутствует в этом уравнении, хотя он не равен нулю. 
Однако он может быть рассчитан, если известны σx и σy. 

Составляющие уравнения плоских упругих деформаций применимы только к элемен-
там PLANE2D и TRIANG. После задания этих элементов в команде EGROUP 
(Propsets > Element Group) необходимо указать условие плоских деформаций в треть-
ей опции, OP3; более подробная информация приведена в Главе 5, Библиотека эле-
ментов. 

Осесимметричные задачи  

Во многих практических задачах модели являются телами вращения, и, следовательно, 
они обладают осевой симметрией. Поведение таких моделей независимо от коорди-
наты по окружности. Для точного расчета трехмерной модели может быть использо-
вано двухмерное сечение. Для тел с осевой симметрией требуется матрица упругости 
материала размером 4х4: 
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 (6-5) 

Напряжения (или деформации) в осесимметричных телах и общих трехмерных телах 
соотносятся следующим образом: σr = σx, σθ= σy, σz = σz. 

Осесимметричные упругие составляющие уравнения применимы только к элементам 
PLANE2D, TRIANG и SHELLAX. Для элемента осесимметричной оболочки эти от-
ношения применяются по умолчанию. Однако для элементов PLANE2D и TRIANG в 
команде EGROUP (Propsets > Element Group) необходимо указать условие осесиммет-
ричности в третьей опции, OP3; более подробная информация приведена в Главе 5, 
Библиотека элементов. 

Трехмерные изотропные отношения напряжения-деформации  

В общем виде изотропные отношения напряжения-деформации с учетом термальных 
эффектов имеют вид: 

 (6-6) 

Трехмерные отношения напряжения-деформации применяются по умолчанию ко всем 
объемным элементам, при это не требуется выполнение никакой дополнительной 
команды. 

Изгиб балок и плит  

При изгибе балки преобладают одноосные напряжения, так что σx = Eεx. Другая форма 
этого уравнения связывает изгибающий момент с вращениями: 

 (6-7) 

Для балочных и стержневых элементов для составления матрицы упругости использу-
ется только модуль упругости EX. При расширении до двух измерений вышеприве-
денное уравнение можно использовать для изгиба плит: 
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 (6-8) 

где h � толщина плиты. Однако элементы оболочек и плит в COSMOS/M используют 
составляющие отношения в форме напряжения-деформации, противоположной  вы-
шеприведенной форме с моментом вращения. 

Ортотропные упругие свойства  

В отличие от изотропного материала, ортотропный материал обладает предпочтитель-
ными направлениями прочности, которые взаимно перпендикулярны. Свойства по 
этим направлениям (также называемым главными направлениями) являются экстре-
мальными значениями коэффициентов упругости. В матрицах [C] или [D] для орто-
тропного материала присутствует девять независимых упругих коэффициентов. Кроме 
этого в них присутствуют три коэффициента термического расширения. 

В COSMOS/M ортотропные свойства материала применимы ко всем составным эле-
ментам: SHELL3L, SHELL4L, SHELL9L и SOLIDL, а также к двухмерным непрерыв-
ным элементам PLANE2D и TRIANG. 

Двухмерные ортотропные отношения напряжения-деформации  

В двух измерениях ортотропные отношения напряжения-деформации с учетом тер-
мальных эффектов имеют следующий вид: 

 (6-9) 

Заметьте, что для выполнения условия симметрии в матрице модулей упругости 
νxyEy = νyxEx. 

ПРИМЕЧАНИЕ: Таким образом, необходимо учитывать это условие симметрии при 
вводе модулей упругости или отношений Пуассона. 

Далее, если вы не введете числовое значение поперечного модуля, программа рассчи-
тает его по формуле: 

 (6-10) 

Ниже показана процедура задания ортотропных свойств материала. В примере пред-
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полагается что поперечный модуль будет рассчитан программой. Для выполнения 
условия симметрии вводятся два модуля упругости и одно отношение Пуассона. 
Control Panel: Propsets > Material Property 
Material property set >1 
Material Property Name >EX; Elasticity modulus 1st dir 
Property value >15.5E6 
Material Property Name >EY; Elasticity modulus 2nd dir 
Property value >10.5E6 
Material Property Name >NUXY; Poisson ratio 2nd to 1st 
Property value >0.25 
Material Property Name >ALPX; Therm expansion coeff 1st dir 
Property value >0.25E-5 
Material Property Name >ALPY; Therm expansion coeff 2nd dir 
Property value >0.45E-5 

Двухмерные ортотропные свойства будут использоваться элементами PLANE2D и 
TRIANG, если были введены все необходимые коэффициенты упругости. В против-
ном случае программа по умолчанию будет использовать изотропные свойства.  

Трехмерные ортотропные отношения напряжения-деформации 

В трех измерениях ортотропные отношения напряжения-деформации принимают вид: 

 (6-11) 

В трех измерениях условия симметрии имеют вид: 

 (6-12) 

При вводе ортотропных свойств материала в трех измерениях необходимо следить, 
чтобы эти условия не нарушались. Процедура ввода ортотропных упругих свойств в 
трех измерениях аналогична примеру для двух измерений. Заметьте, что если вы не 
введете числовые значения для поперечных модулей, программа рассчитает их, ис-
пользуя следующие соотношения: 

 (6-13) 

Значение по умолчанию для νxy �0.3, для νxz и νyz � 0.0. 

Трехмерные ортотропные свойства применяются для элементов SOLID и SOLIDL, ес-
ли были введены все необходимые коэффициенты упругости. В противном случае 
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программа по умолчанию будет использовать изотропные свойства. 

Осесимметричные ортотропные отношения напряжения-деформации  

COSMOS/M также поддерживает осесимметричные тела с ортотропными свойствами 
материала. Иногда называемые цилиндрически ортотропными, отношения напряже-
ния-деформации имеют вид: 

 (6-14) 

Заметьте, что равенства для коэффициентов упругости в COSMOS/M между осесим-
метричными телами и общими трехмерными телами имеют вид: Er = Ex, Eθ = Ez, Ez = 
Ey. Эти равенства вы можете использовать при вводе свойств ортотропного материа-
ла. 

Ориентация осей ортотропного материала  

По умолчанию ориентация осей координатной системы ортотропного материала сов-
падает с ориентацией осей координатной системы элемента (ECS =-1). Вы можете 
указать угол поворота координатной системы материала относительно координатной 
системы элемента при задании вещественных констант (команда RCONST (Propsets > 
Real Constant)) для некоторого элемента. Например, если вы используете 4-узловой 
плоский элемент (PLANE2D) и хотите указать угол поворота координатной системы 
материала равный 30 градусов (см. рис.), то необходимо использовать следующую 
процедуру: 

 

Рис. 6-1. Задание осей ортотропного материала в координатной системе элемента  

На рисунке оси xy представляют координатную систему элемента, а оси x'y' � повер-
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нутую координатную систему ортотропного материала. Этот пример применим ко 
всем составным элементам, кроме элемента SOLIDL, для которого угол материала в 
слое указывается в константе RC4. 

Если вы зададите координатную систему элемента как глобальную Декартову коорди-
натную систему (ECS = 0), то оси ортотропного материала будут иметь ту же ориен-
тацию, что и глобальные Декартовы оси. В этом случае вы не сможете указать угол 
поворота для осей материала. 

Анизотропные упругие свойства  

В анизотропных материала отсутствуют плоскости симметрии, и модули упругости 
различны по всем направлениям. В трех измерениях в отношении напряжения-
деформации для анизотропных материалов используется 21 константа упругости: 

 (6-15) 

Заметьте, что в COSMOS/M можно ввести значения только трех первых коэффициен-
тов термического расширения, а оставшиеся три игнорируются. Имена свойств для 
этих коэффициентов совпадают с именами для ортотропных материалов. Обратная 
форма этого отношения имеет вид: 

 (6-16) 

В текущей версии COSMOS/M анизотропные свойства материала применимы только 
для элементов SOLID, SOLIDPZ, TETRA4, TETRA4R и TETRA10. При задании ани-
зотропных свойств вы можете вводить коэффициенты как матрицы жесткости, так и 
матрицы податливости. Все константы (21 константа) имеют уникальные имена, так 
что, используя некоторые манипуляции (описанные ниже), вы можете описывать ма-
териалы с одной или двумя плоскостями симметрии. Эта возможность используется, 
если необходимо смоделировать моноклинные, поперечно изотропные материалы и 
материалы с кубической симметрией. 

Для различения при вводе матрица жесткости анизотропного материала [D] называет-
ся стандартной матрицей, а матрица податливости материала [C] называется обрат-
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ной (inverted) матрицей. В примере показан ввод коэффициентов податливости для 
анизотропного материала:  
Control Panel: Propsets > Material Property 
Material property set >1 
Material Property Name >MC11 
Property value >0.03E-6 
Material matrix type 1=Std 2=Inverted >2 
Material Property Name >MC12 
Property value >0.01E-6 
... ... ... 
Material Property Name >MC66 
Property value >0.02E-6 

Вы также можете ввести коэффициенты упругости для моноклинного материала (об-
ладающего одной плоскостью симметрии), при этом число коэффициентов �13. 
Уравнение напряжения-деформации для моноклинного материала имеет вид: 

 (6-17) 

Вам необходимо указать те же имена свойств, что и для полностью анизотропного ма-
териала и вводить только ненулевые коэффициенты. 

В случае поперечно изотропного материала, имеет место вращательная симметрия от-
носительно какой-либо координатной оси. Число независимых констант в этом слу-
чае уменьшается до 5, и уравнение напряжения-деформации имеет вид: 

 (6-18) 

В случае линейно упругих материалов с кубической симметрией, свойства идентичны 
вдоль главных направлений. Материал с кубической симметрией обладает только 
тремя независимыми константами упругости. Уравнение напряжения-деформации 
имеет следующий вид: 
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 (6-19) 

Для полностью изотропного материала уравнение напряжения-деформации имеет ту 
же форму, что и для поперечно изотропного, но в нем есть только две независимые 
константы, E and ν. Таким образом, вы можете использовать формат ввода свойств 
анизотропного материала для описания изотропных материалов, однако эта процеду-
ра не гарантирует результат, и рекомендуется использовать процедуру ввода изло-
женную ранее в разделе Изотропные упругие свойства. 

ПРИМЕЧАНИЕ: Если вы используете формат ввода анизотропных материалов для 
описания изотропных материалов, то учитывайте следующее: в этом случае про-
грамма использует полное интегрирование, и результаты будут отличаться от резуль-
татов, полученных при использовании изотропных свойств (заданных через E и ν), 
где используется сокращенное интегрирование. 

Термоупругие свойства  
Действие изменения температуры на конструкции двояко: изменения температуры вы-
зывают термальные деформации, влияющие на состояние напряжений, и в то же 
время изменения температуры могут вызывать изменения а упругих свойствах мате-
риала. Оба эффекта можно эффективно смоделировать в COSMOS/M. Более подроб-
ная информация приведена ниже. 

В Таблице 6-5 приведены названия свойств материала в Основной Системе, которые 
могут быть введены как зависящие от температуры. 

Table 6-5. Температурнозависисмые свойства материала в Основной Системе  

Имя свойства Описание Единицы 
измерения 

ALPX, ALPY, ALPZ  Коэффициенты термического расширения по направлениям 
материала x, y и z  

Деформация 
/Температура 

DAMP  Коэффициент демпфирования материала   
DCij  Коэффициенты диэлектрической матрицы (необходимы 

шесть констант)  
 

DENS  Плотность   
EX, EY, EZ  Модули упругости по направлениям X, Y и Z  Сила/Площадь 
GXY, GXZ, GYZ  Поперечный модуль по направлениям XY, XZ и YZ  Сила/Площадь 
MCij  Модули анизотропной упругости (необходима двадцать одна 

константа)  
Сила/Площадь 

NUXY Отношение Пуассона, деформация по второму направлению 
материала, вызываемая деформацией по первому направле-
нию  

нет 

NUXZ  Отношение Пуассона, деформация по третьему направлению 
материала, вызываемая деформацией по первому направле-
нию  

нет 

NUYZ  Отношение Пуассона, деформация по третьему направлению 
материала, вызываемая деформацией по второму направле-

нет 
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нию  
PCij  Коэффициенты матрицы пьезоэлектрического материала 

(необходимо восемнадцать констант)  
 

SIGXC Прочность материала на сжатие по направлению материала x  Сила/Площадь 
SIGXT  Прочность материала на разрыв по направлению материала x  Сила/Площадь 
SIGXYC  Прочность материала на сжатие в плоскости материала xy Сила/Площадь 
SIGXY Прочность на срез в плоскости материала xy Сила/Площадь 
SIGYT  Прочность материала на разрыв по направлению материала y  Сила/Площадь 

Термальные отношения напряжения-деформации  

Изменения температуры, вызывающие термальные напряжения в COSMOS/M назы-
ваются термальными нагрузками. Существует возможность перенести температуры, 
полученные в термальном расчете как термальные нагрузки в расчет напряжений в 
той же задаче; более подробная информация приведена в Главе 7, Нагрузки и гранич-
ные условия, и Главе 12, Междисциплинарный расчет. 

Соотношение между термальными напряжениями и деформациями в общем виде за-
писывается так: 

 (6-20) 

где [D] � матрица упругости материала (изотропного, ортотропного или анизотропно-
го), {σt} � вектор термальных напряжений а {εt} � вектор термальных деформаций. 
Модули упругости в [D] могут зависеть от температуры (см. в следующем разделе). 
Без учета действия температуры на коэффициенты термического расширения тер-
мальные деформации рассчитываются по формуле: 

 (6-21) 

где {αt} � вектор коэффициентов термического расширения, T � действующая (или 
приложенная) температура, а T0 � начальная температура (задаваема командой TREF 
(LoadsBC > LOAD OPTIONS > Reference Temp)), при которой конструкция свободна 
от напряжений. Заметьте, что начальная температура � это обычно температура при 
которой задаются коэффициенты термического расширения. Однако, в COSMOS/M 
коэффициенты термического расширения могут зависеть от температуры. Ранее бы-
ли представлены различные уравнения для изотропных, ортотропных и анизотроп-
ных материалов, учитывающее действие термальных деформаций. Компоненты век-
тора {αt} для термально изотропных, ортотропных и анизотропных материалов 
имеют вид: 

 (6-22) 
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Для изотропных материалов в команде MPROP (Propsets > Material Property) необходи-
мо указать только свойство ALPX, для ортотропных необходимо ввести два остав-
шихся компонента, ALPY и ALPZ. Для анизотропных материалов, требующих шесть 
компонентов вектора коэффициентов, в COSMOS/M позволяется вводить только 
первые три, и эти коэффициенты могут быть изотропными или ортотропными. Если 
коэффициенты термического расширения зависят от температуры, то вы можете вы-
полнить команду CURDEF (LoadsBC > FUNCTION CURVE > Time/Temp Curve) для 
задания кривой, определяющей зависимость коэффициента термического расшире-
ния от температуры и связать ее с любым компонентом {αt}. Ниже следует подроб-
ное изложение. 

Свойства материала, зависимые от температуры  

Для моделирования термоупругих задач можно использовать почти все элементы  Ос-
новной Системы. Многие из упругих свойств, а также коэффициенты термического 
расширения, задаваемых командой MPROP (Propsets > Material Property) можно задать 
как зависимые от температуры. В большинстве случаев модули упругости уменьша-
ются с увеличением температуры, в то время как отношение Пуассона остается по-
стоянным. Например, модуль упругости (E) нержавеющей стали уменьшается при-
мерно на 20% при увеличении температуры с 0° до 450°C. 

Для задания зависимости модулей упругости от температуры можно использовать 
возможность задания температурных кривых в COSMOS/M. Сначала необходимо ак-
тивизировать задание температурной кривой командой ACTSET, TP, 1, (Control > 
ACTIVATE > Set Entity, Temperature Curve, 1) а затем командой CURDEF (LoadsBC > 
FUNCTION CURVE > Time/Temp Curve) задать различные температуры и соответст-
вующие модули упругости, как показано ниже. Матрица жесткости составляется с 
использованием интерполированных свойств материала на основе температуры пер-
вого рассматриваемого в расчете варианта нагрузки (то есть с самой маленькой ме-
той) вне зависимости от природы этого варианта нагрузки (то есть является ли он 
термальным, или нет). В данном примере предполагается, что модуль упругости 
уменьшается на 10%, когда температура повышается с 0 до 100 градусов, и на 20%, 
когда температура повышается до 1000 градусов, то есть зависимость модуля упру-
гости от температуры билинейна. Заметьте, что можно задать как кривую, задающую 
зависимость модуля упругости от температуры, так и кривую, задающую зависи-
мость множителя от температуры.  
Control Panel: LoadsBC > FUNCTION CURVE > Time/Temp Curve 
Curve type >Temp 
Curve number >1 
Start point >1 
Temperature for point 1 >0 
Function value for point 1 >1 
Temperature for point 2 >100 
Function value for point 2 >0.9 
Temperature for point 3 >1000 
Function value for point 3 >0.8 

Эта процедура связывает температурную кривую 1 с заданной зависимостью. Для 
просмотра зависимости модуля упругости от температуры можно использовать ко-
манду CURLIST (LoadsBC > FUNCTION CURVE > List Time/Temp). ниже приведена 
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процедура отображения температурной кривой: 
Control Panel: Display > XY PLOTS > Activate Pre-Proc 
Graph Number >1 
Curve type >Time/Temp/BHC/MPC 
Curve type >Temp 
Curve number >1 
Graph color >12 
Graph line style >Solid 
Graph symbol style >Circle 
Control Panel: Display > XY PLOTS > Plot Curves 
Plot graph 1 0=No, 1=Yes >Yes 

На экране будет отображен график, показанный на рис. 6-2. 

 

Рис. 6-2. Пример модуля упругости, зависящего от температуры 

Далее, для связывания температурной зависимости с модулем упругости EX, исполь-
зуйте команду MPROP (Propsets > Material Property) и укажите множитель для свойст-
ва (действующие значения свойства будут считываться из ранее заданной темпера-
турной кривой и домножаться на это число): 
Control Panel: Propsets > Material Property 
Material property set >1 
Material Property Name >EX; Elasticity modulus 1st dir 
Property value >30E6 

Если вы выведете свойства материала на экран (командой MPLIST (Edit > LIST > 
Material Props)), то получите примерно следующую таблицу, подтверждающую свя-
зывание EX и температурной кривой: 
    Label Name Temp/BH_Cr Value  
A 1         EX   1               3.000000e+07  
A 1         EX       1                      
 3.000000e+07  
A 1         NUXY   0                      
 3.300000e-01  
A 1         GXY   0                      
 5.800000e+06  
A 1         ALPX   0                     
 1.100000e-05  
A 1         DENS   0                     
 7.893000e-04  
A 1         C         0  
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 3.477600e+01  
A 1         KX       0                 
 5.370000e-03 

Если вы продолжите задание модулей упругости командой MPROP (Propsets > Material 
Property), они также будут связываться с температурной кривой 1. Для деактивирова-
ния этой зависимости необходимо выполнить команду ACTSET, TP, 0 , (Control > 
ACTIVATE > Set Entity, Temperature Curve, 0). 

Для задания коэффициентов термического расширения, зависимых от температуры, 
необходимо сначала активизировать задание температурной кривой командой 
ACTSET, TP, 1, (Control > ACTIVATE > Set Entity, Temperature Curve, 1,), а затем вы-
полнить команду CURDEF (LoadsBC > FUNCTION CURVE > Time/Temp Curve). Те-
перь можно задать кривую 2, определяющую зависимость коэффициента термиче-
ского расширения от температуры, после чего командой MPROP (Propsets > Material 
Property) задать свойство ALPX или другой компонент вектора коэффициентов тер-
мического расширения. 

ПРИМЕЧАНИЕ: Для вычисления действия температуры на свойства материала про-
грамма использует одно значение для каждого элемента, являющееся средним 
значением узловых температур. 

Слоистые составные материалы  
Слоистые составные материалы состоят из двух или более скрепленных слоев различ-
ной толщины и с различными свойствами материала. Свойства материала в каждом 
слое могут быть изотропными или ортотропными. Часто применяется такая конфи-
гурация слоев, когда две из главных осей материала каждого слоя ортогональны осям 
другого слоя. Слоистые материалы с такой конфигурацией слоев зазываются попе-
речно-слоистыми (cross-ply) материалами. На рис. 6-3 показаны конфигурации двух- 
и трехслойного поперечно-слоистых материалов. 

 

Рис. 6-3. Плоские конструкции из поперечно-слоистых материалов  

Слоистый материал может быть смоделирован одним элементом плиты или оболочки 
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соответствующим описанием свойств материала каждого слоя в матрице жесткости 
элемента. Это достигается использованием предоставленной пользователем инфор-
мации о числе слоев, толщине слоев и относительной ориентации ортотропных осей 
для каждого слоя. На этапе постпроцессинга результаты расчета для каждого слоя 
можно отобразить и анимировать по отдельности. Слоистые составные материалы 
могут быть смоделированы с использованием элементов оболочки SHELL3L, 
SHELL4L, SHELL9L и объемного элемента SOLIDL. 

В COSMOS/M слоистые составные материалы предполагаются идеально скрепленны-
ми. Толщина скрепления между слоями предполагается бесконечно малой. Попереч-
ные деформации в скреплениях не учитываются, поэтому межслойное скольжение 
отсутствует, и перемещения на границах материала непрерывны. 

ПРИМЕЧАНИЕ: Слоистый составной материал из трех слоев (причем верхний и 
нижний слой имеют одинаковую толщину и одинаковые характеристики материала) 
в COSMOS/M называется плитой ил оболочкой типа «бутерброд». 

Для использования варианта «бутерброд» вам необходимо установить соответствую-
щий признак в команде EGROUP (Propsets > Element Group). 

Свойства материала для слоистых составных материалов  

Для слоистых составных материалов свойства материала для каждого слоя определя-
ются номером ранее заданного командой MPROP (Propsets > Material Property) набора 
свойств материала. Одина набор свойств материала может быть назначен более чем 
одному слою. Свойства материала в каждом слое могут быть изотропными или орто-
тропными. Более подробная информация по заданию упругих свойств и осей мате-
риала для изотропных и ортотропных материалов приведена в соответствующих раз-
делах. Заметьте, что толщина каждого слоя, номер набора свойств материала и 
ориентация главных направлений материала задаются командой RCONST (Propsets > 
Real Constant). 

Ниже приведена процедура задания свойств материала для слоистых составных мате-
риалов. Рекомендуется сначала задать группу элементов командой EGROUP (Propsets 
> Element Group) и указать имя составного элемента и число слоев в элементе. Ниже 
приведен пример для составной оболочки с четырьмя слоями: 
Control Panel: Propsets > Element Group 
Element Group >1 
Element Category >Area 
Element Type (for area) >SHELL4L; Multilayer 4-node shell/plate element 
OP1:Type >QUAD4 
OP2:Number of Layers >4 
... ... ... 
Примите значения 

Далее, задайте необходимые свойства материала командой MPROP (Propsets > Material 
Property). Для составного материала с четырьмя слоями необходимо задать четыре 
набора свойств материала, если свойства материала в каждом слое различны. Теперь 
можно приступать к заданию данных для каждого слоя командой RCONST (Propsets > 
Real Constant). В нижеприведенном примере свойства материала для каждого слоя 
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одинаковы, но ориентация главных направлений материала в каждом слое различна. 
Для каждого слоя необходимо ввести толщину слоя, номер набора свойств материала 
и  угол материала. Команда RCONST (Propsets > Real Constant) принимает максимум 
10 значений при каждом выполнении, поэтому понадобится выполнить эту команду 
повторно для ввода данных для остальных слоев. 
Control Panel: Propsets > Real Constant 
Associated Element group >1 
Real Constant set >1 
Start location of the real constants >1 
No. of real constants to be entered >10 
RC1 : Dist. from ref. plane to top surface >0.5 
RC2 : Temperature gradient >0 
RC3 : Thickness of layer 1>0.25 
RC4 : Material number for layer 1 >1 
RC5 : Material angle for layer 1 >0 
RC6 : Thickness of layer 2 >0.25 
RC7 : Material number for layer 2 >1 
RC8 : Material angle for layer 2 >30 
RC9 : Thickness of layer 3 >0.25 
RC10 : Material number for layer 3 >1 

Выполните команду RCONST (Propsets > Real Constant) повторно, и введите оставшие-
ся данные: 
Control Panel: Propsets > Real Constant 
Associated Element group >1 
Real Constant set >1 
Start location of the real constants >11 
No. of real constants to be entered >4 
RC11 : Material angle for layer 3 >60 
RC12 : Thickness of layer 4 >0.25 
RC13 : Material number for layer 4 >1 
RC14 : Material angle for layer 4 >90 

Критерий отказа для слоистых составных материалов  

Критерий отказа предоставляет математическое соотношения для прочности под ком-
бинированными напряжениями. В отличие от обычных изотропных материалов, где 
для нахождения уровня и места отказа требуется одна константа, для слоистых со-
ставных материалов требуются более тщательные методы нахождения напряжения 
отказа. Прочность слоистого составного материла основана на прочностях отдельных 
слоев этого материала. Кроме этого отказ слоев может быть последовательным при 
увеличении нагрузки. После первого отказа слоя могут последовать отказы других 
слоев, пока не откажет последний слой, что означает полный отказ материала. Таким 
образом, описание последовательного отказа для конструкций из составных слои-
стых материалов может быть очень сложным. 

Более простой подход для нахождения отказа состоит в определении целостности кон-
струкции, зависящей от задания поля допустимых напряжений. Поле напряжений 
обычно описывается множеством допустимых напряжений по главным направлени-
ям материала. В таблице приведены компоненты допустимых напряжений, необхо-
димые для теорий отказа и их имена свойств в COSMOS/M. 

Таблица 6-6. Необходимые компоненты прочности материала для критерия отказа составных материа-
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лов  

Символ  Описание Имя свойства 
материала 

X1
T  Прочность на разрыв в продольном направлении материала  SIGXT 

X1
C  Прочность на сжатие в продольном направлении материала  SIGXC 

X2
T  Прочность на разрыв в поперечном направлении материала  SIGYT 

X2
C  Прочность на сжатие в поперечном направлении материала   SIGYC 

S12 Прочность на срез в плоскости материала xy  SIGXY 

В текущей версии доступны два критерия отказа, использующие вышеприведенные 
прочности, вводимые пользователем. Это критерии отказа Хилла и Тсай-Ву. Эти 
критерии отказа используются для расчета индекса отказа (F.I.) на основе рассчитан-
ных напряжений и введенных пользователем прочностей. Индекс отказа, равный 1, 
обозначает отказ, а значение индекса, меньшее 1 обозначает отсутствие отказа. В 
следующих разделах приведено описание этих критериев. 

ПРИМЕЧАНИЕ: Критерии отказа Хилла и Тсай-Ву применимы только к элементам 
SHELL3L и SHELL4L. Для расчета индексов отказа должны быть введены все ком-
поненты прочности материала для всех слоев. 

Индексы отказа рассчитываются для всех слоев в каждом элементе в модели. На этапе 
постпроцессинга вы можете отобразить индексы отказа в КЭ-сети для любого слоя. 

Критерий отказа Хилла  

Критерий отказа Хилла (иногда называемый критерием Тсай-Хилла) часто применяет-
ся к ортотропным материалам с равными прочностями на сжатие и разрыв. Индекс 
отказа, рассчитываемый на основе теории Хилла, приведенной ниже, представляет  
аналитическое выражение для эллипса в плоскости σ1 - σ2: 

 (6-23) 

где σ1, σ2 и τ12 � рассчитанные напряжения по направлениям материала, ( обозначаемы 
SIGMA-X, SIGMA-Y и SIGMA-XY в файле вывода) и 

 

Применение критерия отказа Хилла указывается в команде A_STRESS (Analysis > 
STATIC > Stress Analysis Options): 
Control Panel: Analysis > STATIC > Stress Analysis Options 
AISC code check Flag >No 
... ... ... 
Type of failure analysis >Hill Criterion 

Программа рассчитывает индексы отказа для всех слоев в каждом элементе и выводит 
их вместе со значениями напряжений в элементах в файле вывода. В данном примере 
был использован элемент SHELL3L с четырьмя слоями. 
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    ELEMENT NUMBER                     1 
  
 NX     NY       NXY   MX  MY       MXY   VX  VY  
 
      -2.70E+03 -1.04E+03 -4.39E+01 -3.75E+03 -2.73E+02 -6.51E+02 -1.26E+02 -1.21E+02  
 
LAYER (ECS:-1)   SIGMA-X          SIGMA-Y    SIGMA-XY      TAU-XZ  TAU-YZ           HILL  
 
NUMBER  
 
      4  TOP  -2.941E+04 -4.544E+03 -4.193E+03 -1.322E+02 -1.551E+02 4.93245E+01  
 
             BOTTOM  -1.686E+04 -3.564E+03 -1.452E+03 -1.322E+02 -1.551E+02 1.34369E+01  
 
         (INTERLAMINAR SHEAR STRESSES) -1.395E+02 -1.350E+02  
 
      3  TOP         -2.621E+04   3.514E+03 -6.611E+03 -1.526E+02 -1.611E+02  1.23329E+02  
 
                 BOTTOM  -5.560E+03 -1.424E+03 -4.318E+02 -1.526E+02 -1.611E+02 2.45260E+00  
 
        (INTERLAMINAR SHEAR STRESSES) -2.231E+02 -1.774E+02  
 
      2  TOP  -7.103E+03 -5.668E+02 9.327E+02 -1.679E+02 -1.464E+02 6.25082E+00  
 
              BOTTOM    1.537E+04  -4.018E+03 5.256E+02 -1.679E+02 -1.464E+02 4.80744E+01   
 
        (INTERLAMINAR SHEAR STRESSES) -1.697E+02 -1.109E+02  
 
      1  TOP  1.240E+04 -5.105E+02 4.030E+03 -1.630E+02 -1.258E+02 3.28336E+01  
 
               BOTTOM   3.103E+04   9.984E+02 6.771E+03 -1.630E+02 -1.258E+02 1.69770E+02  
 
               ENRGYE = 0.5509E+03 ENRGYD = 0.1344E+02 

Критерий отказа Тсай-Ву  

Критерий отказа Тсай-Ву (также называемый полиномиальной теорией тензоров Тсай-
Ву) обычно используется для ортотропных материалов с неравными прочностями на 
сжатие и разрыв. Индекс отказа рассчитывается из следующего уравнения: 

 (6-24) 

и 

 (6-25) 
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Применение критерия отказа Тсай-Ву указывается в команде A_STRESS (Analysis > 
STATIC > Stress Analysis Options): 
Control Panel: Analysis > STATIC > Stress Analysis Options 
AISC code check Flag >No 
... ... ... 
Type of failure analysis >Tsai-Wu Criterion 

Программа рассчитывает индексы отказа для всех слоев в каждом элементе и выводит 
их вместе со значениями напряжений в элементах в файле вывод. В нижеприведен-
ном примере, так же как и в примере для критерия отказа Хилла, были использован 
элемент SHELL3L с четырьмя слоями. Вы можете заметить разницу в значениях ин-
дексов отказа. 
ELEMENT NUMBER  1  
 
 NX     NY       NXY   MX     MY       MXY   VX    VY  
 
      -2.70E+03 -1.04E+03 -4.39E+01 -3.75E+03 -2.73E+02 -6.51E+02 -1.26E+02 -1.21E+02  
 
LAYER (ECS:-1)    SIGMA-X          SIGMA-Y    SIGMA-XY      TAU-XZ  TAU-YZ         TSAI-WU  
 
NUMBER  
 
      4  TOP  -2.941E+04 -4.544E+03 -4.193E+03 -1.322E+02 -1.551E+02 1.11044E+02  
 
                BOTTOM  -1.686E+04 -3.564E+03 -1.452E+03 -1.322E+02 -1.551E+02 3.37088E+01  
 
         (INTERLAMINAR SHEAR STRESSES) -1.395E+02 -1.350E+02  
 
       3  TOP  -2.621E+04    3.514E+03 -6.611E+03 -1.526E+02 -1.611E+02 1.46136E+02  
 
              BOTTOM  -5.560E+03 -1.424E+03 -4.318E+02 -1.526E+02 -1.611E+02 3.78808E+00  
 
        (INTERLAMINAR SHEAR STRESSES) -2.231E+02 -1.774E+02  
 
       2  TOP  -7.103E+03 -5.668E+02 9.327E+02 -1.679E+02 -1.464E+02 7.79441E+00  
 
               BOTTOM    1.537E+04 -4.018E+03 5.256E+02 -1.679E+02 -1.464E+02 4.63253E+01  
 
        (INTERLAMINAR SHEAR STRESSES) -1.697E+02 -1.109E+02  
 
      1  TOP  1.240E+04 -5.105E+02 4.030E+03 -1.630E+02 -1.258E+02 2.84385E+01  
 
               BOTTOM  3.103E+04    9.984E+02 6.771E+03 -1.630E+02 -1.258E+02 1.51238E+02  
 
               ENRGYE = 0.5509E+03 ENRGYD = 0.1344E+02 

Пьезоэлектрические свойства  
Пьезоэлектричеством называется феномен электрической поляризации некоторых 
кристаллов при деформации по определенным направлениям. Обратный эффект, а 
именно механические деформации кристалла в электрическом поле также называется 
пьезоэлектричеством. Последний широко используется при изучении пьезоэлектри-
ческих резонаторов и других приложений. Пьезоэлектрический резонатор, например, 
это устройство состоящее из бруска или плитки из пьезоэлектрического материала с 
двумя или более электродами, подключенными к его поверхности. При приложении 
к электродам гармонического напряжения в пьезоэлектрическом материале начина-
ются механические вибрации. Для резонанса частота возбуждающего сигнала (на-
пряжения) должна быть близка к частоте резонанса. Пьезоэлектрический эффект 
также играет важную роль в физике кристаллов и технологии приемников. Пьезо-
электрические материала могут быть использованы в статическом, модальном, гар-
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моническом расчетах и расчете переходного состояния. Изучение деформаций в пье-
зоэлектрических материалов, помещенных в электрическое поле, часто называется 
электроупругим расчетом. 

COSMOS/M предоставляет возможность рассчитывать свободные вибрации пьезо-
электрических компонентов, помещенных в электрическое поле. В текущей версии 
был введен новый объемный элемент SOLIDPZ, который может иметь изотропные, 
анизотропные и ортотропные упругие свойства материала и может быть использован 
в электроупругом расчете пьезоэлектрических компонентов. 

Пьезоэлектрические материалы  

Обычно в качестве примера пьезоэлектрического материала приводят кристалл кварца 
в наручных часах. Однако, применение пьезоэлектрических материалов расширилось 
на другие области. Сегодня кроме пьезоэлектрических кристаллов существуют пье-
зоэлектрические полимеры и керамика. Пьезоэлектрическая керамика основана на 
твердых растворах цирконата свинца (PbZrO3) и титаната свинца (PbTiO3) и называ-
ется PZT-керамикой. В таблице приведены часто используемые в промышленности 
пьезоэлектрические материалы. 

Таблица 6-7. Примеры пьезоэлектрических материалов 

Тип пьезоэлектриче-
ского материала  

Примеры Примечания 

Кристаллические пьезо-
электрические материалы  

Кварц  
Берлинит 
Ниобат лития  
Танталат лития  
Германиевый оксид висмута  
Кремниевый оксид висмута  

. . .  

. . . 

. . .  

. . .  

. . .  

. . . 
Пьезоэлектрическая кера-
мика 

PZT  
VIBRIT  
PKM  

Корпорация Clevite  
Siemens  
. . . 

Пьезоэлектрические поли-
меры 

Поливинилхлорид (PVC)  
Полинвинилфторид (PVF)  
Двафторполиэтилен (PVF2)  
 
Нейлон 11  

. . .  

. . .  
PVF2-β и PVF2-δ � наиболее часто встречаю-
щиеся формы.  
. . . 

Задание пьезоэлектрических свойств в COSMOS/M 

Для выполнения электроупругого расчета необходимо ввести упругие, диэлектриче-
ские и пьезоэлектрические свойства пьезоэлектрического материала. Многие пьезо-
электрические обладают кристаллической структурой с четко обозначенными плос-
костями прочности и симметрии, что приводит к неадекватному их описанию 
изотропными упругими свойствами. В этом случае необходимо использовать орто-
тропные или анизотропные упругие свойства. Элемент SOLIDPZ поддерживает ис-
пользование ортотропных и анизотропных упругих свойств. Ввод упругих свойств 
был описан выше. 

В электроупругом расчете упругие составляющие уравнения (6-1) и составляющие 
уравнения электрического поля (см. Руководство по Расширенным модулям) связы-
ваются пьезоэлектрической матрицей. Таким образом, электромеханические состав-
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ляющие уравнения для линейного поведения имеют следующий вид: 

  (6-26) 

где {T} � вектор напряжений, {DL} � вектор плотности электрического потока, [D] � 
матрица коэффициентов упругости при постоянном электрическом поле (без учета 
электросужения (electrostrictive effects)), {ε} � механическая деформация, [e] � мат-
рица пьезоэлектрических свойств, {EL} � вектор электрического поля и [εd] � матрица 
диэлектрических свойств при постоянной механической деформации. Коэффициенты 
матрицы упругости [D] вводятся, как описано выше, с использованием изотропных, 
ортотропных или анизотропных описаний материала. Ниже приведено описание 
процедуры ввода пьезоэлектрических и диэлектрических свойств. 

Пьезоэлектрическая матрица [e] связывает электрическое поле и напряжения, и имеет 
размерность 6x3 для трехмерных моделей, и 4x2 для двухмерных. ниже приведена 
матрица для трехмерных моделей. 

 (6-27) 

В Таблице Table 6-2 видно, что имена свойств для коэффициентов пьезоэлектрической 
матрицы обозначаются PCij, где i=1�6 b j=1�3. Для задания пьезоэлектрических 
свойств материала команда MPROP (Propsets > Material Property) используется сле-
дующим образом: 
Control Panel: Propsets > Material Property 
Material property set >1 
Material Property Name >PC11 
Property value [0]>-4.1 
... ... ... 
Material Property Name >PC63 
Property value [0]>14.1 

Ниже приведена матрица диэлектрических свойств [εd]: 

  (6-28) 

Имена свойств для коэффициентов этой матрицы обозначаются DCij где i,j=1�3. Для 
задания диэлектрических свойств материала команда MPROP (Propsets > Material 
Property) используется следующим образом: 
Control Panel: Propsets > Material Property 
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Material property set >1 
Material Property Name >DC11 
Property value >7.124E-9 
... ... ... 
Material Property Name >DC33 
Property value >5.85E-9 

Свойства массы и демпфирования  
Свойства массы, а именно плотность, указываются под именем свойства DENS в ко-
манде MPROP (Propsets > Material Property). Эти данные используются для вычисления 
матриц сосредоточенной или распределенной массы при расчете собственных частот. 
Эти данные также необходимы, если вы хотите приложить гравитационную или цен-
тробежную нагрузку. 

Сосредоточенная масса в узле может быть задана с использованием элемента MASS; 
более подробная информация приведена в Главе 5, Библиотека элементов.  

Свойства демпфирования указываются под именем свойства DAMP в команде MPROP 
(Propsets > Material Property). Включение информации о демпфировании приводит к 
извлечению комплексных собственных значений. Заметьте, что в Основной Системе 
демпфирование может быть применено к моделям с числом степеней свободы 50 и 
менее. 

Неупругое поведение материала 
Кроме уже описанных различных типов упругих, термоупругих, составных и пьезо-
электрических свойств материала, в COSMOS/M существуют возможности описания 
неупругих свойств, свойств зависимых от времени и температуры для нелинейных 
конструкционных, термальных или электромагнитных расчетов. Неупругие свойства 
материала могут быть использованы только в нелинейном расчете в модуле NSTAR. 
Более подробная информация приведена в Руководстве по Расширенным модулям 
COSMOS/M, Часть 1, NSTAR, Глава 3. 

Библиотека материалов  
Библиотека материалов COSMOS/M позволяет выбирать стандартные свойства мате-
риала из встроенной библиотеки или ваши свойства материалов из пользовательской 
библиотеки. Свойства материалов во встроенной библиотеке доступны в системах 
единиц измерения FPS, MKS или СИ. В таблице приведены имена свойств в библио-
теке материалов и их описание. 

Таблица 6-8. Имена свойств в библиотеках материалов  

Имя свойства Символ Описание 
ALPX  αx  Коэффициент термического расширения по направ-

лению x 
BETA  β Коэффициент объемного расширения  
C (Cp)  Cp  Удельная теплота 
DENS  ρ Плотность 
EX  Ex  Модуль упругости по направлению x 
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GAMMA  γ отношение удельных теплот  
GXY  Gxy  Поперечный модуль в плоскости xy 
KX  Kx  Теплопроводность по направлению x 
NUXY  νxy  Отношение Пуассона  
VISC  η Динамическая вязкость  

По умолчанию во встроенной и пользовательской библиотеках материалов находятся 
изотропные свойства материала. Если необходимо использовать ортотропные свой-
ства материала, то вы должны предоставить недостающие данные в том же наборе 
свойств материала. Однако существует возможность дополнить свойства материала в 
библиотеке для описания анизотропных свойств материала. 

Для выбора заранее заданных свойств материала из встроенной и пользовательской 
библиотек используются команды PICK_MAT (Propsets > Pick Material Lib) и USER_MAT 
(Propsets > User Material Lib), соответственно. В нижеследующих разделах приведено 
подробное описание использования библиотек материалов. 

Использование встроенной библиотеки материалов  

В COSMOS/M были заранее определены свойства для некоторых часто используемых 
материалов. Свойства для материалов с изотропными свойствами, линейной упруго-
стью и линейной теплопроводностью можно выбрать из встроенной библиотеки ко-
мандой PICK_MAT (Propsets > Pick Material Lib). 

Когда вы выполняете команду PICK_MAT (Propsets > Pick Material Lib) свойства мате-
риала считываются из текстового файла PICKMAT.LIB, находящегося в директории 
COSMOS/M. В Таблице 6-9 приведены доступные материалы их имена в 
COSMOS/M. 

Таблица 6-9. Материалы во встроенной библиотеке материалов 

Имя в COSMOS/M  Материал 
ACRYLIC  Средне-высоко ударопрочный акрил  
AIR  Воздух (300 K) 
ALUMINUM  Сплав алюминия  
AL_1345  Сплав алюминия 1345  
AL_1350  Сплав алюминия 1350  
AL_2014  Сплав алюминия 2014  
AL_2018  Сплав алюминия 2018  
AL_2024  Сплав алюминия 2024  
AL_3003 Сплав алюминия 3003  
AL_6061  Сплав алюминия 6061  
AL_7079  Сплав алюминия 7079  
AL_BRONZE Алюминиевая бронза  
A_STEEL  Легированная сталь  
BRASS  Кремниевая латунь и бронза  
CA_STEEL  Литая легированная сталь, содержание легирующих добавок 

меньше 8% 
COBALT  Кобальт 
CS_STEEL  Литая нержавеющая сталь, CF-8M или CF-20, водной закалки 
D_NICKEL  Сплав никеля Duranickel 301 
GC_IRON  Серое литое железо ASTM Class 40 
GLASS  Стекло 
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GOLD  Чистое золото  
IRON  Железо 
LEAD  Чистый свинец 
MAGNES  Сплав магния, кованый или литой  
MC_IRON  Ковкое литое железо ASTM A220 
MN_BRONZE  Марганцевая бронза  
MOLYBDENUM  Молибден  
MONEL  Сплав никеля MONEL 400 
NYLON  Нейлон 6/10 
PC_STEEL  Обычная углеродистая сталь  
PORCELAIN  Керамический фарфор  
RUBBER  Резина 
SILVER  Чистое серебро  
STEEL  Сталь 
ST_1020  Сталь AISI C1020 (Горячей ковки) 
ST_304  Сталь AISI 304 (Листовая) 
ST_ST  Нержавеющая сталь  
TITANIUM  Титан 
TUNGSTEN  Вольфрам 
T_BRONZE  Оловянная бронза 1B 
VANADIUM  Ванадий 
WATER  Вода (300 K) 
WS_STEEL  Кованая нержавеющая сталь  
W_COPPER  Кованая медь  
ZIRCONIUM  Циркон 

ПРИМЕЧАНИЕ: Свойства материалов во встроенной библиотеке действительны при 
температуре 70° F. Некоторые из свойств можно сделать зависимыми от температу-
ры, более подробная информация приведена в разделе Термоупругие свойства. 

Использовать встроенную библиотеку материалов очень просто.  Например, если вы 
хотите выбрать кованую медь, используя единицы системы FPS для набора свойств 
материала 1, то команда PICK_MAT (Propsets > Pick Material Lib) выполняется следую-
щим образом: 
Control Panel: Propsets > Pick Material Lib 
Material property set >1 
Material Name >W_COPPER 
Unit Label >FPS 

В библиотеке хранятся следующие свойства кованой меди: 

Имя материала: W_COPPER Wrought Copper 
Имя свойства 
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.16E+08 psi  
0.33  
0.58E+07 psi  
0.11E-04 /Fahrenheit  
0.79E-03 lbf*s*s/in**4  
0.31E-02 BTU/in/s/F  
35. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.11E+07 Kgf/cm/cm  
0.33  
0.41E+06 Kgf/cm/cm  
0.20E-04 /Centigrade  
0.86E-05 Kgf*s*s/cm**4  
0.56 Cal/cm/s/C  
0.88E+05 Cal*cm/kgf/s/s/C 

Значение (SI)  
0.11E+12 Pascals  
0.33  
0.40E+11 Pascals  
0.20E-04 /Kelvin  
0.84E+04 Kgm/m**3  
0.23E+03 W/m/K  
0.38E+03 J/kgm/K 

Изотропные отношения напряжения-деформации для линейного статического расчета 
напряжений (с учетом термальных эффектов) для выбранного материала в системе 
единиц FPS под действием напряжений в плоскости имеют следующий вид: 
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Дополнение этих свойств материала для описания ортотропности также очень просто. 
Например, если вам известны остальные ортотропные свойства меди (мы не утвер-
ждаем что медь является ортотропным материалом!) и вы хотите их использовать, то 
для дополнения свойств материала необходимо применить следующую процедуру: 
Control Panel: Propsets > Material Property 
Material property set >1 
Material Property Name >EY; Elasticity modulus 2nd dir 
Property value >20.5E6 
Material Property Name >ALPY; Therm expansion coeff 2nd dir 
Property value >15.5E-6 
Material Property Name >KY; Y Thermal conductivity 
Property value >8.5E-3 

Заметьте, что необходимо ввести либо значение NUYX (Отношение Пуассоня для y-
деформаций от x-напряжений) либо EY (модуль упругости по направлению y), по-
скольку программа вычисляет одно из этих значений, используя условие симметрии, 
νxyEy=νyxEx. С учетом этих свойств ортотропные отношения напряжения-деформации 
для меди принимают вид: 

 

Эти уравнения будут использованы программой при вычислении матриц жесткости 
элементов и других вычислениях. 

Вы можете использовать команду MPLIST (Edit > LIST > Material Props) для просмотра 
заданных свойств (включая выбранные из библиотеки) на экране для проверки: 
  Label Name Temp/BH_Cr    Value  
_A   1    EX        0  1.550000e+07  
_A   1    EY        0  2.050000e+07  
_A   1  NUXY      0  3.300000e-01  
_A   1   GXY       0  5.800000e+06  
_A   1  ALPX      0  1.100000e-05  
_A   1  ALPY      0  1.550000e-05  
_A   1  DENS      0  7.893000e-04  
_A   1     C         0  3.477600e+01  
_A   1    KX        0  5.370000e-03  
_A   1    KY        0  8.500000e-03 

Содержимое встроенной библиотеки материалов  

Во встроенной библиотеке материалов содержатся заранее заданные свойства для 45 
материалов. Ниже приведены свойства материала в единицах трех систем. 

ПРИМЕЧАНИЕ: Свойства во встроенной библиотеке действительны при температу-
ре 70° F. Для любых других условий вы должны внести необходимые поправки, осо-
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бенно для свойств, чувствительных к температуре, например, коэффициента терми-
ческого расширения. 
Имя материала: A_STEEL Легированная сталь  
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.30E+08 psi  
0.28  
0.12E+08 psi  
0.74E-05 /Fahrenheit  
0.73E-03 lbf*s*s/in**4  
0.67E-03 BTU/in/s/F  
42. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.21E+07 Kgf/cm/cm  
0.28  
0.81E+06 Kgf/cm/cm  
0.13E-04 /Centigrade  
0.79E-05 Kgf*s*s/cm**4  
0.12 Cal/cm/s/C  
0.11E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.21E+12 Pascals  
0.28  
0.79E+11 Pascals  
0.13E-04 /Kelvin  
0.77E+04 Kgm/m**3  
0.46E+03 J/kgm/K  
0.46E+03 J/kgm/K 

Имя материала: ACRYLIC Акрил (Средне-высоко ударопрочный) 
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.35E+06 psi  
0.35  
0.13E+06 psi  
0.29E-04 /Fahrenheit  
0.11E-03 lbf*s*s/in**4  
0.28E-05 BTU/in/s/F  
0.14E+03 BTU*in/lbf/s/s/F  

Значение (MKS)  
0.25E+05 Kgf/cm/cm  
0.35  
0.91E+04 Kgf/cm/cm  
0.52E-04 /Centigrade  
0.12E-05 Kgf*s*s/cm**4  
0.50E-03 Cal/cm/s/C  
0.34E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.24E+10 Pascals  
0.35  
0.89E+09 Pascals  
0.52E-04 /Kelvin  
0.12E+04 Kgm/m**3  
0.21 W/m/K  
0.15E+04 J/kgm/K  

Имя материала: ALUMINUM Сплав алюминия 
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.10E+08 psi  
0.33  
0.39E+07 psi  
0.13E-04 /Fahrenheit  
0.25E-03 lbf*s*s/in**4  
0.27E-02 BTU/in/s/F  
83. BTU*in/lbf/s/s/F  

Значение (MKS) 
0.70E+06 Kgf/cm/cm  
0.33  
0.27E+06 Kgf/cm/cm  
0.24E-04 /Centigrade  
0.28E-05 Kgf*s*s/cm**4  
0.49 Cal/cm/s/C  
0.21E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.69E+11 Pascals  
0.33  
0.27E+11 Pascals  
0.24E-04 /Kelvin  
0.27E+04 Kgm/m**3  
0.20E+03 W/m/K  
0.90E+03 J/kgm/K 

Имя материала: AL_1345 Сплав алюминия 1345  
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp) 

Значение (FPS)  
0.10E+08 psi  
0.33  
0.39E+07 psi  
0.13E-04 /Fahrenheit  
0.25E-03 lbf*s*s/in**4  
0.29E-02 BTU/in/s/F  
93. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.70E+06 Kgf/cm/cm  
0.33  
0.27E+06 Kgf/cm/cm  
0.24E-04 /Centigrade 
0.27E-05 Kgf*s*s/cm**4 
0.53 Cal/cm/s/C 
0.24E+06 Cal*cm/kgf/s/s/C 

Значение (SI)  
0.69E+11 Pascals  
0.33  
0.27E+11 Pascals  
0.24E-04 /Kelvin  
0.27E+04 Kgm/m**3  
0.22E+03 W/m/K  
0.10E+04 J/kgm/K 

Имя материала: AL_1350 Сплав алюминия 1350  
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.10E+08 psi  
0.33  
0.39E+07 psi  
0.13E-04 /Fahrenheit  
0.25E-03 lbf*s*s/in**4  
0.31E-02 BTU/in/s/F  
93. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.70E+06 Kgf/cm/cm  
0.33  
0.27E+06 Kgf/cm/cm  
0.24E-04 /Centigrade  
0.28E-05 Kgf*s*s/cm**4  
0.56 Cal/cm/s/C  
0.24E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.69E+11 Pascals  
0.33  
0.27E+11 Pascals  
0.24E-04 /Kelvin  
0.27E+04 Kgm/m**3  
0.23E+03 W/m/K  
0.10E+04 J/kgm/K 

Имя материала: AL_2014 Сплав алюминия 2014  
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.11E+08 psi  
0.33  
0.40E+07 psi  
0.13E-04 /Fahrenheit  
0.26E-03 lbf*s*s/in**4  
0.21E-02 BTU/in/s/F  
89. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.78E+06 Kgf/cm/cm  
0.33  
0.28E+06 Kgf/cm/cm  
0.23E-04 /Centigrade  
0.28E-05 Kgf*s*s/cm**4  
0.38 Cal/cm/s/C  
0.23E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.77E+11 Pascals  
0.33  
0.28E+11 Pascals  
0.23E-04 /Kelvin  
0.28E+04 Kgm/m**3  
0.16E+03 W/m/K  
0.96E+03 J/kgm/K 

Имя материала: AL_2018 Сплав алюминия 2018  
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  

Значение (FPS)  
0.11E+08 psi  
0.33  
0.39E+07 psi  
0.12E-04 /Fahrenheit  
0.26E-03 lbf*s*s/in**4  

Значение (MKS)  
0.76E+06 Kgf/cm/cm  
0.33  
0.27E+06 Kgf/cm/cm  
0.22E-04 /Centigrade  
0.29E-05 Kgf*s*s/cm**4  

Значение (SI)  
0.74E+11 Pascals  
0.33  
0.27E+11 Pascals  
0.22E-04 /Kelvin  
0.28E+04 Kgm/m**3  
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KX  
C (Cp)  

0.21E-02 BTU/in/s/F  
93. BTU*in/lbf/s/s/F  

0.37 Cal/cm/s/C  
0.24E+06 Cal*cm/kgf/s/s/C  

0.15E+03 W/m/K  
0.10E+04 J/kgm/K 

Имя материала: AL_2024 Сплав алюминия 2024  
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp) 

Значение (FPS)  
0.11E+08 psi  
0.33  
0.40E+07 psi  
0.13E-04 /Fahrenheit  
0.26E-03 lbf*s*s/in**4  
0.19E-02 BTU/in/s/F  
73. BTU*in/lbf/s/s/F  

Значение (MKS) 
0.74E+06 Kgf/cm/cm  
0.33  
0.28E+06 Kgf/cm/cm  
0.23E-04 /Centigrade  
0.28E-05 Kgf*s*s/cm**4  
0.34 Cal/cm/s/C  
0.19E+06 Cal*cm/kgf/s/s/C   

Значение (SI)  
0.73E+11 Pascals  
0.33  
0.28E+11 Pascals  
0.23E-04 /Kelvin  
0.28E+04 Kgm/m**3  
0.14E+03 W/m/K  
0.80E+03 J/kgm/K 

Имя материала: AL_3003 Сплав алюминия 3003  
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.10E+08 psi  
0.33  
0.39E+07 psi  
0.13E-04 /Fahrenheit  
0.26E-03 lbf*s*s/in**4  
0.22E-02 BTU/in/s/F  
93. BTU*in/lbf/s/s/F  

Значение (MKS) 
0.70E+06 Kgf/cm/cm  
0.33  
0.27E+06 Kgf/cm/cm  
0.23E-04 /Centigrade  
0.28E-05 Kgf*s*s/cm**4  
0.40 Cal/cm/s/C  
0.24E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.69E+11 Pascals  
0.33  
0.27E+11 Pascals  
0.23E-04 /Kelvin  
0.27E+04 Kgm/m**3  
0.17E+03 W/m/K  
0.10E+04 J/kgm/K 

Имя материала: AL_6061 Сплав алюминия 6061  
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.10E+08 psi  
0.33  
0.38E+07 psi  
0.13E-04 /Fahrenheit  
0.25E-03 lbf*s*s/in**4  
0.22E-02 BTU/in/s/F  
0.12E+03 BTU*in/lbf/s/s/F  

Значение (MKS)  
0.70E+06 Kgf/cm/cm  
0.33  
0.27E+06 Kgf/cm/cm  
0.24E-04 /Centigrade  
0.28E-05 Kgf*s*s/cm**4  
0.40 Cal/cm/s/C  
0.29E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.69E+11 Pascals  
0.33  
0.26E+11 Pascals  
0.24E-04 /Kelvin  
0.27E+04 Kgm/m**3  
0.17E+03 W/m/K  
0.13E+04 J/kgm/K 

Имя материала: AL_7079 Сплав алюминия 7079  
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.10E+08 psi  
0.33  
0.39E+07 psi  
0.14E-04 /Fahrenheit  
0.26E-03 lbf*s*s/in**4  
0.16E-02 BTU/in/s/F  
89. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.73E+06 Kgf/cm/cm  
0.33  
0.27E+06 Kgf/cm/cm  
0.25E-04 /Centigrade  
0.28E-05 Kgf*s*s/cm**4  
0.29 Cal/cm/s/C  
0.23E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.72E+11 Pascals  
0.33  
0.27E+11 Pascals  
0.25E-04 /Kelvin  
0.27E+04 Kgm/m**3  
0.12E+03 W/m/K  
0.96E+03 J/kgm/K 

Имя материала: AL_BRONZE Алюминиевая бронза  
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.17E+08 psi  
0.30  
0.62E+07 psi  
0.95E-05 /Fahrenheit  
0.70E-03 lbf*s*s/in**4  
0.75E-03 BTU/in/s/F  
35. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.12E+07 Kgf/cm/cm  
0.30  
0.44E+06 Kgf/cm/cm  
0.17E-04 /Centigrade  
0.76E-05 Kgf*s*s/cm**4  
0.13 Cal/cm/s/C  
0.88E+05 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.11E+12 Pascals  
0.30  
0.43E+11 Pascals  
0.17E-04 /Kelvin  
0.74E+04 Kgm/m**3  
56. W/m/K  
0.38E+03 J/kgm/K 

Имя материала: BRASS Кремниевая латунь и бронза  
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.15E+08 psi  
0.33  
0.54E+07 psi  
0.10E-04 /Fahrenheit  
0.80E-03 lbf*s*s/in**4  
0.15E-02 BTU/in/s/F  
36. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.11E+07 Kgf/cm/cm  
0.33  
0.38E+06 Kgf/cm/cm  
0.18E-04 /Centigrade  
0.87E-05 Kgf*s*s/cm**4  
0.26 Cal/cm/s/C  
0.90E+05 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.10E+12 Pascals  
0.33  
0.37E+11 Pascals  
0.18E-04 /Kelvin  
0.85E+04 Kgm/m**3  
0.11E+03 W/m/K  
0.39E+03 J/kgm/K 

Имя материала: BRONZE Бронза 
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  

Значение (FPS)  
0.16E+08 psi  
0.37  
0.59E+07 psi  
0.18E-04 /Fahrenheit  
0.81E-03 lbf*s*s/in**4  
0.35E-03 BTU/in/s/F  

Значение (MKS)  
0.11E+07 Kgf/cm/cm  
0.37  
0.41E+06 Kgf/cm/cm  
0.32E-04 /Centigrade  
0.88E-05 Kgf*s*s/cm**4  
0.62E-01 Cal/cm/s/C  

Значение (SI)  
0.11E+12 Pascals  
0.37  
0.41E+11 Pascals  
0.32E-04 /Kelvin  
0.87E+04 Kgm/m**3  
26. W/m/K  
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C (Cp)  32. BTU*in/lbf/s/s/F  0.81E+05 Cal*cm/kgf/s/s/C  0.34E+03 J/kgm/K 
Имя материала: CA_STEEL Литая легированная сталь (Легирующих добавок меньше 8%) 
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.28E+08 psi  
0.26  
0.11E+08 psi  
0.81E-05 /Fahrenheit  
0.68E-03 lbf*s*s/in**4  
0.50E-03 BTU/in/s/F  
41. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.20E+07 Kgf/cm/cm  
0.26  
0.79E+06 Kgf/cm/cm  
0.15E-04 /Centigrade  
0.74E-05 Kgf*s*s/cm**4  
0.90E-01 Cal/cm/s/C  
0.10E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.19E+12 Pascals  
0.26  
0.78E+11 Pascals  
0.15E-04 /Kelvin  
0.73E+04 Kgm/m**3  
38. W/m/K  
0.44E+03 J/kgm/K 

Имя материала: COBALT Кобальт 
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.33E+08 psi  
0.31  
0.13E+08 psi  
0.68E-05 /Fahrenheit  
0.83E-03 lbf*s*s/in**4  
0.92E-03 BTU/in/s/F  
38. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.23E+07 Kgf/cm/cm  
0.31  
0.90E+06 Kgf/cm/cm  
0.12E-04 /Centigrade  
0.91E-05 Kgf*s*s/cm**4  
0.16 Cal/cm/s/C  
0.96E+05 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.23E+12 Pascals  
0.31  
0.88E+11 Pascals  
0.12E-04 /Kelvin  
0.89E+04 Kgm/m**3  
69. W/m/K  
0.41E+03 J/kgm/K 

Имя материала: COPPER Медь 
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.16E+08 psi  
0.37  
0.58E+07 psi  
0.13E-04 /Fahrenheit  
0.84E-03 lbf*s*s/in**4  
0.52E-02 BTU/in/s/F  
36. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.11E+07 Kgf/cm/cm  
0.37  
0.41E+06 Kgf/cm/cm  
0.24E-04 /Centigrade  
0.91E-05 Kgf*s*s/cm**4  
0.92 Cal/cm/s/C  
0.90E+05 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.11E+12 Pascals  
0.37  
0.40E+11 Pascals  
0.24E-04 /Kelvin  
0.89E+04 Kgm/m**3  
0.39E+03 W/m/K  
0.39E+03 J/kgm/K 

Имя материала: CS_STEEL Литая нержавеющая сталь (Cf-8m или Cf-20) 
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.28E+08 psi  
0.26  
0.12E+08 psi  
0.84E-05 /Fahrenheit  
0.73E-03 lbf*s*s/in**4  
0.50E-03 BTU/in/s/F  
48. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.20E+07 Kgf/cm/cm  
0.26  
0.81E+06 Kgf/cm/cm  
0.15E-04 /Centigrade  
0.79E-05 Kgf*s*s/cm**4  
0.90E-01 Cal/cm/s/C  
0.12E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.19E+12 Pascals  
0.26  
0.79E+11 Pascals  
0.15E-04 /Kelvin  
0.77E+04 Kgm/m**3  
37. W/m/K  
0.52E+03 J/kgm/K 

Имя материала: GC_IRON Серое литое железо (ASTM - Class40) 
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.17E+08 psi  
0.27  
0.72E+07 psi  
0.66E-05 /Fahrenheit  
0.67E-03 lbf*s*s/in**4  
0.60E-03 BTU/in/s/F  
47. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.12E+07 Kgf/cm/cm  
0.27  
0.51E+06 Kgf/cm/cm  
0.12E-04 /Centigrade  
0.73E-05 Kgf*s*s/cm**4  
0.11 Cal/cm/s/C  
0.12E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.12E+12 Pascals  
0.27  
0.50E+11 Pascals  
0.12E-04 /Kelvin  
0.72E+04 Kgm/m**3  
45. W/m/K  
0.51E+03 J/kgm/K 

Имя материала: GLASS Стекло 
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.92E+07 psi 
0.22  
0.15E+08 psi  
0.55E-05 /Fahrenheit  
0.28E-03 lbf*s*s/in**4  
0.22E-04 BTU/in/s/F  
70. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.64E+06 Kgf/cm/cm  
0.22  
0.10E+07 Kgf/cm/cm  
0.99E-05 /Centigrade  
0.31E-05 Kgf*s*s/cm**4  
0.38E-02 Cal/cm/s/C  
0.18E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.63E+11 Pascals  
0.22  
0.10E+12 Pascals  
0.99E-05 /Kelvin  
0.30E+04 Kgm/m**3  
1.6 W/m/K  
0.75E+03 J/kgm/K 

Имя материала: GOLD Чистое золото 
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.11E+08 psi  
0.42  
0.38E+07 psi  
0.79E-05 /Fahrenheit  
0.18E-02 lbf*s*s/in**4  
0.40E-02 BTU/in/s/F  
12. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.76E+06 Kgf/cm/cm  
0.42  
0.27E+06 Kgf/cm/cm  
0.14E-04 /Centigrade  
0.20E-04 Kgf*s*s/cm**4  
0.71 Cal/cm/s/C  
0.30E+05 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.74E+11 Pascals  
0.42  
0.26E+11 Pascals  
0.14E-04 /Kelvin  
0.19E+05 Kgm/m**3  
0.30E+03 W/m/K  
0.13E+03 J/kgm/K 
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Имя материала: IRON Железо 
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.17E+08 psi  
0.31  
0.11E+08 psi  
0.61E-05 /Fahrenheit  
0.74E-03 lbf*s*s/in**4  
0.10E-02 BTU/in/s/F  
42. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.12E+07 Kgf/cm/cm  
0.31  
0.78E+06 Kgf/cm/cm  
0.11E-04 /Centigrade  
0.80E-05 Kgf*s*s/cm**4  
0.18 Cal/cm/s/C  
0.11E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.12E+12 Pascals  
0.31  
0.77E+11 Pascals  
0.11E-04 /Kelvin  
0.79E+04 Kgm/m**3  
75. W/m/K  
0.45E+03 J/kgm/K 

Имя материала: LEAD Чистый свинец  
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.20E+07 psi  
0.40  
0.71E+06 psi  
0.29E-04 /Fahrenheit  
0.11E-02 lbf*s*s/in**4  
0.47E-03 BTU/in/s/F  
12. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.14E+06 Kgf/cm/cm  
0.40  
0.50E+05 Kgf/cm/cm  
0.53E-04 /Centigrade  
0.12E-04 Kgf*s*s/cm**4  
0.83E-01 Cal/cm/s/C  
0.30E+05 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.14E+11 Pascals  
0.40  
0.49E+10 Pascals  
0.53E-04 /Kelvin  
0.11E+05 Kgm/m**3  
35. W/m/K  
0.13E+03 J/kgm/K 

Имя материала: MAGNES Марганцевый сплав (кованый или литой)  
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.65E+07 psi  
0.35  
0.24E+07 psi  
0.14E-04 /Fahrenheit  
0.16E-03 lbf*s*s/in**4  
0.21E-02 BTU/in/s/F  
97. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.46E+06 Kgf/cm/cm  
0.35  
0.17E+06 Kgf/cm/cm  
0.25E-04 /Centigrade  
0.18E-05 Kgf*s*s/cm**4  
0.38 Cal/cm/s/C  
0.25E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.45E+11 Pascals  
0.35  
0.17E+11 Pascals  
0.25E-04 /Kelvin  
0.17E+04 Kgm/m**3  
0.16E+03 W/m/K  
0.10E+04 J/kgm/K 

Имя материала: MC_IRON Ковкое литое железо (ASTM - A220) 
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.27E+08 psi  
0.27  
0.13E+08 psi  
0.67E-05 /Fahrenheit  
0.68E-03 lbf*s*s/in**4  
0.63E-03 BTU/in/s/F  
47. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.19E+07 Kgf/cm/cm  
0.27  
0.88E+06 Kgf/cm/cm  
0.12E-04 /Centigrade  
0.74E-05 Kgf*s*s/cm**4  
0.11 Cal/cm/s/C  
0.12E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.19E+12 Pascals  
0.27  
0.86E+11 Pascals  
0.12E-04 /Kelvin  
0.73E+04 Kgm/m**3  
47. W/m/K  
0.51E+03 J/kgm/K 

Имя материала: MN_BRONZE Марганцевая бронза 
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp))  

Значение (FPS)  
0.15E+08 psi  
0.37  
0.56E+07 psi  
0.12E-04 /Fahrenheit  
0.78E-03 lbf*s*s/in**4  
0.13E-03 BTU/in/s/F  
35. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.11E+07 Kgf/cm/cm  
0.37  
0.39E+06 Kgf/cm/cm  
0.22E-04 /Centigrade  
0.85E-05 Kgf*s*s/cm**4  
0.23E-01 Cal/cm/s/C  
0.88E+05 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.11E+12 Pascals  
0.37  
0.39E+11 Pascals  
0.22E-04 /Kelvin  
0.83E+04 Kgm/m**3  
9.6 W/m/K  
0.38E+03 J/kgm/K 

Имя материала: MOLYBDENUM Молибден 
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.47E+08 psi  
0.38  
0.17E+08 psi  
0.28E-05 /Fahrenheit  
0.96E-03 lbf*s*s/in**4  
0.20E-02 BTU/in/s/F  
25. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.33E+07 Kgf/cm/cm  
0.38  
0.12E+07 Kgf/cm/cm  
0.50E-05 /Centigrade  
0.10E-04 Kgf*s*s/cm**4  
0.35 Cal/cm/s/C  
0.64E+05 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.32E+12 Pascals  
0.38  
0.12E+12 Pascals  
0.50E-05 /Kelvin  
0.10E+05 Kgm/m**3  
0.15E+03 W/m/K  
0.27E+03 J/kgm/K 

Имя материала: MONEL Сплав никеля MONEL 400  
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.26E+08 psi  
0.34  
0.97E+07 psi  
0.77E-05 /Fahrenheit  
0.83E-03 lbf*s*s/in**4  
0.29E-03 BTU/in/s/F  
39. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.18E+07 Kgf/cm/cm  
0.34  
0.68E+06 Kgf/cm/cm  
0.14E-04 /Centigrade  
0.90E-05 Kgf*s*s/cm**4  
0.52E-01 Cal/cm/s/C  
0.10E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.18E+12 Pascals  
0.34  
0.67E+11 Pascals  
0.14E-04 /Kelvin  
0.88E+04 Kgm/m**3  
22. W/m/K  
0.43E+03 J/kgm/K 

Имя материала: NICKEL Никель 
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Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.31E+08 psi  
0.31  
0.11E+08 psi  
0.92E-05 /Fahrenheit  
0.80E-03 lbf*s*s/in**4  
0.58E-03 BTU/in/s/F  
42. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.21E+07 Kgf/cm/cm  
0.31  
0.81E+06 Kgf/cm/cm  
0.17E-04 /Centigrade  
0.87E-05 Kgf*s*s/cm**4  
0.10 Cal/cm/s/C  
0.11E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.21E+12 Pascals  
0.31  
0.79E+11 Pascals  
0.17E-04 /Kelvin  
0.85E+04 Kgm/m**3  
43. W/m/K  
0.46E+03 J/kgm/K 

Имя материала: D_NICKEL Сплав никеля Duranickel 301  
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.30E+08 psi  
0.34  
0.11E+08 psi  
0.82E-05 /Fahrenheit  
0.77E-03 lbf*s*s/in**4  
0.32E-03 BTU/in/s/F  
54. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.21E+07 Kgf/cm/cm  
0.34  
0.79E+06 Kgf/cm/cm  
0.15E-04 /Centigrade  
0.84E-05 Kgf*s*s/cm**4  
0.57E-01 Cal/cm/s/C  
0.14E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.21E+12 Pascals  
0.34  
0.77E+11 Pascals  
0.15E-04 /Kelvin  
0.82E+04 Kgm/m**3  
24. W/m/K  
0.59E+03 J/kgm/K 

Имя материала: NYLON Нейлон 6/10 
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.12E+07 psi  
0.28  
0.47E+06 psi  
0.16E-04 /Fahrenheit  
0.13E-03 lbf*s*s/in**4  
0.70E-05 BTU/in/s/F  
0.14E+03 BTU*in/lbf/s/s/F  

Значение (MKS)  
0.84E+05 Kgf/cm/cm  
0.28  
0.33E+05 Kgf/cm/cm  
0.30E-04 /Centigrade  
0.14E-05 Kgf*s*s/cm**4  
0.13E-02 Cal/cm/s/C  
0.34E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.83E+10 Pascals  
0.28  
0.32E+10 Pascals  
0.30E-04 /Kelvin  
0.14E+04 Kgm/m**3  
0.53 W/m/K  
0.15E+04 J/kgm/K 

Имя материала: PC_STEEL Простая углеродистая сталь  
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.30E+08 psi  
0.28  
0.12E+08 psi  
0.74E-05 /Fahrenheit  
0.73E-03 lbf*s*s/in**4  
0.57E-03 BTU/in/s/F  
41. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.21E+07 Kgf/cm/cm  
0.28  
0.81E+06 Kgf/cm/cm  
0.13E-04 /Centigrade  
0.79E-05 Kgf*s*s/cm**4  
0.10 Cal/cm/s/C  
0.10E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.21E+12 Pascals  
0.28  
0.79E+11 Pascals  
0.13E-04 /Kelvin  
0.78E+04 Kgm/m**3  
43. W/m/K  
0.44E+03 J/kgm/K 

Имя материала: PORCELAIN Керамический фарфор 
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.15E+08 psi  
0.22  
0.15E+08 psi  
0.35E-05 /Fahrenheit  
0.24E-03 lbf*s*s/in**4  
0.68E-04 BTU/in/s/F  
81. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.11E+07 Kgf/cm/cm  
0.22  
0.10E+07 Kgf/cm/cm  
0.63E-05 /Centigrade  
0.26E-05 Kgf*s*s/cm**4  
0.12E-01 Cal/cm/s/C  
0.21E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.10E+12 Pascals  
0.22  
0.10E+12 Pascals  
0.63E-05 /Kelvin  
0.25E+04 Kgm/m**3  
5.0 W/m/K  
0.88E+03 J/kgm/K 

Имя материала: RUBBER Резина 
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  

Значение (FPS)  
0.88E+03 psi  
0.4  
0.42E+03 psi  
0.37E-03 /Fahrenheit  
0.93E-04 lbf*s*s/in**4  
0.19E-05 BTU/in/s/F  

Значение (MKS)  
62. Kgf/cm/cm  
0.49  
29. Kgf/cm/cm  
0.67E-03 /Centigrade  
0.10E-05 Kgf*s*s/cm**4  
0.34E-03 Cal/cm/s/C  

Значение (SI)  
0.61E+07 Pascals  
0.49  
0.29E+07 Pascals  
0.67E-03 /Kelvin  
0.10E+04 Kgm/m**3  
0.14 W/m/K 

Имя материала: SILVER Чистое серебро 
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.10E+08 psi  
0.37  
0.36E+07 psi  
0.11E-04 /Fahrenheit  
0.98E-03 lbf*s*s/in**4  
0.56E-02 BTU/in/s/F  
22. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.70E+06 Kgf/cm/cm  
0.37  
0.26E+06 Kgf/cm/cm  
0.20E-04 /Centigrade  
0.11E-04 Kgf*s*s/cm**4  
1.0 Cal/cm/s/C  
0.55E+05 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.69E+11 Pascals  
0.37  
0.25E+11 Pascals  
0.20E-04 /Kelvin  
0.11E+05 Kgm/m**3  
0.42E+03 W/m/K  
0.23E+03 J/kgm/K 

Имя материала: STEEL Сталь 
Имя свойства  Значение (FPS)  Значение (MKS)  Значение (SI)  



 103

EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

0.29E+08 psi  
0.32  
0.11E+08 psi  
0.65E-05 /Fahrenheit  
0.73E-03 lbf*s*s/in**4  
0.40E-03 BTU/in/s/F  
46. BTU*in/lbf/s/s/F  

0.20E+07 Kgf/cm/cm  
0.32  
0.77E+06 Kgf/cm/cm  
0.12E-04 /Centigrade  
0.80E-05 Kgf*s*s/cm**4  
0.72E-01 Cal/cm/s/C  
0.12E+06 Cal*cm/kgf/s/s/C  

0.20E+12 Pascals  
0.32  
0.76E+11 Pascals  
0.12E-04 /Kelvin  
0.78E+04 Kgm/m**3  
30. W/m/K  
0.50E+03 J/kgm/K 

Имя материала: ST_1020 Сталь AISI C1020 (горячей ковки) 
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp) 

Значение (FPS)  
0.29E+08 psi  
0.29  
0.11E+08 psi  
0.84E-05 /Fahrenheit  
0.74E-03 lbf*s*s/in**4  
0.62E-03 BTU/in/s/F  
39. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.20E+07 Kgf/cm/cm  
0.29  
0.79E+06 Kgf/cm/cm  
0.15E-04 /Centigrade  
0.80E-05 Kgf*s*s/cm**4  
0.11 Cal/cm/s/C  
0.98E+05 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.20E+12 Pascals  
0.29  
0.77E+11 Pascals  
0.15E-04 /Kelvin  
0.79E+04 Kgm/m**3  
47. W/m/K  
0.42E+03 J/kgm/K 

Имя материала: ST_304 Сталь AISI 304 (Листовая) 
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.28E+08 psi  
0.29  
0.11E+08 psi  
0.99E-05 /Fahrenheit  
0.75E-03 lbf*s*s/in**4  
0.22E-03 BTU/in/s/F  
46. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.20E+07 Kgf/cm/cm  
0.29  
0.76E+06 Kgf/cm/cm  
0.18E-04 /Centigrade  
0.82E-05 Kgf*s*s/cm**4  
0.39E-01 Cal/cm/s/C  
0.12E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.19E+12 Pascals  
0.29  
0.75E+11 Pascals  
0.18E-04 /Kelvin  
0.80E+04 Kgm/m**3  
16. W/m/K  
0.50E+03 J/kgm/K 

Имя материала: ST_ST Нержавеющая сталь 
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.29E+08 psi  
0.28  
0.11E+08 psi  
0.60E-05 /Fahrenheit  
0.73E-03 lbf*s*s/in**4  
0.24E-03 BTU/in/s/F  
42. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.20E+07 Kgf/cm/cm  
0.28  
0.78E+06 Kgf/cm/cm  
0.11E-04 /Centigrade  
0.80E-05 Kgf*s*s/cm**4  
0.43E-01 Cal/cm/s/C  
0.11E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.20E+12 Pascals  
0.28  
0.77E+11 Pascals  
0.11E-04 /Kelvin  
0.78E+04 Kgm/m**3  
18. W/m/K  
0.46E+03 J/kgm/K 

Имя материала: T_BRONZE Оловосодержащая бронза  
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.13E+08 psi  
0.33  
0.54E+07 psi  
0.10E-04 /Fahrenheit  
0.78E-03 lbf*s*s/in**4  
0.62E-03 BTU/in/s/F  
35. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.91E+06 Kgf/cm/cm  
0.33  
0.38E+06 Kgf/cm/cm  
0.18E-04 /Centigrade  
0.85E-05 Kgf*s*s/cm**4  
0.11 Cal/cm/s/C  
0.88E+05 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.90E+11 Pascals  
0.33  
0.37E+11 Pascals  
0.18E-04 /Kelvin  
0.83E+04 Kgm/m**3  
47. W/m/K  
0.38E+03 J/kgm/K 

Имя материала: TITANIUM Титан 
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.16E+08 psi  
0.30  
0.63E+07 psi  
0.49E-05 /Fahrenheit  
0.43E-03 lbf*s*s/in**4  
0.29E-03 BTU/in/s/F  
2. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.11E+07 Kgf/cm/cm  
0.3  
0.44E+06 Kgf/cm/cm  
0.88E-05 /Centigrade  
0.47E-05 Kgf*s*s/cm**4  
0.52E-01 Cal/cm/s/C  
0.11E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.11E+12 Pascals  
0.30  
0.43E+11 Pascals 
0.88E-05 /Kelvin  
0.46E+04 Kgm/m**3  
22. W/m/K  
0.46E+03 J/kgm/K 

Имя материала: TUNGSTEN Вольфрам 
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.59E+08 psi  
0.28  
0.23E+08 psi  
0.25E-05 /Fahrenheit  
0.18E-02 lbf*s*s/in**4  
0.27E-02 BTU/in/s/F  
12. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.41E+07 Kgf/cm/cm  
0.28  
0.16E+07 Kgf/cm/cm  
0.45E-05 /Centigrade  
0.20E-04 Kgf*s*s/cm**4  
0.48 Cal/cm/s/C  
0.31E+05 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.41E+12 Pascals  
0.28  
0.16E+12 Pascals  
0.45E-05 /Kelvin  
0.19E+05 Kgm/m**3  
0.20E+03 W/m/K  
0.13E+03 J/kgm/K 

Имя материала: VANADIUM Ванадий  
Имя свойства  
EX  

Значение (FPS)  
0.20E+08 psi  

Значение (MKS)  
0.14E+07 Kgf/cm/cm  

Значение (SI)  
0.14E+12 Pascals  
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NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

0.36  
0.74E+07 psi  
0.46E-05 /Fahrenheit  
0.57E-03 lbf*s*s/in**4  
0.41E-03 BTU/in/s/F  
46. BTU*in/lbf/s/s/F  

0.36  
0.52E+06 Kgf/cm/cm  
0.83E-05 /Centigrade  
0.62E-05 Kgf*s*s/cm**4  
0.74E-01 Cal/cm/s/C  
0.12E+06 Cal*cm/kgf/s/s/C  

0.36  
0.51E+11 Pascals  
0.83E-05 /Kelvin  
0.61E+04 Kgm/m**3  
31. W/m/K  
0.50E+03 J/kgm/K 

Имя материала: W_COPPER Кованая медь  
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.16E+08 psi  
0.33  
0.58E+07 psi  
0.11E-04 /Fahrenheit  
0.79E-03 lbf*s*s/in**4  
0.31E-02 BTU/in/s/F  
35. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.11E+07 Kgf/cm/cm  
0.33  
0.41E+06 Kgf/cm/cm  
0.20E-04 /Centigrade  
0.86E-05 Kgf*s*s/cm**4  
0.56 Cal/cm/s/C  
0.88E+05 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.11E+12 Pascals  
0.33  
0.40E+11 Pascals  
0.20E-04 /Kelvin  
0.84E+04 Kgm/m**3  
0.23E+03 W/m/K  
0.38E+03 J/kgm/K 

Имя материала: WS_STEEL Кованая нержавеющая сталь  
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp) 

Значение (FPS)  
0.29E+08 psi  
0.26  
0.12E+08 psi  
0.60E-05 /Fahrenheit  
0.75E-03 lbf*s*s/in**4  
0.25E-03 BTU/in/s/F  
46. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.20E+07 Kgf/cm/cm  
0.26  
0.81E+06 Kgf/cm/cm  
0.11E-04 /Centigrade  
0.82E-05 Kgf*s*s/cm**4  
0.45E-01 Cal/cm/s/C  
0.12E+06 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.20E+12 Pascals  
0.26  
0.79E+11 Pascals  
0.11E-04 /Kelvin 
0.80E+04 Kgm/m**3  
19. W/m/K  
0.50E+03 J/kgm/K 

Имя материала: ZIRCONIUM Циркон 
Имя свойства  
EX  
NUXY  
GXY  
ALPX  
DENS  
KX  
C (Cp)  

Значение (FPS)  
0.14E+08 psi  
0.34  
0.53E+07 psi  
0.61E-05 /Fahrenheit  
0.62E-03 lbf*s*s/in**4  
0.22E-04 BTU/in/s/F  
27. BTU*in/lbf/s/s/F  

Значение (MKS)  
0.10E+07 Kgf/cm/cm  
0.34  
0.37E+06 Kgf/cm/cm  
0.11E-04 /Centigrade  
0.67E-05 Kgf*s*s/cm**4  
0.40E-02 Cal/cm/s/C  
0.69E+05 Cal*cm/kgf/s/s/C  

Значение (SI)  
0.98E+11 Pascals  
0.34  
0.36E+11 Pascals  
0.11E-04 /Kelvin  
0.66E+04 Kgm/m**3  
1.7 W/m/K  
0.29E+03 J/kgm/K 

Имя материала: WATER Вода (300 K) 
Имя свойства  
DENS  
KX  
C (Cp)  
VISC  
BETA  

Значение (FPS)  
0.93E-04 lbf*s*s/in**4  
0.82E-05 BTU/in/s/F  
0.39E+03 BTU*in/lbf/s/s/F  
0.13E-06 lbf*s/in/in  
0.15E-03 / Rankin  

Значение (MKS)  
0.10E-05 Kgf*s*s/cm**4  
0.15E-02 Cal/cm/s/C  
0.98E+06 Cal*cm/kgf/s/s/C  
0.88E-08 kgf*s/cm/cm  
0.27E-03 /Kelvin  

Значение (SI)  
0.10E+04 Kgm/m**3  
0.61 W/m/K  
0.42E+04 J/kgm/K  
0.87E-03 kgm/m/s  
0.27E-03 /Kelvin 

Имя материала: AIR Воздух (300 K) 
Имя свойства  
DENS  
KX  
C (Cp)  
VISC  
BETA  
GAMMA  

Значение (FPS)  
0.10E-06 lbf*s*s/in**4  
0.36E-06 BTU/in/s/F  
93. BTU*in/lbf/s/s/F  
0.27E-08 lbf*s/in/in  
0.19E-02 / Rankin  
1.40  

Значение (MKS)  
0.11E-08 Kgf*s*s/cm**4  
0.64E-04 Cal/cm/s/C  
0.24E+06 Cal*cm/kgf/s/s/C  
0.19E-09 kgf*s/cm/cm  
0.33E-02 /Kelvin  
1.40  

Значение (SI)  
1.1 Kgm/m**3  
0.27E-01 W/m/K  
0.10E+04 J/kgm/K  
0.19E-04 kgm/m/s  
0.33E-02 /Kelvin  
1.40 

Использование пользовательской библиотеки материалов  

Если вам необходимо часто использовать свойства материалов, не входящие во встро-
енную библиотеку материалов, то существует возможность добавлять материалы в 
пользовательскую библиотеку. Для считывания свойств материала из файла 
USERMAT.LIB, имеющего тот же формат что и файл  PICKMAT.LIB, используется 
команда USER_MAT (Propsets > User Material Lib). Заметьте, что файл USERMAT.LIB 
уже существует в директории COSMOS/M, и в него помещено содержимое файла 
PICKMAT.LIB. Число материалов, для которых вы можете задать свойства в файле 
USERMAT.LIB не ограничено. 
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Ниже приведен формат записи свойств материала в файле USERMAT.LIB. Для зада-
ния своих свойств материала вам необходимо изменить имя материала и числовые 
значения, не изменяя существующий формат. 
123456789012345678901234567890123456789012345678901234567890123456789012345678901234567890 
  
MATL:W_COPPER           :                          WROUGHT COPPER  
 
EX  15.5E+6 p.s.i.  1.0897E6 kg/sq.cm.  106.87E+9 Pascals  
 
NUXY 0.33  0.33  0.33  
 
GXY  5.80E+6 p.s.i.  4.078E+5 kg/sq.cm.  39.99E+9 Pascals  
 
ALPX  11.0E-6 /Fahrenheit  19.80E-6 /Centigrade  19.80E-6 /Kelvin 
 
DENS  7.893E-4 lb.s.s/in**4  8.6059E-6 kgf.s.s/cm**4  8442.4 kg/cu.m  
 
KX  5.370E-3 BTU/in.s.F  0.062 Cal/cm.s.C  26 W/m.K  
 
C (Cp)  34.776 BTUin/lbssF  88305.696 Calcm/kgssC  376.64 J/kg.K  
 
ENDMATL 

Как видно из примера, запись свойств для каждого материала начинается со строки 
MATL: и заканчивается строкой ENDMATL. Формат строк между этими двумя строками 
долже совпадать с вышеприведенным. Например, если вы хотите задать свойства ма-
териала для бетона (только для сжатия) в единицах системы FPS, то запись будет 
иметь следующий вид: 
123456789012345678901234567890123456789012345678901234567890123456789012345678901234567890  
 
MATL:CONCRETE  :  CEMENT CONCRETE  
 
EX  3.0E+6 p.s.i.  *.****** kg/sq.cm.  ***.**** Pascals  
 
NUXY  0.18  0.18  0.18  
 
GXY  1.27E+6 p.s.i.  *.****** kg/sq.cm.  **.***** Pascals  
 
ALPX  1.25E-5 /Fahrenheit  *.****** /Centigrade  **.***** /Kelvin  
 
DENS  2.20E-4 lb.s.s/in**4  *.******* kgf.s.s/cm**4  ****** kg/cu.m  
 
KX  0.2 BTU/in.s.F  *.*** Cal/cm.s.C  ** W/m.K  
 
C (Cp)  7.2E-4 BTUin/lbssF  *****.*** Calcm/kgssC  ***.** J/kg.K  
 
ENDMATL 

Оставшиеся значения можно задать, умножив единицы системы FPS на соответст-
вующий коэффициенты перевода (приведенные в Приложении A, Единицы измере-
ния). Для использования этих свойств необходимо выполнить команду USER_MAT 
(Propsets > User Material Lib) для набора свойств материала 1 в системе единиц FPS: 
Control Panel: Propsets > User Material Lib 
Material Property set >1 
Имя материала >CONCRETE 
Unit Label >FPS 

Изменение, просмотр и вывод заданных свойств материала  
Команда MPDEL (Edit > DELETE > Material Props) используется для удаления всех за-
данных свойств в одном или более наборе свойств материала. Если вы хотите уда-
лить или изменить какое-либо отдельное свойство в наборе, то необходимо выпол-
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нить команду MPROP (Propsets > Material Property), указать необходимый номер набо-
ра свойств материала и имя свойства и ввести новое значение. 

Во время генерации КЭ-сети, активный набор свойств материала связывается с созда-
ваемыми элементами. Если в вашей модели присутствует более чем один набор 
свойств материала и вы хотите сделать какую-либо группу активной, то необходимо 
выполнить команду ACTSET (Control > ACTIVATE > Set Entity). Кроме активизирова-
ния наборов свойств материала эта команда может использоваться для активизирова-
ния наборов вещественных констант, координатных систем, температурных кривых 
и других примитивов. Имена этих примитивов и их описания приведены в Таблице 6-
10.  

Таблица 6-10. Имена примитивов, активизируемых командой ACTSET  

Имя примитива Описание 
EG  Группа элементов 
MP  Набор свойств материала 
RC  Набор вещественных констант 
LC  Вариант нагрузки 
TC  Временная кривая 
TP  Температурная кривая 
BH  Кривая B-H (для магнитного расчета) 
CS  Координатная система 
ECS  Координатная система элемента 
LOC  Точка усталости 
MC  Кривая материала 

Имена активных в данный момент примитивов отображаются в таблице Status1. 

 

Рис. 6-4. Таблица статуса примитивов и наборов  

Для изменения связи существующих наборов свойств материала с группами элементов 
и наборами вещественных констант используется команда EPROPCHANGE (Propsets > 
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Change El-Prop). Эта команда также назначает указанный цвет выбранному шаблону 
элементов. Назначенные цвета используются для отображения и выделения частей 
КЭ-сети с различными свойствами материала, группами элементов и наборами веще-
ственных констант. Более подробная информация приведена в следующем разделе. 

Отображения заданных свойств материала  

Для моделей с более чем одним набором свойств материала COSMOS/M предоставля-
ет способ графически представлять различные наборы свойств материала  для про-
верки модели. Для активизирования цветов по умолчанию для элементов и одного из 
связанных примитивов (в данном случае � наборов свойств материала) используется 
команда ACTECLR (Meshing > ELEMENTS > Activate Elem Color). Ниже приведен 
пример, иллюстрирующий процедуру для двухмерной модели с тремя различными 
наборами свойств материала. 

 

Рис. 6-5.  Пример выделения элементов цветом с несколькими наборами свойств материала  

Для начала создайте три соединяющихся ПОВЕРХНОСТИ, как показано на рисунке. 
Задайте свойства материала для первой поверхности командой MPROP (Propsets > Ma-
terial Property) или PICK_MAT (Propsets > Pick Material Lib). Затем сгенерируйте КЭ-
сеть для первой ПОВЕРХНОСТИ, так что созданные элементы будут связаны с на-
бором свойств материала 1. Перед тем, как приступить к ПОВЕРХНОСТИ 2, задайте 
набор свойств материала 2, и затем сгенерируйте КЭ-сеть для ПОВЕРХНОСТИ 2. 
Повторите эти действия для последней ПОВЕРХНОСТИ. Если вы выведете список 
созданных элементов командой ELIST (Edit > LIST > Elements), вы увидите, что эле-
менты, созданные для каждой из ПОВЕРХНОСТЕЙ связаны с соответствующим на-
бором свойств материала. 

Для отображения КЭ-сети с цветами по умолчанию для свойств материала необходи-
мо выполнить команду ACTECLR (Meshing > ELEMENTS > Activate Elem Color): 
Control Panel: Meshing > ELEMENTS > Activate Elem Color 
Color Flag >Activate 
Set Label >Material Property Set 
Default colors flag >Yes 

После выполнения этой процедуры элементам с различными наборами свойств мате-
риала назначаются цвета по умолчанию (для просмотра цветов GEOSTAR по умол-
чанию и их номеров используйте таблицу Status1). Затем используйте команду 
EPLOT (Edit > PLOT > Elements) для отображения элементов с различными наборами 
свойств материала. Для получения лучшего изображения можно уменьшить и закра-
сить элемента командами SHRINK (Display > DISPLAY OPTION > Shrink) и SHADE 
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(Display > DISPLAY OPTION > Shaded Element Plot). На рис. 6-6 показано изображе-
ние КЭ-сети с уменьшенными элементами с цветами по умолчанию для свойств ма-
териала. 

 

Рис. 6-6. Изображение уменьшенных элементов с цветами по умолчанию для свойств материала  

Если вы хотите назначить элементам цвета, отличные от цветов по умолчанию, то не-
обходимо использовать команду SETECLR (Meshing > ELEMENTS > Set Element 
Color). Вы должны повторно выполнять команду для каждого набора свойств мате-
риала и назначать номер необходимого цвета. 

Вывод свойств материала  

По умолчанию информация о свойствах материала не записывается в файл вывода 
jobname.OUT, создаваемый после успешного выполнения расчета. Если вы хотите 
включить в файл информацию о свойствах материала, необходимо запросить под-
робный вывод, установив признак печати исходных данных в команде PRINT_OPS 
(Analysis > OUTPUT OPTIONS > Set Print Options): 
Control Panel: Analysis > OUTPUT OPTIONS > Set Print Options 
Displacement Print Flag >Yes 
... ... ... 
Input Print Flag >Yes 

Заданные свойства материала также могут быть выведены на экран командой MPLIST 
(Edit > LIST > Material Props). Эта команда выведет заданные свойства для всех набо-
ров свойств материала и укажет активный набор свойств (буква A): 
     Label   Name   Temp/BH_Cr     Value  
 
_  1  EX  0  1.550000e+07  
 
_  1  NUXY  0  3.300000e-01  
 
_  1  GXY  0  5.800000e+06  
 
_  1  ALPX  0  1.100000e-05  
 
_  1  DENS  0  7.893000e-04  
 
_  1  C  0  3.477600e+01  
 
_  1  KX  0  5.370000e-03  
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_A  2  EX  0  1.550000e+07  
 
_A  2  NUXY  0  3.300000e-01  
 
_A  2  GXY  0  5.800000e+06  
 
_A  2  ALPX  0  1.100000e-05  
 
_A  2  DENS  0  7.893000e-04  
 
_A  2  C  0  3.477600e+01  
 
_A  2  KX  0  5.370000e-03 

Как и для любой команды вывода списка GEOSTAR, информация, выводимая команда 
MPLIST (Edit > LIST > Material Props) может быть перенаправлена в ASCII-файл ко-
мандой LISTLOG (Control > MISCELLANEOUS > List Log). 

Свойства сечения и другие физические свойства  
В COSMOS/M, свойства сечения элементов и другие физические свойства, не задавае-
мые командой MPROP (Propsets > Material Property), называются вещественными кон-
стантами и задаются командой RCONST (Propsets > Real Constant). К вещественным 
константам относятся: различные свойства сечения, такие как площадь, ширина и 
высота поперечного сечения, периметр, момент инерции, радиус кривизны, внутрен-
ние шарниры, углы материала для ортотропных материалов, градиенты температуры, 
константы пружины, информация о слоях для слоистых составных материалов и 
многие другие физические свойства (список вещественных констант для элементов 
Основной Системы приведен в Таблице 6-11), необходимые для расчета матриц же-
сткости элементов. Вещественные константы могут быть представлены либо целыми, 
либо вещественными числами. Поскольку вещественные константы зависят от типа 
используемого элемента, информация о группах элементов должна быть задана до 
задания вещественных констант. Команда RCONST (Propsets > Real Constant) задает 
номер набора вещественных констант, связывает его с номером группы элементов и 
запрашивает необходимые вещественные константы для указанного типа элементов. 
То есть приглашения в команде RCONST (Propsets > Real Constant) зависят от типа 
используемого элемента и обычно предоставляют достаточно информации для ввода 
необходимых данных с минимумом трудностей. При использовании команды 
RCONST (Propsets > Real Constant) необходимо ввести номер группы элементов, свя-
занной с набором вещественных констант и номер набора вещественных констант. 
Аргумент начала ввода констант описан в следующем разделе. 

ПРИМЕЧАНИЕ: Максимальное допустимое число наборов вещественных констант в 
модели �5000. 

Как видно из Таблицы 6-11, число вещественных констант, которые необходимо вве-
сти изменяется от 1 (для элемента жесткого бруса) до 78 (для численного задания же-
сткости). Однако максимальное число констант, которое можно ввести в команде 
RCONST (Propsets > Real Constant) за один раз равно 10. Если вам необходимо ввести 
большее число констант, то необходимо повторно выполнить команду RCONST 
(Propsets > Real Constant) и ввести недостающие константы. В этом случае программа 
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автоматически предложит начало ввода констант 11 и так далее. Если вы совершите 
ошибку при вводе вещественных констант, то не обязательно повторно вводит все 
константы. Вы можете перейти к необходимому месту (используя начало ввода кон-
стант, описанное в следующем разделе) в вещественных константах и ввести пра-
вильное значение. Программа предупредит вас, если число введенных констант 
меньше необходимого.  

Так же, как и в случае с библиотекой материалов, в COSMOS/M доступны встроенные 
библиотеки сечений для стандартных поперечных сечений. Команда PICK_SEC 
(Propsets > AISC Sect Table) выбирает стандартные стальные сечения и соответст-
вующие свойства сечения из таблиц AISC (Американский Институт Стальных Кон-
струкций), а команда BMSECDEF (Propsets > Beam Section) выбирает стандартные и 
пользовательские сечения из библиотеки сечений COSMOS/M. При использовании 
этих команд вы также задаете номер набора вещественных констант, но свойства се-
чения будут вычислены программой. Командой BMSECLIST (Edit > LIST > Beam 
Section) можно просмотреть свойства сечения, выбранного из библиотеки сечений 
COSMOS/M. 

Команда RCDEL (Edit > DELETE > Real Constants) удаляет набор вещественных кон-
стант и соответствующие свойства, заданные командами RCONST (Propsets > Real 
Constant), PICK_SEC (Propsets > AISC Sect Table) или BMSECDEF (Propsets > Beam 
Section). Команда RCLIST (Edit > LIST > Real Constants) позволяет просмотреть за-
данные свойства сечения на экране. Более подробная информация об изменении за-
данных свойств сечения приведена в разделе Изменение, отображение и вывод за-
данных свойств. 

Для иллюстрации процедуры задания свойств сечения командой RCONST (Propsets > 
Real Constant) возьмем в качестве примера 3-узловой элемент составной оболочки 
(SHELL3L) с четырьмя слоями (задается командой EGROUP (Propsets > Element 
Group)). В COSMOS/M информация о слоях, такая как толщина и ориентация глав-
ных осей материала задается как вещественные константы. Для каждого слоя необ-
ходимо ввести толщину, номер набора свойств материала и угол материала. Из Таб-
лицы 6-11 видно, что для четырех слоев необходимо ввести 14 констант. Как было 
упомянуто ранее, в команде RCONST (Propsets > Real Constant) можно ввести макси-
мум 10 значений за одно выполнение команды, следовательно для ввода значений 
оставшихся констант необходимо выполнить эту команду повторно: 
Control Panel: Propsets > Real Constant 
Associated Element group >1 
Real Constant set >1 
Start location of the real constants >1 
No. of real constants to be entered >10 
RC1 : Dist. from ref. plane to top surface >0.5 
RC2 : Temperature gradient >0 
RC3 : Thickness of layer 1>0.25 
RC4 : Material number for layer 1 >1 
RC5 : Material angle for layer 1 >0 
RC6 : Thickness of layer 2 >0.25 
RC7 : Material number for layer 2 >1 
RC8 : Material angle for layer 2 >30 
RC9 : Thickness of layer 3>0.25 
RC10 : Material number for layer 3 >1 
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Выполните команду RCONST (Propsets > Real Constant) повторно, чтобы ввести остав-
шиеся данные: 
Control Panel: Propsets > Real Constant 
Associated Element group >1 
Real Constant set >1 
Start location of the real constants >11 
No. of real constants to be entered >4 
RC11 : Material angle for layer 3 >60 
RC12 : Thickness of layer 4 >0.25 
RC13 : Material number for layer 4 >1 
RC14 : Material angle for layer 4 >90 

Заметьте, что для продолжения ввод вещественных констант необходимо указать тот 
же номер набора вещественных констант. 

В Таблице 6-11 кратко описаны вещественные константы для всех элементов Основ-
ной Системы. В следующем разделе на примере подробно описана концепция начала 
вводы констант, после чего следует подробное описание вещественных констант для 
всех элементов Основной Системы. Описания сгруппированы отдельно для одно-
мерных элементов (включая стержни и балки), двухмерных и трехмерных элементов. 
Вещественные константы для элементов жесткого бруса, пружины, GAP, численного 
задания массы и жесткости описаны в отдельном разделе. 

Таблица 6-11. Вещественные константы для всех элементов Основной Системы  

Имя элемента в 
COSMOS/M  

Требуемые вещественные константы 

 Число RC  Описание 
TRUSS2D  2  RC1  

RC2  
Площадь поперечного сечения 
Периметр поперечного сечения (только для термального расчета) 

TRUSS3D  2  RC1  
RC2  

Площадь поперечного сечения 
Периметр поперечного сечения (только для термального расчета) 

BEAM2D  8  RC1  
RC2  
RC3  
RC4  
RC5  
RC6  
RC7  
RC8  

Площадь поперечного сечения 
Момент инерции  
Высота (диаметр для круглого сечения)  
Код концевого закрепления в узле 1  
Код концевого закрепления в узле 2  
Поперечный множитель по оси элемента y  
Разность температур по оси элемента y  
Периметр (только для термального расчета) 

BEAM3D  14 to 27  RC1  
RC2  
�  
�  

Площадь поперечного сечения 
Момент инерции 
� � �  
Разность температур по оси элемента y 
Периметр (только для термального расчета) 
 � � �  
(Более подробная информация приведена в Руководстве пользова-
теля COSMOS/M, Глава 4)  

RBAR  1  RC1  Продольная жесткость 
SPRING 2  RC1  

RC2  
Продольная жесткость 
Угловая жесткость 

PIPE  3  RC1  
RC2  
RC3  

Внешний диаметр 
Толщина стенки 
Внутреннее давление  

ELBOW  4  RC1  
RC2  
RC3  
RC4  

Внешний диаметр 
Толщина стенки 
Внутреннее давление 
радиус кривизны 

GAP  2  RC1  Допустимое относительное перемещение между двумя узлами  
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RC2 Коэффициент трения 
MASS  7  RC1  

RC2  
RC3  
RC4  
RC5  
RC6  
RC7 

Масса по направлению x  
Масса по направлению y  
Масса по направлению z  
Инерция вращения вокруг оси x  
Инерция вращения вокруг оси y  
Инерция вращения вокруг оси z  
Теплоемкость (в единицах тепловой энергии) 

BOUND  2  RC1  
RC2  

Продольная жесткость 
Угловая жесткость 

PLANE2D 4-узловой  2  RC1  
RC2  

Толщина (только для задач на плоские напряжения)  
Угол материала 

PLANE2D 8-узловой 2  RC1  
RC2  

Толщина (только для задач на плоские напряжения)  
Угол материала 

PLANE2D 4-узловой 
(Осесимметричный)  

1  RC2  Угол материала 

PLANE2D 8-узловой 
(Осесимметричный) 

1  RC2  Угол материала 

TRIANG 3-узловой 2  RC1  
RC2  

Толщина (только для задач на плоские напряжения)  
Угол материала 

TRIANG 6-узловой 2  RC1  
RC2  

Толщина (только для задач на плоские напряжения)  
Угол материала 

TRIANG 9-узловой 2  RC1  
RC2  

Толщина (только для задач на плоские напряжения)  
Угол материала 

TRIANG 3-узловой 
(Осесимметричный) 

1  RC2  Угол материала 

TRIANG 6-узловой 
(Осесимметричный) 

1  RC2  Угол материала 

TRIANG 9-узловой 
(Осесимметричный) 

1  RC2  Угол материала 

SHELL3  3  RC1  
RC2  
RC3  

Толщина 
Градиент температуры  
Жесткость основания 

SHELL4  3  RC1  
RC2  
RC3  

Толщина 
Градиент температуры  
Жесткость основания 

SHELL3T  3  RC1  
RC2  
RC3  

Толщина 
Градиент температуры  
Жесткость основания 

SHELL4T  3  RC1  
RC2  
RC3  

Толщина 
Градиент температуры  
Жесткость основания 

SHELL3L  2+3NL  RC1  
RCxx  

Число вещественных констант зависит от числа слоев (NL). Более 
подробная информация приведена в Руководстве пользователя 
COSMOS/M, Глава 4 

SHELL4L  2+3NL  RC1  
RCxx  

Число вещественных констант зависит от числа слоев (NL). Более 
подробная информация приведена в Руководстве пользователя 
COSMOS/M, Глава 4 

SHELL6  2  RC1  
RC2  

Толщина 
Градиент температуры 

SHELL9  1  RC1  Толщина 
SHELL9L  2+3NL  RC1  

RCxx  
Число вещественных констант зависит от числа слоев (NL). Более 
подробная информация приведена в Руководстве пользователя 
COSMOS/M, Глава 4 

SHELLAX  1  RC1  Толщина 
TETRA4  9  RC1-9  X,Y,Z-координаты трех точек (только для ортотропных материалов) 
TETRA4R  9  RC1-9  X,Y,Z-координаты трех точек (только для ортотропных материалов) 
TETRA10  9  RC1-9  X,Y,Z-координаты трех точек (только для ортотропных материалов) 
SOLID  9  RC1-9  X,Y,Z-координаты трех точек (только для ортотропных материалов) 
SOLIDL  2+6NL  RC1  

RCxx  
Число вещественных констант зависит от числа слоев (NL). Более 
подробная информация приведена в Руководстве пользователя 
COSMOS/M, Глава 4 

SOLIDPZ  9  RC1-9  X,Y,Z-координаты трех точек (только для ортотропных материалов) 



 113

GENSTIF  78  RC1-
78  

Числовые коэффициенты жесткости. 

Концепция начала ввода констант  

При вводе вещественных констант в команде RCONST (Propsets > Real Constant) про-
грамма запрашивает начало ввода констант. Если вводите константы в первый раз, то 
необходимо начинать ввод констант с первой. Однако если при вводе констант вы 
допустили ошибку, для ее исправления не обязательно повторять ввод сначала. Вы 
можете начать ввод с той константы, которую необходимо изменить, используя па-
раметр начала ввода констант. Этот параметр позволяет изменить или переопреде-
лить какие-либо значения констант, не изменяя остальных. Эта возможность особен-
но полезна для элементов с большим количеством констант. В качеств примера 
рассмотрим задачу, в которой используется элемент BEAM2D (для которого необхо-
димо ввести 8 констант), показанную на рисунке: 

 

Рис. 6-7. Задача, иллюстрирующая концепция начала ввода констант  

Вещественные константы для элемента BEAM2D задаются следующим образом: 
Control Panel: Propsets > Real Constant 
Associated Element group >1 
Real Constant set >1 
Start location of the real constants >1 
No. of real constants to be entered >8 
RC1 : Cross-sectional area >0.785 
RC2 : Moment of inertia (Iz) >0.0491 
RC3 : Depth [0]>1 
RC4 : End-release code (node 1) >0 
RC5 : End-release code (node 2) >0 
RC6 : Shear factor in elem. y-axis >0.9 
RC7 : Temp. diff. in elem. y-axis >0 
RC8 : Perimeter (HSTAR only) >3.1416 

Введенные значения будут сохранены в соответствующих ячейках для вещественных 
констант: 

RC1  RC2  RC3  RC4  RC5  RC6  RC7  RC8 
0.785  0.0491  1  0  0  0  0  3.1416 

Предположим, что теперь необходимо задать разность температур между верхней и 
нижней гранями (вдоль оси элемента y), равную 10 градусов. Для элемента BEAM2D 
разность температур храниться в ячейке RC7. Таким образом, необходимо изменить 
только значение в ячейке RC7 в этом наборе. Это выполняется следующей процеду-
рой: 
Control Panel: Propsets > Real Constant 
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Associated Element group >1 
Real Constant set [2]>1 
Start location of the real constants [9]>7 
No. of real constants to be entered [2]>1 
RC7 : Temp. diff. in elem. y-axis [0]>10 

При выполнении такой процедуры будет изменено только значение константы RC7, а 
оставшиеся будут неизменными (константы, введенные ранее, выделены серым цве-
том): 

RC1  RC2  RC3  RC4  RC5  RC6  RC7  RC8 
0.785  0.0491  1  0  0  0  10  3.1416 

Если вы выполните команду RCLIST (Edit > LIST > Real Constants), то эти значения бу-
дут выведены на экран. 

Описание некоторых свойств сечения  
Полное описание всех вещественных констант для всех элементов приведено в Главе 

4 Руководства пользователя COSMOS/M. Ниже приведено дальнейшее описание не-
которых свойств сечения для элементов Основной Системы. Чтобы облегчить пред-
ставление, элементы были сгруппированы, как показано в таблице, и их веществен-
ные константы описаны в соответствующих разделах. 
Имя элемента Раздел 
TRUSS2D, TRUSS3D, BEAM2D, BEAM3D, PIPE и ELBOW  Свойства сечения для одномерных эле-

ментов  
PLANE2D, SHELL3, SHELL4, SHELL3T, SHELL4T, 
SHELL3L, SHELL4L, SHELL9, SHELL9L, SHELLAX и 
TRIANG  

Свойства сечения для двухмерных и осе-
симметричных элементов  

SOLID, SOLIDL, SOLIDPZ, TETRA4, TETRA4R и 
TETRA10  

Свойства сечения для трехмерных объ-
емных элементов  

BOUND, GAP, GENSTIF, MASS, RBAR и SPRING  Свойства сечения для особых элементов  

Свойства сечения для одномерных элементов  
В этом разделе описаны свойства сечения элементов TRUSS2D, TRUSS3D, BEAM2D, 

BEAM3D, PIPE и ELBOW. 

Для элементов TRUSS2D и TRUSS3D существуют только два свойства сечения: пло-
щадь поперечного сечения (RC1) и периметр (RC2). Для балочных элементов, как 
видно из Таблицы 6-11, константы сечения включают коды концевого закрепления, 
поперечные множители и другие данные, которые будут описаны ниже.  

Поперечные множители (также называемые множителями сокращенной площади) для 
балочных элементов используются в расчете поперечных изгибов и вводятся как ве-
щественные константы для элементов BEAM2D и BEAM3D. Эти множители равны 
0.8333 для сплошного прямоугольного сечения, 0.9 для сплошного круглого сечения 
и 0.5 для полого круглого сечения. 

Если вы используете несимметричные поперечные сечения балок (доступно только 
для элемента BEAM3D), то необходимо ввести 27 вещественных констант. Узел 
трехмерного балочного элемента не обязательно должен совпадать с центром тяже-
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сти сечения, и вы можете использовать константы с 15 по 27 для задания расстояний 
смещения. Более подробная информация приведена в Главе 4 Руководства пользова-
теля COSMOS/M (Т. 1). 

Константы сечения для элементов труб в COSMOS/M (PIPE и ELBOW) включают 
внешний диаметр, толщину стенки и радиус кривизны. Внутреннее давление также 
задается как вещественная константа, так что для частей модели с различными раз-
мерами поперечного сечения вы можете использовать различные значения давления, 
если это необходимо. Кроме этого, задание внутреннего давления как вещественной 
константы облегчает приложение внешних распределенных нагрузок на элементы 
изогнутой трубы. 

Коды концевого закрепления для балочных элементов  

Для элементов BEAM2D и BEAM3D две из вещественных констант описывают коды 
концевого закрепления в узлах 1 и 2. Эти коды используются для моделирования 
внутренних шарниров и роликов, которые могут располагаться в опорах. Опоры мо-
гут быть смоделированы с использованием команд задания граничных условий (см. 
Главу 7, Нагрузки и граничные условия). 

 

Рис. 6-8. Степени свободы для кодов концевого закрепления  

Как видно из рисунка, для трехмерного балочного элемента в каждом узле есть шесть 
степеней свободы. Линейные компоненты (с 1 по 3, обозначены одной стрелкой) за-
нимают первые три позиции кода концевого закрепления, а угловые компоненты (с 4 
по 6, обозначены двойными стрелками) занимают три последние позиции. Таким об-
разом, код концевого закрепления � это шестизначные целые числа, являющиеся 
комбинацией нулей и единиц. Если внутренние ролики или шарниры отсутствуют, то 
значение кодов концевого закрепления � 0 (значение по умолчанию). Если на какую-
либо позицию ставится единица, до сила или момент по этому направлению прини-
маются равными нулю. Например, для моделирования ролика по оси z необходимо 
ввести код концевого закрепления 001. Завершающие нули могут быть опущены, так 
как они являются значениями по умолчанию. В Таблице 6-12 приведена сводка раз-
личных кодов концевого закрепления и соответствующих им роликов/шарниров. 

Таблица 6-12. Коды концевого закрепления для балочных элементов  

Степень 
свободы 

Код концевого 
закрепления  

Описание 

ALL  000000  Вычисляются все компоненты сил (по умолчанию) 
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UX  100000  Сила по направлению x равна нулю (ролик по оси x) 
UY  010000  Сила по направлению y равна нулю (ролик по оси y) 
UZ  001000  Сила по направлению z равна нулю (ролик по оси z) 
RX  000100  Момент вокруг оси x равен нулю (шарнир в плоскости yz) 
RY  000010  Момент вокруг оси y равен нулю (шарнир в плоскости xz) 
RZ  000001  Момент вокруг оси z равен нулю (шарнир в плоскости xy) 

Заметьте, что для элемента BEAM2D, поскольку для него доступны только три степе-
ни свободы в каждом узле (ux, uy и θz), коды концевого закрепления на позициях 3, 4 
и 5 всегда принимаются равными нулю, независимо от указанного вами значения. 

Константы для расчета максимальных поперечных напряжений для балочных 
элементов  

Для элемента BEAM3D одна из констант представляет константу для расчета макси-
мальных поперечных напряжений. Эта величина, обозначаемая CTOR, вводится как 
константа RC14 для симметричных сечений и как RC20 для симметричных сужаю-
щихся сечений. Максимальные поперечные напряжения вычисляются из CTOR, мо-
мента инерции J и приложенного крутящего момента T по формуле: 

 (6-29) 

В Таблице 6-13 приведены констант J и CTOR для некоторых стандартных попереч-
ных сечений. 

ПРИМЕЧАНИЕ: Если вы используете команду BMSECDEF (Propsets > Beam Section) 
для выбора стандартного сечения для элемента BEAM3D из библиотеки сечений 
COSMOS/M, CTOR вычисляется программой. 
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Таблица 6-13. Константы для расчета максимальных поперечных напряжений для стандартных попе-
речных сечений  
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Таблица 6-13. Константы для расчета максимальных поперечных напряжений для стандартных попе-
речных сечений (Продолжение) 
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Таблица 6-13. Константы для расчета максимальных поперечных напряжений для стандартных попе-
речных сечений (Продолжение) 
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Свойства сечения для двухмерных и осесимметричных элементов  
В данном разделе описаны свойства сечения элементов PLANE2D, SHELL3, SHELL4, 

SHELL3T, SHELL4T, SHELL3L, SHELL4L, SHELL9, SHELL9L, SHELLAX и 
TRIANG. 

Как видно из Таблицы 6-11, для всех двухмерных элементов (кроме элементов состав-
ной оболочки) первая вещественная константа (RC1) представляет толщину. Для 
элементов PLANE2D и TRIANG (плоских и осесимметричных) вторая вещественная 
константа (RC2) представляет угол материала, необходимый если вы используете ор-
тотропные материалы. Для всех элементов оболочки (кроме составных) вторая веще-
ственная константа (RC2) представляет градиент температуры по толщине. Для эле-
ментов SHELL3, SHELL4, SHELL3T и SHELL4T третья вещественная константа 
(RC3) представляет жесткость основания. При ненулевом значении этой константы 
программа моделирует пружину в каждом узле, прикладывая внеплоскостную жест-
кость. Более подробная информация об этой константе приведена в описании эле-
мента SHELL4 в Главе 4 Руководства пользователя COSMOS/M (Том 1). 

Процедура задания вещественных констант для большинства двухмерных и осесим-
метричных элементов очень проста. Однако для элементов составных оболочек 
(SHELL3L, SHELL4L и SHELL4L) толщина слоя, номер группы материала и ориен-
тация главных направлений материала указываются в зависимости от числа слоев. 
Более подробная информация о задании вещественных констант для каждого слоя 
приведена в разделе Свойства материала для составных слоистых материалов. 
Также в этом разделе иллюстрируется возможность вращения осей ортотропного ма-
териала относительно локальной координатной системы элемента или их ориентации 
относительно глобальной Декартовой координатной системы. 

ПРИМЕЧАНИЕ: Толщина каждого слоя в элементах составной оболочки постоянна. 
Если вам необходимо смоделировать слои с переменной толщиной, используйте со-
ставной объемный элемент SOLIDL. 

Свойства сечения для трехмерных элементов  
В данном разделе описаны свойства элементов SOLID, SOLIDL, SOLIDPZ, TETRA4, 

TETRA4R и TETRA10. 

Если свойства материала изотропны, то задавать вещественные константы не надо ни 
для какого трехмерного элемента. Единственное исключение � слоистый составной 
объемный элемент SOLIDL. Для этого элемента в качестве вещественных констант 
необходимо задавать толщину каждого слоя и соответствующую информация о 
свойствах материала (изотропных или ортотропных). 

В качестве примера рассмотрим элемент SOLIDL с тремя слоями. Предполагаются что 
все три слоя имеют различные свойства материала, заданные в команде MPROP 
(Propsets > Material Property). Перед заданием вещественных констант необходимо за-
дать группу элементов, в которой указывается число слоев: 
Control Panel: Propsets > Element Group 
Element Group >1 
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Element Category >Volume 
Element Type (for volume) >SOLIDL; Composite 8-node solid element 
OP1:Integr Type:1=Hybrid;2=Full >Full 
OP2:Number of Layers >3 
OP3:Stress Dir:0=Global;2=Mat >Global 

Из Таблицы 6-11 видно, что для элемента SOLIDL с тремя слоями необходимо ввести 
20 вещественных констант. Вещественные константы для отдельных слоев задаются 
следующим образом: 
Control Panel: Propsets > Real Constant 
Associated Element group >1 
Real Constant set >1 
Start location of the real constants >1 
No. of real constants to be entered >10 
RC1 : Thickness flag (0:thickness,1:ratio) >Thickness 
RC2 : Symmetric flag (0:all,1:sym,2:antisym) >All 
RC3 : Material number for layer 1 >1 
RC4 : Material angle for layer 1 >0 
RC5 : Thickness (ratio) of layer 1 along 1-5 >0.2 
RC6 : Thickness (ratio) of layer 1 along 2-6 >0.25 
RC7 : Thickness (ratio) of layer 1 along 3-7 >0.3 
RC8 : Thickness (ratio) of layer 1 along 4-8 >0.35 
RC9 : Material number for layer 2 >2 
RC10 : Material angle for layer 2 >0 

Теперь необходимо повторно выполнить команду RCONST (Propsets > Real Constant), 
указать тот же номер набора вещественных констант и ввести оставшиеся константы, 
начиная с 11. Поскольку элемент SOLIDL допускает ввод переменой толщины для 
каждого слоя, вводимые константы отличаются от констант для элементов составной 
оболочки. 

Если вы используете объемные элементы с ортотропными свойствами материала, то в 
качестве вещественных констант необходимо задать ориентацию осей ортотропного 
материала. Необходимо задать 9 вещественных констант, представляющих x-, y- и z-
координаты трех точек. Заметьте, что оси ортотропного материала ориентируются 
относительно координатной системы элемента по умолчанию (ECS =-1). Более под-
робная информация приведена в Главе 4 Руководства пользователя COSMOS/M (Том 
1). 

Свойства сечения для особых элементов  
В этом разделе описаны свойства сечения элементов BOUND, GAP, GENSTIF, MASS, 

RBAR и SPRING. Эти элементы называются особыми в том смысле, что для часто 
выполняемых КЭ-расчетов они используются относительно редко. 

Уже описанные свойства сечения для одно-, двух- и трехмерных элементов в основ-
ном описывают геометрию. Однако, как было упомянуто ранее, командой RCONST 
(Propsets > Real Constant) можно задавать некоторые физические свойства особых 
элементов. Сюда входит масса, коэффициенты жесткости и константы трения, опи-
санные в следующих разделах. 
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Элемент численного задание массы  

Элемент численного задания массы (MASS) в COSMOS/M представляет сосредото-
ченную массу, которая может быть определена в узле и использована при представ-
лении общей массы. Однако в отличие от общих масс, которые в общем случае не 
обладают инерцией вращения, используя элемент численного задания массы вы мо-
жете задать инерцию вращения по всем трем направлениям. Таки образом, вещест-
венные константы элемента численного задания массы представляют диагональные 
члены матрицы общей массы. Кроме этого, седьмая вещественная константа пред-
ставляет теплоемкость, используемую в термальном расчете.  

Перед заданием вещественных констант для элемента численного задания массы не-
обходимо задать группу элементов командой (EGROUP (Propsets > Element Group)): 
Control Panel: Propsets > Element Group 
Element Group >1 
Element Category >Point 
Element Type (for point) >MASS; General mass element 
OP1:Unused option > 

Затем используйте команду RCONST (Propsets > Real Constant) для задания компонен-
тов массы и инерции вращения: 
Control Panel: Propsets > Real Constant 
Associated Element group >1 
Real Constant set >1 
Start location of the real constants [1]>1 
No. of real constants to be entered [7]>7 
RC1 : Mass in x-direction >1 
RC2 : Mass in y-direction >1 
RC3 : Mass in z-direction >1 
RC4 : Rotary inertia about x-axis >2 
RC5 : Rotary inertia about y-axis >2 
RC6 : Rotary inertia about z-axis >2 
RC7 : Thermal capacity [0]> 

Элемент жесткого бруса  

2-узловой элемент жесткого бруса (RBAR) используется для моделирования беско-
нечно жестких частей в КЭ-модели. Этот элемент используется для передачи пере-
мещений и вращений жесткого тела между двумя узлами. Группа элементов для это-
го элемента задается командой EGROUP (Propsets > Element Group) следующим 
образом: 
Control Panel: Propsets > Element Group 
Element Group >1 
Element Category >Line 
Element Type (for line) >RBAR; Rigid bar element 
OP1:Unused option > 

Вещественные константы для элемента жесткого бруса включают жесткость бруса, 
обычно равную некоторой большой величине: 
Control Panel: Propsets > Real Constant 
Associated Element group >1 
Real Constant set >1 
Start location of the real constants >1 
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No. of real constants to be entered >1 
RC1 : Rigid bar stiffness [1e+10]>2E15 

Граничный элемент  

Граничный элемент (BOUND) � 2-узловой элемент (третий узел используется для за-
дания ориентации элемента), в котором один из узлов зафиксирован, а другой имеет 
две степени свободы � линейную и угловую. Вещественные константы для этого 
элемента, таким образом, включают продольную и угловую жесткости. Группа эле-
ментов для этого элемента задается командой EGROUP (Propsets > Element Group) 
следующим образом: 
Control Panel: Propsets > Element Group 
Element Group >1 
Element Category >Line 
Element Type (for line) >BOUND 
OP1:Bound. Type:0=Axial;1=Rot;2=Axial & Rot [0]>2 

Соответствующие вещественные константы задаются командой RCONST (Propsets > 
Real Constant) следующим образом: 
Control Panel: Propsets > Real Constant 
Associated Element group >1 
Real Constant set >1 
Start location of the real constants >1 
No. of real constants to be entered >2 
RC1 : Axial stiffness >1.5E6 
RC2 : Rotational stiffness >2E5 

Элемент пружины  

Элемент пружины (SPRING) используется для моделирования продольных и/или уг-
ловых действий в одно-, двух- и трехмерных моделях. Вещественные константы для 
этого элемента включают продольную и угловую жесткости. Группа элементов для 
этого элемента задается командой EGROUP (Propsets > Element Group) следующим 
образом:  
Control Panel: Propsets > Element Group 
Element Group >1 
Element Category >Line 
Element Type (for line) >SPRING; Spring element 
OP1:Spring Type:0=Axial;1=Rot;2=Both >2 
OP2:Number of nodes:1=1-Node;2=2-Node >2-Node 

Соответствующие вещественные константы задаются командой RCONST (Propsets > 
Real Constant) следующим образом:  
Control Panel: Propsets > Real Constant 
Associated Element group >1 
Real Constant set >1 
Start location of the real constants >1 
No. of real constants to be entered >2 
RC1 : Axial stiffness >1.5E6 
RC2 : Rotational stiffness >2.E5 

Можно заметить, что вещественные константы для граничного элемента и элемента 
пружины задаются одинаково. 
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Элемент GAP  

Элемент GAP в Основной Системе � это интерфейс узел-узел, позволяющий модели-
ровать задачи на взаимодействие с/без учета трения и скольжения. Группа элементов 
для этого элемента задается командой EGROUP (Propsets > Element Group) следую-
щим образом: 
Control Panel: Propsets > Element Group 
Element Group >1 
Element Category >Line 
Element Type (for line) >GAP; Gap element 
OP1:Surface coord. update:0=No;1=Yes [0]>No 
OP2:Friction:0=No;1=Yes;2=Yes & Slide [0]>Yes & Slide 
OP3:Frict. outside X-Y plane:0=No;1=Yes [0]>No 
OP4:Gap Type:0=N-N;1=N-L;2=N-S [0]>N-N 
OP5:Unused option > 
OP6:Compressive gap measurement:0=User;1=Auto [0]>User 

Последний признак позволяет пользователю избежать вычисления расстояния, на ко-
торое должны пройти два узла по направлению друг к другу прежде чем начнется 
сопротивление. В данном примере используется ручной ввод. 

Вещественные константы для этого элемента задаются следующим образом: 
Control Panel: Propsets > Real Constant 
Associated Element group >1 
Real Constant set >1 
Start location of the real constants [1]>1 
No. of real constants to be entered [7]>7 
RC1 : Relative displ. between 2 nodes [0]>0.1 
RC2 : Coefficient of friction [0]>0.5 
RC3 : Gap stiffness 0=No Spring k=Stiffness [0]>1.5E4 
RC4 : Spring pre-load [0]>1000 
RC5 : Maximum spring deflection [1e+08]>10000000. 
RC6 : Damping constant (c) [0]>0 
RC7 : Damping constant (p) [1]>1 

Более подробная информация об элементе GAP приведена в Главе 4 Руководства 
пользователя COSMOS/M (Том 1). 

Элемент численного задания жесткости  

Элемент численного задания жесткости � 2-узловой трехмерный элемент, используе-
мый в конструкционных моделях, коэффициенты жесткости которого вводятся поль-
зователем. Вещественные константы (общим числом 78) для элемента GENSTIF 
представляют коэффициенты жесткости, хранимые в следующей матрице: 
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В этой матрице также приведены номера соответствующих вещественных констант (в 
скобках). Перед использованием команды RCONST (Propsets > Real Constant) убеди-
тесь, что была задана группа элементов GENSTIF командой EGROUP (Propsets > 
Element Group). Вещественные константы вводятся «порциями» по 10, как показано 
ниже. Программа выведен напоминание, что осталось ввести еще 68 констант для 
полного описания элемента GENSTIF. 
Control Panel: Propsets > Real Constant 
Associated Element group >1 
Real Constant set >1 
Start location of the real constants >1 
No. of real constants to be entered >10 
RC1 : K 1,1 stiffness term >2.0E10 
RC2 : K 1,2 stiffness term >2.5E8 
RC3 : K 1,3 stiffness term >1.5E10 
RC4 : K 1,4 stiffness term >2.8E4 
RC5 : K 1,5 stiffness term >4E10 
RC6 : K 1,6 stiffness term >3E12 
RC7 : K 1,7 stiffness term >5E10 
RC8 : K 1,8 stiffness term >6E8 
RC9 : K 1,9 stiffness term >7E6 
RC10 : K 1,10 stiffness term >6E10 
RC set 2 may need 68 more constants 

Для задания оставшихся вещественных констант выполните команду RCONST 
(Propsets > Real Constant) повторно, укажите тот же номер набора вещественных кон-
стант и продолжайте вводить константы, начиная с 11. 

Библиотека сечений  
Как и в случае с библиотекой материалов, в COSMOS/M есть две встроенные библио-
теки сечений для балочных элементов BEAM2D и BEAM3D. Сюда входят сечения 
для стандартных форм AISC (American Institute of Steel Construction, 9th Edition, 
1991) и сечения COSMOS/M для стандартных и нестандартных (пользовательских) 
форм. Для выбора сечений и их свойств из библиотек COSMOS/M и AISC использу-
ются команды BMSECDEF (Propsets > Beam Section) и PICK_SEC (Propsets > AISC Sect 
Table), соответственно. Если вы используете эти команды, то для задания веществен-
ных констант не требуется использовать команду RCONST (Propsets > Real Constant). 
В следующих разделах приведена более подробная информация о различных попе-
речных сечениях и их использовании. 
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ПРИМЕЧАНИЕ: Библиотека сечений COSMOS/M может быть использована с эле-
ментами BEAM2D и BEAM3D, а библиотека сечений AISC используется только с 
элементом BEAM3D. 

Использование встроенной библиотеки сечений COSMOS/M 

Чтобы использовать встроенную библиотеку сечений COSMOS/M, сначала необходи-
мо задать необходимый балочный элемент и выбрать соответствующий вариант 
симметрии, то есть: симметричное, несимметричное и симметричное сужающееся 
поперечное сечение. После этого можно использовать команду BMSECDEF (Propsets > 
Beam Section), проиллюстрированную ниже, для выбора типа поперечного сечения и 
его размеров. В этой команде необходимо указать соответствующий номер группы 
элементов, номер набора вещественных констант и форму поперечного сечения (из 
приведенных в таблице). Команда BMSECDEF (Propsets > Beam Section) используется 
вместо команды RCONST (Propsets > Real Constant), поэтому в ней также указываются 
коды концевого закрепления и другие вещественные константы для балочных эле-
ментов. В Таблице 6-15 приведены формы поперечных сечений и их параметры. 

Таблица 6-14. Поперечные сечения, доступные в библиотеке сечений COSMOS/M  

Номер 
сечения  

Описание Элементы Примечания  

1  Сплошное прямоугольное сече-
ние 

BEAM2D, 
BEAM3D  

Для BEAM3D возможны все варианты симмет-
рии 

2  Сплошное круглое сечение BEAM2D, 
BEAM3D  

Для BEAM3D возможны все варианты симмет-
рии 

3  Полое круглое сечение BEAM2D, 
BEAM3D  

Для BEAM3D возможны все варианты симмет-
рии 

4  Полое прямоугольное сечение BEAM2D, 
BEAM3D  

Для BEAM3D возможны все варианты симмет-
рии 

5  Симметричное двутавровое се-
чение  

BEAM2D, 
BEAM3D  

Для BEAM3D возможны все варианты симмет-
рии 

6  Сплошное трапециевидное сече-
ние  

BEAM3D  BEAM3D должен быть несимметричным 

7  Швеллерное сечение  BEAM3D  BEAM3D должен быть несимметричным 
8  Z-сечение  BEAM3D BEAM3D должен быть несимметричным 
9  Тавровое сечение  BEAM3D  BEAM3D должен быть несимметричным 
10  Уголковое сечение  BEAM3D  BEAM3D должен быть несимметричным 
0  Пользовательское сечение  BEAM3D  BEAM3D должен быть несимметричным 
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Таблица 6-15. Параметры сечений встроенной библиотеки сечений COSMOS/M  
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Как видно из Таблицы 6-14, первые пять сечений симметричны, и применимы к эле-
ментам BEAM2D и BEAM3D. Сечения с 6 по 10, а также 0, применимы только к эле-
менту BEAM3D. Кроме этого, в некоторых из этих сечений существуют ограниче-
ния, наложенные на пропорции. например, трапециевидное сечение (сечение номер 
6) имеет следующее ограничение: высота должна быть больше ширины нижнего ос-
нования, которая, в свою очередь, должна быть больше ширины верхнего основания. 
При использовании трапециевидного сечения следует учитывать это ограничение. 

Когда вы используете команду BMSECDEF (Propsets > Beam Section) для элементов 
BEAM3D, константы для расчета максимальных поперечных напряжений, приведен-
ные в Таблице 6-13, автоматически вычисляются программой, и вам не надо их вво-
дить. Поскольку сечения балок связываются с наборами вещественных констант, для 
удаления выбранного сечения необходимо воспользоваться командой RCDEL (Edit > 
DELETE > Real Constants).  

Следующий пример показывает выбор полого круглого сечения (номер 3 в Таблице 6-
14) для элемента BEAM2D. Чтобы использовать это сечение, сначала необходимо за-
дать группу элементов, а затем командой BMSECDEF (Propsets > Beam Section) вы-
брать поперечное сечение из библиотеки: 
Control Panel: Propsets > Beam Section 
Associated Element group >1 
Real Constant set >1 
Section number [1]>3 
Start location of the section parameters >1 
No. of beam section constants to be entered >7 
BS1 : Outside diameter (D)>1 
BS2 : Thickness (T)>0.1 
BS3 : End-release code (node 1) >0 
BS4 : End-release code (node 2) >0 
BS5 : Shear factor in elem. y-axis >0 
BS6 : Temp. diff. in elem. y-axis >0 
BS7 : Perimeter (HSTAR only) >0 

Заметьте, что если вам необходимо смоделировать внутренний шарнир или ролик, то 
необходимо указать соответствующее значение в команде BMSECDEF (Propsets > 
Beam Section). Команда BMSECLIST (Edit > LIST > Beam Section) может быть исполь-
зована для просмотра выбранного сечения и других вещественных констант. Инфор-
мация, выводимая на экран имеет следующий вид: 
Real Constant Sets  
Real Constant Set : 1 (ACTIVE)  
Associated Element Group : 1 ( BEAM2D - Symmetric Pipe )  
Center of Gravity : ( cgy = 0.000000e+00 cgz = 0.000000e+00 )  
   Bs1 : Outside diameter (D) . . . . . . . . .     = 1.000000e+00  
   Bs2 : Thickness (T)  .  . .  .  .  .  .  . . . .      = 1.000000e-01 
   Bs3 : End-release code (node 1) . . . . . . .   = 0  
   Bs4 : End-release code (node 2) . . . . . . .   = 0  
   Bs5 : Shear factor in elem. y-axis . . . . . . = 0.000000e+00  
   Bs6 : Temp. diff. in elem. y-axis . . .  .  .  . = 0.000000e+00  
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   Bs7 : Perimeter (HSTAR only) .  .  .  . .  .  .  . = 0.000000e+00 

Для просмотра вычисленных данных поперечного сечения, таких как площадь и мо-
мент инерции, используется команда RCLIST (Edit > LIST > Real Constants). будут вы-
ведены свойства поперечного сечения и другие вещественные константы: 
Real Constant Sets  
Real Constant Set : 1 (ACTIVE)  
Associated Element Group : 1 ( BEAM2D )  
  Rc1 : Cross-sectional area .  .  .  .  .  .  .  .  . = 2.827433e-01  
  Rc2 : Moment of inertia (Iz) .  .  .  .  .  .  . . = 2.898119e-02  
  Rc3 : Depth .  .  .  .  .  .  .  .  .  .  .  .  .  .      = 1.000000e+00  
  Rc4 : End-release code (node 1) . .  .  .  .  . . = 0  
  Rc5 : End-release code (node 2) .  .  .  . . . . = 0  
  Rc6 : Shear factor in elem. y-axis . . . . . . = 0.000000e+00  
  Rc7 : Temp. diff. in elem. y-axis .  .  .  . . . = 0.000000e+00  
  Rc8 : Perimeter (HSTAR only) . . .  .  .  .  .  . = 0.000000e+00 

Симметричные сужающееся и несимметричные (с 6 по 10, а также 0) сечения исполь-
зуются аналогично. Поскольку эти сечения применимы только к элементу BEAM3D, 
сначала необходимо задать группу элементов и выбрать вариант симметрии, а затем 
выбрать необходимое сечение командой BMSECDEF (Propsets > Beam Section). 

Использование встроенной библиотеки сечений AISC  

Если вы рассчитываете стальные фермовые конструкции с использованием стандарт-
ных поперечных сечений AISC, то COSMOS/M предоставляет возможность выбирать 
различные свойства, такие как центр тяжести, площадь, момент инерции и другие из 
встроенной библиотеки сечений. Команда PICK_SEC (Propsets > AISC Sect Table) вы-
бирает необходимое сечение из библиотеки AISC и связывает его с набором вещест-
венных констант. Эта команда должна использоваться только вместе с системой 
единиц измерения FPS. Единицей измерения длины в данном случае является дюйм, а 
веса � фунт. Параметр "section name" может принимать значения, указанные в табли-
це. 

Таблица 6-16. Сечения, доступные в библиотеке сечений AISC  

Section Name  Описание Пример 
ANGLE  Стандартные уголковые сечения L 9x 4 x 5/8 
CBEAM  Американские стандартные швеллерные сечения C 15 x 50 
HPBEAM  Двутавровые сечения с одинаковой толщиной 

полки и стенки  
HP 14 x 117 

MBEAM  Разные двутавровые сечения  M 14 x 18 
MCBEAM  Разные швеллерные сечения  MC 18 x 58 
PIPE  Полые круглые сечения с постоянной толщиной  12 x 0.375 
RANGLE  Уголковые сечения с повернутыми свойствами  L 9x 4 x 5/8 
SBEAM  Двутавровые сечения с меньшей толщиной по-

лок  
S 24 x 121 

STUBE  Полые прямоугольные сечения с постоянной 16 x 16 
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толщиной  
WBEAM  Двутавровые сечения с различными толщинами 

полок и стенки  
W 36 x 300 

Также в этой команде параметры dim_1, dim_2 и dim_3 представляют идентификацион-
ные параметры по AISC. Например, если вы хотите выбрать W-сечение 36x300, то 
dim_1 будет равен 36, dim_2 � 300. Параметр dim_3 необходим только для сечений 
ANGLE, RANGLE и STUBE. Заметьте, что определения локальных координат x, y и z 
различны в GEOSTAR и кодах AISC. В Таблице 6-17 приведены идентификационные 
параметры dim_1, dim_2 и dim_3 для доступных сечений. 

Вес всех сечений, кроме уголковых, зависит от плотности стали. Если вы используете 
какой-либо другой материал в своей модели, то вес должен быть основан ан плотно-
сти стали, как в кодах AISC. Это не влияет на свойства материала, поскольку вес се-
чения используется только для определения свойств сечения. 

ПРИМЕЧАНИЕ: Сечения AISC в текущей версии программы применимы только к 
элементам BEAM3D. 

Существует возможность проверки соответствия рассчитываемой конструкции спе-
цификациям AISC на допустимые напряжения (ASD). Эта возможность описана в 
следующем разделе. 
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Таблица 6-17. Идентификационные параметры сечений AISC 

 

Процедура выбора стандартного сечения AISC в COSMOS/M очень проста: исполь-
зуйте команду PICK_SEC (Propsets > AISC Sect Table) и укажите имя сечения (приве-
денное в Таблице 6-16): 

Control Panel: Propsets > AISC Sect Table 
Associated Element group >1 
Real Constant set >1 
Section Name >WBEAM 
AISC Dimension 1 >36 
AISC Dimension 2 >300 

Для проверки свойств сечения, выбранных из библиотеки сечений AISC можно ис-
пользовать команду RCLIST (Edit > LIST > Real Constants): 
Real Constant Sets  
Real Constant Set : 1 (ACTIVE)  
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Associated Element Group : 1 ( BEAM3D )  
Rc1 : Cross-sectional area  .  .  .  .  .  .  .  .  .    = 8.830000e+01  
Rc2 : Moment of inertia about y-axis (Iy) . . . . = 1.300000e+03  
Rc3 : Moment of inertia about z-axis (Iz) . . . . = 2.030000e+04  
Rc4 : Depth of beam (y-axis) .  .  .  .  .  .  .  .       = 3.674000e+01  
Rc5 : Width of beam (z-axis)  .  .  .  .  .  .  .  .     = 1.665500e+01  
Rc6 : End-release code (node 1)  .  .  .  .  .  .  .   = 0  
Rc7 : End-release code (node 2)  .  .  .  .  .  .  .   = 0  
Rc8 : Moment of inertia about x-axis (Ix) . . . . = 6.420000e+01 

Проверка кода AISC  

Если в модели использовались стандартные сечения AISC, то в команде A_STRESS 
(Analysis > STATIC > Stress Analysis Options) можно указать признак проверки соот-
ветствия выбранных сечений кодам AISC: 

Control Panel: Analysis > STATIC > Stress Analysis Options 
AISC code check Flag 0=No 1=Yes >Yes 
... ... ... >... 
Примите значения по умолчанию 

Если признак проверки кода AISC включен, то программа создаст файл jobname.AIS. 
Этот файл может быть использован с программой проверки кодов SDM (Модуль 
стальных конструкций), являющейся отдельной программой проверки по критериям 
AISC (для получения программы свяжитесь с Structural Research). 

Изменение, отображение и вывод заданных свойств сечения  
Команда RCDEL (Edit > DELETE > Real Constants) используется для удаления всех 
свойств, заданных в одном или более наборах вещественных констант. Если вы хоти-
те удалить или изменить какое-либо отдельное свойства в наборе, то необходимо ис-
пользовать концепцию начала ввода констант, изложенную выше.  

Если в вашей модели присутствует больше одного набора вещественных констант, и 
вы хотите сделать какой-либо набор активным, то вам необходимо использовать ко-
манду ACTSET (Control > ACTIVATE > Set Entity). Кроме активизирования наборов 
вещественных констант, эта команда может активизировать координатные системы, 
температурные кривые и другие примитивы. Описание этих примитивов и их имена 
приведены в таблице Table 6-10. Имена активных в данный момент примитивов гра-
фически отображаются в таблице Status1, как показано на рис. 6-4. 

Для изменения связи существующих наборов вещественных констант с группами эле-
ментов и наборами свойств материала используется команда EPROPCHANGE (Propsets 
> Change El-Prop). Также эта команда назначает указанный цвет выбранному шабло-
ну элементов. Назначенные цвета могут быть использованы для отображения и обо-
значения частей КЭ-сети м различными наборами вещественных констант. В сле-
дующем разделе данная возможность описана более подробно. 
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Отображение заданных свойств сечения  

Для моделей с более чем одним набором вещественных констант COSMOS/M предос-
тавляет способ графического представления различных наборов вещественных кон-
стант с целью проверки модели. Команда ACTECLR (Meshing > ELEMENTS > Activate 
Elem Color) используется для активизации цветов по умолчанию для элементов и од-
ного из связанных с ними примитивов (в данном случае наборов вещественных кон-
стант). Процедура отображения различных наборов вещественных констант анало-
гична процедуре для наборов свойств материала; более подробная информация 
приведена в соответствующем разделе. 

Вывод свойств сечения  

По умолчанию информация о вещественных константах не записывается в файл выво-
да.  Однако вы можете запросить подробный вывод в команде PRINT_OPS (Analysis > 
OUTPUT OPTIONS > Set Print Options), включив признак печати исходных данных. 
Также заданные свойства сечения могут быть выведены на экран командой RCLIST 
(Edit > LIST > Real Constants). Как и для всех команд вывода списков в GEOSTAR, 
информация, выводимая командой RCLIST (Edit > LIST > Real Constants) может быть 
перенаправлена в ASCII-файл командой LISTLOG (Control > MISCELLANEOUS > List 
Log). 

Вычисление свойств массы и инерции  
Команда MASSPROP (Control > MEASURE > Find Mass Property) рассчитывает и выво-
дит свойства массы и инерции для шаблона элементов. Выводятся следующие свой-
ства: длина, площадь, объем, масса и соответствующие центры тяжести, моменты 
инерции и радиусы инерции. Длина выводится только для одномерных элементов 
(например, BEAM3D, ELBOW, PIPE и т.д.), площадь выводится только для двухмер-
ных элементов (например, SHELL9L, SHELLAX, FLOW2D, MAG2Dи т.д.) а объем 
выводится для всех элементов, имеющих объем (например, SOLID, FLOW3D, 
BEAM2D, SHELL4 и т.д.). Масса выводится для элементов обладающих массой (не-
обходимо указать плотность). Эта команда также рассчитывает главные моменты 
инерции и соответствующие главные направления относительно произвольной Де-
картовой координатной системы. Признак "check flag" в этой команде устанавливает-
ся для проверки на присутствие несовместимых данных таких как незаданные свой-
ства материала, вещественные константы, связность и вырожденные элементы. Вы 
можете вычислить свойства массы и инерции для всех или для некоторых элементов. 

Алгоритм вычисления свойств массы и инерции использует определенные интегралы 
по одному, двум и трем измерениям. Эти интегралы численно вычисляются для каж-
дого элемента и суммируются для всех элементов, указанных в команде MASSPROP 
(Control > MEASURE > Find Mass Property). В следующих разделах приведена ин-
формация о вычислении свойств массы и сечения для фермовых, плоскостных (пло-
ских и искривленных) и объемных конструкций.  

Процедура вычисления свойств массы и инерции командой MASSPROP (Control > 
MEASURE > Find Mass Property) осень проста. Просто выполните эту команде после 
задания групп элементов, вещественных констант и свойств материала в своей КЭ-
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сети. Рекомендуется включать признак проверки, чтобы убедиться в том, что для 
указанных элементов были заданы все необходимые свойства: 

Control Panel: Control > MEASURE > Find Mass Property 
Check flag: 1: Yes; 0: No [0]>1 
Beginning Element >1 
Ending Element >40 
Increment >1 
Coordinate system >0 

ПРИМЕЧАНИЕ: Некоторые из свойств массы и инерции, описанных в данном разде-
ле также вычисляются и записываются в файл вывода при выполнении модального 
расчета или статического расчета с гравитационной нагрузкой. 

Вычисление свойств массы и инерции для фермовых конструкций  

Рассмотрим в качестве примера для вычисления свойств массы и инерции ферму, при-
веденную на рисунке. Размеры и плотность фермы также приведены на рисунке. 
Предполагается что командой MASSPROP (Control > MEASURE > Find Mass Property) 
вычисляются свойства массы и инерции для всех элементов. Для вычисления свойств 
массы и инерции используется показанная координатная система. 

 

Рис. 6-9. Пример для вычисления свойств массы и инерции для фермовой конструкции  

Длина объем и масс фермы фермовых конструкций вычисляются по формулам: 

 (6-30) 

где Ai и li площадь поперечного сечения и длина элемента i, nel � общее число указан-
ных элементов.  

Координаты центров тяжести получаются вычислением статических моментов и деле-
нием их на общую длину: 

 (6-31) 
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где xci и yci � координаты центра тяжести элементов.  

ПРИМЕЧАНИЕ: Под центром тяжести в этом и двух следующих разделах понима-
ются центр масс, центр длины, центр площади и центр объема. 

Информация о длине, объеме и массе, выводимая командой MASSPROP (Control > 
MEASURE > Find Mass Property) имеет следующий вид: 
Mass Distribution Table  

_ Physical Properties: Centroids w.r.t. Coord. Sys. [0]:  

_  x  y  z  

_ Length = 415.561 CGL = ( 50 , 8.54282 , 0 )  

_ Area = 0         CGA = ( 0 ,  0 ,  0 )  

_ Volume = 415.561 CGV = ( 50 , 8.54282 , 0 )  

_ Mass = 0.301116  CG =  ( 50 , 8.54282 , 0 ) 

Уравнения моментов инерции относительно дины имеют вид: 

 (6-32) 

Произведения инерции для фермовых конструкции вычисляются следующим образом: 

 (6-33) 

Радиусы инерции вычисляются следующим образом: 

 (6-34) 

Моменты и произведения инерции относительно указанной координатной системы и 
соответствующие радиусы инерции, выводятся командой MASSPROP (Control > 
MEASURE > Find Mass Property) в следующей форме: 
_ Moments of Inertia and Radii of Gyration ( w.r.t. Coord. Sys. [0] ) 

_  Length  Area  Volume  Mass  

_ Ixx  | 59842.5  | 0  | 59899  | 43.4028  

_ Iyy  | 1.28185e+06  | 0  | 1.2819e+06  | 928.862  

_ Izz  | 1.34169e+06  | 0  | 1.34173e+06  | 972.215  

_ Ixy  | 177503  | 0  | 177503  | 128.619  

_ Iyz  | 0  | 0  | 0  | 0  

_ Izx  | 0  | 0  | 0  | 0  
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_ Rx  | 12.0002  | 0  | 12.0058  | 12.0058  

_ Ry  | 55.5394  | 0  | 55.5404  | 55.5404  

_ Rz  | 56.821  | 0  | 56.8217  | 56.8217 

Также выводятся моменты и произведения инерции относительно центра тяжести в 
указанной координатной системе: 

_ Moments of Inertia and Radii of Gyration (w.r.t. CG's in Coord. Sys. [0]): 

_  Length  Area  Volume  Mass  

_ Ixx  | 29514.9  | 0  | 29571.4  | 21.4274  

_ Iyy  | 242946  | 0  | 242993  | 176.073 

_ Izz  | 272461  | 0  | 272495  | 197.45  

_ Ixy  | -0.0235475  | 0  | -0.0235475  | -7.92031e-06  

_ Iyz  | 0  | 0  | 0  | 0  

_ Izx  | 0  | 0  | 0  | 0  

_ Rx  | 8.42759  | 0  | 8.43565  | 8.43565  

_ Ry  | 24.1789  | 0  | 24.1813  | 24.1813  

_ Rz  | 25.6056  | 0  | 25.6072  | 25.6072 

Главные моменты инерции � это максимальные и минимальные моменты инерции, 
измеряемые относительно любой оси, проходящей через данную точку. Произведе-
ние инерции равно нулю для любых двух осей, если одна из них главная. Ось сим-
метрии всегда является главной осью. Ниже приведены главные моменты инерции 
относительно центра тяжести: 
_ Principal Moments of Inertia ( w.r.t. CG's ) :  

_  Length  Area  Volume  Mass  

_ I1  | 272461  | 0  | 272495  | 197.45  

_ I2  | 242946  | 0  | 242993  | 176.073  

_ I3  | 29514.9  | 0  | 29571.4  | 21.4274 

Соответствующие направляющие косинусы главных осей относительно указанной ко-
ординатной системы выводятся в следующей форме: 
_ Direction Cosine Vectors ( w.r.t. Coord. System [0] ) :  

_  Length  Area  Volume  Mass  

_ a11  | 0  | 0  | 0  | 0  

_ a21  | 0  | 0  | 0  | 0  

_ a31  | 1  | 0  | 1  | 1  

_ a12  | 1.10329e-07  | 0  | 1.10333e-07  | 5.1216e-08  

_ a22  | 1  | 0  | 1  | 1  

_ a32  | 0  | 0  | 0  | 0  

_ a13  | -1  | 0  | -1  | -1  

_ a23  | 1.10329e-07  | 0  | 1.10333e-07  | 5.1216e-08  
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_ a33  | 0  | 0  | 0  | 0 

Вычисление свойств массы и инерции для плоскостных конструкций  

Рассмотрим в качестве примера для вычисления свойств массы и инерции плоскую 
плиту, показанную на рисунке. Также на рисунке показаны размеры модели и плот-
ность. Нижний левый угол плиты расположен в координатах (10,15) относительно 
показанной координатной системы. Данный пример очень прост, так что вы можете 
проверить результаты, получаемые в команде MASSPROP (Control > MEASURE > 
Find Mass Property), выполнив расчеты самостоятельно. При вычислении свойств  
массы и инерции будут рассматриваться все элементы, показанные на рисунке. 

 

Рис. 6-10. Пример для вычисления свойств массы и инерции для плоскостных конструкций  

Площадь, объем и масса плоской конструкции вычисляются по формулам: 

 (6-35) 

где Ai � площадь, ti � толщина и ρi � масса элемента i а nel � число указанных элемен-
тов.  

Координаты центра тяжести находятся вычислением статических моментов и делени-
ем их на общую площадь: 

 (6-36) 

Ниже приведены площадь, объем, масса и координаты центра тяжести, выводимые 
командой MASSPROP (Control > MEASURE > Find Mass Property): 
Mass Distribution Table  

Physical Properties: Centroids w.r.t.  

Coord. Sys. [0]:  x  y  z  

Length = 0  CGL =  ( 0 ,  0 ,  0 )  

Area = 3150  CGA =  ( 50 ,  42.5 ,  0 )  
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Volume = 315  CGV =  ( 50 ,  42.5 ,  0 )  

Mass = 0.228249 CG =  ( 50 , 42.4999 , 0 ) 

Моменты и произведения инерции для плоскостных моделей рассчитываются относи-
тельно площади, объема и массы. Ниже приведены уравнения моментов инерции 
плоской области: 

 (6-37) 

Произведения инерции плоской области рассчитываются по формуле: 

 (6-38) 

Радиусы инерции рассчитываются по уравнению 6-34.  

Моменты и произведения инерции относительно указанной координатной системы и 
соответствующие радиусы инерции выводятся командой MASSPROP (Control > 
MEASURE > Find Mass Property) в следующей форме: 

Moments of Inertia and Radii of Gyration ( w.r.t. Coord. Sys. [0] ) :

 Length  Area  Volume  Mass  

Ixx  | 0  | 6.22125e+06  | 622125  | 450.792  

Iyy  | 0  | 9.16125e+06  | 916125  | 663.824  

Izz  | 0  | 1.53825e+07  | 1.53825e+06  | 1114.62  

Ixy  | 0  | 6.69375e+06  | 669375  | 485.029  

Iyz  | 0  | 0  | 0  | 0  

Izx  | 0  | 0  | 0  | 0  

Rx  | 0  | 44.441  | 44.441  | 44.4409  

Ry  | 0  | 53.929  | 53.929  | 53.9289  

Rz  | 0  | 69.8808  | 69.8809  | 69.8808 

Моменты и произведения инерции также вычисляются относительно центра тяжести в 
указанной координатной системе и выводятся в следующей форме: 
Moments of Inertia and Radii of Gyration (w.r.t. CG's in Coord. Sys. [0]): 

 Length  Area  Volume  Mass  

Ixx  | 0  | 531564  | 53156.4  | 38.5176  

Iyy  | 0  | 1.28625e+06  | 128625  | 93.2023  

Izz  | 0  | 1.81781e+06  | 181781  | 131.72  

Ixy  | 0  | -0.510693  | -0.0510693  | 0.000538818  

Iyz  | 0  | 0  | 0  | 0  

Izx  | 0  | 0  | 0  | 0  
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Rx  | 0  | 12.9904  | 12.9904  | 12.9905  

Ry  | 0  | 20.2072  | 20.2073  | 20.2073  

Rz  | 0  | 24.0225  | 24.0225  | 24.0226 

Для плоских объектов существуют две взаимно перпендикулярных оси, проходящих 
через одну точку, для которых произведение инерции равно нулю. Такие оси называ-
ются главными осями. Если ω представляет угол поворота относительно исходных ко-
ординатных осей, то значение этого угла, при котором условие нулевого произведения 
инерции выполняется, вычисляется по формуле: 

 (6-39) 

Главные моменты инерции вычисляются по формуле: 

 (6-40) 

Главные моменты инерции � это максимальный и минимальный моменты инерции, 
измеряемые относительно любой оси, проходящей через данную точку. Произведе-
ние инерции равно нулю для любых двух осей, одна из которых главная. Ось сим-
метрии всегда является главной. Ниже приведены главные моменты инерции относи-
тельно центра тяжести: 
Principal Moments of Inertia ( w.r.t. CG's ) :  

 Length  Area  Volume  Mass  

I1  | 0  | 1.81781e+06  | 181781  | 131.72  

I2  | 0  | 1.28625e+06  | 128625  | 93.2023 

I3  | 0  | 531564  | 53156.4  | 38.5176 

Ниже приведены соответствующие направляющие косинусы главных осей относи-
тельно указанной координатной системы: 

Direction Cosine Vectors ( w.r.t. Coord. System [0] ) :  

 Length  Area  Volume  Mass  

a11  | 0  | 0  | 0  | 0  

a21  | 0  | 0  | 0  | 0  

a31  | 0  | 1  | 1  | 1  

a12  | 0  | 6.76698e-07  | 6.76696e-07  | -9.85317e-06  

a22  | 0  | 1  | 1  | 1  

a32  | 0  | 0  | 0  | 0  

a13  | 0  | -1  | -1  | -1  

a23  | 0  | 6.76698e-07  | 6.76696e-07  | -9.85317e-06  

a33  | 0  | 0  | 0  | 0 
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Вычисление свойств массы и инерции для объемных конструкций  

Рассмотрим в качестве примера объемную КЭ-модель, показанную на рисунке, на ко-
тором также приведена плотность. Показанная модель была создана генерацией КЭ-
сети для поперечного сечения с последующим «охватыванием» КЭ-сети вокруг оси 
Y на 45 градусов с получением КЭ-сети, состоящей из шестигранных элементов. Для 
«охватывания» использовалась команда PHEXTR (Geometry > POLYHEDRA > Extru-
sion). 

 

Рис. 6-11. Пример для вычисления свойств массы и инерции для объемных конструкций  

Для объемны моделей объем и масса вычисляются по формулам: 

 (6-41) 

где Vi � объем, ρi � плотность элемента i, а nel � число указанных элементов. Для вы-
числения координат центра тяжести сначала вычисляются статические моменты: 

 (6-42) 

Затем вычисляются координаты центра тяжести: 

 (6-43) 

Ниже приведены объем, масса и координаты центра тяжести, выводимые командой 
MASSPROP (Control > MEASURE > Find Mass Property): 
Mass Distribution Table  

_ Physical Properties: Centroids w.r.t. Coord. Sys. [0]:  

_   x  y  z  

_ Length = 0  CGL =  ( 0 ,  0 ,  0 )  

_ Area = 0  CGA =  ( 0 ,  0 ,  0 )  

_ Volume = 92140.4 CGV =  ( 59.5725 , 25 ,   -34.3942)  

_ Mass = 66.7649  CG =  ( 59.5725 , 24.9999 ,  -34.3942) 
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Моменты инерции массы вычисляются по следующей формуле: 

 (6-44) 

Радиусы инерции рассчитываются по уравнению 6-34. 

Произведения инерции рассчитываются по формуле: 

 (6-45) 

Моменты и произведения инерции относительно указанной координатной системы и 
соответствующие радиусы инерции выводятся командой MASSPROP (Control > 
MEASURE > Find Mass Property) в следующей форме:  
_ Moments of Inertia and Radii of Gyration ( w.r.t. Coord. Sys. [0] ):  

_  Length  Area  Volume  Mass  

_ Ixx  | 0  | 0  | 2.08959e+08  | 151412  

_ Iyy  | 0  | 0  | 5.01588e+08  | 363451  

_ Izz  | 0  | 0  | 4.16356e+08  | 301691  

_ Ixy  | 0  | 0  | 1.37226e+08  | 99433.8  

_ Iyz  | 0  | 0  | -7.92274e+07 | -57408.2  

_ Izx  | 0  | 0  | -1.7961e+08  | -130146  

_ Rx  | 0  | 0  | 47.6218  | 47.6218  

_ Ry  | 0  | 0  | 73.7817  | 73.7817  

_ Rz  | 0  | 0  | 67.2213  | 67.2213 

Моменты и произведения инерции также вычисляются относительно центра тяжести в 
указанной координатной системе и выводятся в следующей форме: 

_ Moments of Inertia and Radii of Gyration ( w.r.t. CG's in Coord. Sys.[0]): 

_  Length  Area  Volume  Mass  

_ Ixx  | 0  | 0  | 4.23736e+07  | 30704  

_ Iyy  | 0  | 0  | 6.55942e+07  | 47530.2  
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_ Izz  | 0  | 0  | 3.17729e+07  | 23022.7  

_ Ixy  | 0  | 0  | 234.25  | 0.358757  

_ Iyz  | 0  | 0  | -205.045  | -0.266214  

_ Izx  | 0  | 0  | 9.18023e+06  | 6652.03  

_ Rx  | 0  | 0  | 21.4448  | 21.4449  

_ Ry  | 0  | 0  | 26.6813  | 26.6815  

_ Rz  | 0  | 0  | 18.5696  | 18.5697 

Как и для плоских объектов, существуют взаимно перпендикулярные оси, проходящие 
через одну точку, для которых произведение инерции равно нулю. Такие оси назы-
ваются главными осями. Ориентация главных осей находится, если принять произве-
дения инерции для любых осей равными нулю и найти направляющие косинусы. Ес-
ли известна одна из главных осей, то остальные оси могут быть найдены с 
использованием  правила для плоскостных конструкций. Ниже приведены главные 
моменты инерции относительно центра тяжести: 
_ Principal Moments of Inertia ( w.r.t. CG's ) :  

_  Length  Area  Volume  Mass  

_ I1  | 0  | 0  | 6.55942e+07  | 47530.2  

_ I2  | 0  | 0  | 4.76737e+07  | 34544.5  

_ I3  | 0  | 0  | 2.64727e+07  | 19182.2 

Ниже приведены соответствующие направляющие косинусы главных осей относи-
тельно указанной координатной системы: 
_ Direction Cosine Vectors ( w.r.t. Coord. System [0] ) :  

_  Length  Area  Volume  Mass  

_ a11  | 0  | 0  | 6.96051e-06  | 1.00935e-05  

_ a21  | 0  | 0  | 1  | 1  

_ a31  | 0  | 0  | 7.95191e-06  | 1.36022e-05  

_ a12  | 0  | 0  | 0.866029  | 0.866028  

_ a22  | 0  | 0  | 5.59952e-06  | 1.36757e-05  

_ a32  | 0  | 0  | 0.499994  | 0.499995  

_ a13  | 0  | 0  | 0.499994  | 0.499995  

_ a23  | 0  | 0  | 3.40637e-06  | 6.73322e-06  

_ a33  | 0  | 0  | -0.866029  | -0.866028 
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Глава 7. 
Нагрузки и граничные условия  
Введение  

В этой главе приведено краткое описание команд для задания нагрузок и граничных 
условий в Основной Системе. Более подробная информация о приложении различ-
ных типов нагрузок, граничных условий, уравнениях ограничений, зависимостях уз-
лов, координатных системах и другом приведена в Руководстве пользователя 
COSMOS/M (Т. 1). 

Нагрузки и граничные условия в Основной Системе  
Нагрузки, которые можно приложить в Основной Системе могут быть классифициро-
ваны следующим образом: 

! Механические нагрузки 

! Термальные нагрузки 

! Гравитационные нагрузки 

Механические нагрузки включают сосредоточенные силы, распределенные нагрузки, 
моменты, вынужденные перемещения и т.д. Гравитационные нагрузки включают на-
грузки от действия гравитации, действия инерции и т.д. В термальные нагрузки вхо-
дят температуры, сообщенные узлам КЭ-модели. В COSMOS/M гравитационные и 
термальные нагрузки называются особыми, и требуют установки особого признака в 
команде A_STATIC (Analysis > STATIC > Static Analysis Options). Вы можете создавать 
более одного варианта нагрузки, связанного со всеми этими типами нагрузки. 

В Основной Системе в граничные условия входят ограничения по перемещениям. 
Кроме этого вы можете налагать зависимости на степени свободы в узлах и задавать 
уравнения ограничения между ними. Возможность «скрепления» описанная в Главах 
1 и 3 является особым вариантом уравнений ограничения, которые прикладываются 
на уровне геометрических примитивов. 

В Таблице 7-1 приведены подменю, содержащие команды для приложения нагрузок и 
граничных условий в Основной Системе. Подменю, приведенные в этой таблице, на-
ходятся в меню Loads-BC. Более подробная информация об использовании команд из 
этих подменю приведена в Главе 3, Руководства пользователя COSMOS/M (Т. 1). 

Таблица 7-1. Меню, содержащие команды для приложения нагрузок и граничных условий  

Тип нагрузок/граничных условий  Меню 
Механические нагрузки LoadsBC > STRUCTURAL > DISPLACEMENT  

LoadsBC > STRUCTURAL > FORCE  
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LoadsBC > STRUCTURAL > PRESSURE 
Гравитационные нагрузки LoadsBC > STRUCTURAL > GRAVITY  
Термальные нагрузки LoadsBC > THERMAL > TEMPERATURE  

LoadsBC > LOAD OPTIONS 
Граничные условия LoadsBC > STRUCTURAL > DISPLACEMENT  

LoadsBC > STRUCTURAL > COUPLING  
LoadsBC > STRUCTURAL > BONDING 

Реакции опор Analysis 
Температурно-зависимые нагрузки LoadsBC > FUNCTION CURVE 
Сокращение степеней свободы в частотно рас-
чете (метод Ги)  

LoadsBC > STRUCTURAL > MASTER DOF 

Множественные варианты нагрузки в Основной Системе  
Во многих случаях требуется вычислить отклик конструкции от различных типов на-
грузки по отдельности. Для линейных задач матрица жесткости постоянна, а вектор 
нагрузки изменяется при изменении нагрузки. Если рассматривать отдельные усло-
вия нагружения как отдельные задачи, то большинство шагов решения будут иден-
тичны, включая вычисление матрицы жесткости и ее разложение. Таким образом бу-
дет выгодно вычислить и разложить матрицу жесткости только один раз и 
использовать ее для вычисления результатов при различных условиях нагружения. 

Условие нагружения в GEOSTAR называется вариантом нагрузки (load case). По 
умолчанию активным является вариант нагрузки номер 1, и все задаваемые нагрузки 
будут связаны с вариантом нагрузки 1. Другие варианты нагрузки могут быть акти-
визированы командой ACTSET (Control > ACTIVATE > Set Entity), в которой имя 
примитива указывается равны LC (вариант нагрузки). Все нагрузки, связанные с ак-
тивным вариантом нагрузки не будут влиять на другие варианты нагрузки. Вариант 
нагрузки, задаваемый командой LCSET (Analysis > STATIC > Activate Load Case) на-
зывается первичным вариантом нагрузки. Можно создать до 50 первичных вариантов 
нагрузки. 

Исходя из принципа суперпозиции отклик конструкции от нагрузки, полученной ли-
нейной комбинацией двух других нагрузок, может быть получен такой же линейной 
комбинацией результатов от этих нагрузок. Команда LCCOMB (Results > Combine 
Load Case) используется для создания нового варианта нагрузки и вычисления ре-
зультатов линейной комбинацией других вариантов нагрузки. Варианты нагрузки, 
создаваемые командой LCCOMB (Results > Combine Load Case) называются вторич-
ными вариантами нагрузки. Можно создать до 50 вторичных вариантов нагрузки. 
Команды, приведенные в таблице, применяются для работы с множественными вари-
антами нагрузки: 

Таблица 7-2. Команды для работы с множественными вариантами нагрузки  

Команда  Функция 
ACTSET  Активизирует некоторый вариант нагрузки  
LCCOMB  Создает вторичный вариант нагрузки  
LCSET  Позволяет пользователю выбирать варианты нагрузки, которые убудут рас-

считаны, и которые будут игнорированы. По умолчанию рассчитываются 
все первичные варианты нагрузки. 

LCLIST  Выводит заданные варианты нагрузки 

В то время как нагрузка изменяется в различных вариантах нагрузки, граничные усло-
вия остаются неизменными. Однако, существует возможность комбинировать вари-
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анты нагрузки с различными граничными условиями: 

! Задайте один или более вариантов нагрузки с некоторыми граничными условия-
ми. 

! Командой R_STATIC (Analysis > STATIC > Run Static Analysis) выполните расчет. 

! Задайте новые граничные условия. 

! Задайте новые варианты нагрузки. 

! Командой LCSET (Analysis > STATIC > Activate Load Case) деактивируйте уже 
рассчитанные варианты нагрузки. 

! Командой R_STATIC (Analysis > STATIC > Run Static Analysis) выполните расчет 
для новых вариантов нагрузки. 

! Командой LCCOMB (Analysis > STATIC > Combine Load Case) комбинируйте ре-
зультаты различных вариантов граничных условий как вам необходимо. 

При использовании множественных вариантов нагрузки следует иметь в виду сле-
дующее: 

! Если в модели присутствует элемент GAP, то в большинстве случаев вторичные 
варианты нагрузки будут бессмысленны. 

! Если учитываются плоскостные эффекты, то расчет выполняется только для ак-
тивного варианта нагрузки. 

! Если выполняется расчет устойчивости или нелинейный расчет, а в базе данных 
находятся множественные варианты нагрузки, то рассматривается только актив-
ный вариант нагрузки. 

Результаты от вторичных вариантов нагрузки не записываются в файл вывода, но лис-
тинг результатов может быть получен командой LISTLOG (Control > 
MISCELLANEOUS > List Log) и некоторыми другими командами вывода списков. 

Гравитационные, центробежные и термальные нагрузки называются особыми нагруз-
ками и рассматриваются если в команде A_STATIC (Analysis > STATIC > Static 
Analysis Options) был включен признак особых нагрузок. Особые нагрузки также свя-
зываются с активным на момент их задания вариантом нагрузки и могут быть ском-
бинированы с другими механическими нагрузками. 

ПРИМЕЧАНИЕ: Не пытайтесь использовать множественные варианты нагрузки, ес-
ли для статического, модельного расчетов и расчета устойчивости активизированы 
плоскостные эффекты (дифференциальная жесткость). Программа вычисляет резуль-
таты только для активного варианта нагрузки. 
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Множественные варианты термальных нагрузок  

Термальные эффекты могут быть включены во все 50 первичных вариантов нагрузки 
дополнительно к другим типам нагрузки. Чтобы термальные эффекты учитывались в 
статическом расчете, пользователь должен активизировать признак термальной на-
грузки в команде A_STATIC (Analysis > STATIC > Static Analysis Options). Термальная 
нагрузка может быть задана двумя способами: 

a. Пользовательские профили температуры: 
Узловые температуры задаются с помощью команд в подменю LoadsBC > 
TEMPERATURE. Заданные температуры будут связаны с активным первичным ва-
риантом нагрузки. Команда TREF (LoadsBC > LOAD OPTIONS > Reference Temp) ис-
пользуется для задания начальной температуры. 

b. Профили температуры считываются из расчета теплопереноса:  
Профили температуры из указанных временных шагов назначаются соответствую-
щим первичным вариантам нагрузки командой TEMPREAD (LoadsBC > LOAD 
OPTIONS > Read Temp as Load). Расчет теплопереноса должен быть выполнен до вы-
полнения статического расчета на той же базе данных с использованием модулей 
HSTAR или FFE Thermal. Для считывания профиля температуры из расчета теплопе-
реноса устойчивого состояния в команде TEMPREAD (LoadsBC > LOAD OPTIONS > 
Read Temp as Load) должен использоваться временной шаг номер один. 

При использовании термальной нагрузки следует учитывать следующие ограничения: 

1. Если пользователь связывает временной шаг термального расчета с некоторым ва-
риантом нагрузки, то узловые температуры, заданные пользователем для этого шага 
будут проигнорированы. 

2. Вы можете использовать оба способа, описанных выше (a и b), в одной задаче, но в 
разных вариантах нагрузки. 

3. Если вы используете свойства материала, зависимые от температуры, то матрица 
жесткости вычисляется на основе интерполированных свойств материала, получае-
мых на основе первого рассматриваемого варианта нагрузки (то есть варианта на-
грузки с наименьшим номером) независимо от природы этого варианта нагрузки (то 
есть присутствуют в нем термальные эффекты или нет). 

4. Если задан градиент температуры, от для всех элементов, для которых можно, гра-
диент температуры будет приложен, если установлен признак термальной нагрузки. 

5. Начальная температура применима только к термальным вариантам нагрузки. Тер-
мальный вариант нагрузки � вариант нагрузки с приложенным профилем температу-
ры. 

6. Поскольку в расчете устойчивости и в других вариантах расчета, где вычисляется 
геометрическая жесткость, расчет выполняется только для активного варианта на-
грузки, то в расчете будут рассматриваться только температуры, связанные с актив-
ным вариантом нагрузки. 
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7. Для просмотра профилей температуры, считанных из временных шагов термально-
го расчета и назначенных первичным вариантам нагрузки используется команда 
TEMPRDLIST (LoadsBC > LOAD OPTIONS > List Step/Load Case). 

Файл TEMP1.GEO в разделе примеров иллюстрирует использование команд для зада-
ния множественных вариантов термальной нагрузки. 
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Глава 8. 
Советы по моделированию  
Введение 

В данной главе представлены советы по моделированию в некоторых особых случаях 
в Основной Системе. Более подробная информация приведена в Главе 3 Руководства 
пользователя COSMOS/M (Т. 1). 

«Скрепление» КЭ-сетей с несовместимыми элементами  
Возможность «скрепления» позволяет пользователю соединять КЭ-сети любых двух 
пересекающихся геометрических примитивов без необходимости соблюдать совмес-
тимость или непрерывность КЭ-сетей в месте соприкосновения. В таблице приведе-
ны геометрические примитивы и соответствующие типы элементов, которые могут 
быть «скреплены»: 

Таблица 8-1. Геометрические примитивы, используемые при «скреплении»  

 

В таблице SHELL обозначает все 3-узловые треугольные и 4- или 9-узловые четырех-
угольные элементы оболочки, поддерживаемые в COSMOS/M. Аналогично, SOLID 
обозначает 8- или 20-узловые шестигранные элементы, а также 4- или 10-узловые 
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элементы TETRA и 4-узловой элемент TETRA4R. Также в таблице показаны типич-
ные применения возможности «скрепления». 

ПРИМЕЧАНИЕ: Возможность «скрепления» в текущей версии применима только 
линейному статическому, нелинейному конструкционному расчетам и расчету теп-
лопереноса. 

«Скрепление» задается с использованием команд подменю LoadsBC > STRUCTURAL 
> BONDING. Команда BONDDEF (LoadsBC > STRUCTURAL > BONDING > Define 
Bond Parameter) «скрепляет» грани элементов, связанные с выбранными геометриче-
скими примитивами. Пользователь указывает первый примитив (КРИВУЮ, 
ПОВЕРХНОСТЬ или ОБЛАСТЬ) и шаблон целевых примитивов (КРИВЫХ, 
ПОВЕРХНОСТЕЙ или ОБЛАСТЕЙ). Перед выполнением этой команды для всех 
примитивов должна быть сгенерирована КЭ-сеть, чтобы информация о «скреплении» 
была создана корректно. Ребра/грани элементов, связанные с первым геометриче-
ским примитивом «скрепляются» с ребрами/гранями вторых примитивов. Эта коман-
да используется при соединении частей модели с несовместимыми в месте соприкос-
новения КЭ-сетями.  

Команда BONDLIST (LoadsBC > STRUCTURAL > BONDING > List) используется для 
вывода наборов «скрепления», ранее созданных командой BONDDEF (LoadsBC > 
STRUCTURAL > BONDING > Define Bond Parameter). Ниже приведен типичный ре-
зультат выполнения этой команды: 
Set Stype Source Ttype #Targets Targets  
1  CR  53  SF  1  7  
2  CR  50  SF  1  7  
3  CR  47  SF  1  7  
4  CR  44  SF  1  7  
5  CR  41  SF  1  7 

Примеры скрепления  
На рисунках показаны примеры несовместимых КЭ-сетей, для которых требуется 

«скрепление». 

 

Рис. 8-1. Соединение тела и оболочки  
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Рис. 8-2. Соединение оболочки и оболочки 

 

Рис. 8-3. Соединение тела и тела 

 

Рис. 8-4. Соединение оболочки и оболочки 

 

Рис. 8-5. Соединение  оболочки и оболочки  

Рекомендации по использованию «скрепления» 
При использовании этой функции следует иметь в виду следующее: 

! Команда BONDDEF (LoadsBC > STRUCTURAL > BONDING > Define Bond 
Parameter) использует уравнения ограничений для обеспечения совпадения пере-
мещений и вращений. Тесты проверки качества показали, что для частей с разум-
ными свойствами жесткости и плотностями КЭ-сетей, максимальные значения 
перемещений и напряжений, полученные при использовании «скрепления» отли-
чаются от значений, полученных при использовании модели с совместимыми 
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элементами и совпадающими узлами, не более чем на 10%. 

! В текущей версии «скрепление» применимо только к линейному статическому, 
частотному, нелинейному конструкционному расчетам и расчетам устойчивости и 
теплопереноса. 

! В команде BONDDEF (LoadsBC > STRUCTURAL > BONDING > Define Bond Pa-
rameter) предлагается выбор между однонаправленным «скреплением» (то есть 
соединением узлов на первом примитиве с элементами на втором примитиве) или 
двунаправленным «скреплением» (то есть соединением узлов на каждом прими-
тиве с элементами на другом примитиве). Однонаправленное «скрепление» сле-
дует использовать при соединении элементов низкого порядка на первом прими-
тиве с элементами высокого или низкого порядка на втором примитиве. 
Двунаправленное «скрепление» следует использовать при соединении элементов 
высокого порядка на первом примитиве с элементами высокого порядка на вто-
ром примитиве. На рисунке показано однонаправленное и двунаправленное 
«скрепление». 
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Рис. 8-6. Однонаправленное и двунаправленное «скрепление»  

! При скреплении объемных тел и оболочек рекомендуется использовать оболочки 
в качестве первых примитивов, а тела в качестве вторых, независимо от порядка 
элементов. 

! Когда элементы оболочки соединяются с объемными элементами, совпадающие 
узлы на общих границах не следует «сливать», поскольку это освободит угловые 
степени свободы оболочки в этом узле. В таких задачах рекомендуется, чтобы 
совпадающих узлов вообще не было. Если соединяются оболочки с оболочками, 
или тела с телами, то «слияние» совпадающих узлов допускается. 

! В задачах, где сосредоточение напряжений в месте «скрепления» критично, обе 
части должны обладать частой КЭ-сетью в этой области, даже если две КЭ-сети 
не совпадают (см. рис.). Для определения области, которой требуется улучшить 
КЭ-сеть, может понадобиться выполнение предварительного расчета с грубой се-
тью. 
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Рис. 8-7. Стратегия генерации КЭ-сети в месте «скрепления»  

! Результаты, полученные при использовании команды BONDDEF (LoadsBC > 
STRUCTURAL > BONDING > Define Bond Parameter) могут вырождаться в зада-
чах, где жесткая часть соединена с относительно гибкой. «Скрепленная» область 
гибкой части подвергается выворачиванию или обладает высокими градиентами 
перемещений. Результаты станут более точными, если в области «скрепления» 
увеличить плотность КЭ-сети для гибкой части. 

! Действующие уравнения ограничений между узлами первого и второго примити-
вов составляются и вычисляются на стадии расчета. 

Использование подмоделей  
После выполнения расчета с относительно грубой КЭ-сетью вы можете определить 
интересующие вас области, в которых напряжения могли быть рассчитаны неточно 
из-за острых углов, неоднородностей геометрии или нагрузок, как подмодели. КЭ-
сеть в подмодели будет улучшена и вы можете выполнить расчет повторно для уточ-
нения результатов только для подмодели, без изменения результатов для остальной 
модели. Процесс подмоделирования ускоряет получение точных результатов в об-
ластях сосредоточения напряжений для больших задач. С использованием подмоде-
лирования вы избежите необходимости рассчитывать всю модель, включая области 
меньшей важности, в которых для получения удовлетворительных результатов дос-
таточно использование грубой КЭ-сети. 
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Рис. 8-8. Типичная подмодель с улучшенной КЭ-сетью  

Принципы подмоделирования  

Подмоделирование основано на принципе Св. Венанта. Вы можете «вырезать» часть 
модели и выполнить расчет только для выбранной части при условии правильного 
приложения перемещений в границах выбранной части. Если перемещения на грани-
цах выбранной части были точно рассчитаны при первом расчете, то их можно рас-
сматривать как граничные условия для расчета подмодели. Границы подмодели 
должны быть расположены на адекватном расстоянии от областей сосредоточения 
напряжений. 

Преимущества подмоделирования  

! Для больших задач (то есть с более чем 10 000 степенями свободы), подмодели-
рование позволяет сэкономить время и вычислительные ресурсы. 

! Вы получаете точные решения в местах сосредоточения напряжений. 

! Позволяет последовательно изменять части модели во время процесса разработ-
ки. 

Доступные элементы 

Участок КЭ-сети для улучшения должен состоять из следующих треугольных элемен-
тов. 

! Линейные элементы TRIANG  

! SHELL3, SHELL3T и SHELL3L 

! TETRA4 и TETRA4R 
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Доступные возможности и функции  

1. Хотя участок КЭ-сети, который необходимо улучшить, должен состоять только из 
вышеупомянутых элементов, остальная часть модели может содержать любые эле-
менты. 

2. В любой момент времени вы можете деактивировать подмоделирование и выпол-
нить расчет для всей модели. 

3. Для создания подмодели может быть выбрано несколько раздельных частей модели. 

4. После выполнения расчета для подмодели вы можете задать новые произвольные 
подмодели. 

5. Пользователю не следует заботиться об узловых силах или распределенных нагруз-
ках на элементы внутри подмодели, поскольку улучшение выполняется без переме-
щения узлов. Однако в случае с узловыми температурами, пользователю может по-
требоваться задать температуры во вновь созданных узлах в подмодели. 

6. Вы можете использовать подмодель совместно с множественными вариантами на-
грузки. 

7. Поля перемещений и напряжений вне подмодели остаются неизменными во время 
выполнения расчета подмодели и могут быть интегрированы с перемещениями и на-
пряжениями в подмодели во время постпроцессинга деактивированием списка выбо-
ра элементов. 

Этапы подмоделирования  

Процесс подмоделирования очень прост. Он состоит из следующих этапов: 

1. Выполните расчет для всей модели с относительно грубой КЭ-сетью. 

2. Создайте список выбора элементов с использованием команд подменю Control > 
SELECTION. 

3. Активизируйте подмоделирование командой SUBMODEL (Analysis > STATIC > De-
fine SubModel). 

4. Выполните расчет командой R_STATIC (Analysis > STATIC > Run Static Analysis). 

5. Используйте команды постпроцессинга для отображения результатов как обычно. 
Вы можете работать только с подмоделью или отключить список выбора, чтобы вы-
полнять постпроцессинг для всей модели. 

6. Повторите процесс для новых подмоделей, если необходимо. В Главе 11 приведен 
пример подмоделирования. 

Получение напряжений из статического линейного расчета в тре-



 156

буемой координатной системе  
Во многих случаях требуется получить напряжения в некоторой координатной систе-
ме. В COSMOS/M напряжения могут быть получены в любой заданной Декартовой, 
цилиндрической или сферической координатной системе. Следует заметить, что вы-
бор следует делать до выполнения команды R_STATIC (Analysis > STATIC > Run 
Static Analysis) или R_STRESS (Analysis > STATIC > Run Stress Analysis). Если пере-
мещения уже были рассчитаны, то достаточно выбрать необходимую координатную 
систему и выполнить команду R_STRESS (Analysis > STATIC > Run Stress Analysis). 
Координатная система, которая будет использована при вычислении напряжений для 
каждого элемента, управляется двумя признаками. 

Первый признак � опция в команде EGROUP (Propsets > Element Group), указывающая в 
локальной или глобальной координатной системах необходимо получить напряже-
ния. Эта опция доступна для всех двухмерных (TRIANG, PLANE2D и все элементы 
семейства SHELL) и трехмерных элементов (SOLID и все элементы семейства 
TETRA). 

Второй признак � это атрибут элемента, в Руководствах пользователя называемый ко-
ординатной системой элемента (ECS). Также как и группы элементов, наборы 
свойств материала и вещественных констант, ECS выводится для каждого элемента 
командой ELIST (Edit > LIST > Elements). Для связывания элементов с некоторой ECS 
используется команда ACTSET (Control > ACTIVATE > Set Entity) для активизирова-
ния необходимой ECS перед созданием этих элементов. Значение ECS для шаблона 
элементов может быть изменено командой EPROPCHANGE (Propsets > Change El-
Prop). Значение по умолчанию для ECS равно -1, обозначающее локальную коорди-
натную систему элемента, определяемую порядком задания узлов, как описано для 
каждого элемента в Главе 4 Руководства пользователя COSMOS/M (Т. 1) 

Признак в группе элементов определяет использовать ли заданные значения ECS. Ес-
ли используется вариант глобальной системы (по умолчанию), то напряжения вы-
числяются в глобальной Декартовой координатной системе (номер 0), вне зависимо-
сти от указанных значений ECS. Если используется вариант локальной системы, то 
управление переходит к значению ECS для всех элементов в этой группе и напряже-
ния вычисляются в указанной координатной системе для каждого элемента. Для эле-
ментов оболочки иногда бывает необходимо изменить ECS, спроецировав ее на по-
верхность оболочки. 

Следует помнить, что процесс усреднения напряжений основан на значениях, полу-
ченных в указанной координатной системе для каждого элемента. Напряжения в цен-
тре элемента получаются усреднением напряжений в узлах элемента. Напряжений в 
узле вычисляются усреднением соответствующих значений для всех двух- и трех-
мерных элементов, для которых этот узел является общим. Если усреднение произ-
водится в разных координатных системах, то часто получаются смешанные или бес-
смысленные результаты. Тот факт, что усреднение производится по спискам выбора, 
помогает, если различные значения ECS были намерено присвоены различным эле-
ментам. Списки выбора создаются командами в подменю Control > SELECT.  

Силы и напряжения в одномерных элементах всегда вычисляются в ECS=-1 и не рас-
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сматриваются при вычислении узловых напряжений усреднением. 
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Глава 9. 
Выполнение расчета  
Введение 

Расчет для многих КЭ-моделей в COSMOS/M выполняется очень просто. Как вы мог-
ли увидеть из третьей главы, независимо от размера модели подготовка исходных 
данных для КЭ-модели и передача ее на расчет организованны в эффективные меню. 
Это также позволяет выполнять различные расчеты на одной геометрии задачи, не 
покидая GEOSTAR. Кроме этого, результаты, полученные в одном модуле, можно 
перенести и использовать их в другом модуле в качестве нагрузок для междисципли-
нарного расчета (см. Главу 12). Для согласования потребностей новичка и опытного 
пользователя в COSMOS/M доступен гибкий набор инструментов, делающий про-
цесс выполнения расчета эффективным. 

В данной главе описаны команды, необходимые для выполнения расчета в Основной 
Системе, причем особое внимание уделено установке настроек расчета и вывода ре-
зультатов. Более подробная информация о командах, упомянутых в данной главе, 
приведена в Справочнике Команд COSMOS/M (Том 2). Также в этой главе описаны 
наиболее часто встречающиеся неполадки, возникающие при расчете в Основной 
Системе и пути их устранения. 

Выполнение расчета в COSMOS/M 
Процесс выполнения расчета в Основной Системе может быть разбит на следующие 
этапы: 

! Предрасчетные операции  

! Задание настроек вывода результатов  

! Перенос нагрузок для междисциплинарного расчета  

! Задние настроек расчета  

! Проверка настроек расчета  

! Выполнение расчета  

В таблице приведены команды, необходимые для каждого из этапов. 

Таблица 9-1. Этапы расчета и необходимые команды  

Этап расчета Команды* 
Предрасчетные операции SHOW_MERGE, NMERGE, 

NCOMPRESS  
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ECOMPRESS  
ECHECK  
REACTION  
DATA_CHECK  
R_CHECK  
RENUMBER  
STRESS 

Задание настроек вывода результатов PRINT_OPS  
PRINT_NDSET  
PRINT_ELSET  
RFND, RFPT, RFCR, RFSF, RFCT, RFRG 

Перенос нагрузок для междисциплинарного расче-
та (из модулей ESTAR, FLOWSTAR и HSTAR)  

EMFREAD  
NPRREAD  
TEMPREAD 

Задание настроек расчета LCSET, LCLIST  
A_STATIC  
A_STRESS  
ADAPTIVE  
A_BUCKLING  
A_FREQUENCY 

Проверка настроек расчета  A_LIST 
Выполнение расчета R_STATIC  

R_STRESS  
R_BUCKLING  
R_FREQUENCY 

* Соответствие кратких и полных имен указано в Приложении B. 

ПРИМЕЧАНИЕ: Если не указано иначе, то все команды, упоминаемые в данной гла-
ве находятся в меню Analysis, подменю OUTPUT OPTIONS, STATIC и 
FREQUENCY/BUCKLING. 

Предрасчетные операции  
Предрасчетными операциям называются те операции, которые необходимо выполнить 
до передачи модели на расчет. В эти операции может входить «слияние» узлов, про-
верка данных модели на ошибки, задание настроек для перенумерации узлов и вы-
числения напряжений. В нижеследующих параграфах эти операции изложены более 
подробно. 

Требования к совместимости  

Поскольку генерация КЭ-сети выполняется независимо для различных частей модели, 
то в ней будут присутствовать дублирующиеся узлы на общих граничных КРИВЫХ 
и ПОВЕРХНОСТЯХ. Из требований к совместимости следует, что узлы на общих 
границах должны быть «слиты», чтобы избежать неполадок при расчете (единствен-
ное исключение � элемент трещины). В качестве примера рассмотрим геометрию за-
дачи, показанную на рисунке: 



 160

 

Рис. 9-1. «Слияние» узлов на общих границах  

Для идентификации созданных узлов используется команда NIDENT (Edit > IDENTIFY 
> Nodes ). Метки узлов на общей границе, на которые указывает стрелка равны: 

Control Panel: Edit > IDENTIFY > Nodes 
Pick node id :19,37.5 25 0, 
Pick node id :14,37.5 25 0, 

Можно заметить, что узлы 14 и 19 имеют одинаковые координаты x, y и z (37.5, 25, 0), 
и один из этих узлов должен быть «слит» командой NMERGE (Meshing > NODES > 
Merge). Команда SHOW_MERGE (Meshing > NODES > ShowMerged Node) используется 
для определения узлов, которые необходимо»слить». После использования команды 
NMERGE (Meshing > NODES > Merge) совпадающие (с указанным допуском) узлы бу-
дут «слиты». Вы можете выполнять «слияние» выборочно, или по всем узлам. Узлы 
будут «слиты» только в том случае, если разности между соответствующими коор-
динатами X, Y и Z меньше указанного допуска. Признак all/among указывает, выпол-
нять «слияние» по всем узлам в модели, или только по указанным. Признак echo ука-
зывает, выводить ли сообщение при «слиянии» двух узлов. Признак low/high 
определяет какой узел будет оставлен, а какой удален при «слиянии» двух узлов. 

После выполнения «слияния» автоматически обновляются связности элементов, на-
грузки и граничные условия. Если к обоим «сливаемым» узлам были приложены на-
грузки или граничные условия, то оставляется нагрузка/граничные условия с наи-
большей величиной. Если нагрузки или граничные условия, наложенные на 
«сливаемые» узлы, заданны в различных координатных системах, то будут оставле-
ны нагрузки/граничные условия оставляемого узла, а нагрузки/граничные условия 
удаляемого узла игнорируются. 

Если вы хотите создать КЭ-сеть на основе существующих геометрических примити-
вов, для которых уже была сгенерирована КЭ-сеть, операциями выдавливания, «ох-
ватывания», переворачивания, перемещения и т.д., то рекомендуется (для корректно-
го связывания КЭ-сети с геометрическими примитивами) отложить использование 
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команды NMERGE (Meshing > NODES > Merge) до тех пор, пока все такие операции 
не будут выполнены. 

Поскольку при «слиянии» некоторые узлы удаляются, то номера узлов не будут по-
следовательными. Команда NCOMPRESS (Edit > COMPRESS > Nodes) производящая 
последовательную перенумерацию узлов в указанном диапазоне,  используется для 
удаления разрывов в нумерации. 

ПРИМЕЧАНИЕ: В общем случае рекомендуется использовать команду NCOMPRESS 
(Edit > COMPRESS > Nodes), так что полученные последовательные номера узлов не 
будут превышать верхний предел на число узлов. 

ПРИМЕЧАНИЕ: Аналогично, если вы удалили часть вашей модели, то рекомендует-
ся использовать команду ECOMPRESS (Edit > COMPRESS > Elements), так что полу-
ченные последовательные номера элементов не будут превышать верхний предел 
числа элементов. 

Проверка модели  

Для предоставления большей гибкости и для новичков, и для опытных пользователей, 
в COSMOS/M используется иерархический подход к проверке данных КЭ-модели до 
передачи ее на расчет. Вы можете проверить правильность данных только для вы-
бранных компонентов или для всей модели. Более того, вы также можете проверить, 
имеет ли смысл полная КЭ-модель. 

Команда ECHECK (Meshing > ELEMENTS > Check Elements) проверяет соотношение 
сторон элементов для указанного шаблона. Если соотношение сторон элемента пре-
вышает указанное значение, то выводится соответствующее сообщение. Команда ав-
томатически удаляет вырожденные элементы из базы данных. Рекомендуется выпол-
нять эту команду до выполнения расчета. 

Команда DATA_CHECK (Analysis > Data Check) проверяет наличие связанных группы 
элементов, набора свойств материала и набора вещественных констант (если необхо-
димы) для каждого элемента в базе данных. GEOSTAR автоматически накладывает 
ограничения на излишние степени свободы. Эта команда не накладывает никаких ог-
раничений. Рекомендуется выполнять команду DATA_CHECK (Analysis > Data Check) 
перед всеми этапами решения. 

ПРИМЕЧАНИЕ: Команда DATA_CHECK (Analysis > Data Check) является подмноже-
ством команды R_CHECK (Analysis > Run Check), выполняющей и другие операции 
проверки. Таким образом, для тщательной проверки КЭ-модели следует использо-
вать команду R_CHECK (Analysis > Run Check). 

Команда R_CHECK (Analysis > Run Check) выполняет тщательную проверку базы дан-
ных задачи и записывает отчет о статусе исходных данных в файл probname.CHK. 

Выполняются следующие проверки: 

1. Выполняет все функции команды DATA_CHECK (Analysis > Data Check), а именно: 
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проверяет наличие связанных группы элементов, набора свойств материала и набора 
вещественных констант для каждого элемента. 

2. Выводит предупреждение, если для задания элемента используется несуществую-
щий узел. 

3. Для элемента PLANE2D и всех элементов оболочки выводит предупреждение в сле-
дующих случаях: 

a. Если соотношение сторон элемента превосходит 5.0. 

b. Если угол в 3-узловом элементе меньше 20 или больше 135 градусов. 

c. Если угол в 4-узловом элементе меньше 45 или больше 135 градусов. 

4. Для объемны элементов проверяется только соотношение сторон. 

5. Для элементов BEAM3D и BOUNDARY, а также для всех треугольных элементов 
оболочки, проверяется связность и если площадь, ограничиваемая элементом меньше 
1.0E-15 выводится предупреждение. 

Рекомендуется всегда использовать эту команду перед выполнением любого расчета. 

Типичный отчет команды R_CHECK (Analysis > Run Check) имеет вид: 
Output from CHECK program  
Maximum node label  =  63  
Number of nodes  =  63  
Maximum element label  =  48  
Number of elements  =  48  
Check all elements (Aspect ratio, Material properties  
Connectivities, Real constants, . . .)  
Total number of elements checked =  48  
Total warnings found  0  
Total errors found  0  
Checking completed 

Разрешение/запрещение вычислений напряжений  

Команда STRESS управляет вычислением напряжений. По умолчанию напряжения 
всегда вычисляются. Однако в больших задачах рекомендуется вычислять только пе-
ремещения и проверить решение перед вычислением напряжений. 

Перенумерация узлов  

Команда RENUMBER (Analysis > Renumber) производит перенумерацию узлов для 
уменьшения профиля и диапазона матрицы жесткости. Команда RENUMBER (Analysis 
> Renumber) только считывает и хранит значение аргумента flag. В действительности 
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перенумерация выполняется расчетным модулем. 

ПРИМЕЧАНИЕ: Если вы не выполните эту команде, то программа будет выполнять-
ся без перенумерации. 

При выполнении любого расчетного модуля сначала выполняется перенумерация (мо-
дуль RENUM), затем идет обработка исходных данных (модуль PRE1), после чего 
выполняются расчетные модули. Отчет о перенумерации записывается в файл job-
name.RNM.  

 

Рис. 9-2. Модель для перенумерации  

Ниже приведен типичный отчет о перенумерации: 
Number of nodes  =  10  
Number of elements  =  12  
Before resequencing - - -  

Node difference  8  
Profile  37  
Average node difference  3.70  
RMS node difference  3.96  

After resequencing by GPS  
Node difference  3  
Profile  28  
Average node difference 2.80  
RMS node difference  2.90   

 1  1  1  
 ... ...  
The time required to reduce the Bandwidth is 1 Seconds 

Задание настроек вывода результатов  
Команда PRINT_OPS (Analysis > OUTPUT OPTIONS > Set Print Options) управляет за-
писью перемещений, скоростей, ускорений, форм мод, матрицы жесткости, темпера-
тур, градиентов температуры, значений теплового потока и исходных данных в файл 
вывода. Управление выводом перемещений, скоростей, ускорений, координат форм 
мод и пр. осуществляется с помощью соответствующих признаков. Кроме этого, если 
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вы установите признак вывода исходных данных, до в файл вывода будут записаны 
координаты узлов, связности элементов, наборы свойств материала и вещественных 
констант, приложенные нагрузки и т.д.  

Фильтрованный вывод  

В больших задачах файл вывода может иметь очень большой размер, поскольку по 
умолчанию результаты выводятся для всех узлов и элементов. Однако можно перед 
выполнением расчета указать узлы и/или элементы, для которых будут выводиться 
результаты. Команда PRINT_NDSET (Analysis > OUTPUT OPTIONS > Set Nodal Range) 
задает группы узлов, для которых в файл вывода будут записаны значения переме-
щений, скоростей и ускорений (используется только с модулями STAR и NSTAR). 
Можно задать до 10 групп. 

Команда PRINT_ELSET (Analysis > OUTPUT OPTIONS > Set Element Range) задает 
группы элементов, для которых в файл вывода будут записаны значения напряжений 
(используется только с модулями STAR и NSTAR). Можно задать до 10 групп. 

Силы реакции  

Команда REACTION (Analysis > Reaction) управляет вычислением сил и/или моментов 
реакции во всех степенях свободы с наложенными ограничениями. Силы реакции 
могут быть получены только для тех степеней свободы, на которые наложены пред-
писанные перемещения. 

Равновесие сил  

Вы можете запросить равновесие сил в каждом узле, установив соответствующий при-
знак в команде A_STATIC (Analysis > STATIC > Static Analysis Options). Модуль STAR 
рассчитывает и выводит силы во всех элементах, имеющих общий узел. Силы в каж-
дом свободном узле должны находится в равновесии. Однако, в узлах с наложенны-
ми на них ограничения внутренние силы должны уравновешиваться силами реакции. 
Если вычисление сил реакции не было запрошено, то силы реакции принимаются 
равными неуравновешенным силам с противоположным знаком. Просмотреть силы 
реакции можно командой DISLIST (Results > LIST > Displacement). 

Перенос нагрузок для междисциплинарного расчета  
Команды TEMPREAD (LoadsBC > LOAD OPTIONS > Read Temp as Load), NPRREAD 

(LoadsBC > LOAD OPTIONS > Read Fluid Pressure) и EMFREAD (LoadsBC > LOAD 
OPTIONS > Read Emag Force) используются для переноса нагрузок из модулей 
HSTAR, FLOWSTAR и ESTAR. Подробное описание процедур выполнения междис-
циплинарного расчета с примерами представлено в Главе 12. 

Команда TEMPREAD (LoadsBC > LOAD OPTIONS > Read Temp as Load) связывает уз-
ловые температуры, полученные в термальном расчете устойчивого или переходного 
состояния на некотором временном шаге с вариантом нагрузки линейного статиче-
ского расчета. Если выполнялся расчет теплопереноса устойчивого состояния, то не-
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обходимо указать временной шаг 1. 

ПРИМЕЧАНИЕ: Расчет теплопереноса должен быть выполнен до выполнения этой 
команды. В команде A_STATIC (Analysis > STATIC > Static Analysis Options) должен 
быть установлен признак особой нагрузки, чтобы термальные эффекты были учтены. 

Команда EMFREAD (LoadsBC > LOAD OPTIONS > Read Emag Force) используется для 
магнитно-конструкционного связывания, перенося магнитные узловые силы в конст-
рукционный модуль. Необходимо указать временной шаг (если выполнялся магнит-
ный расчет переходного состояния), из которого магнитостатические силы будут пе-
ренесены в упругостатический расчет. Если выполнялся магнитный расчет 
устойчивого состояния, то необходимо указать временной шаг 1. 

ПРИМЕЧАНИЕ: До выполнения этой команды должен быть выполнен магнитный 
расчет с включенным признаком расчета сил. 

Давление жидкости, вычисленное в модуле FLOWSTAR может быть перенесено в Ос-
новную Систему как распределенные нагрузки на элементы. Команда NPRREAD 
(LoadsBC > LOAD OPTIONS > Read Fluid Pressure) прикладывает вычисленные дав-
ления из любого временного шага к граням элементов, связанных с указанными кри-
выми. Когда вы выполняете эту команду, то программа запросит тип геометрических 
примитивов в поверхностях переноса и их метки. В текущей версии поддерживаются 
только КРИВЫЕ. 

ПРИМЕЧАНИЕ: В текущей версии команда NPRREAD (LoadsBC > LOAD OPTIONS > 
Read Fluid Pressure) применима только к двухмерным задачам. 

Задание настроек расчета  
Команда A_STATIC (Analysis > STATIC > Static Analysis Options) задает настройки ли-
нейного статического расчета, выполняемого командой R_STATIC (Analysis > STATIC 
> Run Static Analysis). Команда A_STRESS (Analysis > STATIC > Stress Analysis Op-
tions) задает настройки вычисления напряжений, выполняемого командой R_STRESS 
(Analysis > STATIC > Run Stress Analysis). Команда A_BUCKLING (Analysis > STATIC 
> FREQUENCY/BUCKLING > Buckling Options) задает настройки расчета устойчиво-
сти, выполняемого командой R_BUCKLING (Analysis > FREQUENCY/BUCKLING > 
Run Buckling). Команда A_FREQUENCY (Analysis > FREQUENCY/BUCKLING > Fre-
quency Options) задает настройки расчет собственных частот, выполняемого коман-
дой R_FREQUENCY (Analysis > FREQUENCY/BUCKLING > Run Frequency). Более 
подробная информация приведена в Справочнике Команд (Т. 2). 

Задание настроек адаптивного КЭ-расчета  

Команда ADAPTIVE (Analysis > STATIC > Adaptive Method) задает настройки адаптив-
ной генерации КЭ-сети для линейного статического расчета. Параметры этой коман-
ды используются командой R_STATIC (Analysis > STATIC > Run Static Analysis) для 
последовательного улучшения КЭ-сети пока не будет достигнут необходимый уро-
вень точности. Улучшение КЭ-сети основывается на оценке ошибки энергии дефор-
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мации с использованием результатов расчета напряжений. Наибольшие значения 
ошибки находятся в местах сосредоточения напряжений и элементах с высоким со-
отношением сторон. 

Для улучшения КЭ-сети доступны три метода: 

1. H-метод: Элементы с высокой относительной ошибкой последовательно подразде-
ляются, пока ошибка при вычислении напряжений по фон Мизесу не приближается к 
средней ошибке с указанным допуском. 

2. P-метод: Увеличивается степень полинома с текущей до указанной. Это выполняет-
ся без добавления новых узлов в базу данных. Число элементов остается неизмен-
ным. 

3. H-P-метод: Этот метод является комбинацией H- и P-методов. Сначала последова-
тельно применяется H-метод, пока не будет удовлетворен критерий по ошибке или не 
будет достигнуто максимальное число итераций. После этого используется P-метод 
для расчета улучшенной КЭ-сети с использованием указанной степени полинома. 

Более подробная информация приведена в Справочнике Команд (Т. 2). 

Задание настроек вариантов нагрузки  

Команда LCSET (Analysis > STATIC > Activate Load Case) активизирует или деактиви-
рует указанные первичные варианты нагрузки для статического расчета. Команда 
LCLIST (Analysis > STATIC > List Load Case) выводит тип номер и признак расчета 
для существующих вариантов нагрузки. 

Проверка настроек расчета  
Команда A_LIST (Analysis > List Analysis Option) выводит подробный список настроек, 
выбранных для различных вариантов расчета. Ниже приведены варианты расчетов, 
поддерживаемые этой командой: 
Вариант расчета Признак 

"type"  
Статический расчет (по умолча-
нию)  

STATIC 

Статический расчет FFE  FFESTATIC 
Расчет напряжений STRESS 
Частотный расчет FREQ 
Расчет устойчивости BUCK 
Расчет усталости FATIGUE 
Нелинейный расчет  NONLIN 
Термальный расчет  THERMAL 
Термальный расчет FFE  FFETHERMAL 
Расчет течения жидкости  FLOW 
Электромагнитный расчет  EMAGNETIC 
Оптимизационный расчет  OPTIMIZE 
Расчет чувствительности  SENSITIVITY 
Высокочастотный электромагнитный HFREQUENCY 
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расчет  

Выполнение расчета  
Команда R_STATIC (Analysis > STATIC > Run Static Analysis) выполняет линейный ста-
тический расчет. Сначала в модуле STAR рассчитываются узловые перемещения. 
При успешном выполнении автоматически запускается модуль STRESS, вычисляю-
щий напряжения, если не указано иначе в команде STRESS (Analysis > STATIC > 
Stress Analysis Options). Команда STRESS (Analysis > STATIC > Stress Analysis Op-
tions) управляет вычислением напряжений. Ее параметры используются командой 
R_STATIC (Analysis > STATIC > Run Static Analysis). 

ПРИМЕЧАНИЕ: По умолчанию напряжения вычисляются всегда для всех активизи-
рованных первичных вариантов нагрузки. 

Команда R_BUCKLING (Analysis > FREQUENCY/BUCKLING > Run Buckling) выполня-
ет расчет устойчивости с собственными значениями. Эта команда использует при-
знаки, установленные в команде A_BUCKLING (Analysis > FREQUENCY/BUCKLING 
> Buckling Options). 

Команда R_FREQUENCY (Analysis > FREQUENCY/BUCKLING > Run Frequency) вы-
полняет расчет собственных частот. При этом в модуле DSTAR вычисляются собст-
венные частоты и формы мод. Эта команда использует признаки, установленные в 
команде A_FREQUENCY (Analysis > FREQUENCY/BUCKLING > Frequency Options). 

Неполадки при расчете  
Ниже приведен неполный список ошибок, встречающихся при выполнении расчета в 
Основной Системе и рекомендации по их устранению.  

ОШИБКА: Аварийное завершение программы перед составлением матрицы жесткости. 

a. Возможно ваша КЭ-сеть не закончена. Используйте команды NLIST (Edit > LIST > 
Nodes) и ELIST (Edit > LIST > Elements), чтобы убедиться, что все узлы и элементы 
были созданы корректно. 

b. В вашей модели могут отсутствовать степени свободы. Это может случиться, если 
приложить ограничения ко всем узлам модели. Проверьте, имеет ли модель не огра-
ниченные степени свободы командой DLIST (LoadsBC > STRUCTURAL > 
DISPLACEMENT > List). В больших задачах вы можете запросить подробный вывод, 
установив соответствующий признак в команде PRINT_OPS (Analysis > OUTPUT 
OPTIONS > Set Print Options). 

c. Ваша база данных может быть повреждена. Создайте новую задачу и считайте ста-
рый файл сессии командой FILE (File > Load...). 

d. На диске может быть недостаточно свободного места. В этом случае программа вы-
водит предупреждение. 
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ОШИБКА: Аварийное завершение программы во время составления матрицы жесткости. 

a. В модели могут присутствовать вырожденные элементы. Выполните команду 
ECHECK (Meshing > ELEMENTS > Check Elements) для обнаружения и удаления та-
ких элементов. 

b. Возможно с некоторыми элементами связана недопустимая группа элементов (на-
пример 4-узловые элементы PLANE2D связаны с 3-узловыми треугольниками, соз-
данными командами автоматической генерации КЭ-сети). Переопределите соответ-
ствующую группу элементов или измените КЭ-сеть, так, чтобы она состояла из 
соответствующих элементов командой MASFCHANGE (Meshing > AUTOMATIC > 
Surface Mesh Type) или другими подобными командами. 

c. Элементы могут иметь очень маленькие размеры. Измените единицы измерения, 
используемые в задаче. 

d. Может быть неправильно задана связность элементов, особенно для элементов, соз-
данных командой EL (Meshing > ELEMENTS > Define Element). Информация о пра-
вильных подходах к заданию связности элементов приведена в Главе 4, Руководства 
пользователя COSMOS/M. 

e. Двухмерная модель может располагаться в недопустимой плоскости (например эле-
менты PLANE2D, расположенные в плоскости XZ). 

ОШИБКА: Выполнение прерывается из-за единичной матрицы. 

a. В модели может быть недостаточно граничных условий. Добавьте ограничений для 
предотвращения возможных движений жесткого тела. 

b. В модели могут присутствовать не «слитые» узлы. В моделях с несколькими 
ОБЛАСТЯМИ или ПОВЕРХНОСТЯМИ узлы и элементы создаются независимо для 
каждой ОБЛАСТИ/ПОВЕРХНОСТИ. Однако, из условий совместимости следует, 
что для узлов на общих границах необходимо выполнить «слияние». Используйте 
команду NMERGE (Meshing > NODES > Merge) с соответствующим значением допус-
ка. 

c. В модели могут присутствовать свободные узлы, связанные только с неконструкци-
онными элементами (например, CLINK, RLINK, MASS, �). Зафиксируйте эти узлы 
по всем направлениям. 

d. На общих границах могут находиться несовместимые узлы. Это бывает, если сосед-
ствующие КЭ-сети имеют различные размеры и/или типы элементов. Сгенерируйте 
КЭ-сеть заново, указав правильные размеры и связность элементов, или используйте 
команду BONDDEF (LoadsBC > STRUCTURAL > Define Bond Parameter) для «скреп-
ления» несовместимых КЭ-сетей . 

e. Может быть превышена критическая нагрузки устойчивости при включенном при-
знаке плоскостных эффектов (см. команду A_STATIC (Analysis > STATIC > Static 
Analysis Options)). Отключите признак плоскостных эффектов или выполняйте нели-
нейный расчет. 
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f. Конструкция может быть неустойчивой из-за наложения ограничений только на 
движение твердого тела элементами GAP. Выполните расчет с добавлением мягкой 
пружины (см. команду A_STATIC (Analysis > STATIC > Static Analysis Options)) или 
добавьте мягкие стержни поверх элементов GAP.  

g. Если модель осесимметрична, то убедитесь, что вся она находится в той полуплос-
кости, где X положителен. 

h. Для некоторых элементов могут быть заданы несоответствующие изотропные свой-
ства материала (например,  NUXY=0.6 или EX=0.0). Переопределите эти свойства 
материала. 

i. Возможно заданы несоответствующие ортотропные свойства материала. В таких 
случаях необходимо задать допустимые значения для всех компонентов отношения 
Пуассона (то есть NUXY, NUYX, NUXZ, NUZX, NUYZ и NUZY). Переопределите 
эти свойства материала. 

j. Возможно заданы неправильные значения вещественных констант (например, нуле-
вая или отрицательная толщина).  

Примечание: В случае единичной матрицы жесткости с нулевым диагональным чле-
ном выполните расчет с добавлением мягкой пружины (указывается в команде 
A_STATIC (Analysis > STATIC > Static Analysis Options)). Произведите анимацию де-
формаций, чтобы обнаружить движение твердого тела. После этого можно ввести ог-
раничения по этому направлению. 

ОШИБКА: Выполнение прервано во время вычисления напряжений. 

a. Возможно кончилось дисковое пространство. 

b. Возможно для некоторых элементов заданы нереалистичные свойства материала 
или вещественные константы, что вызывает завершение программы. 
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Глава 10. 
Постпроцессинг 
Введение  

Постпроцессинг в Основной Системе является эффективным способом быстро про-
анализировать результаты расчета и принять инженерные решения. Постпроцессин-
гом называется графическое манипулирование результатами для лучшего их пред-
ставления. Результаты КЭ-расчета обычно представляют собой большой объем 
данных, обычно записываемый в файл вывода. Имея возможность выборочно ото-
бражать данные графически или выводить их на экран в текстовой форме, 
COSMOS/M предоставляет одну из самых мощных функций постпроцессинга ре-
зультатов КЭ-расчета. 

Различные функции, такие как графики сечений, изоплоскостей и графики изменения 
величины вдоль пути, позволят вам лучше анализировать результаты. В данной главе 
приведены некоторые примеры использования этих функций. 

ПРИМЕЧАНИЕ: Полная информация о постпроцессинге в GEOSTAR, включая соз-
дание тве6ржых копий, приведена в Руководстве пользователя COSMOS/M (Т. 1). 

Постпроцессинг 
Основными операциями постпроцессинга в Основной Системе являются отображение 
и листинг требуемых компонентов результатов расчета. В таблице приведены раз-
личные функции постпроцессинга и команды, необходимые для их использования. 
Команды, приведенные в этой таблице, находятся в меню Results, подменю 
ACTIVATE, PLOT, LIST и EXTREMES. 

Таблица 10-1. Команды постпроцессинга результатов расчета в Основной Системе  

Операция постпроцессинга Команда * 
Предварительные операции постпроцессинга  LCCOMB  

AVERAGE  
RESULTS? 

Активизирование варианта расчета для постпро-
цессинга 

ACTPOST 

Активизирование компонента результата для ото-
бражения или листинга  

ACTSTR  
ACTSTN  
ACTDIS  
ACTUSRPLOT 

Отображение активизированного компонента  IDRESULT  
ANIMATE  
DEFPLOT  
DISPLOT  
STRPLOT  
STNPLOT  
SMPLOT  
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ISOPLOT  
SECPLOT  
LSECPLOT  
USRPLOT 

Листинг активизированного компонента  DISLIST  
STRLIST  
STNLIST  
SMLIST  
BEAMRESLIST  
GAPRESLIST  
FREQLIST 
 

Листинг экстремумов активизированного компо-
нента  

DISMAX  
STRMAX  
STNMAX  
SMMAX  
BEAMRESMAX 

Установка настроек отображения  SETPLOT  
SETLSECPLOT  
SETERASE 

Создание твердых копий  см. Том 1 
Сохранение графических результатов в файлы изо-
бражений  

см. Том 1 

* Соответствие кратких и полных имен указано в Приложении B. 

ПРИМЕЧАНИЕ: Можно комбинировать результаты расширенного динамического 
расчета, выполняемого в модуле ASTAR, с результатами статического расчета. Это 
выполняется командой READ_PDRESP (Results > Read Post-Dyn Response). 

Процедура постпроцессинга в COSMOS/M очень проста: выполните необходимые 
предварительные операции, активизируйте необходимый компонент результатов 
расчета и либо отобразите, либо выведите его для интерпретации. Поскольку боль-
шинство функций постпроцессинга являются функциями GEOSTAR, то в этой главе 
не буде приведено подробное описание постпроцессинга. Более подробная информа-
ция приведена в Главе 3 Руководства пользователя COSMOS/M (Том 1). В следую-
щем разделе описаны некоторые функции постпроцессинга, появившиеся в новой 
версии. 

Отображение графиков изменения величины вдоль пути, попе-
речных сечения и изоплоскостей  

В текущей версии появилась возможность графически отображать изменение величи-
ны вдоль пути командами LSECPLOT (Results > PLOT > Path Graph) и SECPLOT (Re-
sults > PLOT > Stress or Displacement). Также вы можете отображать плоскости с 
одинаковыми значениями напряжений (изоплоскости) для трехмерных моделей  ко-
мандой ISOPLOT (Results > PLOT > Stress or Displacement). Эти команды применимы 
к любому контурному графику в двух или трех измерениях. 

Команда LSECPLOT (Results > PLOT > Path Graph) создает xy-график на основе кон-
турного графика в активном окне. Путь задается некоторым числом узлов. Ось X 
представляет расстояние между узлами пути и точкой отсчета. Ось Y представляет 
значение величины. Для задания пути можно использовать от 2 до 20 узлов, для вы-
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числения значений вдоль пути используется линейная интерполяция. На рисунке по-
казан график изменения результатов вдоль ломаной линии в поперечном сечении 
шарнирного соединения. 

 

Рис. 10-1. График изменения результирующих перемещений в двух измерениях  

Для этого же шарнирного соединения была использована команда SECPLOT (Results > 
PLOT > Stress or Displacement) в трех измерениях для создания 12 сечений контурно-
го графика результирующих перемещений. На рисунке показан результат выполне-
ния команды и геометрия соединения. 

 

Рис. 10-2. График поперечных сечений результирующих перемещений в трех измерениях  

Также для шарнирного соединения был построен контурный график одинаковых пе-
ремещений. Команда ISOPLOT (Results > PLOT > Stress or Displacement) отображает 
изоповерхности для активной величины в буфере. Эта команда работает только с 
трехмерными моделями. Для двухмерных моделей можно получить аналогичный 
график изолиний, если использовать вариант линий при построении контурных гра-
фиков. На рисунке показана геометрия шарнирного соединения и изоповерхности ре-
зультирующих перемещений. 
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Рис. 10-3. Изоповерхности результирующих перемещений а трех измерениях  
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Глава 11. 
Примеры моделирования и расче-
та  
Введение  

В данной главе приведены примеры расчетов, которые можно выполнять в Основной 
Системе. Эти примеры полностью описывают линейный статический, модальный 
расчеты и расчет устойчивости. Почти во всех примерах, приведенных в данной гла-
ве, используются команды, необходимые для создания модели, генерации КЭ-сети, 
приложения нагрузок и граничных условий, расчета и постпроцессинга. Там где это 
возможно, произведены сравнения с аналитическими решениями чтобы подчеркнуть 
точность расчета в COSMOS/M. 

Для использования этих примеров запустите GEOSTAR и выполняйте команды в том 
порядке, как они даны в примерах. Приглашения программы приведены обычным 
шрифтом, а соответствующие введенные значения � полужирным начертанием: 
Control Panel: Propsets > Material Property 
Material property set >1 
Material Property Name >EX; Elasticity modulus 1st dir 
Property value >15.5E6 
Material Property Name > 
(Click on cancel to terminate) 

Информация об использовании GEOSTAR приведена в Руководстве пользователя 
COSMOS/M (Т. 1). 

Файлы исходных данных для описанных здесь примеров находятся в файле 
PROBLEMS.EXE, помещенном в директорию COSMOS/M (в версиях для Macintosh 
и Unix Workstation эти файлы могут находиться в отдельной директории, называемой 
Example Problems или PROBS, соответственно). На персональных компьютерах файл 
PROBLEMS.EXE можно распаковать, введя PROBLEMS в приглашении DOS. На дру-
гих машинах инструкции по распаковыванию файла приведены отдельно. 

ПРИМЕЧАНИЕ: Во второй части настоящего Руководства приведено более 100 про-
верочных задач для всех функций расчета в Основной Системе. Рекомендуется ис-
пользовать эти примеры для лучшего ознакомления с Основной Системой. 

Примеры линейного статического расчета  
Линейный статические задачи, которые можно рассчитывать в Основной Системе 
включают модели с различными комбинациями механических, термальных и грави-
тационных нагрузок, трещинами, зазорами и поверхностями контакта, подконструк-
циями, циклической симметрией и многие другие. Примеры, приведенные в данном 
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разделе из-за ограничений по объему охватывают только некоторые из функций мо-
дуля линейного статического расчета STAR. Проверочные задачи, приведенные во 
второй части настоящего Руководства, охватывают почти все аспекты линейного ста-
тического моделирования и расчета. 

Пример LGAP1 � задача контакта Герца с использованием линейных элементов  
GAP узел-узел  

Полные исходные данные для этого примера находятся в файле LGAP1.GFM. Изуче-
ние напряжений, вызываемых давлением между упругими телами имеет большое 
значение в разработке рельсов, шариковых и роликовых подшипников, соединений 
для стальных ферм и других практических задачах. Из-за большого значения напря-
жений, возникающих в областях контакта, значение которых может достигать преде-
ла текучести, задачи контакта часто рассчитываются как нелинейные КЭ-задачи. Од-
нако, в Основной Системе можно получить достаточно точное приближение 
значений напряжений контакта, если использовать линейные элементы GAP узел-
узел. На рисунке приведена половина модели цилиндра, подлежащего расчету на-
пряжений контакта с использованием элементов GAP узел-узел. Также на рисунке 
приведены свойства материала, размеры модели и приложенные нагрузки. 

 

Рис. 11-1. Геометрия задачи  

Поскольку вам были предоставлены полные исходные данные для этого примера, то в 
выполнении команд генерации КЭ-сети нет необходимости. Вам понадобится ис-
пользовать только две команды: FILE (File > Load...) для считывания файла исходных 
данных и R_STATIC (Analysis > STATIC > Run Static Analysis) для выполнения расче-
та. Ниже будет описан процесс подготовки КЭ-модели для расчет. Если понадобится 
выполнения какой-либо команды, то это будет указано явно. 

Для начала скопируйте файл LGAP1.GFM в свою рабочую директорию, запустите 
GEOSTAR и выполните команду FILE (File > Load...): 
Control Panel: File > Load... 
Input file name with extension >LGAP1.GFM 
Примите значения по умолчанию 

В файле LGAP1.GFM содержится информация о геометрии модели (ТОЧКИ, 
КРИВЫЕ, КОНТУРЫ и ОБЛАСТИ) и ее КЭ-сети (узлы, элементы, свойства, нагруз-
ки и настройки расчета). Вы увидите как создается и отображается КЭ-модель по ме-
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ре считывания файла. Для корректного отображения модели нажмите на кнопку ав-
томатического масштабирования, а затем с помощью кнопки View установите проек-
цию на плоскость XY. 

Для активизации нумерации КЭ-примитивов и отображения соответствующих меток 
используется команда ACTNUM (Control > ACTIVATE > Entity Label). Геометрия ци-
линдра была создана командой CRARC3PT (Geometry > CURVES > CIRCLES > by 3 
Points) для криволинейной части и CRLINE (Geometry > CURVES > Line with 2 Pts) дял 
прямой линии. Затем эти КРИВЫЕ были разбиты командой CRBRK (Geometry > 
CURVES > MANIPULATION MENU > Break (equally)) на меньшие сегменты для соз-
дания ОБЛАСТЕЙ с целью получения более тонкой КЭ-сети. Ни рисунке показаны 
КРИВЫЕ, КОНТУРЫ и ОБЛАСТИ цилиндра с соответствующими метками. Для вы-
вода списков созданных геометрических примитивов можно использовать команды 
PTLIST, CTLIST, RGLIST (Edit > LIST > Points, Contours, Regions, ...) и т.д. 

 

Рис. 11-2. КРИВЫЕ, КОНТУРЫ и ОБЛАСТИ цилиндра  

В данной модели используются два типа элементов. Элементы PLANE2D моделируют 
цилиндр в состоянии плоских деформаций, а элементы GAP соединяют цилиндр с 
поверхностью контакта. Эти элементы задаются командой EGROUP (Propsets > 
Element Group). Элемент PLANE2D был объявлен как группа 1, а элемент GAP � как 
группа 2. Поскольку элементы PLANE2D моделируют поведение в состоянии пло-
ских деформаций, для них не требуется задание вещественных констант. 

КЭ-сеть цилиндра был создана командой MA_RG (Meshing > AUTO MESH > Regions) 
для всех четырех ОБЛАСТЕЙ. После этого командой NMERGE (Meshing > NODES > 
Merge) было произведено «слияние» узлов на общих граничных КРИВЫХ. Элемент 
GAP � это особый элемент, который необходимо создавать активизированием соот-
ветствующего набора вещественных констант, как описано ниже. 

На рисунке показана законченная КЭ-сеть модели цилиндра с приложенными нагруз-
ками и ограничениями. Элементы GAP были заданы командой EL (Meshing > 
ELEMENTS > Define Element), соединяющей указанные узлы, созданные командой 
ND (Meshing > NODES > Define). В Основной Системе допуск закрытия зазора (gdist) 



 177

задается как вещественная константа. Таким образом для каждого элемента GAP не-
обходим набор вещественных констант, который должен быть активизирован перед 
заданием элемента. В данной задаче были использованы 5 элементов GAP с метками 
с 72 по 76. 

 

Рис. 11-3. КЭ-модель цилиндра 

На рис. 11-4 приведено увеличенное изображение соединения между цилиндром и по-
верхностью контакта. Сначала была активизирована группа элементов 2 (элементы 
GAP) и были созданы узлы с 76 по 80 с y-координатой, равной нулю, и x-
координатами в точности равными координатам соответствующих узлов цилиндра, к 
которым  будут присоединены элементы. Важно указать точные x-координаты эле-
ментов GAP, поскольку при эксцентриситете в зазорах появятся боковые компонен-
ты сил. На следующем шаге был активизирован набор вещественных констант 2 и 
командой EL (Meshing > ELEMENTS > Define Element) был создан первый элемент 
GAP (с меткой 72). Этот элемент соединяет узлы 7 и 76. Аналогично были созданы 
остальные элементы GAP с соответствующими наборами вещественных констант. 

 

Рис. 11-4. Увеличенное изображение поверхности контакта  

Для элемента GAP необходимо указать допустимое относительное перемещение меж-
ду двумя узлами, при превышении которого зазор начинает сопротивляться сжатию 
или растяжению. Для сжимаемых элементов GAP, часто это значение указывается 
равным первоначальному расстоянию между ними, так что сопротивление сжатию 
начинается после соприкосновения узлов. Поскольку для ввода этих значения для 
большого количества элементов потребуется много времени, при задании группы 
элементов командой EGROUP (Propsets > Element Group) в соответствующей опции 
можно указать программе вычислять и использовать начальное расстояние между уз-
лами. Более подробная информация приведена в Главе 4 руководства пользователя 
COSMOS/M. В этом случае задание вещественных констант не требуется и любые 
введенные значения будут проигнорированы. 
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Нижние узлы всех элементов GAP были зафиксированы командой DND (LoadsBC > 
STRUCTURAL > DISPLACEMENT > Define Nodes). Узел 6, представляющий собой 
узел, непосредственно соприкасающийся с нижней поверхностью также был зафик-
сирован той же командой. На вертикальную ось симметрии были наложены гранич-
ные условия симметрии (UX = 0) командой DCR (LoadsBC > STRUCTURAL > 
DISPLACEMENT > Define Curves). К верхней части модели была приложена сила ко-
мандой FND (LoadsBC > STRUCTURAL > FORCE > Define Nodes). В данной задаче 
используется только один набор свойств материала для цилиндра. Свойства E и 
ν были заданы командой MPROP (Propsets > Material Property). Для проверки точности 
решения было запрошено вычисление сил реакции командой REACTION (Analysis > 
Reaction). 

После того как вы исследовали модель, выполните команду R_STATIC (Analysis > 
STATIC > Run Static Analysis) для выполнения линейного статического расчета. Силы 
реакции в узлах на поверхности контакта записываются в файл вывода. Можно уви-
деть, что вертикальные компоненты сил реакции в сумме равны 100 000, то есть при-
ложенной силе, из чего следует, что условие равновесия удовлетворено: 
LOAD CASE NUMBER. . . . . . . . . . . . = 1  
FORCES IN THE CLOSED BOUNDARY/GAP ELEMENT(S), NCE = 3  
 ELEMENT  FX  FY  FZ  GAP DISTANCE NORMAL FORCE  
 72  0.0000E+00  0.4404E+05  0.0000E+00 0.5163E-01  0.4404E+05  

 73  0.0000E+00  0.3153E+05  0.0000E+00 0.2032E+00  0.3153E+05  

 74  0.0000E+00  0.6277E+03  0.0000E+00 0.4496E+00  0.6277E+03  
 TOTAL 0.0000E+00  0.7620E+05  0.0000E+00  
R E A C T I O N F O R C E S  
NODE CSYS  RFX  RFY  RFZ  RMX  RMY  RMZ  
   6    0 0.1373E+05 0.2380E+05 ---- ----  ----  ---- 

Для просмотра полученных напряжений необходимый компонент напряжений может 
быть выведен командой STRPLOT (Results > PLOT > Stress). На рисунке приведены 
контурные графики вертикального и горизонтального компонентов напряжений и 
напряжения по фон Мизесу. 

 

Рис. 11-5. Контурные графики напряжений  
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Герц (1895) разработал математическую теорию, подкрепленную результатами экспе-
риментов, описывающую напряжений и деформации, вызываемые давлением между 
двумя криволинейными телами. Максимальные сжимающие напряжения, согласно 
этой теории, возникают в центре поверхностей контакта, а максимальные срезающие 
напряжения возникают внутри сжимаемых частей. Максимальное напряжений кон-
такта находится по следующей формуле (Roark's Formulas for Stress and Strain, Sixth 
Edition, Young, 1989): 

 (11-1) 

где p � нагрузка на единицу длины а D � диаметр цилиндра. Значение вертикального 
компонента напряжений на поверхности контакта, полученное по этой формуле рав-
но 3.2376E6, а рассчитанный максимальный вертикальный компонент напряжений в 
центре элемента 5 равен 4.43372E6. Из-за малой площади контакта, в первом при-
ближении � точки или линии, напряжений контакта даже для малых нагрузок могут 
иметь очень большие значения. 

Поскольку на практике напряжения сильно локализованы и имеют три компонента, 
действительная интенсивность напряжений может быть очень большой, и в данном 
случае линейная упругая теория механического контакта неприменима. Таким обра-
зом, результаты, полученные при КЭ-расчете, могут рассматриваться как точные. 

Для отображения деформаций цилиндра можно использовать команду DEFPLOT 
(Results > PLOT > Deformed Shape). Для просмотра контурных графиков перемеще-
ний можно использовать команду DISPLOT (Results > PLOT > Displacement). На ри-
сунке показаны график деформированной формы (общий план и увеличенный), а 
также контурные графики вертикальных и результирующих перемещений модели 
цилиндра. 

 

Рис. 11-6. Деформированная форма и контурные графики перемещений  

Пример использования «скрепления»  

Во многих задачах трудно достигнуть совместимости узлов и элементов на общих 
границах во время генерации КЭ-сети. Как рекомендовалось в Главе 8 следует со-
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блюдать совместимость элементов, а в исключительных случаях следует применять 
функцию «скрепления» несовместимых частей КЭ-сети. 

Пример BOND1 � статический расчет U-образной рамы с несовместимыми элементами  

Исходные данные для создания геометрии этой задачи находятся в файле 
BOND1.GFM. Ниже подробно описаны процедуры создания геометрических прими-
тивов более высокого порядка, таких как МНОГОГРАННИКИ и ЧАСТИ, генерации 
КЭ-сети, задания поверхностей «скрепления», приложения граничных условий и на-
грузок и выполнения расчета. Модель, которую необходимо рассчитать, состоит из u-
образного тела, закрепленного консольно, и подвергающегося действию распреде-
ленной нагрузки. Геометрия модели с приложенными нагрузками и граничными ус-
ловиями показана на рисунке. Поскольку КЭ-сеть модели будет генерироваться та-
ким образом, чтобы она получилась несовместимой, также обозначены 
ПОВЕРХНОСТИ «скрепления».  

ПРИМЕЧАНИЕ: В данном примере присутствуют 4000 узлов, 2200 элементов и 
11 700 уравнений. Для выполнения линейного статического расчета потребуется 30 
Mb дискового пространства на персональном компьютере с 16 Mb RAM. Убедитесь, 
что на диске есть необходимое количество свободного места перед выполнением 
этого примера. 

 

Рис. 11-7. Модель с показанными ПОВЕРХНОСТЯМИ «скрепления»  

Из рисунка видно, что модель состоит из четырех объемных тел. Для половины из них 
КЭ-сеть будет сгенерирована с использованием шестигранных элементов  SOLID 
различного размера, для остальных � с использованием четырехгранных элементов 
TETRA10 также различного размера. В результате получится КЭ-сеть с несовмести-
мыми интерфейсами элементов SOLID-SOLID, SOLID-TETRA10 и TETRA10-
TETRA10. В обычно программе КЭ-расчета для такой КЭ-сети расчет невыполним. 
Однако, при использовании возможности «скрепления» в COSMOS/M, с помощью 
только одной команды BONDDEF (LoadsBC > STRUCTURAL > BONDING > Define 
Bond Parameter) можно соединить несовместимые части КЭ-сети, обеспечив тем са-
мым совместимость, и выполнить расчет. Задание «скрепления» выполняется на 
уровне геометрических примитивов, так что узлы и элементы в интерфейсах «скреп-
ления» автоматически определяются и связываются уравнениями ограничениями. 
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Заметьте, несовместимость здесь определяется как несовпадение узлов на общих 
границах, и отличается от случая, когда узлы на общих границах совпадают, но поля 
деформаций элементов несовместимы.  

Чтобы приступить к работе, скопируйте файл BOND1.GFM в вашу рабочую директо-
рию, запустите GEOSTAR и выполните команду FILE (File > Load...): 
Control Panel: File > Load... 
Input file name with extension >BOND1.GFM 
Примите значения по умолчанию 

По мере считывания файла будет создаваться и отображаться геометрия. Геометрия 
модели состоит из четырех сплошных объемных тел. В файле находятся исходные 
данные для создания КРИВЫХ, ПОВЕРХНОСТЕЙ, ОБЛАСТЕЙ и двух ОБЪЕМОВ. 
Для ОБЪЕМОВ КЭ-сеть будет сгенерирована с использованием шестигранных эле-
ментов параметрической генерацией КЭ-сети (команда M_VL (Meshing > 
PARAMETRIC MESH > Volumes)). Остальных тела будут описаны как ЧАСТИ, и  
КЭ-сеть для них будет сгенерирована с использованием четырехгранных элементов 
командой MA_PART (Meshing > AUTO MESH > Parts). 

Приступим к заданию МНОГОГРАННИКОВ и ЧАСТЕЙ на основе существующих 
ПОВЕРХНОСТЕЙ и ОБЛАСТЕЙ чтобы использовать процедуру автоматической ге-
нерации трехмерной КЭ-сети. Процедура автоматической генерации трехмерной КЭ-
сети описана в Руководстве пользователя COSMOS/M. Чтобы задать 
МНОГОГРАННИК, сначала необходимо обозначить только те ПОВЕРХНОСТИ и 
ОБЛАСТИ, которые составляют МНОГОГРАННИК. Лучше всего это сделать, ис-
пользуя списки выбора GEOSTAR. На рисунке показаны ПОВЕРХНОСТИ и 
ОБЛАСТИ, составляющие МНОГОГРАННИКИ (и ЧАСТИ) 1 и 2. Заметьте, что 
ПОВЕРХНОСТЬ 22 является общей для обеих ЧАСТЕЙ. 

 

Рис. 11-8. ОБЛАСТИ и ПОВЕРХНОСТИ, составляющие ЧАСТИ 1 и 2 

Перед заданием первого МНОГОГРАННИКА выполните команду INITSEL (Control > 
SELECT > Initialize) отдельно для ПОВЕРХНОСТЕЙ и для ОБЛАСТЕЙ: 
Control Panel: Control > SELECT > Initialize 
Entity Name >Surfaces 
Initialization Flag >Yes 
Selection Set number >1 
Entity Name >Regions 
Initialization Flag >Yes 
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Selection Set number >1 

Из рисунка видно, что первый МНОГОГРАННИК ограничивается 
ПОВЕРХНОСТЯМИ 13, 14, 15, 16 и 22 и ОБЛАСТЯМИ R1 и R3. Необходимо помес-
тить эти примитивы в список выбора командой SELINP (Control > SELECT > by 
Label): 
Control Panel: Control > SELECT > by Label 
Entity Name >Surfaces 
Beginning Entity >13 
Ending Entity >16 
Increment >1 
Selection Set number >1 
Control Panel: Control > SELECT > by Label 
Entity Name >Surfaces 
Beginning Entity >22 
Ending Entity >22 
Increment >1 
Selection Set number >1 
Control Panel: Control > SELECT > by Label 
Entity Name >Regions 
Beginning Entity >1 
Ending Entity >3 
Increment >2 
Selection Set number >1 

Если вы очистите экран и последовательно выполните команды SFPLOT; и RGPLOT; 
(Edit > PLOT > Surfaces, Regions), вы увидите, что отображаются только примитивы, 
помещенные в список выбора. Теперь можно выполнить команду PH (Geometry > 
POLYHEDRA > Define), задающую МНОГОГРАННИК, и для создания примитива 
программа выберет только примитивы, помещенные в список выбора. Для первого 
МНОГОГРАННИКА укажите средний размер элемента равным 5: 
Control Panel: Geometry > POLYHEDRA > Define 
Polyhedron Label >1 
Reference entity name >Surfaces 
Surface/Region Label >1 
Average element size >5 
Tolerance >0.0001 
Redefine element size on bound >Change size 

МНОГОГРАННИК � это полый примитив, и его необходимо преобразовать в сплош-
ное тело командой PART (Geometry > Define Part): 

Control Panel: Geometry > Define Part 
Part Label >1 
Polyhedron 1 >1 
Polyhedron 2 >1 

Аналогично определяются и помещаются в список выбора ПОВЕРХНОСТИ и 
ОБЛАСТИ, составляющие второй МНОГОГРАННИК: 
Control Panel: Control > SELECT > Initialize 
Entity Name >Surfaces 
Initialization Flag >Yes 
Selection Set number >1 
Control Panel: Control > SELECT > Initialize 
Entity Name >Regions 
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Initialization Flag >Yes 
Selection Set number >1 
Control Panel: Control > SELECT > by Label 
Entity Name >Surfaces 
Beginning Entity >17 
Ending Entity >22 
Control Panel: Control > SELECT > by Label 
Entity Name >Regions 
Beginning Entity >2 
Ending Entity >4 
Increment >2; 
Selection Set number >1 

Теперь задайте второй МНОГОГРАННИК со средним размером элемента, равным 7.5, 
и вторую ЧАСТЬ: 
Control Panel: Geometry > POLYHEDRA > Define 
Polyhedron Label >2 
Reference entity name SF or RG >Surfaces 
Surface/Region Label >22 
Average element size >7.5 
Tolerance >0.0001 
Redefine element size on bound >Change size 
Control Panel: Geometry > Define Part 
Part Label >2 
Polyhedron 1 >2 
Polyhedron 2 >2 

Для того, чтобы все ПОВЕРХНОСТИ и ОБЛАСТИ снова были доступны, необходимо 
выполнить команду INITSEL (Control > SELECT > Initialize) для всех примитивов: 
Control Panel: Control > SELECT > Initialize 
Entity Name >All 
Initialization Flag >Yes 
Selection Set number >0 

Процедуры, выполненные на текущий момент, подготавливали геометрию к генера-
ции КЭ-сети. Поскольку ОБЪЕМЫ 1 и 2 уже заданы, то можно применить к ним ко-
манду M_VL (Meshing > PARAMETRIC MESH > Volumes). Для генерации КЭ-сети для 
ЧАСТЕЙ 1 и 2 будет использована команда MA_PART (Meshing > AUTO MESH > 
Parts). 

Сначала сгенерируем КЭ-сети из 8-узловых объемных элементов для ОБЪЕМОВ 1 и 2 
параметрической генерацией КЭ-сети. Выполните команду M_VL (Meshing > 
PARAMETRIC MESH > Volumes) и введите нижеприведенные значения: 
Control Panel: Meshing > PARAMETRIC MESH > Volumes 
Beginning Volume >1 
Ending Volume >1 
Increment >1 
Number of nodes per element >8 
Number of elements on 1st curve >3 
Number of elements on 2nd curve >10 
Number of elements on 3rd curve >4 
Примите значения по умолчанию ... 

По умолчанию со вновь созданными элементами SOLID будет связана группа элемен-
тов 1. Повторите команду M_VL (Meshing > PARAMETRIC MESH > Volumes) для 
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второго ОБЪЕМА, указав другие количества элементов вдоль каждой КРИВОЙ: 
Control Panel: Meshing > PARAMETRIC MESH > Volumes 
Beginning Volume >2 
Ending Volume >2 
Increment >1 
Number of nodes per element >8 
Number of elements on 1st curve >4 
Number of elements on 2nd curve >15 
Number of elements on 3rd curve >6 
Примите значения по умолчанию ... 

До генерации КЭ-сети четырехгранных элементов для ЧАСТЕЙ 1 и 2 необходимо ак-
тивизировать другую группу элементов, которая будет связана с создаваемыми 10 
узловыми четырехгранными элементами (TETRA10): 
Control Panel: Control > ACTIVATE > Set Entity 
Set Label >Element Group 
Element Set number >2 

Теперь можно приступить к генерации КЭ-сети для ЧАСТЕЙ 1 и 2. Поскольку 
ПОВЕРХНОСТЬ 22 является общей для обеих частей, и последней была задана 
ЧАСТЬ 2 с размером элементов 7.5, размер элементов на ПОВЕРХНОСТИ по умол-
чанию будет равным 7.5. Таким образом, до генерации КЭ-сети для ЧАСТИ 1 необ-
ходимо установить размер элементов на всех ПОВЕРХНОСТЯХ ЧАСТИ 1 равным 5 
командой PHDENS (Meshing > MESH DENSITY > Polyhedron Elem Size): 
Control Panel: Meshing > MESH DENSITY > Polyhedron Elem Size 
Beginning Polyhedron >1 
Beginning Polyhedron >1 
Increment >1 
Average element size >5 

Используйте команду MA_PART (Meshing > AUTO MESH > Parts) для генерации КЭ-
сети: 
Control Panel: Meshing > AUTO MESH > Parts 
Beginning Part >1 
Ending Part >1 
Increment >1 
Hierarchy check flag >Check Hierarchy 
Element order >High 
Number of Smoothing Iterations >4 

Выполните команду PHDENS (Meshing > MESH DENSITY > Polyhedron Elem Size) по-
вторно и сгенерируйте КЭ-сеть для второй ЧАСТИ: 
Control Panel: Meshing > MESH DENSITY > Polyhedron Elem Size 
Beginning Polyhedron >2 
Beginning Polyhedron >2 
Increment >1 
Average element size >7.5 
Control Panel: Meshing > AUTO MESH > Parts 
Beginning Part >1 
Ending Part >1 
Increment >1 
Hierarchy check flag >Check Hierarchy 
Element order >High 
Number of Smoothing Iterations >4 
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Очистите экран и выполните команды HIDDEN,1; (Display > DISPLAY OPTION > Hid-
den Element Plot) и EPLOT (Edit > PLOT > Elements) для отображения элементов 
модели без отображения скрытых линий. Можно увидеть, что КЭ-сети на всех трех 
общих границах не совпадают. Ни рисунке показана трехмерная проекция КЭ-сети и 
увеличенные изображения общих границ. 

 

Рис. 11-9. Сгенерированная КЭ-сеть и несовместимые интерфейсы  

ПРИМЕЧАНИЕ: Поскольку типы элементов несовместимы, не пытайтесь выполнить 
«слияние» в этой задаче, даже если кажется, что узлы на общих границах совпадают. 
Узлы могут быть «слиты» только в интерфейсах с полной совместимостью.  

Необходимо определить ПОВЕРХНОСТИ, образующие общие границы с несовпа-
дающими элементами. Очистите экран, активизируйте отображением меток 
ПОВЕРХНОСТЕЙ командой ACTNUM,SF,1 (Control > ACTIVATE > Entity Label) и 
отобразите все ПОВЕРХНОСТИ командой SFPLOT (Edit > PLOT > Surfaces). Для бо-
лее точного определения ПОВЕРХНОСТЕЙ можно увеличить масштаб. На рисунке 
показаны увеличенные изображения ПОВЕРХНОСТЕЙ на общих границах и их ме-
ток. 

 

Рис. 11-10. ПОВЕРХНОСТИ на общих границах  

Их этого рисунка видно, что: 

! интерфейс SOLID-SOLID образован ПОВЕРХНОСТЯМИ 7 и 9, которые будут 
использованы для набора «скрепления» 1, 
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! интерфейс SOLID-TETRA10 образован ПОВЕРХНОСТЯМИ 11 и 16, которые бу-
дут использованы для набора «скрепления» 2, 

! интерфейс TETRA10-TETRA10 состоит из ПОВЕРХНОСТИ 22, соединяющей две 
ЧАСТИ, которая будет использована для набора «скрепления» 3. 

Эта информация будет использована при задании «скрепления» командой BONDDEF 
(LoadsBC > STRUCTURAL > BONDING > Define Bond Parameter). Выполните эту ко-
манду и укажите номера ПОВЕРХНОСТЕЙ для первого набора «скрепления»: 
Control Panel: LoadsBC > STRUCTURAL > BONDING > Define Bond Parameter 
Bonding set >1 
Primary Geometric entity type >Surface 
Primary Surface >9 
Secondary Geometric entity type >Surface 
Beginning Surface >7 
Ending Surface >7 
Increment >1 
Direction flag >Bi Dir 

Повторите эту процедуру для двух оставшихся наборов «скрепления»: 
Control Panel: LoadsBC > STRUCTURAL > BONDING > Define Bond Parameter 
Bonding set >2 
Primary Geometric entity type >Surface 
Primary Surface >11 
Secondary Geometric entity type >Surface 
Beginning Surface >16 
Ending Surface >16 
Increment >1 
Direction flag >Bi Dir 
Control Panel: LoadsBC > STRUCTURAL > BONDING > Define Bond Parameter 
Bonding set >3 
Primary Geometric entity type >Surface 
Primary Surface >22 
Secondary Geometric entity type >Surface 
Beginning Surface >22 
Ending Surface >22 
Increment >1 
Direction flag >Bi Dir 

Если при задании набора «скрепления» вы допустили ошибку, то вы можете удалить 
этот набор командой BONDDEL (LoadsBC > STRUCTURAL > BONDING > Delete 
Bond Parameter). Используйте команду BONDLIST (LoadsBC > STRUCTURAL > 
BONDING > List) для проверки «скрепляемых» примитивов. Эта команда выведет 
информацию о «скреплении» между первым (источником) и вторым (целью) прими-
тивами в следующей форме: 
Set Stype Source Ttype #Targets Targets  
1  SF  9  SF  1  7  
2  SF  11  SF  1  16  
3  SF  22  SF  1  22 

Действительные уравнения ограничений между узлами источника и геометрическими 
примитивами цели составляются и вычисляются на этапе расчета. Во время этого 
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процесса наборы «скрепления», заданные ранее, дробятся на подмножества, в кото-
рых каждый узел источника соединяется с одним или более узлами цели, располо-
женными в его окрестности. Существует возможность получения подробной инфор-
мации об узлах источника и цели в таких подмножествах, что будет описано ниже.  

Теперь можно приступить к приложению граничных условий и нагрузок. Используйте 
команду DSF (LoadsBC > STRUCTURAL > DISPLACEMENT > Define Surfaces) для 
фиксирования всех степеней свободы в левом конце (ПОВЕРХНОСТЬ 4): 
Control Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define Surfaces 
Beginning Surface >4 
Displacement Label >ALL; All 6 DOF 
Value >0.0 
Ending Surface >4 
Increment >1 

Распределенная нагрузка на правый конец и на верхнюю поверхность прикладывается 
командой PSF (LoadsBC > STRUCTURAL > PRESSURE > Define Surfaces): 
Control Panel: LoadsBC > STRUCTURAL > PRESSURE > Define Surfaces 
Beginning Surface >18 
Pressure Magnitude >500 
Ending Surface >18 
Increment >1 
Pressure at the end of direction 1 >500 
Pressure at the end of direction 2 >500 
Pressure Direction >Normal 
Control Panel: LoadsBC > STRUCTURAL > PRESSURE > Define Surfaces 
Beginning Surface >19 
Pressure Magnitude >500 
Ending Surface >19 
Increment >1 
Pressure at the end of direction 1 >500 
Pressure at the end of direction 2 >500 
Pressure Direction >Normal 

Этап подготовки модели завершается вводом свойств материала и данных группы 
элементов: 
Control Panel: Propsets > Pick Material Lib 
Material property set >1 
Имя материала >A_STEEL 
Unit Label > FPS 
Control Panel: Propsets > Element Group 
Element group >1 
Element category >Volume 
Element type (for volume) >SOLID;8- to 20-node 3D solid element 
Примите значения по умолчанию ... 
Control Panel: Propsets > Element Group 
Element group >2 
Element category >Volume 
Element type (for volume) >TETRA10; 10-node tetrahedral solid element 
Примите значения по умолчанию 

Перед выполнением линейного статического расчета напряжений необходимо активи-
зировать признак вывода исходных данных в команде PRINT_OPS (Analysis > 
OUTPUT OPTIONS > Set Print Options) чтобы получить листинг связей «скрепления» 
между узлами источников и целей. 
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Control Panel: Analysis > OUTPUT OPTIONS > Set Print Options 
Displacement Print Flag >Yes 
... ... 
Input Print Flag >Yes 

Как было упомянуто ранее, не выполняйте «слияние» узлов в это примере. Выполните 
линейный статический расчет командой R_STATIC (Analysis > STATIC > Run Static 
Analysis). Для расчета этого примера потребуется около 30 Mb дискового простран-
ства на персональном компьютере с 16 Mb памяти. 

После успешного выполнения расчета результаты будут записаны в файл вывода job-
name.OUT. Информация о «скреплении» записывается в следующей форме: 

Bond coupling information  
-------------------------  

Ref.; Reference node  
Types of coupling  
EQ. PTC ; Point to curve  
EQ. PTS ; Point to surface  

Set Type Ref.  NODE1 NODE2 NODE3 NODE4 NODE5 NODE6 NODE7 NODE8 NODE9 NODE10 
1  PTS  3224 3075  3079  3035  3031  
2  PTS  3225 3079  3083  3039  3035  
... ... 

В данной распечатке Set обозначает подмножества, образованные из наборов «скреп-
ления», заданных командой BONDDEF (LoadsBC > STRUCTURAL > BONDING > 
Define Bond Parameter). 

Полученные перемещения и напряжения можно просмотреть, активизировав требуе-
мые компоненты командами (Results > PLOT > Stress, Displacement). На рисунке по-
казаны контурные графики результирующих перемещений и напряжений по фон Ми-
зесу. Эти графики подтверждают тот факт, что результаты, полученные с 
использованием «скрепления», такие же непрерывные, как если бы они были полу-
чены с использованием совместимой КЭ-сети. 

 

Рис. 11-11. Контурные графики перемещений и напряжений  
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Примеры линейно упругой механики трещин  

Для моделирования задач с трещинами в Основной Системе доступны два четырех-
вершинных элемента (8-узловой PLANE2D и 20-узловой SOLID). При использовании 
этих элементов вычисляемым параметром трещины является фактор интенсивности 
напряжений для применимой моды трещины. Другие параметры трещины, такие как 
J-интеграл или освобождение энергии (G) могут быть вычислены на основе рассчи-
танных факторов интенсивности напряжений. В версии 1.75 добавлена возможность 
вычисления J-интеграла для упругих и упруго-пластичных трещин в модуле NSTAR. 
В двух следующих примерах проиллюстрировано вычисление факторов интенсивно-
сти напряжений в задачах с различной геометрией трещины. Следует помнить, что 
из-за симметрии конструкции в нижеприведенных примерах моделируется только 
половина или четверть конструкции. Однако в общем случае может понадобиться 
создать элемент трещины для каждой грани трещины. 

Пример LEFM1 � фактор интенсивности напряжений в плите с двумя трещинами по 
краям  

Исходные данные для этого примера находятся в файле LEFM1.GEO. В данном при-
мере вычисляется фактор интенсивности напряжений моды I плиты с двумя трещи-
нами по всей толщине, подвергающейся действию удаленных растягивающих на-
пряжений, показанной на рисунке. также на рисунке приведены упругие свойства 
материала и размеры. 

 

Рис. 11-12. Задача на вычисление фактора интенсивности напряжений  

Симметрия задачи позволяет рассчитать только четверть модели. Установите проек-
цию на плоскость XY с помощью кнопки View. Геометрия и КЭ-сеть создаются сле-
дующими командами: 
Control Panel: Geometry > GRID > Plane 
Rotation/Sweep Axis >Z 
Offset on Axis >0.0 
Grid Line style >Solid 
Control Panel: Geometry > SURFACES > Draw w/ 4 Coord 
Surface >1 
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Keypoint 1 XYZ-Coordinate value >30,30,0 
Keypoint 2 XYZ-Coordinate value >150,30,0 
Keypoint 3 XYZ-Coordinate value >150,150,0 
Keypoint 4 XYZ-Coordinate value >30,150,0 
Click on Auto Scale icon ... 
Control Panel: Meshing > PARAMETRIC MESH > Surfaces 
Beginning Surface >1 
Ending Surface >1 
Increment >1 
Number of nodes per element >8 
Number of elements on the 1st curve >12 
Number of elements on the 2nd curve >15 
Spacing ratio for 1st curve >1.0 
Spacing ratio for 2nd curve >1.0 

Заметьте, что КЭ-сеть была сгенерирована с использованием элементов более высоко-
го порядка чтобы использовать четырехвершинные элементы. Элемент PLANE2D, 
который необходимо использовать в данной задаче, задается в команде EGROUP 
(Propsets > Element Group), а свойства материала и сечения задаются следующими 
командами: 
Control Panel: Propsets > Element Group 
Element Group >1 
Element Category >Area 
Element Type (for area) >PLANE2D; 2D 4- to 8-node plane element 
Примите значения по умолчанию ... 
Control Panel: Propsets > Pick Material Lib 
Material Property set >1 
Имя материала >A_STEEL 
Unit Label >FPS 
Control Panel: Propsets > Real Constant 
Associated Element group >1 
Real Constant set >1 
Start loc. of the real const >1 
No. of real const to be entered >2 
RC1: Thickness >0.5 
RC2: Material angle (Beta) >0.0 

Граничные условия симметрии накладываются на вертикальную и горизонтальную 
оси симметрии. Поскольку трещина представляет собой край без сцепления и разрыв 
в геометрии, на нее не накладываются никакие граничные условия. То есть, после то-
го как вы приложите граничные условия на КРИВУЮ, необходимо убрать граничные 
условия с трещины. Это выполняется следующими командами: 
Control Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define Curves 
Beginning curve >1 
Displacement Label >UY; Y translation 
Value >0.0 
Ending curve > 
Increment >1 
Control Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define Curves 
Beginning curve >4 
Displacement Label >UX; X translation 
Value >0.0 
Ending curve >4 
Increment >1 
Control Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Delete Nodes 
Beginning node >1 
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Displacement Label >UY; Y translation 
Ending node >4 
Increment >1 

Удаленные растягивающие напряжения на верхней грани прикладываются командой 
PCR (LoadsBC > STRUCTURAL > PRESSURE > Define Curves): 
Control Panel: LoadsBC > STRUCTURAL > PRESSURE > Define Curves 
Beginning curve >2 
Pressure magnitude >-1000 
Ending curve >2 
Increment >1 
Pressure at the end of direction 1 >-1000 
Pressure Direction >Normal Direction 

Теперь можно приступит к заданию четырехвершинного элемента в окончании тре-
щины. Как было описано в Главе 8 для определения узлов в крае трещины использу-
ется команда CRACK (Analysis > STATIC > CRACK > Define Crack). Первый узел все-
гда находится в крае трещины, второй � в углу того же элемента на удалении от края 
трещины. Третий узел необходим только для трехмерных задач с трещинами. При-
менение команды CRACK(Analysis > STATIC > CRACK > Define Crack) проиллюстри-
ровано ниже: 
Control Panel: Analysis > STATIC > CRACK > Define Crack 
Crack number >1 
Node 1 >5 
Node 2 >3 
Node 3 > 

Команды CRACKLIST и CRACKDEL (Analysis > STATIC > CRACK > List Crack, Delete 
Crack), находящиеся в подменю CRACK используются для просмотра или удаления 
созданных элементов. На рисунке показана КЭ-модель с приложенными нагрузками 
и граничными условиями. Также на рисунке показаны номера узлов в окончании 
трещины и углу четырехвершинного элемента. 

 

Рис. 11-13.  КЭ-модель с граничными условиями и нагрузками  

Теперь можно выполнить линейный статический расчет модели командой R_STATIC 
(Analysis > STATIC > Run Static Analysis). Основная система рассчитывает факторы 
интенсивности напряжений и записывает их в файл вывода. Для отображения дейст-
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вия геометрической особенности, привносимой трещиной, на распределение напря-
жений можно использовать команду STRPLOT (Results > PLOT > Stress). На рисунке 
показаны графики напряжений по фон Мизесу и деформированной формы модели. 

 

Рис. 11-14. Контурный график напряжений и деформированная форма плиты с трещиной  

Факторы интенсивности напряжений записываются в файл вывода jobname.OUT. В 
данном примере они равны: 
CRACK STRESS INTENSITY FACTORS  

KI = 0.892371E+03 

Заметьте, что фактор интенсивности напряжений моды II не имеет отношения к дан-
ной задаче. Аналитическое решение для фактора интенсивности напряжений моды I 
имеет следующий вид (Keer и Freedman, 1973): 

 (11-2) 

В таблице приведен сравнение результатов аналитического решения и решения в 
COSMOS/M. 

Таблица 11-1. Сравнение аналитического решения для KI и решения в COSMOS/M 

Решение для KI  Результат Ошибка (%) 
Теоретическое 925.868  N/A 
COSMOS/M, 300 элементов 892.371  3.62 

Пример LFEM2 � фактор интенсивности напряжений при изгибе по трем точкам 

Исходные данные для этого примера находятся в файле LEFM2.GEO. В данном при-
мере вычисляется фактор интенсивности напряжений моды I балки с трещиной по 
толщине в центре, подвергающейся действию сосредоточенной нагрузки, показанной 
на рисунке. Также называемый изгибом по трем точкам, такой тип моделей часто ис-
пользуется для экспериментального определения фактора интенсивности напряже-
ний моды I. Упругие свойства материала и размеры также приведены на рисунке. 
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Рис. 11-15. Задача на вычисление фактора интенсивности напряжений  

Симметрия модели позволяет выполнять расчет только для половины модели. Устано-
вите проекцию на плоскость XY кнопкой View. Геометрия и КЭ-сеть модели созда-
ются следующими командами: 
Control Panel: Geometry > GRID > Plane 
Rotation/sweep Axis >Z 
Offset on Axis >0.0 
Grid Line Style >Solid 
Control Panel: Geometry > SURFACES > Draw w/ 4 Coord 
Surface >1 
Keypoint 1 XYZ-Coordinate Value >20,20,0 
Keypoint 2 XYZ-Coordinate Value >100,20,0 
Keypoint 3 XYZ-Coordinate Value >100,60,0 
Keypoint 4 XYZ-Coordinate Value >20,60,0 
Click on Auto Scale icon ... 
Control Panel: Meshing > PARAMETRIC MESH > Surfaces 
Beginning surface >1 
Ending surface >1 
Increment >1 
Number of nodes per element >8 
Number of elements on the 1st curve >20 
Number of elements on the 2nd curve >10 
Примите значения по умолчанию ... 

Как и в предыдущем примере, КЭ-сеть будет сгенерирована с использованием элемен-
тов боле высокого порядка чтобы использовать четырехвершинный элемент. Эле-
мент PLANE2D, который необходимо использовать в данной задаче, а также свойст-
ва материала и сечения задаются следующими командами: 
Control Panel: Propsets > Element Group 
Element Group >1 
Element Category >Area 
Element Type (for area) >PLANE2D; 2D 4- to 8-node plane element 
Примите значения по умолчанию ... 
Control Panel: Propsets > Pick Material Lib 
Material Property set >1 
Имя материала >A_STEEL 
Unit Label >FPS 
Control Panel: Propsets > Real Constant 
Associated Element group >1 
Real Constant set >1 
Start loc. of the real const >1 
No. of real const to be entered >2 
RC1: Thickness >0.5 
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RC2: Material angle (Beta) >0.0 

На вертикальную ось симметрии накладываются граничные условия симметрии. По-
скольку трещина представляет собой незафиксированный край, на трещину не на-
кладываются ограничения по перемещениям. Горизонтальный компонент перемеще-
ний устанавливается равным нулю на вертикальной оси симметрии (но не в 
трещине). Граничные условия накладываются следующим образом: 
Control Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define Nodes 
Beginning node >1 
Displacement Label >UY; Y translation 
Value >0.0 
Ending node >1 
Increment >1 
Control Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define Nodes 
Beginning node >351 
Displacement Label >UX; X translation 
Value >0.0 
Ending node >351 
Increment >1 

Повторите эту команду для компонента UX в узлах 372, 413, 434, 475, 496, 537, 558, 
599, 620 и 661. Сосредоточенная нагрузка на верхней грани прикладывается следую-
щим образом: 
Control Panel: LoadsBC > STRUCTURAL > FORCE > Define Node 
Beginning node >661 
Force label >FY; Y force 
Value >-0.5 
Ending node >661 
Increment >1 

Теперь можно приступит к заданию четырехвершинного элемента в крае трещины. В 
данном примере первый узел, который всегда находится в крае трещины, имеет но-
мер 351, а второй узел, который находится в углу того же элемента на удалении от 
края трещины, � 289. Эти узлы указываются в команде CRACK(Analysis > STATIC > 
CRACK > Define Crack): 
Control Panel: Analysis > STATIC > CRACK > Define Crack 
Crack number >1 
Node 1 >351, 
Node 2 >289 
Node 3 >289 

На рисунке показана КЭ-модель с приложенными нагрузками и граничными условия-
ми. Также на рисунке показаны номера узлов в крае трещины и углу четырехвер-
шинного элемента.  
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Рис. 11-16. КЭ-модель с приложенными нагрузками и граничными условиями  

Теперь можно выполнить линейный статический расчет напряжений модели командой 
R_STATIC (Analysis > STATIC > Run Static Analysis).   

Действие геометрической особенности, привносимой трещиной, на напряжения мож-
но отобразить командой STRPLOT (Results > PLOT > Stress). На рисунке показаны 
графики напряжений по фон Мизесу и деформированной формы модели. 

 

Рис. 11-17. Контурный график напряжений и деформированная форма плиты с трещиной  

Факторы интенсивности напряжений записываются в файл вывода jobname.OUT. В 
данном примере они равны: 
CRACK STRESS INTENSITY FACTORS  

KI = 0.296985E+01 

Как и в предыдущем примере фактор интенсивности напряжений моды II не имеет 
значения в данной задаче. Аналитическое решение для фактора интенсивности на-
пряжений моды I имеет следующий вид (Gross и Srawley, 1972): 

  (11-3) 

В таблице приведено сравнение решений, полученных аналитически и в Основной 
Системе. Второе решение в Основной системе, полученной с использованием 800 
элементов, показывает сходимость к аналитическому решению для фактора интен-
сивности напряжений моды I. 

Таблица 11-2. Сравнение результатов, полученных в COSMOS/M и аналитического решения для KI 

Решение для KI  Результат Ошибка (%) 
Теоретическое 3.3541  N/A 
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COSMOS/M, 200 элементов 2.96985  11.46 
COSMOS/M, 800 элементов 3.05867  8.81 

Примеры расчета устойчивости  
Расчет устойчивости, определяющий критические нагрузки устойчивости и формы 
мод, применим ко многим практическим задачам в Основной Системе. Различные 
методы извлечения собственных значений и возможности моделирования, доступные 
в модуле DSTAR позволят вам изучить почти все ситуации моделирования и расчета. 
Из-за обширности материала продемонстрировать все возможности здесь невозмож-
но. Приведенный здесь пример демонстрирует применение некоторых возможностей, 
перечисленных в Главе 1. Кроме этого, во второй части настоящего Руководства 
приведено более 12 проверочных задач, которые могут оказаться полезными для изу-
чения различных аспектов расчета устойчивости. 

Пример BUCKL1 � устойчивость прямоугольной плиты, подвергающейся дейст-
вию распределенной нагрузки  

Исходные данные для этого примера находятся в файле BUCKL1.GEO. В данном при-
мере производится расчет устойчивости с собственными значениями прямоугольной 
плиты, подвергающейся действию распределенной нагрузки. Свойства материала и 
размеры плиты показаны на рисунке. Две стороны плиты имеют опоры, а две другие 
зажаты. Распределенная нагрузка постоянна и имеет единичную величину, так что 
вычисленные собственные значения дадут критические нагрузки устойчивости. В 
противном случае собственные значения представляют собой коэффициенты крити-
ческой нагрузки. 

 

Рис. 11-18. Задача на вычисление критической нагрузки и граничные условия  

На одну из зажатых сторон плиты действует распределенная нагрузка. Однако, чтобы 
произошло нарушение устойчивости модели, x-компонент перемещений на этой гра-
ни не был ограничен, в то время как на второй зажатой грани были зафиксированы 
все компоненты перемещений. На рисунке также показаны плита с приложенными 
граничными условиями в трех измерениях. Геометрия и КЭ-сеть модели создаются 
следующими командами: 
Control Panel: Geometry > GRID > Plane 
Rotation/sweep Axis >Z 
Offset on Axis >0.0 
Grid Line Style >Solid 
Control Panel: Geometry > SURFACES > Draw w/ 4 Coord 
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Surface >1 
Keypoint 1 XYZ-Coordinate value >20,20,0 
Keypoint 2 XYZ-Coordinate value >80,20,0 
Keypoint 3 XYZ-Coordinate value >80,40,0 
Keypoint 4 XYZ-Coordinate value >20,40,0 
Control Panel: Meshing > PARAMETRIC MESH > Surfaces 
Beginning surface >1 
Ending surface >1 
Increment >1 
Number of nodes per element >4 
Number of elements on 1st curve >20 
Number of elements on 2nd curve >10 
Примите значения по умолчанию 

Используйте автоматическое изменение масштаба для получения лучшей проекции 
модели. Стороны плиты с опорами моделируются фиксированием z-компонента пе-
ремещений. Распределенная нагрузка и граничные условия прикладываются сле-
дующими командами: 
Control Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define Curves 
Beginning curve >1 
Displacement label >UZ; Z translation 
Value >0.0 
Ending curve >4 
Increment >1 
Control Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define Curves 
Beginning curve >3 
Displacement label >ALL; All 6 DOF 
Value >0.0 
Ending curve >3 
Increment >1 
Control Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define Curves 
Beginning curve >4 
Displacement label >UY; Y translation 
Value >0.0 
Ending curve >4 
Increment >1 
Displacment label >RX; X rotation 
Displacment label >RY; Y rotation 
Displacment label >RZ; Z rotation 
Control Panel: LoadsBC > STRUCTURAL > PRESSURE > Define Curves 
Beginning curve >4 
Pressure magnitude >1 
Ending curve >4 
Increment >1 
Pressure at the end of direction 1 >1 
Pressure direction >Normal Direction 

Плита будет смоделирована с использованием элементов SHELL4, что указывается в 
команде EGROUP (Propsets > Element Group). Свойства материала и вещественные 
константы вводятся командами MPROP (Propsets > Material Property) и RCONST (Prop-
sets > Real Constant):  
Control Panel: Propsets > Element Group 
Element group >1 
Element category >Area 
Element type (for area) >SHELL4; 4-node thin shell element 
OP1: Type >QUAD4 
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... ... 
Примите значения по умолчанию 
Control Panel: Propsets > Material Property 
Material property set >1 
Material property name >EX; Elasticity modulus 1st dir 
Property value >30E6 
Material property name >NUXY; Poisson ratio 2nd to 1st 
Property value >0.3 
Control Panel: Propsets > Real Constant 
Associated Element group >1 
Real constant set >1 
Start loc. of the real const. >1 
No. of real const. to be entered >6 
RC1: Thickness >0.3 
... ... 
Примите значения по умолчанию 

Число мод устойчивости и метод извлечения собственных значений указываются в 
команде A_BUCKLING (Analysis > FREQUENCY/BUCKLING > Buckling Options). В 
данном примере мы найдем первые пять мод с помощью метода Ланцоша: 
Control Panel: Analysis > FREQUENCY/BUCKLING > Buckling Options 
Number of Eigenvalues >5 
Method >Lanczos method 
... ... 
Примите значения по умолчанию 

Теперь можно выполнить команду R_BUCKLING (Analysis > FREQUENCY/BUCKLING 
> Run Buckling) для вычисления критических нагрузок устойчивости. Результаты 
расчета записываются в файл вывода jobname.OUT. также критические нагрузки ус-
тойчивости можно вывести на экран командой FREQLIST (Results > LIST > Natural 
Frequency). Ниже приведены нагрузки устойчивости для первых пяти мод: 
B U C K L I N G E I G E N V A L U E (S)  

 by  

L A N C Z O S A L G O R I T H M  

 EIGENVALUE  EIGENVALUE  

  NUMBER  

 1  0.2712833E+05  

 2  0.2775473E+05  

 3  0.3399390E+05  

 4  0.3841013E+05  

 5  0.5009584E+05 

Аналитическое решение этой задачи, взятое из Roark's Formulas for Stress and Strain 
(Sixth Edition, Young, 1989), для a/b = 3 имеет вид: 

 (11-4) 

где b � длина короткой стороны, а t � толщина.  
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В таблице приведено сравнение результатов, полученных аналитически и в Основной 
Системе. 

Таблица 11-3. Сравнение аналитического решения и решения в COSMOS/M  

Решения для первой моды устойчивости  Результат Ошибка(%) 
Аналитическое 26925.82  N/A 
COSMOS/M, 200 элементов 27128.33  0.75 

Как видно из таблицы, решения, найденные в Основной Системе достаточно точны. 
Для отображения форм мод устойчивости можно использовать команду DEFPLOT 
(Results > PLOT > Deformed Shape). На рисунке показаны первые три моды устойчи-
вости в трех измерениях. 

 

Рис. 11-19. Формы мод устойчивости плиты в трех измерениях  

Вы можете изменить проекцию на двухмерную для отчетливого изображения боковых 
деформаций. на рисунке показаны первые три моды устойчивости в двухмерной про-
екции. 

 

Рис. 11-20. Формы мод устойчивости в двухмерной проекции  

Примеры модального расчета  
Модальный расчет, определяющий собственные частоты и формы мод, применим ко 
многим типам практических задач в Основной Системе. Различные методы извлече-
ния собственных значений и возможности моделирования модуля DSTAR позволят 
вам изучить почти все ситуации моделирования и расчета. Из-за обширности мате-
риала не представляется возможным продемонстрировать все возможности. Приве-
денные здесь два примера (MODAL1 и MODAL2) демонстрируют применение неко-
торых возможностей, перечисленных в Главе 1. Кроме этого, во второй части 
настоящего Руководства приведены проверочные задачи, которые могут оказаться 
полезными для понимания возможностей моделирования и расчета. 
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Пример MODAL1 � действие плоскостных эффектов на собственные частоты ко-
лонны  

Исходные данные для данного примера находятся в файле MODAL1.GEO. Для тонких 
конструкций с плоскостными эффектами тип преднапряжения оказывает значитель-
ное влияние на собственные частоты. Как было описано в Главе 2, сжимающие на-
грузки понижают собственные частоты, а растягивающие � повышают. Действие 
преднапряжения на собственные частоты велико для нескольких первых мод и по-
степенно уменьшается для высших мод. В данном примере численно демонстрирует-
ся действие сжимающего и растягивающего преднапряжения на собственные часто-
ты, по сравнению с частотами, полученными без преднапряжения. 

 

Рис. 11-21. Задача для модального расчета с учетом плоскостных эффектов  

Геометрия и КЭ-сеть для этой задачи создаются следующими командами: 
Control Panel: Geometry > GRID > Plane 
Rotation/sweep Axis >Z 
... ... 
Примите значения по умолчанию 
Control Panel: Geometry > CURVES > Draw Polyline 
Curve >1 
Keypoint 1 XYZ-Coordinate value >50,0,0 
Keypoint 2 XYZ-Coordinate value >50,55,0 
Keypoint 3 XYZ-Coordinate value >50,55,0 
Control Panel: Meshing > PARAMETRIC MESH > Curves 
Beginning curve >1 
Ending curve >1 
Increment >1 
Number of nodes per element >2 
Number of elements on each curve >8 
Spacing ratio >1.0 

Колонна будет смоделирована с использованием двухмерных балочных элементов 
elements (BEAM2D). Этот элемент выбирается в команде EGROUP (Propsets > Element 
Group), а свойства материала и вещественные константы вводятся в соответствую-
щих командах: 
Control Panel: Propsets > Element Group 
Element group >1 
Element category >Line 
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Element type (for line) >BEAM2D; 2D elastic beam element 
Примите значения по умолчанию 
Control Panel: Propsets > Real Constant 
Associated Element group >1 
Real constant set >1 
Start loc. of the real const. >1 
No. of real const. to be entered >8 
RC1: Cross-sectional area >1.0 
RC2: Moment of inertia IZ >0.01 
RC3: Depth >1.0 
Control Panel: Propsets > Pick Material Lib 
Material Property set >1 
Имя материала >A_STEEL 
Unit label >FPS 

Граничные условия по перемещениям в верху и низу колонны накладываются коман-
дой DND (LoadsBC > STRUCTURAL > DISPLACEMENT > Define Nodes), вертикаль-
ная нагрузка на колонну задается командой FND (LoadsBC > STRUCTURAL > 
FORCE > Define Nodes). Сначала вычислим собственные частоты при сжимающем 
преднапряжении. Это выполняется следующими командами: 
Control Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define Nodes 
Beginning node >9 
Displacement label >ALL; All 6 DOF 
Value >0.0 
Ending node >1 
Increment >1 
Control Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define Nodes 
Beginning node >9 
Displacement label >UX; X translation 
Value >0.0 
Ending node >9 
Increment >1 
Control Panel: LoadsBC > STRUCTURAL > FORCE > Define Nodes 
Beginning node >9 
Force label >FY; Y force 
Value >-1000 
Ending node >9 
Increment >1 

Действие преднапряжения на собственные частоты учитывается после активизирова-
ния соответствующего признака в команде A_FREQUENCY (Analysis > 
FREQUENCY/BUCKLING > Frequency Options). Также в этой команде указывается 
интересующее нас число собственных значений. В данном примере мы рассмотрим 
первые пять мод. 
Control Panel: Analysis > FREQUENCY/BUCKLING > Frequency Options 
Number of frequencies >5 
Method >Subspace iteration method 
Maximum number of iterations >16 
Sturm sequence flag >No 
Shift flag >No Eigenvalue Shift 
Shift value >0.0 
Inplane effect flag >Yes 
... ... 
Примите значения по умолчанию 

Теперь можно выполнить команду R_FREQUENCY (Analysis > 
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FREQUENCY/BUCKLING > Run Frequency) для вычисления первых пяти собствен-
ных частот колонны с учетом сжимающего преднапряжения. После успешного вы-
полнения расчета полученные собственные частоты можно вывести на экран коман-
дой FREQLIST (Results > LIST > Natural Frequency). 

Удалите нагрузку на верху колонны и задайте растягивающее преднапряжение: 
Control Panel: LoadsBC > STRUCTURAL > FORCE > Delete Nodes 
Beginning node >9 
Force label >FY; Y force 
Ending node >9 
Increment >1 
Control Panel: LoadsBC > STRUCTURAL > FORCE > Define Nodes 
Beginning node >9 
Force label >FY; Y force 
Value >10000 
Ending node >9 
Increment >1 

Перед выполнением нового расчета собственных частот необходимо активизировать 
признак, запрещающий перезапись результатов последнего расчета. Используйте ко-
манду PRINT_OPS (Analysis > OUTPUT OPTIONS > Set Print Options): 
Control Panel: Analysis > OUTPUT OPTIONS > Set Print Options 
Displacement Print Flag >Yes 
... ... 
Output Flag >Append 

Выполните расчет командой R_FREQUENCY (Analysis > FREQUENCY/BUCKLING > 
Run Frequency) для вычисления первых пяти собственных частот колонны с учетом 
растягивающей нагрузки. 

Удалите нагрузку на верху колонны командой FNDEL (LoadsBC > STRUCTURAL > 
FORCES > Delete Nodes) и деактивируйте признак учета плоскостных эффектов в ко-
манде A_FREQUENCY (Analysis > FREQUENCY/BUCKLING > Frequency Options).  
Выполните расчет еще раз, чтобы получить результаты без преднапряжения. Вы 
также можете использовать команду FREQLIST (Results > LIST > Natural Frequency) 
для просмотра вычисленных собственных частот. Результаты дописываются в файл 
вывода jobname.OUT. 

В таблице приведена сводка результатов для первых пяти мод. Из результатов ясно 
видно действие сжимающего и растягивающего преднапряжения на собственные 
частоты. Как утверждалось ранее, действие преднапряжения уменьшается для выс-
ших мод. 
Номер моды Сжимающее преднапря-

жение  
Частота (Hz) 

Нет преднапря-
жения  

Частота (Hz) 

Растягивающее пред-
напряжение  
Частота (Hz) 

1 11.71 16.44 20.03 
2 48.43 53.26 57.68 
2 48.43 53.26 57.68 
3 105.92 110.83 115.54 
4 183.02 187.90 192.66 
5 275.20 279.88 284.47 

Более отчетливо действие преднапряжения представлено на рисунке. 
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Рис. 11-22. Действие сжимающего и растягивающего преднапряжения на собственные частоты  

Для отображения мод свободной вибрации колонны используется команда DEFPLOT 
(Results > PLOT > Deformed Shape). На рисунке показаны первые три моды колонны 
без преднапряжения. 

 

Рис. 11-23. Моды свободной вибрации колонны  

Пример MODAL2 � модальный расчет квадратной рамы с модами жесткого тела  

Исходные данные для этой задачи находятся в файле MODAL2.GEO. Задача состоит 
из квадратной рамы со свойствами и размерами, приведенными на рисунке. Рама, 
лежащая в двухмерном пространстве, не закреплена. Необходимо найти первые 10 
собственных частот и форм мод. 

 

Рис. 11-24. Задача на модальный расчет с модами жесткого тела  

Геометрия и КЭ-сеть задачи создаются следующими командами: 
Control Panel: Geometry > GRID > Plane 
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Rotation/sweep Axis >Z 
Offset on Axis >0.0 
Grid Line Style > Solid 
Control Panel: Geometry > CURVES > Draw Polyline 
Curve >1 
Keypoint 1 XYZ-Coordinate value >20,20,0 
Keypoint 2 XYZ-Coordinate value >80,20,0 
Keypoint 3 XYZ-Coordinate value >80,80,0 
Keypoint 4 XYZ-Coordinate value >20,80,0 
Keypoint 5 XYZ-Coordinate value >20,20,0 
Control Panel: Meshing > PARAMETRIC MESH > Curves 
Beginning curve >1 
Ending curve >4 
Increment >1 
Number of nodes per element >2 
Number of elements on each curve >5 
Spacing ratio >1.0 

Установите проекцию на плоскость XY. Для того, чтобы модель помещалась в окно 
отображения можно использовать автоматическое изменение масштаба. Для модели-
рования рамы будут использованы элементы BEAM2D. Этот элемент выбирается в 
команде EGROUP (Propsets > Element Group), а свойства материала и вещественные 
константы вводятся в соответствующих командах: 
Control Panel: Propsets > Element Group 
Element group >1 
Egroup category >Line 
Element type (for line) >BEAM2D; 2D elastic beam element 
Примите значения по умолчанию 
Control Panel: Propsets > Real Constant 
Associated Element group >1 
Real constant set >1 
Start loc. of the real const. >1 
No. of real const. to be entered >8 
RC1: Cross-sectional area >1 
RC2: Moment of inertia (IZ) >0.01 
RC3: Depth >1 
... ... 
Примите значения по умолчанию 
Control Panel: Propsets > Pick Material Lib 
Material Property set >1 
Имя материала >A_STEEL 
Unit label >FPS 

Поскольку КЭ-сеть для каждой КРИВОЙ генерировалась по отдельности, в каждом 
углу будет по два узла. Для выполнения требований совместимости необходимо вы-
полнить «слияние» узлов. Для «слияния» узлов и их перенумерации используются 
команды NMERGE (Meshing > NODES > Merge) и NCOMPRESS (Edit > COMPRESS > 
Nodes). 

Поскольку данная модель ограничена двумя измерениями, будут присутствовать три 
моды жесткого тела: два линейных движения и одно угловое. Как было описано в 
Главе 2, задачи с модами жесткого тела можно рассчитывать двумя способами: ис-
пользовать сдвиг собственных значений или добавление мягкой пружины; оба вари-
анта указываются в команде A_FREQUENCY (Analysis > FREQUENCY/BUCKLING > 
Frequency Options). Мы используем оба варианта и сравним результаты. В данном 



 205

примере мы вычислим первые десять мод свободной вибрации и соответствующие 
формы мод. Число собственных значений и сдвиг собственных значений указывают-
ся в команде A_FREQUENCY (Analysis > FREQUENCY/BUCKLING > Frequency Op-
tions): 
Control Panel: Analysis > FREQUENCY/BUCKLING > Frequency Options 
Number of frequencies >10 
Method >S 
Maximum number of iterations >16 
Sturm sequence flag >No 
Shift flag >Shift by program 
Shift value >0.0 
... ... 
Примите значения по умолчанию 

Затем необходимо выполнить команду R_FREQUENCY (Analysis > 
FREQUENCY/BUCKLING > Run Frequency) для выполнения модального расчета 
квадратной рамы. После успешного выполнения расчет вычисленные собственные 
частоты можно вывести на экран командой FREQLIST (Results > LIST > Natural 
Frequency). В таблице приведены номера мод и соответствующие частоты, получен-
ные со сдвигом собственных значений. Первые три моды представляют собой моды 
жесткого тела с пренебрежимо малыми частотами. Также в этой таблице приведены 
собственные частоты, полученные при добавлении мягкой пружины, получение ко-
торых будет описано ниже. 

Таблица 11-5. Сравнение собственных частот полученных с использованием сдвига собственных значе-
ний и с добавлением мягкой пружины  

Номер моды Частота (Hz.) (Сдвиг) Частота (Hz.) (Пружина) 
1 2.15694e-05 1.70680e-03 
2 9.03026e-06 1.70692e-03 
3 1.16211e-05 1.70759e-03 
4 5.10878e+00 5.10878e+00 
5 8.87700e+00 8.87700e+00 
6 1.72265e+01 1.72265e+01 
7 1.72265e+01 1.72265e+01 
8 2.01030e+01 2.01030e+01 
9 3.75790e+01 3.75791e+01 

10 4.49250e+01 4.49251e+01 

Для отображения форм мод используется команда DEFPLOT (Results > PLOT > De-
formed Shape). Моды жесткого тела также могут быть вычислены с добавлением 
мягкой пружины. Как было описано в Главе 2, добавление мягкой пружины прибав-
ляет небольшую величину к диагональным членам матрицы конструкционной жест-
кости для достижения численной устойчивости. В Основной Системе жесткость мяг-
кой пружины можно варьировать. Добавление мягкой пружины производится 
следующим образом: 
Control Panel: Analysis > FREQUENCY/BUCKLING > Frequency Options 
Number of frequencies >10 
Method >Subspace iteration method 
Maximum number of iterations >16 
Sturm sequence flag >No 
Shift flag >No Eigenvalue Shift 
Shift value >0.0 
Inplane effect >No 
Tolerance >0.000010 
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Soft Spring flag >Yes 
... ... 
Примите значения по умолчанию 

Используйте команду PRINT_OPS (Analysis > OUTPUT OPTIONS > Set Print Options) 
чтобы дописать результаты нового расчета к результатам предыдущего в файле вы-
вода. Затем выполните команду R_FREQUENCY (Analysis > FREQUENCY/BUCKLING 
> Run Frequency) для вычисления собственных частот и форм мод квадратной рамы. 
После успешного выполнения расчета можно вывести вычисленные собственные 
частоты на экран командой FREQLIST (Results > LIST > Natural Frequency). Как видно 
из таблицы, первые три моды, представляющие моды жесткого тела, имеют пренеб-
режимо малые частоты. Можно заметить, что собственные частоты деформируемых 
мод (начиная с моды 4) идентичны полученным с использованием сдвига собствен-
ных значений. На рисунке показаны три моды жесткого тела, полученные с добавле-
нием мягкой пружины. 

 

Рис. 11-25. Моды жесткого тела, полученные с добавлением мягкой пружины  

При любом варианте для отображения деформируемых мод свободной вибрации квад-
ратной рамы используется команда DEFPLOT (Results > PLOT > Deformed Shape). На 
рисунке показаны четвертая, пятая и шестая моды свободной вибрации. 

 

Рис. 11-26. Деформируемые моды свободной вибрации квадратной рамы, полученные с добавлением мяг-
кой пружины  

Примеры использования подмоделей  
Использование подмоделей позволяет улучшить точность решения в критичных мес-
тах модели без необходимости повторного расчета всей модели. Для больших задач 
это позволяет сэкономить вычислительные ресурсы. 

Пример LSUBM1 � использование подмоделей в задачах с оболочками  

Исходные данные для этого примера находятся в файле LSUBM1.GEO. На рисунке 
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показано изображение модели, на один из концов которой наложены граничные ус-
ловия, а к другому приложены силы. 

 
Рис. 11-27. Геометрия модели для расчета  

После первого выполнения расчета распределение напряжений по фон Мизесу можно 
просмотреть в более удобной проекции, как показано на рис. 11-28. Для этого необ-
ходимо установить проекцию на плоскость XZ. 
Control Panel: Results > PLOT > Stress 
Load case number >1 
Component >VON 
Layer number >1 
Coordinate system >0 
Stress Flag >Nodal Stress 
Face of element >Top Face 
Выберите контурный график и примите значения по умолчанию 

 
Рис. 11-28. Распределение напряжений по фон Мизесу после первого выполнения расчета  

Для улучшения точности результатов в областях концентрации напряжений командой  
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SELWIN (Control > SELECT > by Windowing) необходимо выбрать четыре области, ок-
ружающие отверстия, на которые были наложены ограничения (список выбранных 
элементов можно найти в файле LSUBM1.GEO). 

После того как выбор элементов для подмодели завершен, используйте команду 
SUBMODEL (Analysis > STATIC > Define SubModel) для активизирования подмодели-
рования и локального улучшения КЭ-сети. Запустите модуль STAR для расчета под-
модели. 
Control Panel: Analysis > STATIC > Define SubModel 
Submodeling option >On 
Push boundary node flag >No 
Control Panel: Analysis > STATIC > Run Static Analysis 

На рисунке отображены напряжений по фон Мизесу. Заметьте, что для отображения 
всей модели необходимо деактивировать список выбора. 
Control Panel: Control > SELECT > Initialize 
Entity name >Elements 
... ... 
Примите значения по умолчанию 
Control Panel: Results > PLOT > Stress 
Load case number >1 
Component >VON 
Layer number >1 
Coordinate system >0 
Stress Flag >Nodal Stress 
Face of element >Top Face 
Выберите контурный график и примите значения по умолчанию 

 

Рис. 11-29.  Распределение напряжений по фон Мизесу после расчета подмодели 

Максимальное напряжение по фон Мизесу, вычисленное при расчете подмодели, от-
личается от предыдущего приблизительно на 10% (см. диаграмму). 

Если вы деактивируете подмоделирование (отключается в команде SUBMODEL (Analy-
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(Analysis > STATIC > Define SubModel)) и выполните расчет всей модели, то расчет 
займет 20 минут на компьютере с 486 процессором с частотой 66 MHz, а для подмо-
дели расчет занимает только 3 минуты. Величина сэкономленного времени увеличи-
вается с ростом размера модели. Кроме этого, максимальные напряжения по фон Ми-
зесу, полученные при расчете всей модели (включая улучшенную КЭ-сеть) 
практически совпадают со значениями, полученными при расчете только подмодели. 
Точность результатов расчета подмодели зависит от степени удаленности границ 
подмодели от областей концентрации напряжений. 

Пример LSUBM2 � использование подмоделей с четырехгранными элементами  

Исходные данные для этого примера находятся в файле LSUBM2.GEO. На рисунке 
показано распределение напряжений по фон Мизесу в соединении после первого вы-
полнения расчета. 

 

Рис. 11-30. Распределение напряжений по фон Мизесу после первого расчета  

Для более удобного выбора подмодели необходимо установить проекцию на плос-
кость XZ. 
Control Panel: Control > SELECT > by Windowing 
... Выберите необходимую область ... 

(Примечание: вместо этого можно использовать команде SELRANGE (Control > 
SELECT > by Range)). 
Control Panel: Analysis > STATIC > Define SubModel 
Submodeling option >On 
Push boundary node flag >No 
Control Panel: Analysis > STATIC > Run Static Analysis 
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Рис. 11-31. Область, выбранная в качестве подмодели 

На рис. 11-32 показано распределение напряжений по фон Мизесу после выполнения 
расчета подмодели. Изменить проекцию на изометрическую можно с помощью 
кнопки View. 
Control Panel: Control > SELECT > Initialize 
Entity name >Elements 
... ... 
Примите значения по умолчанию 
Control Panel: Results > PLOT > Stress 
Load case number >1 
Component >VON 
Layer number >1 
Coordinate system >0 
Stress Flag >Nodal Stress 
Face of element >Top Face 
Выберите контурный график и примите значения по умолчанию 

 

Рис. 11-32. Напряжения по фон Мизесу для подмодели 

После расчета подмодели максимальное значение напряжений по фон Мизесу увели-
чивается с 474 psi до 509 psi. 

Пример LSUBM3 � использование подмоделей в задачах с оболочками  

Исходные данные для этого примера находятся в файле LSUBM3.GEO. Модель пред-
ставляет приборную доску автомобиля, подвергающуюся действию распределенных 
и сосредоточенных нагрузок. На рисунке показано распределение напряжений по 
фон Мизесу после первого выполнения расчета. Для улучшения точности результа-
тов в нижней части модели используйте команду SELWIN (Control > SELECT > by 
Windowing), используя круглое окно выбора для задания подмодели. 
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Рис. 11-33. Распределение напряжений по фон Мизесу после первого выполнения расчета  

Control Panel: Analysis > STATIC > Run Static Analysis 
(Первый расчет)  
Control Panel: Control > SELECT > by Windowing 
(Выберите область для создания подмодели) 
Control Panel: Analysis > STATIC > Define SubModel 
Submodeling option >On 
Push boundary node flag >No 
Control Panel: Analysis > STATIC > Run Static Analysis 
(Run analysis on the submodel) 
Control Panel: Control > SELECT > Initialize 
Entity name >Elements 
... ... 
Примите значения по умолчанию 
Control Panel: Results > PLOT > Stress 
Load case number >1 
Component >VON 
Layer number >1 
Coordinate system >0 
Stress Flag >Nodal Stress 
Face of element >Top Face 
Выберите контурный график и примите значения по умолчанию 

 

Рис. 11-34. Локальное распределение напряжений по фон Мизесу для подмодели  
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Максимальное значение напряжений по фон Мизесу увеличилось с 2.61E5 psi до 
2.72E5 psi. 

Пример проверки ASME  
В следующем примере напряжения в сечении, связанном с оболочкоподобными кон-
струкциями, пересчитываются на основе избыточных сил и моментов с цель сравне-
ния их с допустимыми напряжениями Sm, 1.5 Sm и 3 Sm, приведенными в секции III 
кода ASME и в соответствии с Gordon, 1976 (более подробная информация приведе-
на в Главе 2 и Приложении C). 

Пример ASME.GEO � оценка кода ASME  

Исходные данные для этого примера находятся в файле ASME.GEO. Напряжения вы-
числяются в двух концах сечения, определяемого сектором поперечного сечения осе-
симметричного сопла, подвергающегося действию внутреннего давления, согласно 
коду ASME. Данный пример иллюстрирует общее использование этой возможности. 
Однако в типичной задаче для нахождения максимального напряжения может потре-
боваться рассмотрение нескольких сечений. Сечение задается двумя узлами в его 
концах. Эти узлы могут быть заданы в любом месте модели, и они могут не принад-
лежать к КЭ-сети (то есть, они не должны быть обязательно связаны с какими-либо 
элементами). В Приложении C приведена информация о нахождении правильной 
ориентации сечений в нерегулярных областях, как, например, место соединения обо-
лочек и сопла. 

 

Рис. 11-35. Сечение, заданное по толщине сопла  

Приведенные ниже команды относятся только проверке кода ASME. 

Чтобы использовать эту возможность, активизируйте признак ASME в команде 
A_STRESS (Analysis > STATIC > Stress Analysis Options): 
Control Panel: Analysis > STATIC > Stress Analysis Options 
AISC code check >No 
... ... 
ASME code check flag >Yes 
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Control Panel: Analysis > STATIC > ASME CODE > Define ASME Section 
ASME section >1 
First node >55 
Second node >75 
Number of points >25 
Radius of curvature: 0=plane >0 axisym -1 straight >-1 
Thickness direction bending stress flag >Yes 

В вышеприведенной команде сечение задается указанием меток узлов. Можно задать 
до 300 сечений в различных областях конструкции. Во втором и третьем приглаше-
ниях команды указываются метки узлов в двух концах сечения, 55 и 75. В четвертом 
приглашении, значение (по умолчанию 25) указывает программе рассматривать 
только 25 точек интегрирования в сечении. Однако в сечении с большим градиентом 
напряжений можно использовать до 65 точек (вы можете проверить изменение на-
пряжений, отобразив напряжения по фон Мизесу вдоль сечения командой LSECPLOT 
(Results > PLOT > Path Graph)). В пятом приглашении, "Radius of curvature" (Радиус 
кривизны), указывается, производится ли вычисление для плоских задач (таких как 
плоские напряжения, плоские деформации или осесимметричные задачи, аппрокси-
мированные Декартовой формулировкой) или истинно осесимметричных задач, та-
ких как рассматриваемый пример. Если рассматривать конструкцию в сечении 1 как 
цилиндр с прямыми стенками (внутренней и внешней), то радиус кривизны следует 
принимать бесконечным (описание радиуса кривизны приведено в Приложении C, 
подраздел Осесимметричная формулировка). Это указывается вводом -1 или боль-
шого числа в данном приглашении. Однако если вы хотите рассмотреть закругление 
в нижней части сечения, то необходимо указать радиус кривизны средней линии, ко-
торый в данной модели равен приблизительно 2 дюймам. Последнее приглашение 
используется для указания программе рассматривать или игнорировать изгибающие 
напряжение по направлению толщины (более подробная информация приведена в 
Приложении C). Для проверки активности этой опции используется команда A_LIST, 
STRESS (Analysis > List Analysis Option), а для просмотра или удаления сечений ис-
пользуются команды ASMESECLIS и ASMESECDEL (Analysis > STATIC > ASME 
CODE > List ASME Section, Delete ASME Section), соответственно. После выполнения 
расчета результаты дописываются в конец файла вывода, и их можно сравнивать с 
допустимыми напряжениями кода ASME. 

Поскольку все вычисления для проверки кода ASME выполняются на стадии расчета 
напряжений, необходимость повторно вычислять перемещения, если вы изменили 
или добавили сечения, отсутствует. В этом случае необходимо повторно выполнить 
расчет напряжений командой R_STRESS (Analysis > STATIC > Run Stress Analysis). 
Кроме этого, если требуется задать сечение, не совпадающее с естественными грани-
цами элементов КЭ-сети, вы можете добавить два узла в любом месте модели и свя-
зать их с двумя концами сечения. Кроме линейного статического расчета, проверка 
кода ASME также применима к расчету временных характеристик в модуле расши-
ренной динамики. 

Пример использования множественных термальных вариантов 
нагрузки  

Во всех первичных вариантах нагрузки можно учитывать термальные эффекты, при-
чем температуры могут быть либо введены пользователем, либо считаны из предва-
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рительно проведенного термального расчета. В следующем примере продемонстри-
рованы оба типа задания термальных нагрузок. 

Пример TEMP1.GEO � множественные термальные варианты нагрузки  

Исходные данные для этой задачи находятся в файле TEMP1.GEO. Модель осесим-
метричного сопла рассматривается при пяти различных вариантах нагружения, каж-
дый из которых представлен вариантом нагрузки:  

a. Вариант нагрузки 5:  
Сосредоточенная нагрузка на кончике сопла и узловые температуры, взятые с вре-
менного шага 6 предварительно выполненного термального расчета. 

b. Вариант нагрузки 10:  
Узловые температуры задаются пользователем. 

c. Вариант нагрузки 20:  
Узловые температуры задаются пользователем. 

d. Вариант нагрузки 30:  
Узловые температуры, взятые с временного шага 20 предварительно выполненного 
термального расчета. 

e. Вариант нагрузки 40:  
Узловые температуры, взятые с временного шага 10 предварительно выполненного 
термального расчета. 

 

Рис. 11-36. Осесимметричное сопло  
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Рис. 11-37. нагрев сопла жидкостью  

Предположим, что сопло нагревается жидкостью, причем температура изменяется как 
показано на рисунке. Сначала необходимо выполнить термальный расчет переходно-
го состояния в модуле HSTAR или FFE Thermal. Чтобы просмотреть команды, отно-
сящиеся к термальному расчету, откройте файл TEMP1.GEO. После выполнения 
термального расчета активизируйте признак термальной нагрузки: 
Control Panel: Analysis > STATIC > Static Analysis Options 
Loading flag >T 
... ... 
Примите значения по умолчанию 

Чтобы задать вариант нагрузки 5, выполните следующие команды: 
Control Panel: Control > ACTIVATE > Set Entity 
Set label >LC 
Load case set number >5 
(Активизируйте вариант нагрузки 5) 
Control Panel: LoadsBC > STRUCTURAL > FORCE > Define Nodes 
Beginning node >101 
Force label >FX; X force 
Value >100 
Ending node >101 
Increment >1 
(Приложите узловую силу величиной 100 единиц в узле 101) 
Control Panel: LoadsBC > LOAD OPTIONS > Read Temp as Load 
Time step label >6 
Load case number >5 
(Считайте профиль температуры из временного шага 6 в вариант нагрузки 5) 

Чтобы задать вариант нагрузки 10: 
Control Panel: Control > ACTIVATE > Set Entity 
Set label >LC 
Load case set number >10 
(Активизируйте вариант нагрузки 10) 
Control Panel: LoadsBC > THERMAL > TEMPERATURE > Define Nodes 
Beginning node >101 
Value >200 
Ending node >104 
Increment >1 
(Задайте узловую температуру,  равную 200 в узлах с 101 по 104) 

Чтобы задать вариант нагрузки 20: 
Control Panel: Control > ACTIVATE > Set Entity 
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Set label >LC 
Load case set number >20 
(Активизируйте вариант нагрузки 20) 
Control Panel: LoadsBC > THERMAL > TEMPERATURE > Define Nodes 
Beginning node >101 
Value >400 
Ending node >104 
Increment >1 
(Задайте узловую температуру,  равную 400  в узлах с 101 по 104) 

Чтобы задать вариант нагрузки 30: 
Control Panel: Control > ACTIVATE > Set Entity 
Set label >LC 
Load case set number >30 
(Активизируйте вариант нагрузки 30) 
Control Panel: LoadsBC > LOAD OPTIONS > Read Temp as Load 
Time step label >20 
Load case number >30 
(Считайте профиль температуры из временного шага 20 в вариант нагрузки 30) 

Чтобы задать вариант нагрузки 40: 
Control Panel: LoadsBC > LOAD OPTIONS > Read Temp as Load 
Time step label >10 
Load case number >40 
(Считайте профиль температуры из временного шага 10 в вариант нагрузки 40) 

После того как все варианты нагрузки заданы, можно выполнять статический расчет 
командой R_STATIC (Analysis > STATIC > Run Static Analysis). Постпроцессинг мож-
но выполнять для всех вариантов нагрузки, как обычно. 
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Глава 12. 
Междисциплинарный расчет  
Введение  

В COSMOS/M из модуля пре- и постпроцессинга, GEOSTAR, можно получить доступ 
ко всем расчетным модулям. Вы можете создать КЭ-модель и выполнять различные 
расчеты одной и той же модели, не покидая GEOSTAR. Кроме этого, можно исполь-
зовать взаимодействие различных расчетных модулей, то есть использовать резуль-
таты одного расчета в качестве нагрузок в другом. Такое взаимодействие имеет 
большое значение в практических задачах. Например, вы можете выполнить тер-
мальный расчет переходного состояния в модуле HSTAR и перенести результаты как 
термальную нагрузку в Основную Систему командой TEMPREAD (LoadsBC > LOAD 
OPTIONS > Read Temp as Load). В данной главе рассмотрено только взаимодействие 
расширенных модулей и Основной Системы, а полный список возможных взаимо-
действие различных расчетных модулей COSMOS/M приведен в Главе 3 Руководства 
пользователя COSMOS/M. 

Междисциплинарным расчетом в настоящем Руководстве называется взаимодействие 
электромагнитного, термального расчетов и расчета тока жидкости с линейным ста-
тическим, модальным расчетами и расчетом устойчивости, доступными в Основной 
Системе. Взаимодействие расширенных модулей, ESTAR, HSTAR, и FLOWSTAR, с 
модулями STAR и DSTAR Основной Системы однонаправлено. Сначала необходимо 
выполнить необходимый КЭ-расчет в соответствующем модуле. После успешного 
выполнения расчета результаты переносятся с использованием одной из команд счи-
тывания как эквивалентные механические или термальные нагрузки в Основную 
Систему для дальнейшего расчета. 

В данной главе представлено подробное описание процедур выполнения междисцип-
линарного расчета в Основной Системе. Команды и процедуры поясняются на при-
мерах, рассматривающих все необходимые этапы, и сопровождаемых иллюстрация-
ми. 

ПРИМЕЧАНИЕ: Также существует возможность комбинировать результаты расши-
ренного динамического расчета (выполняемого в модуле ASTAR) с результатами 
расчета в Основной Системе, но только на этапе постпроцессинга. 

Междисциплинарный расчет в COSMOS/M 
Взаимодействие расширенных расчетных модулей с Основной Системой представлено 
на рисунке. Термины термоупругий расчет, квазистатический расчет и магнитоупру-
гий расчет обозначают типы расчетов, которые вы моете выполнять в результате 
взаимодействия с Основной Системой. Чтобы выполнять эти расчеты, должны быть 
установлены соответствующие расширенные модули. Заметьте, что между термаль-
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ным и электромагнитными модулями существует однонаправленная связь, которая 
активизируется в команде A_MAGNETIC (Analysis > ELECTRO MAGNETIC > Analysis 
Options) или A_THERMAL (Analysis > HEAT TRANSFER > Thermal Analysis Options). 
После этого вычисленные температуры можно перенести в Основную Систему для 
термоупругого расчета. Это можно использовать для расчета таких задач как тер-
мальные деформации от Джоулева нагрева (Joule heating). 

 

Рис. 12-1. Взаимодействие расширенных расчетных модулей с Основной Системой  

Команда TEMPREAD (LoadsBC > LOAD OPTIONS > Read Temp as Load) связывает уз-
ловые температуры термального расчета устойчивого состояния или какого-либо 
временного шага расчета переходного расстояния с вариантами нагрузки линейного 
статического расчета. Команда NPRREAD (LoadsBC > LOAD OPTIONS > Read Fluid 
Pressure) прикладывает давление, рассчитанное жидкостным модулем на некотором 
временном шаге, к граням элементов, связанных с указанными КРИВЫМИ. Для маг-
нитно-конструкционного связывания используется команда EMFREAD (LoadsBC > 
LOAD OPTIONS > Read Emag Force), переносящая в Основную Систему узловые 
магнитные силы. В таблице приведена сводка функций этих команд и названия раз-
делов, в которых приведены примеры использования этих команд. Все команды, 
приведенные в таблице, находятся в меню LoadsBC, подменю LOAD OPTIONS. 

Таблица 12-1. Команды для выполнения междисциплинарного расчета  

Тип переноса данных  Команда Раздел 
Расчет теплопереноса (HSTAR) � Основная 
Система (STAR, DSTAR)  

TEMPREAD  Термоупругий расчет в модулях 
HSTAR и STAR 

Расчет тока жидкости (FLOWSTAR) � Ос-
новная Система (STAR, DSTAR)  

NPRREAD  Квазистатический расчет напряже-
ний в модулях FLOWSTAR и STAR 

Электромагнитный расчет (ESTAR) � Ос-
новная Система (STAR, DSTAR)  

EM_OUTPUT 
EMFREAD  

Магнитоупругий расчет в модулях 
ESTAR и STAR 

Все расчетные модули (кроме термального модуля HSTAR) записывают результаты 
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расчета в файл вывода с расширением OUT. Результаты термального расчета записы-
ваются в файл с расширением TEM. Однако, содержимое файлов вывода по умолча-
нию заменяется результатами расчета, выполненного последним. То есть вам необ-
ходимо предотвратить перезапись результатов, установив соответствующий признак 
в команде PRINT_OPS (Analysis > OUTPUT OPTIONS > Set Print Options). 

ПРИМЕЧАНИЕ: Файлы с исходными данными для примеров, приведенных в данной 
главе, находятся в сжатом файле PROBLEMS.EXE, находящемся в директории 
COSMOS/M. Однако рекомендуется выполнять примеры так, как они приведены в 
данной главе. 

Как упоминалось ранее, существует возможность комбинировать результаты расши-
ренного динамического расчета (выполняемого в модуле ASTAR) с результатами 
расчета, выполненного в Основной Системе, но только на этапе постпроцессинга. 
Это выполняется командой READ_PDRESP (Read Post-Dyn Response), находящейся в 
меню Results. Эта команда считывает перемещения и напряжений с указанного вре-
менного (или частотного) шага расширенного динамического расчета и сохраняет их 
для постпроцессинга во вторичном варианте нагрузки в Основной Системе. Вторич-
ный вариант нагрузки может быть скомбинирован с первичными вариантами нагруз-
ки Основной Системы командой LCCOMB (Results > Combine Load Case). Применение 
Для применения команды READ_PDRESP (Results > Read Post-Dyn Response) требует-
ся, чтобы результаты расширенного динамического расчета находились в той же базе 
данных, что и результаты расчета Основной Системы. 

В следующих разделах описано применение команд одностороннего взаимодействия 
между расширенными расчетными модулями и Основной Системой с подробными 
примерами. 

Термоупругий расчет в модулях HSTAR и STAR 
Термальный модуль HSTAR используется для выполнения линейного и нелинейного 
расчета теплопереноса задач на теплопроводность, конвекцию и излучение. Незави-
симо от типа выполняемого расчета, возможен перенос результатов в Основную Сис-
тему. Команда TEMPREAD (LoadsBC > LOAD OPTIONS > Read Temp as Load) связы-
вает узловые температуры с указанного временного шага расчета теплопереноса 
переходного состояния c вариантом нагрузки в Основной Системе. Для расчета ус-
тойчивого состояния номер временного шага необходимо указать равным 1. В расче-
те можно использовать до 50 термальных вариантов нагрузки. Более подробная ин-
формация приведена в Главе 7, Нагрузки и граничные условия. 

ПРИМЕЧАНИЕ: Чтобы использовать термальную нагрузку необходимо активизиро-
вать признак особой нагрузки в команде A_STATIC (Analysis > STATIC > Static 
Analysis Options). 

Пример TEMPR1 � расчет термальных напряжений в теплообменнике  

В данном примере (файл TEMPR1.GEO) рассматривается расчет термальных напря-
жений в теплообменнике, состоящем из сектора трубы в 30° с ребрами на внешней 
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поверхности. На рисунке приведены свойства материала и термальные граничные 
условия для термального расчета. Также на рисунке показано увеличенное изобра-
жение ребра с переменными с окружающими температурами. Для конструкционного 
расчета предполагается, что верхняя и нижняя поверхности трубы зафиксированы, и 
единственной приложенной нагрузкой является термальная, считываемая из резуль-
татов расчета теплопереноса. 

 

Рис. 12-2. Геометрия и термальные граничные условия и нагрузки теплообменника  

Геометрия теплообменника создается путем задания поперечного сечения и «охваты-
ванием» его на угол 30° вокруг оси Y. Процедура, использованная здесь для построе-
ния модели может не быть оптимальной, так как главная цель данного примера � 
продемонстрировать взаимодействие термального модуля и Основной Системы. 

Чтобы начать работу установите рабочую плоскость: 
Control Panel: Geometry > GRID > Plane 
Rotation/sweep Axis >Z 
Offset on Axis >0.0 
Grid Line Style >Solid 

Затем создайте КЛЮЧЕВЫЕ ТОЧКИ для ПОВЕРХНОСТЕЙ и линий командой PT: 
Control Panel: Geometry > POINTS > Define 
Keypoint >1 
XYZ-Coordinate value >25,150,0 

Повторите эту команду для ТОЧЕК с 2 по 20, указывая следующие координаты: 

ТОЧКА Координаты 
2 40,150,0 
3 40,140,0 
4 35,135,0 
5 25,0,0 
6 40,0,0 
7 40,10,0 
8 35,15,0 
9 35,75,0 
10 55,75,0 
11 35,65,0 
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12 55,65,0 
13 35,85,0 
14 55,85,0 
15 35,95,0 
16 55,95,0 
17 35,55,0 
18 55,55,0 
19 35,150,0 
20 35,0,0 

Если необходимо, используйте команду SCALE, чтобы все созданные КЛЮЧЕВЫЕ 
ТОЧКИ помещались на экране. Затем по этим ТОЧКАМ необходимо создать три 
ПОВЕРХНОСТИ и пять линий. ПОВЕРХНОСТИ после «охватывания» их вокруг оси 
Y образуют ОБЪЕМЫ, представляющие сектор трубы, а линии образуют 
ПОВЕРХНОСТИ, представляющие ребра. ПОВЕРХНОСТИ и линии поперечного се-
чения создаются следующим образом: 
Control Panel: Geometry > SURFACES > Define by 4 Pt 
Surface >1 
Keypoint 1 >5 
Keypoint 2 >20 
Keypoint 3 >19 
Keypoint 4 >1 
Underlying Surface > 

Повторите эту команду для создания ПОВЕРХНОСТИ 2 по ТОЧКАМ 19,2,3,4 и 
ПОВЕРХНОСТИ 3 по ТОЧКАМ 8,7,6,20. 
Control Panel: Geometry > CURVES > Line with 2 Pts 
Curve >13 
Keypoint 1 >15 
Keypoint 2 >16 

Повторите эту команду для создания КРИВОЙ 14 между точками 13,14, КРИВОЙ 15 
между ТОЧКАМИ 9,10, КРИВОЙ 16 между ТОЧКАМИ 11,12 и КРИВОЙ 17 между 
ТОЧКАМИ 17,18. 

Очистите экран и установите трехмерную проекцию. Используйте команду VLSWEEP 
(Geometry > VOLUMES > GENERATION MENU > Sweeping) для «охватывания» 
ПОВЕРХНОСТЕЙ с 1 по 3 вокруг оси Y. После этого можно «охватить» КРИВЫЕ с 
13 по 17 вокруг оси Y командой SFSWEEP (Geometry > SURFACES > GENERATION 
MENU > Sweeping) для создания ПОВЕРХНОСТЕЙ, представляющих ребра: 
Control Panel: Geometry > VOLUMES > GENERATION MENU > Sweeping 
Beginning surface >1 
Ending surface >3 
Increment >1 
Axis symbol >4 
Angle of the arc >30 
Number of segments >1 
Control Panel: Geometry > SURFACES > GENERATION MENU > Sweeping 
Beginning curve >13 
Ending curve >17 
Increment >1 
Rotation/sweep Axis >4 
Angle of the arc >30 
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Number of segments >1 

Для ОБЪЕМОВ, представляющих сектор трубы, КЭ-сеть будет сгенерирована с ис-
пользованием объемных элементов, а для ребер � четырехугольных элементов обо-
лочки: 
Control Panel: Propsets > Element Group 
Element group >1 
Element category >Volume 
Element Type (for volume) >SOLID; 8- to 20-node 3D solid element 
... Примите значения по умолчанию ... 
Control Panel: Meshing > PARAMETRIC MESH > Volumes 
Beginning volume >1 
Ending volume >1 
Increment >1 
Number of nodes per element >8 
Number of elements on 1st curve >3 
Number of elements on 2nd curve >30 
Number of elements on 3rd curve >3 
... Примите значения по умолчанию ... 
Control Panel: Meshing > PARAMETRIC MESH > Volumes 
Beginning volume >2 
Ending volume >3 
Increment >1 
Number of nodes per element >8 
Number of elements on 1st curve >2 
Number of elements on 2nd curve >3 
Number of elements on 3rd curve >3 
... Примите значения по умолчанию ... 

Элементы ребер будут связаны с группой элементов и набором вещественных кон-
стант 2: 
Control Panel: Control > ACTIVATE > Set Entity 
Set label >RC 
Real constant set number >2 
Control Panel: Propsets > Element Group 
Element group >2 
Element category >Area 
Element Type (for area) >SHELL4; 4-node thin shell element 
... Примите значения по умолчанию ... 
Control Panel: Meshing > PARAMETRIC MESH > Surfaces 
Beginning surface >19 
Ending surface >23 
Increment >1 
Number of nodes per element >4 
Number of elements on 1st curve >4 
Number of elements on 2nd curve >3 
... Примите значения по умолчанию ... 

Для узлов на общих границах необходимо выполнить «слияние» командой NMERGE 
(Meshing > NODES > Merge), чтобы требования совместимости были удовлетворены. 
Команда NCOMPRESS (Edit > COMPRESS > Nodes) убирает разрывы в нумерации уз-
лов, возникающие после «слияния». 
Control Panel: Meshing > NODES > Merge 
Total number of nodes merged = 52 
Control Panel: Edit > COMPRESS > Nodes 
Number of Nodes compressed = 52 
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Теперь можно приступить к заданию термальных граничных условий. Очистите экран 
и выполните команды ACTNUM,SF,1 (Control > ACTIVATE > Entity Label) и SFPLOT 
(Edit > PLOT > Surfaces) для отображения ПОВЕРХНОСТЕЙ и их меток. Приблизьте 
верхние и нижние ПОВЕРХНОСТИ сектора трубы (по отдельности), к которым не-
обходимо приложит температуру 80°. Как показано на рисунке, эти ПОВЕРХНОСТИ 
имею номера 6 и 9 (верхние) и 4 и 16 (нижние). 

 

Рис. 12-3.  Увеличенные изображения верхних и нижних ПОВЕРХНОСТЕЙ трубы  

Выполните команду NTSF (LoadsBC > THERMAL > TEMPERATURE > Define Sur-
faces) для назначения температур всем узлам, связанным с верхними и нижними 
ПОВЕРХНОСТЯМИ: 
Control Panel: LoadsBC > THERMAL > TEMPERATURE > Define Surfaces 
Beginning surface >6 
Value >80 
Ending surface >9 
Increment >3 
Beginning surface >4 
Value >80 
Ending surface >16 
Increment >12 
Control Panel: LoadsBC > THERMAL > CONVECTION > Define Elements 
Beginning Element >310 
Convection coefficient >0.01 
Ambient temperature >60 
Face number >5 
Ending Element >366 
Increment >4 
Time curve for ambient temperature >0 
Beginning Element >309 
Convection coefficient >0.01 
Ambient temperature >65 
Face number >5 
Ending Element >365 
Increment >4 
Time curve for ambient temperature >0 
Beginning Element >308 
Convection coefficient >0.01 
Ambient temperature >70 
Face number >5 
Ending Element >364 
Increment >4 
Time curve for ambient temperature >0 
Beginning Element >307 
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Convection coefficient >0.01 
Ambient temperature >75 
Face number >5 
Ending Element >363 
Increment >4 
Time curve for ambient temperature >0 

Элементы на ребрах имеют номера с 307 по 366. В каждом ребре присутствует по че-
тыре ряда элементов, соответствующих четырем окружающим температурам. Вы 
можете активизировать отображение меток элементов командой ACTNUM,EL,1 (Con-
trol > ACTIVATE > Entity Label) и отобразить эти элементы командой EPLOT,307,366 
(Edit > PLOT > Elements). Приблизьте эти элементы, чтобы ясно видеть их номера. 
Внешние ряды элементов пронумерованы таким образом, что вы можете назначить 
пленочные коэффициенты и окружающие температуры ко всем ребрам, увеличивая 
номера элементов на 4. Вышеприведенная процедура иллюстрирует назначение 
пленочных коэффициентов и окружающих температур всем ребрам командой CEL 
(LoadsBC > THERMAL > CONVECTION > Define Elements). Номера граней 
элементов (5 означает верхнюю грань) подробно описаны в Главе 4 Руководства 
пользователя COSMOS/M. На рисунке показана КЭ-сеть теплообменника и 
увеличенное изображение ребер с заданными коэффициентами конвекции. 

 

Рис. 12-4.  КЭ-сеть и увеличенное изображение ребер  

Ниже приведена процедура задания теплопроводности и вещественных констант дял 
элементов оболочки, которая завершает ввод исходных данных для термального рас-
чета: 
Control Panel: Propsets > Material Property 
Material property set >1 
Material property name >KX; X Thermal conductivity 
Property value >1 
Control Panel: Propsets > Real Constant 
Associated element group >2 
Real constant set >2 
Start loc. of the real const. >1 
No. of real const. to be entered >6 
RC1: Thickness >0.1 
... Примите значения по умолчанию ... 
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Используйте команду R_THERMAL (Analysis > HEAT TRANSFER > Run Thermal 
Analysis) чтобы выполнить расчет теплопереноса устойчивого состояния. После ус-
пешного выполнения расчета программа возвращается в GEOSTAR. Для использова-
ния результатов термального расчета необходимо связать результаты термального 
расчета с необходимым вариантом нагрузки командой TEMPREAD (LoadsBC > LOAD 
OPTIONS > Read Temp as Load). Для графического отображения результатов тер-
мального расчета, которые будут использованы Основной Системе, необходимо по-
следовательно выполнить команды ACTTEMP и TEMPPLOT (Results > PLOT > 
Thermal). Связывание термальной нагрузки эквивалентно назначению узловых тем-
ператур всем узлами командой NTND (LoadsBC > THERMAL > TEMPERATURE > 
Define Nodes). Если вы активизируете признак вывода исходных данных в команде 
PRINT_OPS (Analysis > OUTPUT OPTIONS > Set Print Options), то использованная 
термальная нагрузка будет записана в файл вывода. 
Control Panel: LoadsBC > LOAD OPTIONS > Read Temp as Load 
Time step label >1 
Load case number >1 

Для расчета термальных напряжений необходимо зафиксировать верхние и нижние 
ПОВЕРХНОСТИ трубы по всем направлениям командой DSF (LoadsBC > 
STRUCTURAL > DISPLACEMENT > Define Surfaces). Также для расчета напряжений 
требуются дополнительные свойства материала � модуль упругости и отношение Пу-
ассона, которые задаются следующим образом: 
Control Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define Surfaces 
Beginning surface >4 
Displacement label >ALL; All 6 DOF 
Value >0.0 
Ending surface >16 
Increment >12 
Beginning surface >6 
Displacement label >ALL; All 6 DOF 
Value >0.0 
Ending surface >9 
Increment >3 
Control Panel: Propsets > Material Property 
Material property set >1 
Material property name >EX; Elasticity modulus 1st dir 
Property value > 
Material property name >ALPX; Therm expansion coeff 1st dir 
Property value > 0.01 

В COSMOS/M термальные и гравитационные нагрузки рассматриваются как особые, 
(см. Главу 7, Нагрузки и граничные условия), и требуют активизирования соответст-
вующего признака в команде A_STATIC (Analysis > STATIC > Static Analysis Options) 
перед выполнением расчета. Кроме этого, в той же команде необходимо активизиро-
вать добавление мягкой пружины, поскольку элементы, использованные в задаче 
имеют несовместимые поля перемещений. Другой способ обеспечения устойчивости 
� ограничение компонента θz в любом узле элемента оболочки в каждом ребре. До-
бавление мягкой пружины не оказывает значительного влияния на результаты. 
Control Panel: Analysis > STATIC > Static Analysis Options 
Loading flag >T; Thermal loading 
Inplane effect flag >No 
Soft Spring flag >Yes 
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... Примите значения по умолчанию ... 

Теперь можно выполнить расчет термальных напряжений командой R_STATIC (Analy-
sis > STATIC > Run Static Analysis). После успешного выполнения расчета можно пе-
реходит к постпроцессингу. 

Поскольку последним выполнялся статический расчет напряжений, он становится ак-
тивным для постпроцессинга. Постпроцессинг результатов термального расчета про-
изводится после его активизирования: 
Control Panel: Results > SET UP > Set Postprocess Type 
Analysis type >Thermal 

Вы можете отобразить контурные графики температур командой TEMPPLOT (Results > 
PLOT > Thermal) или вывести их в текстовом виде командой TEMPLIST (Results > 
LIST > Thermal Results). Для просмотра результатов расчета напряжений повторите 
команду ACTPOST (Results > SET UP > Set Postprocess Type) и укажите 0 (линейный 
статический расчет). Для отображения деформаций и контурных графиков напряже-
ний используются команды DEFPLOT (Results > PLOT > Deformed Shape) и ACTSTR 
совместно с STRPLOT (Results > PLOT > Stress), соответственно. На рисунке показа-
ны графики деформаций и контурные графики напряжений. 

 

Рис. 12-5. Контурный график температуры, деформированная форма и контурный график напряжений  

Магнитоупругий расчет в модулях ESTAR и STAR 
Магнитная механика объемных тел изучает действие магнитных сил на деформации и 
напряжения тел. В магнитоупругом расчете эти эффекты предполагаются линейны-
ми. Необходимость выполнения магнитоупругого расчета следует из роста числа его 
применений в таких задачах, как переключатели, генераторы, сверхпроводящие мо-
торы, ядерные реакторы, поезда на магнитной подушке, магнитогидродинамические 
устройства, и других. В Основной Системе можно выполнять расчеты задач на маг-
нитоупругие напряжения и магнитоупругую устойчивость. 

Результатами магнитоупругого расчета являются перемещения (u), деформации (ε), 
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напряжения (σ), электрический ток (J), магнитный поток (B) и температура (T). Дей-
ствие электромагнитных полей на механическое поведение включает (Moon, 1984): 

! Изменение статических напряжений из-за электромагнитных сил. 

! Создание угловых моментов из-за body couples. 

! Выделение термальной энергии из-за Джоулева нагрева или ферромагнитного 
гистерезиса. 

! Изменение деформаций из-за магнитных полей (магнитосужение). 

! Термоупругие деформации, вызванные Джоулевым нагревом. 

Из этих эффектов непосредственно из взаимодействия модуля ESTAR и Основной 
Системы доступен только первый. Заметьте, что выделение термальной энергии из-за 
Джоулева нагрева можно учесть, выполнив зависимый термоэлектрический расчет в 
COSMOS/M. Последний эффект, вызывающий термоупругие деформации из-за Джо-
улева нагрева может быть рассмотрен, если сначала выполнить зависимый термо-
электрический расчет, после чего перенести результаты как термальную нагрузку 
(командой TEMPREAD (LoadsBC > LOAD OPTIONS > Read Temp as Load)) в Основ-
ную Систему. 

Вычисление электромагнитных сил  

Для расчета электромагнитных сил в COSMOS/M используются два подхода: 

! закон Лоренца  

! метод виртуальной работы  

Первый подход, вычисляющий силы Лоренца, применим только к токонесущим про-
водникам и основывается на следующем уравнении: 

 (12-1) 

где X обозначает векторное произведение.  

Метод виртуальной работы используется для получения значений сил на ферромаг-
нитных телах во внешнем поле и токонесущих проводниках. Подробное описание 
этого метода приведено в Руководстве по расширенным модулям. Чтобы вычислить 
силы на объекте, пользователь должен определить область, в которой данный объект 
находится, и назначить всем элементами этого объекта виртуальное перемещение ве-
личиной в одну единицу. Остальным элементам в области назначается нулевое вир-
туальное перемещение (значение по умолчанию для магнитных элементов). Следует 
заметить, что для использования этого метода объект должен быть окружен слоем 
воздуха.  

Команда EM_OUTPUT (Analysis > ELECTRO MAGNETIC > Output Options) использует-
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ся для указания одного из этих методов вычисления сил перед выполнением расчета 
в модуле ESTAR.  

ПРИМЕЧАНИЕ: Вычисление сил Лоренца применимо только к двухмерным и осе-
симметричным моделям, метод виртуальной работы не применим к моделям с трех-
мерными источниками тока. 

После успешного выполнения расчета в модуле ESTAR электромагнитные силы пере-
носятся командой EMFREAD (LoadsBC > LOAD OPTIONS > Read Emag Force) как со-
средоточенные узловые нагрузки в Основную Систему (и другие модули). Необхо-
димо указать номер временного шага, из которого будут перенесены магнитные  
силы. Перенесенные силы могут быть отображены или выведены командами FPLOT и 
FLIST (LoadsBC > STRUCTURAL > FORCE > Plot, List). 

Советы по моделированию  

Ниже приведено несколько советов по моделированию магнито-конструкционных за-
дач: 

! Первоначально модель должна состоять только из элементов, которые можно ис-
пользовать для электромагнитного расчета в модуле. В таблице приведены эле-
менты, используемые в электромагнитном расчете и их эквиваленты в Основной 
Системе: 
ESTAR  Основная Система 
MAG2D  PLANE2D 
MAG3D  SOLID 
TETRA4  TETRA4, TETRA4R 
TETRA10  TETRA10 

! После успешного выполнения электромагнитного расчета удалите части КЭ-сети, 
не требуемые для конструкционного расчета. Сюда входят слои воздуха, жид-
кость, окружающая магниты и другие. 

! Если нагрузки, удаленные вместе с удаленными частями КЭ-сети, значительны и 
требуют учета в расчете, то вы можете аппроксимировать их и задать как отдель-
ные нагрузки. 

! Переопределите типы элементов для оставшихся частей, используя эквивалент-
ные конструкционные элементы, приведенные в таблице, при это необходимо 
следить, чтобы типы элементов соответствовали существующим узлам. 

! Командой EMFREAD (LoadsBC > LOAD OPTIONS > Read Emag Force) перенесите 
электромагнитные силы. Команды FPLOT (LoadsBC > STRUCTURAL > FORCE > 
Plot) и FLIST (LoadsBC > STRUCTURAL > FORCE > List) могут быть использова-
ны для отображения или просмотра перенесенных сил. Заметьте, что из-за ис-
пользуемых числовых допусков, вы иногда можете увидеть незначительные ком-
поненты сил, если команда FPLOT (LoadsBC > STRUCTURAL > FORCE > Plot) 
была выполнена для всех компонентов. 
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Пример EM16 � магнитоупругий расчет длинного цилиндра  

В данном примере (файл EM16.GEO) рассматривается распределение напряжений в 
толстом длинном соленоиде, вызываемых магнитными силами, возникающими из 
равномерного распределения кругового тока. Предполагается, что соленоид сделан 
из изотропного упругого материала. Поскольку длина соленоида велика, в данном 
примере она предполагается бесконечной. Для удобства в данном примере рассмот-
рен участок длиной 0.2 см. Для моделирования бесконечной длины продольные пе-
ремещения на верхней и нижней гранях установлены равными нулю. Также предпо-
лагается, что магнитное поле вне соленоида равно нулю, кроме продольного 
компонента магнитного потока. В центре (r = 0) и на внешней границе (r = 2) нало-
жены граничные условия Дирихле (нулевые магнитные потенциалы в центре и рав-
ные на внешней границе). На все другие границы автоматически накладываются гра-
ничные условия Неймана. 

 

Рис. 12-6. Геометрия соленоида  

Запустив GEOSTAR, установите рабочую плоскость: 
Control Panel: Geometry > GRID > Plane 
Rotation/sweep Axis >Z 
Offset on Axis >0.0 
Grid Line Style >Solid 

Установите проекцию на плоскость XY с помощью кнопки View. Затем создайте 
КЛЮЧЕВЫЕ ТОЧКИ командой PT (Geometry > POINTS > Define) для создания 
ПОВЕРХНОСТЕЙ: 
Control Panel: Geometry > POINTS > Define 
Keypoint >1 
XYZ-Coordinate value >0,0,0. 

Повторите эту команду для следующих КЛЮЧЕВЫХ ТОЧЕК: 

Номер ТОЧКИ Координаты 
2 1,0,0 
3 1,0.2,0 
4 0,0.2,0 
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5 2,0,0 
6 2,0.2,0 

Если необходимо используйте команду SCALE, чтобы все созданные КЛЮЧЕВЫЕ 
ТОЧКИ помещались на экране. 

Затем по этим КЛЮЧЕВЫМ ТОЧКАМ необходимо создать две ПОВЕРХНОСТИ: 
Control Panel: Geometry > SURFACES > Define by 4 Pt 
Surface >1 
Keypoint 1 >1 
Keypoint 2 >2 
Keypoint 3 >3 
Keypoint 4 >4 
Underlying surface >0 
Control Panel: Geometry > SURFACES > Define by 4 Pt 
Surface >2 
Keypoint 1 >2 
Keypoint 2 >5 
Keypoint 3 >6 
Keypoint 4 >3 
Underlying surface >0 

Первая ПОВЕРХНОСТЬ представляет собой воздушный слой, а вторая � сечение со-
леноида. КЭ-сеть для этих ПОВЕРХНОСТЕЙ будет состоять из одного ряда элемен-
тов, причем для воздушного слоя будет использовано меньше элементов. 
Control Panel: Meshing > PARAMETRIC MESH > Surfaces 
Beginning surface >1 
Ending surface >1 
Increment >1 
Number of nodes per element >4 
Number of elements on 1st curve >8 
Number of elements on 2nd curve >1 
... Примите значения по умолчанию ... 
Control Panel: Meshing > PARAMETRIC MESH > Surfaces 
Beginning surface >2 
Ending surface >2 
Increment >1 
Number of nodes per element >4 
Number of elements on 1st curve >20 
Number of elements on 2nd curve >1 
... Примите значения по умолчанию ... 

На рисунке показаны ПОВЕРХНОСТИ и КЭ-сеть: 

 

Рис. 12-7.  ПОВЕРХНОСТИ и КЭ-сеть модели соленоида  

Активизируйте отображение меток КРИВЫХ командой ACTNUM,CR,1 (Control > 
ACTIVATE > Entity Label) (также это можно выполнить, используя таблицу Status1). 
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Очистите экран и отобразите все КРИВЫЕ командой Edit > PLOT > Curves. 

В центре (r = 0), которому соответствует КРИВАЯ 3, магнитный потенциал необходи-
мо установить равным нулю командой NPCR (LoadsBC > E-MAGNETIC > 
MAGNETIC POTENTIAL > Define Curves): 
Control Panel: LoadsBC > E-MAGNETIC > MAGNETIC POTENTIAL > Define Curves 
Beginning Curve >3 
Value >0 
Ending Curve >3 
Increment >1 

Очистите экран и активизируйте отображение меток узлов командой ACTNUM (Control 
> ACTIVATE > Entity Label). Отобразите все узлы командой NPLOT (Edit > PLOT > 
Nodes) и приблизьте правый край КЭ-модели. На этом крае (r = 2), магнитные потен-
циалы должны быть равными, что указывается командой MCPDEF (LoadsBC > E-
MAGNETIC > CurntSrc/MagCoupling > Magnetic Coupling): 
Control Panel: LoadsBC > E-MAGNETIC > CurntSrc/MagCoupling > Magnetic Coupling 
Pattern 1 Beginning Node >39 
Pattern 1 Ending Node >39 
Pattern 1 Increment >1 
Pattern 2 Beginning Node >60, 
Pattern 2 Ending Node >60 
Pattern 2 Increment >1 

Очистите экран и выполните команду SFPLOT (Edit > PLOT > Surfaces). Соленоид по-
мещен в равномерное поле, которое задается применением команды JESF (LoadsBC > 
E-MAGNETIC > ELEMENT CURRENT > Define Surfaces) к ПОВЕРХНОСТИ 2: 
Control Panel: LoadsBC > E-MAGNETIC > ELEMENT CURRENT > Define Surfaces 
Beginning Surface >2, 
Value >10 
Ending Surface >2 
Increment >1 

Теперь можно задать свойства материала и группу элементов: 
Control Panel: Propsets > Material Property 
Material property set >1 
Material Property Name >MPERM; Magnetic Permeability 
Property value >1 
Control Panel: Propsets > Element Group 
Element Group >1 
Element Category >Area 
Element Type (for area) >MAG2D; 2D magnetic element 
OP1: 2D Type > Axisym 
... Примите значения по умолчанию ... 

Вычисление магнитных сил запрашивается следующим образом: 
Control Panel: Analysis > ELECTRO MAGNETIC > Output Options 
Magnetic field info flag 0=No N=steps >1 
Постпроцессинг info flag >Yes 
Force Calc. >Standard 
... Примите значения по умолчанию ... 

Поскольку использовались единицы измерения системы CGS, в команде  A_MAGNETIC 
(Analysis > ELECTRO MAGNETIC > Analysis Options) необходимо указать использо-
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вание этих же единиц в расчете. После выполнения «слияния» и перенумерации уз-
лов КЭ-модель будет завершена и может быть рассчитана: 
Control Panel: Meshing > NODES > Merge 
Control Panel: Edit > COMPRESS > Nodes 
Control Panel: Analysis > ELECTRO MAGNETIC > Analysis Options 
Analysis option >S; Magnetostatic 
Units >CGS 
... Примите значения по умолчанию ... 
Control Panel: Analysis > ELECTRO MAGNETIC > Run EMag Analysis 

После успешного выполнения электромагнитного расчета вы моете выполнить пост-
процессинг для различных компонентов результатов (более подробная информация 
приведена в Руководстве по расширенным модулям). Поскольку слой воздуха не 
требуется для расчета напряжений, необходимо удалить элементы ПОВЕРХНОСТИ 
1 командой MSFDEL,1,1,1; (Edit > DELETE > Element on Surface). Не обращайте вни-
мания на предупреждения, выдаваемые при удалении элементов. Силы для расчета 
напряжений переносятся следующим образом: 
Control Panel: LoadsBC > LOAD OPTIONS > Read Emag Force 
Time step label >1 
Load case number >1 

Для отображения или вывода перенесенных сил можно воспользоваться командами 
FPLOT и FLIST (LoadsBC > STRUCTURAL > FORCE > Plot, List). Для выполнения 
расчета напряжений необходимо ограничить верхнюю и нижнюю КРИВЫЕ 
ПОВЕРХНОСТИ 2 по направлению оси Y: 
Control Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define Curves 
Beginning Curve >5 
Displacement label >UY; Y Translation 
Value >0.0 
Ending Curve >6; 
Increment >1 

Для выполнения расчета напряжений необходимо дополнить набор свойств материала 
1: 
Control Panel: Propsets> Material Property 
Material property set >1 
Material Property Name >EX; Elasticity modulus 1st dir 
Property value >10.76E11 
Material Property Name >NUXY; Poisson ratio 2nd to 1st 
Property value >0.33 

Необходимо заменить магнитные элементы на эквивалентные, в данном случае �
PLANE2D в осесимметричном варианте: 
Control Panel: Propsets> Element Group 
Element group >1 
Element Category >Area 
Element Type (for area) >PLANE2D; 2D 4- to 8-node plane element 
OP1:S/F flag >Solid 
OP2:Integr Type >QM6 
OP2:Type >Axi 
... Примите значения по умолчанию ... 

Если необходимо сохранить результаты электромагнитного расчета, то перед выпол-
нением статического расчета напряжений необходимо использовать команду 
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PRINT_OPS (Analysis > OUTPUT OPTIONS > Set Print Options): 
Control Panel: Analysis > OUTPUT OPTIONS > Set Print Options 
Displacement Print Flag >Yes 
... ... 
Output Flag >Append 

Теперь можно выполнить статический расчет напряжений командой R_STATIC 
(Analysis > STATIC > Run Static Analysis).  После выполнения расчета вы можете ак-
тивизировать необходимый компонент напряжений командой ACTSTR и отобразить 
контурный график командой STRPLOT (Results > PLOT > Stress). На рисунке показан 
контурный график напряжений по фон Мизесу. 

 

Рис. 12-8. Контурный график напряжений по фон Мизесу для модели соленоида  

Для толстого длинного соленоида значения касательного и радиального напряжений 
вычисляются по формулам (Moon, 1984): 

 (12-2) 

где константы A и B вычисляются по следующим формулами: 

 (12-3) 

В этих уравнениях a и b представляют внутренний и внешний диаметры, соответст-
венно, α=a/b, µ0 � магнитная проницаемость пустого пространства (в данном случае � 
воздуха), J0 � плотность равномерного, а γ определяется по формуле: 

γ= (1 � 2ν)/(1 � ν) 

По этим выражениям было вычислено значение касательного напряжения в r = 1.4 и 
сравнено со значением, полученным в COSMOS/M. Сравнение результатов приведе-
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но в таблице. 

Компонент 
напряжений 

Аналитическое 
(Dyne/cm2)  

COSMOS/M 
(Dyne/cm2) 

σθ в r = 1.4 974.07 974.957 

Результат, полученный в COSMOS/M был обнаружен в файле вывода следующим об-
разом. Координата r = 1.4 соответствует узлам 25 и 46. В файле вывода были найдены 
значения напряжений для элемента 14, соединяющего эти узлы. Если элемент 
PLANE2D используется в осесимметричном варианте, то касательный компонент на-
пряжений записывается в колонке SIGMA-Z. Значение, приведенное в таблице, было 
взято из файла вывода со следующей позиции: 

ELEMENT STRESS OUTPUT  

NUMBER     

NODE            SIGMA-X      SIGMA-Y       TAU-XY      SIGMA-Z     VON MISES     SIGMA-P+     SIGMA-P-     ANGLE  

14  

24      -.390935E+01 0.339922E+03 0.149732E-05 0.103397E+04 0.915733E+03 0.339922E+03 -.390935E+01   90.000   

25  -.390935E+01 0.320446E+03 0.149732E-05 0.974957E+03 0.863647E+03 0.320446E+03 -.390935E+01   90.000  

46  -.390935E+01 0.320446E+03 0.149732E-05 0.974957E+03 0.863647E+03 0.320446E+03 -.390935E+01   90.000  

45      -.390935E+01 0.339922E+03 0.149732E-05 0.103397E+04 0.915733E+03 0.339922E+03 -.390935E+01   90.000  

CENTER    -.390935E+01 0.330184E+03 0.149732E-05 0.100447E+04 0.889690E+03 0.330184E+03 -.390935E+01   90.000 

Квазистатический расчет напряжений в модулях FLOWSTAR и 
STAR 

Модуль расчета тока жидкости может выполнять следующие расчеты: 

! ламинарное течение двух и трехмерной несжимаемой жидкости  

! течение двухмерной изотермальной, сжимаемой, несжимаемой жидкости, устой-
чивое, турбулентное (внутреннее) течение с использованием алгебраической мо-
дели, основанной на теории смешивающихся длин Прандтла (Prandtl)  

! устойчивое сверхзвуковое течение двухмерной невязкой жидкости (внутренне те-
чение) 

Давления жидкостей, вычисленные в модуле FLOWSTAR могут быть перенесены в 
Основную Систему как распределенные нагрузки на элементы. Команда NPRREAD 
(LoadsBC > LOAD OPTIONS > Read Fluid Pressure) прикладывает давления, вычис-
ленные на любом временном шаге к граням элементов, связанных с указанными 
КРИВЫМИ. 

ПРИМЕЧАНИЕ: Команда NPRREAD применима только к двухмерным задачам. 

Советы по моделированию  

Ниже приведены несколько советов по моделированию задач на квазистатический 
расчет в модуле FLOWSTAR и Основной Системе: 

! Первоначально модель должна состоять только из элементов, используемых в 
модуле FLOWSTAR. В таблице приведены элементы, поддерживаемые модулем 
жидкостного расчета и их эквиваленты в Основной Системе: 
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FLOWSTAR  Основная Система 
FLOW2D  PLANE2D  

SHELL4  
SHELL4T  
SHELL4L 

FLOW3D  SOLID 

! Жидкость должна быть смоделирована только вышеуказанными элементами, а 
конструкционная часть должна быть смоделирована эквивалентными элементами. 

! После успешного выполнения расчета тока жидкости удалите из КЭ-сети элемен-
ты, представляющие жидкость, поскольку они не требуются для конструкционно-
го расчета. 

! Если нагрузки и эффекты инерции от удаленных элементов значительны, и тре-
буют учета в конструкционном расчете, вы можете аппроксимировать их и задать 
их как нагрузки. 

! Командой NPRREAD (LoadsBC > LOAD OPTIONS > Read Fluid Pressure) перене-
сите давление в Основную Систему. 
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Глава 13. 
Неосесимметричные нагрузки и 
формы мод 
Введение 

Осесимметричные конструкции с несимметричной нагрузкой обычно моделируются 
как трехмерные конструкции. Однако трехмерная задача часто требует много време-
ни для создания и расчета. Поэтому используются осесимметричные элементы в ре-
жиме несимметричной нагрузки. Для выражения нагрузки через сумму нескольких 
компонентов используется ряд Фурье, и расчет выполняется для двухмерного осе-
симметричного сечения конструкции, тем самым уменьшая размер задачи на не-
сколько порядков. Согласно принципу суперпозиции, решение исходной задачи по-
лучается сложением решений задач-компонентов. То есть исходная трехмерная 
задача заменяется последовательность двухмерных. 

Доступные модели и возможности  
В модуле STAR для этой цели доступны два элемента � PLANE2D и SHELLAX. В КЭ-
модели тела вращения (PLANE2D) или тонкостенной оболочки вращения 
(SHELLAX) узлы представляют окружности, а не точки. Элемент оболочки имеет 2 
узла, а элемент осесимметричного тела имеет от 4 до 8 узлов. расчет может выпол-
няться только линейно упругих изотропных и ортотропных материалов. Кроме ста-
тического расчета, для обоих элементов возможно вычисление форм мод для различ-
ных гармоник без геометрического увеличения жесткости. В расчете устойчивости 
программа исследует указанные гармоники от минимальной до максимально для на-
хождения минимальной нагрузки устойчивости на указанном диапазоне гармоник. 
Также можно использовать эффект гравитации и/или центробежной нагрузки (только 
по направлению оси симметрии). 

Геометрические соглашения  
В общем случае перемещения и напряжения в глобальной цилиндрической коорди-
натной системе определяются как показано на рис. 13-1. Для перемещений u1 соот-
ветствует радиальному направлению, u2 � направлению оси, а u3 � касательному на-
правлению. 



 237

 

Рис. 13-1. 

Перемещения, записываемые в файл вывода, следуют этому соглашению. 

Для элемента PLANE2D нормальные напряжения σ1, σ2 и σ3 также соответствуют ра-
диальному, осевому и касательному направлениям, касательные напряжения  опре-
деляются соответственно. Это соглашение действует, если напряжения запрошены в 
глобальной координатной системе. Напряжения, запрошенные в локальной коорди-
натной системе/координатной системе элемента, будут повернуты вокруг касатель-
ного направления (пример � куб на правой части рис. 13-1). 

Напряжения и силы для элементов SHELLAX определяются в координатной системе 
элемента аналогичным образом. Более подробное описание определения этих сил 
приведено в Главе 4 Руководства пользователя COSMOS/M. 

Ввод нагрузок  
Осесимметричные нагрузки (силы/распределенные нагрузки) могут быть заданы дву-
мя способами: 

1. Непосредственный ввод нагрузок: Пользователь задает нагрузки именно так как 
они изменяются вдоль окружности, представленной узлом (по касательному направ-
лению). При выполнении программа сначала находит эквивалентные ряды Фурье, за-
тем ищет отклик для каждой гармоники, а перед завершением расчета складывает 
отклики гармоник для нахождения окончательного решения. Этот способ более про-
стой и часто более удобный из двух. 

Примечания: 

a. Рассчитываться будут только гармоники в указанном диапазоне (указывается в ко-
манде A_ASYM (Analysis > STATIC > Asymmetric Load Options)). Обычно большинст-
во нагрузок адекватно аппроксимируются несколькими низшими гармониками. Для 
представления нагрузок, которые значительно изменяются на небольшой дуге ок-
ружности, требуется большее число гармоник. 
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b. Эквивалентный ряд Фурье при непосредственном вводе нагрузок записываются в 
файл вывода, если в команде PRINT_OPS (Analysis > OUTPUT OPTIONS > Set Print 
Options) запросить вывод исходных данных. См. примеры в конце главы. 

2. Ввод рядов Фурье: Это подход используется, если вектор нагрузки уже преобразо-
ван в ряд Фурье. Вместо задания нагрузки на угол окружности пользователь может 
ввести до 40 коэффициентов при синусах и косинусах ряда Фурье: 

F(θ) = P0 + P1cosθ + P2cos2θ + P3cos3θ + P4cos4θ + � + q1sinθ + q2sin2θ + q3sin3θ + q4sin4θ+ � 

Отклик осесимметричного тела от несимметричных нагрузок может быть рассчитан 
как суперпозиция рассчитанных компонентов, каждый из которых представляет от-
клик от одного компонента нагрузки. Синусные члены ряда Фурье называются не-
четными или несимметричными, так как они представляют несимметричные нагруз-
ки. Косинусные члены ряда называются четными или симметричными, так как они 
представляют симметричные нагрузки: 

Для косинусов: F(θ) = F(-θ) 

Для синусов: F(θ) = -F(-θ) 

Пользователь может использовать только косинусные члены ряда, если нагрузка сим-
метрична относительно плоскости XY, или только синусные, если нагрузка несим-
метрична, или оба типа членов в общем случае. На нижеприведенных рисунках пока-
заны нагрузки, представляемые различными гармониками. 

Нагрузки, соответствующие гармонике 0 (член P0) 

В этом случае нагрузка осесимметрична: 

 

Рис. 13-2. 
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Нагрузки, соответствующие гармонике 1 

Для сosθ: 

 

Рис. 13-3.  

Пиковые значения Fx и Fy находятся в точке θ = 0, пиковое значение Fz находится в 
точке θ = 90. 

Для sinθ: 

Для синуса применима та же конфигурация нагрузки, если нагрузки повернуты на +90 
градусов. 

Нагрузки, соответствующие гармонике 2 

Для лучшего представления этого типа нагрузки приведен вид сверху. 

Для cos2θ: 

 

Рис. 13-4. 

Для sin2θ: 
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Для синуса применима та же конфигурация нагрузки, если нагрузки повернуты на 45 
градусов. 

Нагрузки по другим направлениям  

Основные нагрузки, приведенные выше, имеют радиальное, касательное или осевое 
направления. Нагрузки по другим направлениям можно использовать, если скомби-
нировать вышеприведенные нагрузки. Например, распределенная нагрузка по на-
правлению x может быть получена сложением двух нижеприведенных гармоник. 

 

Рис. 13-5. 

Необходимые команды  
Следующие команды являются основными для расчета с несимметричной нагрузкой. 
В них вводится информация о типе расчета, коэффициентах косинусов и синусов ря-
да  Фурье и несимметричной нагрузке, задаваемой как функции угла θ. 

A_ASYM, (Analysis > STATIC > Asymmetric Load Options) 

ACTSET, (Control > ACTIVATE > Set Entity) 

CURDEF, (LoadsBC > FUNCTION CURVE > Time/Temp Curve) 

CURLIST, (LoadsBC > FUNCTION CURVE > List Time/Temp) и 

CURDEL (LoadsBC > FUNCTION CURVE > Delete Time/Temp Curve) 

В следующем разделе приведено краткое описание использования этих команд в про-
цедуре расчета. 

Статический расчет с несимметричной нагрузкой  
Ниже приведены команды, необходимые для выполнения статического расчета осе-
симметричной модели по несимметричной нагрузкой. Предполагается, что модель 
уже создана. 

1. Команда EGROUP: 
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a. Для элемента PLANE2D необходимо назначить осесимметричный вариант чтобы 
активизировать Z-координату как дополнительную степень свободы. 

b. Для элемента SHELLAX не требуется активизировать особые опции. 

2. Команда A_ASYM: 

В команде A_ASYM (Analysis > STATIC > Asymmetric Load Options) указывается, что 
нагрузка (или формы мод в модальном расчете и расчете устойчивости) будет неосе-
симметричной, а также, четной или нечетной будет функция нагрузки и углы, в кото-
рых необходимо получить результаты. Эту команду необходимо выполнить до ко-
манд ACTSET и CURDEF. Для просмотра настроек статического расчета, включая 
настройки несимметричной нагрузки, используйте команду "A_LIST, STATIC" (Analy-
sis > List Analysis Option). 

3. Команда ACTSET: 

Эта команда активизирует тип нагрузки и номер шаблона нагрузки. Указывая в пер-
вом приглашении одно из значений: FCOS, FSIN или FCOEF, вы указываете тип на-
грузки: ряд Фурье (косинусы и/или синусы) или непосредственный ввод нагрузки. Во 
втором приглашении указывается номер шаблона. Пользователь может задать до 25 
шаблонов для ряда Фурье и/или до 25 шаблонов для непосредственного ввода на-
грузки. Нагрузка будет связана с активным номером шаблона (см. пример). 

4. Команда CURDEF: 

Задает нагрузку или коэффициенты ряда Фурье для различных гармоник. Эти коэф-
фициенты являются множителями к действительной нагрузке, заданной командами 
задания сил и распределенной нагрузки GEOSTAR. Команда CURLIST (LoadsBC > 
FUNCTION CURVE > List Time/Temp) используется для просмотра назначенных ко-
эффициентов, а команда CURDEL (LoadsBC > FUNCTION CURVE > Delete Time/Temp 
Curve) для удаления кривой. Заметьте, что в расчете будут учитываться только гар-
моники, входящие в диапазон, указанный в команде A_ASYM (Analysis > STATIC > 
Asymmetric Load Options). Заданные в команде CURDEF (LoadsBC > FUNCTION 
CURVE > Time/Temp Curve) коэффициенты, не входящие в диапазон, рассматриваться 
не будут. (Также существует возможность считывания значений кривых из файла.) 

При непосредственном вводе нагрузки и для общего случая ряда Фурье диапазон зна-
чений угла θ составляет -180° < θ < 180°. Однако если используется четная или не-
четная функция нагрузки, то диапазон сокращается до 0° < θ < 180°. 

5. Команды просмотра: 

Кроме уже упомянутых команд A_LIST (Analysis > List Analysis Option) и CURLIST 
(LoadsBC > FUNCTION CURVE > List Time/Temp), вы также можете использовать 
команды FLIST (LoadsBC > STRUCTURAL > FORCE > List) и PLIST (LoadsBC > 
STRUCTURAL > PRESSURE > List) для просмотра заданных сил и распределенных 
нагрузок. Для каждого узла или элемента в первой строке выводится величина силы 
или распределенной нагрузки, а во второй � номер связанной кривой. 
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6. Команда PRINT_OPS: 

Активизирование признака "detailed print option" (подробный вывод) в этой команде 
указывает программе дополнительно к обычному выводу помещать в файл вывода 
максимальные значения перемещений и напряжений для каждой гармоники. Эти 
максимумы соответствуют максимальному отклику конструкции на каждой окруж-
ности. 

7. Команды постпроцессинга: 

a. Графики для поперечных сечений  

Напряжения и перемещения для каждого из углов, заданных в команде A_ASYM 
(Analysis > STATIC > Asymmetric Load Options), хранятся как варианты нагрузки. Ис-
пользуйте команду RESULTS (Results > Available Results) для определения доступных 
вариантов нагрузки, а затем используйте команду ACTDISP или ACTSTR для активи-
зирования необходимого варианта нагрузки (угла). Для отображения результатов ис-
пользуются команды DISPLOT и STRPLOT (Results > PLOT > Displacement, Stress). 
Кроме этого вы можете использовать команды вывода результатов в текстовой фор-
ме DISPLIST или STRLIST (Results > LIST > Displacement, Stress Component). 

b. Трехмерные графики  

Графики перемещений, деформаций и напряжений могут быть отображены на трех-
мерной модели в цилиндрической координатной системе. Для создания трехмерных 
графиков необходимо активизировать отображение особых элементов в команде 
SETEPLOT (Meshing > ELEMENTS > Set Element Plot) и активизировать закрашивание 
в команде SHADE (Display > DISPLAY OPTION > Shaded Element Plot). Также необ-
ходимо использовать команду PSCALE (or Perfect Scaling icon) для изменения мас-
штаба. При таких настройках все графики будут трехмерными. 

В нижеприведенных примерах продемонстрировано использование команд для расче-
та моделей с несимметричной нагрузкой. Дополнительные примеры находятся в Час-
ти 2 настоящего Руководства (проверочные задачи с S79 по S83). 

Пример 1: Статический расчет круглого котла  
В данном примере используется непосредственный ввод нагрузки. 
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Рис. 13-6. 

Дано: 

E = 30,000 ksi 

r = 10 in. 

Толщина = 0.1 

Отношение Пуассона = 0.3 

Нагрузки: 

Нагрузки приложены по радиальному направлению и симметричны относительно 
плоскости XY. Значения нагрузок показаны на рисунке. Нагрузки FR

1 и FR
2 имеют 

одинаковый шаблон распределения по окружности (одинаковые диапазоны и относи-
тельное изменение величины) и ниже будет показано что они могут быть представ-
лены одним шаблоном. Однако, нагрузка FR

3 имеет отличное от предыдущих распре-
деление, и потребует ввода дополнительного шаблона. Необходимо задать нагрузки 
только для положительных значений θ. Заметьте, что на рисунке нагрузки приведены 
без соблюдения масштаба. 

Команды GEOSTAR  

Создание модели задачи выполняется следующими командами. 
(Control Panel: Propsets > Element Group) 
EGROUP,1,SHELLAX,0,0,0,0,0,0,0, 
(Задание группы элементов) 
(Control Panel: Propsets > Material Property) 
MPROP,1,EX,3.E7,NUXY,.3, 
(задание свойств материала) 
(Control Panel: Propsets > Real Constant) 
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RCONST,1,1,1,1,0.1, 
(Задание толщины оболочки) 
(Control Panel: Geometry > GRID > Plane) 
PLANE,Z,0,1, 
(Установка проекции на плоскость XY) 
VIEW,0,0,1,0, 
(Control Panel: Geometry > POINTS > Define) 
PT,1,0,0,0, 
PT,2,10,0,0, 
(Control Panel: Geometry > CURVES > CIRCLES > Circle in Plane) 
CRPCIRCLE,1,1,2,10,60.,1, 
(Создание геометрии) 
(Control Panel: Meshing > PARAMETRIC MESH > Curves) 
M_CR,1,1,1,2,30,1, 
(Создание 30 элементов) 
(Control Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define Nodes) 
DND,1,ALL,0,1,1, 
DND,2,RY,0,31,1,RX,, 
(Приложение ограничений по перемещениям) 
(Автоматическое масштабирование) 
SCALE,0, 

Команды для задания несимметричной нагрузки  
Control Panel: Analysis > STATIC > Asymmetric Load Options 
Asymmetric loading option >Yes 
(Активизирование несимметричной нагрузки) 
Harmonic type >COS 
(Учитывать только косинусные гармоники) 
Beginning Harmonic number >0 
(Начиная с гармоники 0) 
Ending Harmonic number >10 
(Заканчивая гармоникой 10) 
Starting angle for output >0 
(Выводит результаты, начиная с угла 0 градусов) 
Ending angle for output >360 
(Заканчивая углом 360°) 
Increment angle for output >10 
(С интервалом в 10°) 

Для проверки введенных данных можно использовать команду "A_LIST, STATIC" 
(Analysis > List Analysis Option). В этой команде программе было указано учитывать 
только симметричные (косинусные) гармоники, чтобы избежать ненужных вычисле-
ний для несуществующих (или пренебрежимо малых) синусных гармоник. Однако, 
если присутствует сомнение в симметричности нагрузки, необходимо использовать 
общий случай (синусные и косинусные члены). Число точек, в которых будут выве-
дены результаты, не должно превышать 50. 

Теперь необходимо задать первый шаблон для нагрузок FR
1 и FR

2: 
Control Panel: Control > ACTIVATE > Set Entity 
Set label >FCOEF; Fourier Cosine Coeff 
(Непосредственный ввод нагрузки) 
Coeff. set >1 
(Шаблон номер 1) 

Теперь необходимо задать кривую нагрузки: 
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Control Panel: LoadsBC > FUNCTION CURVE > Time/Temp Curve 
Curve type >FCOEF; Fourier Cosine Coeff 
(Непосредственный ввод нагрузки) 
Curve number >1 
(Шаблон 1) 
Start point >1 
(Начиная с первой точки) 
Circumf. angle for point 1 >0. 
Circumf. load for point 1 >20000 
. 
. 
. 
Circumf. angle for point 10 >27 
(Задайте первые 10 точек кривой) 
Circumf. load for point 10 >3800 

Поскольку в команде CURDEF за одно выполнение можно задать только точек, необ-
ходимо выполнить эту команду повторно для задания точек 11 и 12. 
Control Panel: LoadsBC > FUNCTION CURVE > Time/Temp Curve 
Curve type >FCOEF; Fourier Cosine Coeff 
Curve number >1 
(Для того же шаблона 1) 
Start point >11 
(Начиная с точки 11) 
Circumf. angle for point 11 >30 
Circumf. load for point 11 >1000 
(Задайте 2 последние точки) 
Circumf. angle for point 12 >31 
Circumf. load for point 12 >0 

ПРИМЕЧАНИЕ: Информация о считывании точек кривой из внешних файлов 
приведена в Справке. 

Для проверки введенных данных можно использовать команду "CURLIST, FCOEF". За-
тем необходимо задать нагрузки FR

1 и FR
2 с соответствующими множителями -1 и      

-0.5 для учета знака и различий в величине этих нагрузок. 
Control Panel: LoadsBC > STRUCTURAL > FORCE > Define Nodes 
Beginning node >31 
Force label >FX; X Force 
Value >-1 
Ending node >31 
Increment >1 
(Задайте множитель кривой для FR

1 в узле 31) 
Control Panel: LoadsBC > STRUCTURAL > FORCE > Define Nodes 
Beginning node >20 
Force label >FX; X Force 
Value >-0.5 
Ending node >20 
Increment >1 
(Задайте множитель кривой для FR

2 в узле 20) 

Для проверки введенных значений можно использовать команду FLIST (LoadsBC > 
STRUCTURAL > FORCE > List). 

Теперь необходимо создать второй шаблон для третьей нагрузки (FR
3). 

Control Panel: Control > ACTIVATE > Set Entity 



 246

Set label >FCOEF; Fourier Cosine Coeff 
Coefficient set >2 
(Шаблон номер 2) 

Зададим шаблон нагрузки: 
Control Panel: LoadsBC > FUNCTION CURVE > Time/Temp Curve 
Curve type >FCOEF; Fourier Cosine Coeff 
Curve number >2 
(Задайте вторую кривую) 
Start point >1 
Circumf. angle for point 1 >0 
Circumf. load for point 2 >5000 
. 
. 
. 
Circumf. angle for point 7 >18 
Circumf. load for point 7 >0 

Зададим множитель для FR
3: 

Control Panel: LoadsBC > STRUCTURAL > FORCE > Define Nodes 
Beginnin node >10 
Force label >FX; X Force 
Value >-1 
Ending node >10 
Increment >1 
(Установите значение -1) 
Control Panel: Analysis > OUTPUT OPTIONS > Set Print Options 
Displacement print flag >Yes 
... ... 
Output flag >Append 
(Запрашивается вывод максимального отклика от каждой гармоники) 
Control Panel: Analysis > STATIC > Run Static Analysis 
(Выполнение расчета и запись результатов в файл вывода) 

Результаты  

1. В файл вывода записываются суммарные перемещения и напряжений в запрошен-
ных точках, кроме этого туда записываются максимальные значения отклика (пере-
мещения и напряжения) на окружности для каждой отдельной гармоники, если был 
установлен соответствующие признак в команде PRINT_OPS (Analysis > OUTPUT 
OPTIONS > Set Print Options).  

2. Кроме максимального значения отклика на для каждой окружности (узла), также в 
файл вывода помещается максимальное значение среди всех узлов для каждой гар-
моники перемещения и для полных перемещений. 

3. Значения отклика от отдельных гармоник помогают оценить степень влияния каж-
дой отдельной гармоники на суммарный отклик. Это является полезным инструмен-
том для отсечения менее важных высших гармоник при последующих расчетах, что 
позволяет сэкономит вычислительные ресурсы. 

4. Учитывая п.3, можно сначала выполнить расчет только для перемещений (отключив 
вычисление напряжений в команде STRESS (Analysis > STATIC > Activate Stress 
Calc)), установить степени влияния гармоник на отклик, указать меньший диапазон  
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гармоник (выполнив команду A_ASYM(Analysis > STATIC > Asymmetric Load Options) 
повторно) и выполнить расчет напряжений на сокращенном диапазоне. 

5. Вы можете выполнить расчет напряжений на другом диапазоне углов без необхо-
димости повторно вычислять перемещения. 

6. Перемещения и напряжения вычисляются в глобальной цилиндрической коорди-
натной системе. 

7. Вы можете отобразить результаты с использованием соответствующих команд. ре-
зультаты для каждого угла, указанного в команде A_ASYM (Analysis > STATIC > 
Asymmetric Load Options), хранятся как вариант нагрузки. 

8. Результаты могут быть отображены на полной трехмерной модели. Процедура опи-
сана ниже. 

Постпроцессинг результатов на трехмерной модели  

Постпроцессинг может выполняться на сечении или на трехмерной модели. Постпро-
цессинг на сечении полезен при использовании таких элементов, как  PLANE2D и 
TRIANG. Постпроцессинг для элементов SHELLAX следует выполнять на трехмер-
ной модели. Для активизирования трехмерного постпроцессинга активизируйте при-
знак отображения особых элементов в команде SETEPLOT (Meshing > ELEMENTS > 
Set Element Plot) и закрашивание элементов. 
Control Panel: Meshing > ELEMENTS > Set Element Plot 
Element plot order >Linear 
Plot beam orientation >No 
Special element plot >Yes 
Ending node >10 
Increment >1 
Control Panel: Display > DISPLAY OPTION > Shaded Element Plot 

График деформаций  
Нажав на кнопку View, установите изометрическую проекцию  
Control Panel: Results > PLOT > Deformed Shape 
Используйте автоматическое изменение масштаба  
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Рис. 13-7. Трехмерный график деформаций  

График построен с шагом в 10 градусов, как было указано в команде A_ASYM (Analysis 
> STATIC > Asymmetric Load Options) до выполнения расчета. Положительное на-
правление угла соответствует указанному в левой части рис. 13-1. 

Контурный график перемещений  

Контурные графики строятся с шагом, указанным в команде A_ASYM (Analysis > 
STATIC > Asymmetric Load Options). Нижеприведенная команда построит контурный 
график перемещений по радиальному направлению. Заметьте, что предварительно 
необходимо выполнить команды SETEPLOT (Meshing > ELEMENTS > Set Element 
Plot) и SHADE (Display > DISPLAY OPTION > Shaded Element Plot). 
Control Panel: Results > PLOT > Displacement 
(Укажите компонент перемещений UX и отобразите его на деформированной модели) 
Используйте автоматическое изменение масштаба  

 

Рис. 13-8. Контурный график радиальных перемещений  

График напряжений  

Напряжения для элемента SHELLAX доступны в координатной системе элемента (см. 
Главу 4 руководства пользователя COSMOS/M). Нижеприведенная команда построит 
контурный график напряжений. Заметьте, что перед этим необходимо выполнить ко-



 249

манды SETEPLOT и SHADE. 
Control Panel: Results > PLOT > Stress 
(Компонент напряжений на элементах SZ отображается на деформированной модели) 
Используйте автоматическое изменение масштаба  

 

Рис. 13-9. Контурный график напряжений  

ПРИМЕЧАНИЕ: Напряжения для элементов SHELLAX доступны только в коорди-
натной системе элемента. Доступны только напряжения на элементах. Значения на-
пряжений отображаются между двумя последовательными углами соответствуют 
значениям в начале интервала. 

Уменьшение интервалов  

Вы можете увеличить точность отображаемых результатов, указав меньший интервал 
и повторно выполнив расчет напряжений, не выполняя расчет перемещений. напри-
мер, можно повторно вычислить напряжения между углами 270 и 360 градусов с 
меньшим интервалом: 
Control Panel: Analysis > STATIC > Asymmetric Load Options 
Asymmetric loading option >Yes 
Harmonic type >COS 
Beginning Harmonic number >0 
Ending Harmonic number >10 
Starting angle for output >270 
Ending angle for output >360 
Increment angle for output >2 
Control Panel: Analysis > STATIC > Run Stress Analysis 

На рис. 13-10 показан контурный график напряжений, вычисленных с уменьшенными 
интервалами. 
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Рис. 13-10. Улучшенный контурный график напряжений  

Заметьте, что если интервал вычисления напряжений отличается от интервала пере-
мещений, вы не можете отображать напряжения на деформированной модели. 

Пример 2: Статический расчет круглого котла  
В данном примере используется непосредственный ввод нагрузок. 

 

Рис. 13-11. 

Дано: 

E = 30,000 ksi 

r = 10 in. 

Толщина = 0.1 
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Отношение Пуассона = 0.3 

Нагрузки: 

Нагрузка приложена перпендикулярно к поверхности оболочки, как показано на ри-
сунке (изображение приведено без соблюдения масштаба). Для данной задачи необ-
ходимо задать только один шаблон. В задачах с более чем одним шаблоном процеду-
ра приложения нагрузки аналогична приведенной в предыдущем примере. 

В отличие от предыдущего примера нагрузка не симметрична, и должна быть опреде-
лена по всей окружности. 

Команды GEOSTAR 

Описание нижеприведенных команд приведено в предыдущем примере. 
(Control Panel: Propsets > Element Group) 
EGROUP,1,SHELLAX,0,0,0,0,0,0,0, 
(Control Panel: Propsets > Material Property) 
MPROP,1,EX,3.E7,NUXY,.3, 
(Control Panel: Propsets > Real Constant) 
RCONST,1,1,1,1,0.1, 
(Control Panel: Geometry > GRID > Plane) 
PLANE,Z,0,1, 
(С помощью кнопки View установите проекцию на плоскость XY) 
VIEW,0,0,1,0, 
(Control Panel: Geometry > POINTS > Define) 
PT,1,0,0,0, 
PT,2,10,0,0, 
(Control Panel: Geometry > CURVES > CIRCLES > Circle in Plane) 
CRPCIRCLE,1,1,2,10,60.,1, 
(Control Panel: Meshing > PARAMETRIC MESH > Curves) 
M_CR,1,1,1,2,30,1, 
(Control Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define Nodes) 
DND,1,ALL,0,1,1, 
DND,2,RY,0,31,1,RX,, 
(Control Panel: Analysis > OUTPUT OPTIONS > Set Print Options) 
PRINT_OPS,1,0,0,1,0,1,0,0,0,1, 
(Используйте автоматическое изменение масштаба) 
SCALE,0, 

Команды для задания несимметричной нагрузки  
Control Panel: Analysis > STATIC > Asymmetric Load Options 
Asymmetric loading option >Yes 
(Активизирование несимметричной нагрузки) 
Harmonic type >GEN 
(Учитывать косинусные и синусные гармоники) 
Beginning Harmonic number >0 
(Начиная с гармоники 0) 
Ending Harmonic number >10 
(Заканчивая гармоникой 10) 
Starting angle for output >0 
(Начиная с угла 0 градусов) 
Ending angle for output >360 
(Заканчивая в угле 360°) 
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Increment angle for output >90 
(С интервалом в  90°) 

В этой команде было указано, что при расчете будут учитываться косинусные и си-
нусные гармоники (общий случай). Также предполагается, что 10 гармоник будет 
достаточно, хотя пользователь может изучить степени влияния каждой гармоники на 
отклик и определить, большее или меньшее количество гармоник требуется для дос-
таточно точного расчета. 
Control Panel: Control > ACTIVATE > Set Entity 
Set label >FCOEF; Fourier Cosine Coeff 
(Assign the Input Load Option) 
Coeff. set >1 
(Assign the load set) 

Задайте шаблон нагрузки: 
Control Panel: LoadsBC > FUNCTION CURVE > Time/Temp Curve 
Curve type >FCOEF; Fourier Cosine Coeff 
Curve number >1 
Start point >1 
Circumf. angle for point 1 >-150. 
Circumf. load for point 1 >500 
. 
. 
. 
Circumf. angle for point 10 >-15 
Circumf. load for point 10 >3250 
(Задайте первые 10 точек) 

Задайте остальные точки: 
Control Panel: LoadsBC > FUNCTION CURVE > Time/Temp Curve 
Curve type >FCOEF; Fourier Cosine Coeff 
Curve number >1 
Start point >11 
Circumf. angle for point 11 >0 
Circumf. load for point 11 >2450 
. 
. 
. 
Circumf. angle for point 15 >55 
Circumf. load for point 15 >0 
(Задайте оставшиеся 5 точек) 

Приложите распределенную нагрузку на элементы вверху модели: 
(Control Panel: LoadsBC > STRUCTURAL > PRESSURE > Define Element) 
PEL,29,-50, 1,30,1,4 
(Нагрузка прикладывается к элементам 29 и30) 
(Control Panel: Analysis > OUTPUT OPTIONS > Set Print Options) 
PRINT_OPS,1,0,0,1,0,1,0,0,1,0, 
(Control Panel: Analysis > STATIC > Run Static Analysis) 
R_STATIC 
(Выполните расчет) 

Процедура постпроцессинга описана в предыдущем примере. 
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Пример 3: Статический расчет сопла  
В данном примере нагрузка задается через косинусные члены ряда Фурье. 

 

Рис. 13-12. 

Дано: 

E = 30,000 ksi 

H = 30 in. 

A = 10 in. 

B = 5 in. 

Отношение Пуассона = 0.3 

Нагрузки: 

Нагрузки аппроксимированы рядами Фурье, как показано на рисунке. Две нагрузки, 
приложенные по радиальному направлению (FR), имеют одинаковый шаблон (хотя 
их амплитуды различны) и для их задания требуется один шаблон (шаблон 1). Одна-
ко для нагрузки, приложенной по направлению оси (FY), необходимо задать еще один 
шаблон (шаблон 2). 

Команды GEOSTAR 

Нижеприведенные команды создают модель задачи. 
(Control Panel: Geometry > GRID > Plane) 
PLANE,Z,0,1, 
(Установите рабочую плоскость XY) 
(С помощью кнопки View установите проекцию на плоскость XY) 
VIEW,0,0,1,0, 
(Control Panel: Geometry > CURVES > Draw Polyline) 
CRSPOLY,1,10,0.,0.,L,10.,30.,0.,L,15.,30.,0.,L,20,0.,0.,L,10.,0.,0., 
(Используйте автоматическое изменение масштаба) 
SCALE,0, 
(Создайте границы сечения) 
(Control Panel: Geometry > SURFACES > Define by 2 Cr) 
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SF2CR,1,2,4,0, 
(Создайте поверхность по двум противоположным краям) 
(Control Panel: Propsets > Element Group) 
EGROUP,1,PLANE2D,0,0,3,0,0,0,0, 
(Задайте элемент PLANE2D в осесимметричном варианте) 
(Control Panel: Propsets > Material Property) 
MPROP,1,EX,30E6,NUXY,.3, 
(Задайте свойства материала) 
(Control Panel: Meshing > PARAMETRIC MESH > Surfaces) 
M_SF,1,1,1,4,5,8,1,1, 
(Сгенерируйте КЭ-сеть из 4-узловых элементов) 
(Control Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define Curves) 
DCR,4,ALL,0,4,1 
(Приложите ограничения к нижней границе сечения) 
(Control Panel: Analysis > OUTPUT OPTIONS > Set Print Options) 
PRINT_OPS,1,0,0,1,0,1,0,0,1,0, 
(Установите признак подробного вывода) 

В приведенной выше команде EGROUP (Propsets > Element Group) важно установить 
осесимметричный вариант элемента PLANE2D (для элемента SHELLAX этого не 
требуется). 

Команды для задания несимметричной нагрузки  
Control Panel: Analysis > STATIC > Asymmetric Load Options 
Asymmetric loading option >Yes 
(Активизирование несимметричной нагрузки) 
Harmonic type >COS 
(Учитывать только косинусные гармоники) 
Beginning Harmonic number >0 
(Начиная с гармоники 0) 
Ending Harmonic number >5 
(Заканчивая гармоникой 5) 
Starting angle for output >0 
(Начиная с угла в 0 градусов) 
Ending angle for output >90 
(Заканчивая углом 90°) 
Increment angle for output >10 
(С шагом 10°) 

Для проверки введенных значений можно использовать команду "A_LIST, STATIC" 
(Analysis > List Analysis Option). 

Теперь необходимо задать первый шаблон для нагрузок FR
1 и FR

2: 
Control Panel: Control > ACTIVATE > Set Entity 
Set label >FCOS; Fourier Cosine Coeff 
COSINE Coeff. set >1 
(Шаблон номер 1) 
Control Panel: LoadsBC > FUNCTION CURVE > Time/Temp Curve 
Curve type >FCOS; Fourier Cosine Coeff 
(Для косинусных гармоник) 
Curve number >1 
(Шаблон номер 1) 
Start point >1 
Cosine Harmonic for point 1 >0 
(Для гармоники 0) 
Fourier Cosine Coeff. for point 1 >1 
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(задайте коэффициент 1) 
Cosine Harmonic for point 2 >1 
Fourier Cosine Coeff. for point 2 >2 
(Для гармоники 1 назначьте коэффициент 2) 
Cosine Harmonic for point 3 >2 
Fourier Cosine Coeff. for point 3 >4 
(Для гармоники 2 назначьте коэффициент 4) 

Эта команда задает шаблон 1 для двух радиальных нагрузок. 
(Control Panel: LoadsBC > STRUCTURAL > FORCE > Define Nodes) 
FND,6,FX,-10000.,6,1 
(Задайте нагрузку величиной -10000 в узле 6 по радиальному направлению  как множитель к шаблону 1) 
FND,30,FX,-30000.,30,1, 
(Аналогично задайте радиальную нагрузку величиной -3000 в узле 30) 

Поскольку гармоники для третьей нагрузки отличаются от предыдущих, необходимо 
задать новый шаблон: 
Control Panel: Control > ACTIVATE > Set Entity 
Set label >FCOS; Fourier Cosine Coeff 
COSINE Coeff. set >2 
(Шаблон номер 2) 
Control Panel: LoadsBC > FUNCTION CURVE > Time/Temp Curve 
Curve type >FCOS; Fourier Cosine Coeff 
Curve number >2 
(Шаблон номер 2) 
Start point >1 
Cosine Harmonic for point 1 >2 
Fourier Cosine Coeff. for point 1 >1 
Cosine Harmonic for point 2 >4 
Fourier Cosine coeff. for point 2 >3 
Cosine Harmonic for point 3 >5 
Fourier Cosine coeff. for point 3 >6 

Для проверки введенных значений можно использовать команду "CURLIST, FCOS" 
(LoadsBC > FUNCTION CURVE > List Time/Temp). 
(Control Panel: LoadsBC > STRUCTURAL > FORCE > Define Nodes) 
FND,1,FY,-20000,1,1 
(Задайте нагрузку по направлению оси величиной -20000 в узле 1 как множитель к шаблону 2) 
(Control Panel: Analysis > STATIC > Run Static Analysis) 
R_STATIC 
(Выполните расчет) 

ПРИМЕЧАНИЕ: Любая гармоника, входящая в диапазон, указанный в команде 
A_ASYM (Analysis > STATIC > Asymmetric Load Options), для которой коэффициент 
равен нулю, оказывает нулевое влияние на суммарный отклик. Например, гармоника 
3, отсутствующая в обоих шаблонах, не оказывает влияния на отклик, что можно 
проверить, найдя максимальное значение перемещений гармоники 3 в файле вывода. 
Любые гармоники заданной нагрузки, не входящие в диапазон вычислений (задавае-
мый в команде A_ASYM) будут проигнорированы. 

Постпроцессинг результатов в сечении  

Как было упомянуто ранее, постпроцессинг можно выполнять как в двух, так и в трех 
измерениях. Признак отображения особых элементов в команде SETEPLOT (Meshing 
> ELEMENTS > Set Element Plot) управляет типом постпроцессинга. По умолчанию 
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используется двухмерный постпроцессинг. Если вы ранее активизировали признак 
отображения особых элементов в команде SETEPLOT, то необходимо его деактивиро-
вать. Результаты доступны в глобальной цилиндрической координатной системе (ко-
ординатная система 1). 

График перемещений  

Значения результатов в углу 40 градусов хранятся как вариант нагрузки 5. Для ото-
бражения графика касательных перемещений в этом сечении необходимо выполнить 
следующие команды: 
(Control Panel: Meshing > ELEMENTS > Set Element Plot) 
SETEPLOT; 
(Control Panel: Results > PLOT > Displacement) 
ACTDIS, 5, UZ, 
DISPLOT; 

 

Рис. 13-13. Касательные перемещения в угле 40 градусов 

График напряжений  

График радиальных напряжений в угле 90 градусов (хранятся как вариант нагрузки 
10) строится следующей последовательностью команд: 
(Control Panel: Results > PLOT > Stresses) 
ACTSTR, 10, SX; 
STRPLOT; 
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Рис. 13-14. радиальные перемещения в угле 90 градусов 

Постпроцессинг на трехмерной модели  

Для выполнения постпроцессинга на трехмерной модели необходимо активизировать 
признак отображения особых элементов в команде SETEPLOT (Meshing > ELEMENTS 
> Set Element Plot) в также необходимо активизировать закрашивание элементов.  
Постпроцессинг выполняется так же как и в первом примере. 

Пример 4: Статический расчет сопла  
В данном примере для задания нагрузки используется общий случай ряда Фурье. 

 

Рис. 13-15 

Дано: 

E = 30,000 ksi 

H = 30 in. 

A = 10 in. 

B = 5 in. 
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Отношение Пуассона  = 0.3 

Нагрузки: 

В данном случае радиальная сила FR состоит из косинусных и синусных гармоник, а 
осевая сила FY состоит только из синусных гармоник. 

Команды GEOSTAR 

Нижеприведенные команды создают модель задачи. 
(Control Panel: Geometry > GRID > Plane) 
PLANE,Z,0,1, 
(Установите рабочую плоскость XY) 
(С помощью кнопки View установите проекцию на плоскость XY) 
VIEW,0,0,1,0, 
(Control Panel: Geometry > CURVES > Draw Polyline) 
CRSPOLY,1,10,0.,0.,L,10.,30.,0.,L,15.,30.,0.,L,20,0.,0.,L,10.,0.,0., 
(Используйте автоматическое изменение масштаба) 
SCALE,0, 
(Создайте границы сечения) 
(Control Panel: Geometry > SURFACES > Define by 2 Cr) 
SF2CR,1,2,4,0, 
(Создайте поверхность по двум противоположным краям) 
(Control Panel: Propsets > Element Group) 
EGROUP,1,PLANE2D,0,0,3,0,0,0,0, 
(Задайте элемент PLANE2D в осесимметричном варианте) 
(Control Panel: Propsets > Material Property) 
MPROP,1,EX,30E6,NUXY,.3, 
(Задайте свойства материала) 
(Control Panel: Meshing > PARAMETRIC MESH > Surfaces) 
M_SF,1,1,1,4,5,8,1,1, 
(Сгенерируйте КЭ-сеть из 4-узловых элементов) 
(Control Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define Curves) 
DCR,4,ALL,0,4,1 
(Приложите ограничения к нижней границе сечения) 
(Control Panel: Analysis > OUTPUT OPTIONS > Set Print Options) 
PRINT_OPS,1,0,0,1,0,1,0,0,1,0, 
(Установите признак подробного вывода) 

В приведенной выше команде EGROUP (Propsets > Element Group) важно установить 
осесимметричный вариант элемента PLANE2D (для элемента SHELLAX этого не 
требуется). 

Команды для задания несимметричной нагрузки  
Control Panel: Analysis > STATIC > Asymmetric Load Options 
Asymmetric loading option >Yes 
(Активизирование несимметричной нагрузки) 
Harmonic type >GEN 
(Учитывать гармоники обоих типов) 
Beginning Harmonic number >1 
(Начиная с гармоники 1) 
Ending Harmonic number >4 
(До гармоники 4) 
Starting angle for output >0 
(Начиная с угла 0 градусов) 
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Ending angle for output >360 
(До угла 360°) 
Increment angle for output >10 
(С шагом 10°) 

В этой команде программе было указано рассчитывать гармоники обоих типов с 1 по 
4. Тот факт, что в нагрузке FY нет косинусных гармоник, не вызовет ошибок, по-
скольку программа автоматически назначит нулевые коэффициенты недостающим 
гармоникам. 

Для проверки введенных значений можно использовать команду "A_LIST, STATIC" 
(Analysis > List Analysis Option). 
Control Panel: Control > ACTIVATE > Set Entity 
Set label >FSIN; Fourier Sine Coeff 
SINE Coeff. set >1 
(Активизирование шаблона номер 1) 
Control Panel: LoadsBC > FUNCTION CURVE > Time/Temp Curve 
Curve type >FSIN; Fourier Sine Coeff 
(Для синусных гармоник) 
Curve number >1 
(Шаблон номер 1) 
Start point >1 
Sine Harmonic for point 1 >2 
(Для гармоники 2) 
Fourier Sine Coeff. for point 1 >1 
(назначьте коэффициент 1) 
Sine Harmonic for point 2 >4 
Fourier Sine Coeff. for point 2 >3 
(Для гармоники 4 назначьте коэффициент 3) 

Для проверки введенных коэффициентов можно использовать команду "CURLIST, 
FSIN" (LoadsBC > FUNCTION CURVE > List Time/Temp). 
(Control Panel: LoadsBC > STRUCTURAL > FORCE > Define Nodes) 
FND,1,FY,-20000,1,1 
(Задайте осевую нагрузку величиной -20000 в узле 1 используя шаблон номер 1) 

Теперь зададим радиальную нагрузку FR: 
Control Panel: Control > ACTIVATE > Set Entity 
Set label >FSIN; Fourier Sine Coeff 
SINE Coeff. set >2 
(Активизирование шаблона синусных гармоник  номер 2) 
Control Panel: LoadsBC > FUNCTION CURVE > Time/Temp Curve 
Curve type >FSIN; Fourier Sine Coeff 
(Для синусных гармоник) 
Curve number >2 
(Set Pattern Number 2) 
Start point >1 
Sine Harmonic for point 1 >1 
(Для гармоники 1) 
Fourier Sine Coeff. for point 1 >3 
(задайте коэффициент 3) 
Sine Harmonic for point 2 >2 
Fourier Sine Coeff. for point 2 >5 
(Для гармоники 2 назначьте коэффициент 5) 

Перед приложением нагрузки необходимо задать косинусные члены ряда Фурье, акти-
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визировав шаблон косинусных гармоник для того же шаблона (номер 2). 
Control Panel: Control > ACTIVATE > Set Entity 
Set label > FCOS; Fourier Cosine Coeff 
COSINE Coeff. set >2 
(Активизирование шаблона косинусных гармоник 2) 
Control Panel: LoadsBC > FUNCTION CURVE > Time/Temp Curve 
Curve type >FCOS; Fourier Cosine Coeff 
(Для косинусных гармоник) 
Curve number >2 
(Шаблон номер 2) 
Start point >1 
Cosine Harmonic for point 1 >1 
(Для гармоники 1) 
Fourier Cosine Coeff. for point 1 >2 
(задайте коэффициент 2) 
Cosine Harmonic for point 2 >3 
Fourier Cosine coeff. for point 2 >4 
(Для гармоники 3 задайте коэффициент 4) 
Control Panel: LoadsBC > STRUCTURAL > FORCE > Define Nodes 
(Задайте радиальную нагрузку величиной -10000 используя шаблон номер 2) 
Control Panel: Analysis > STATIC > Run Static Analysis 
(Выполните расчет) 

Интерпретация результатов описана в конце первого примера. 

Используйте команду ACTDISP или ACTSTR совместно с командой DISPLOT (Results > 
PLOT > Displacement) или STRPLOT (Results > PLOT > Stresses) для отображения ре-
зультатов в необходимом сечении. 

Расчет неосесимметричных форм мод  
Для любой указанной гармоники могут быть рассчитаны частоты и соответствующие 
формы мод. Программа может найти до 200 форм мод конструкции в зависимости от 
используемого метода извлечения собственных значений. Для этой цели вы можете 
использовать методы подпространственной итерации, Ланцоша, обратной степени, а 
также использовать сдвиг частот, проверку последовательности Стурма, геометриче-
ское изменение жесткости и другие возможности модуля DSTAR. Формы мод рас-
считываются в различных углах и печатаются в файл вывода. Расчет форм мод при-
меним к элементам PLANE2D и SHELLAX. 

Ниже приведены команды, необходимые для расчета неосесимметричных форм мод. 
Предполагается что модель уже создана.  

1. Команда EGROUP: 

Также, как и в статическом расчете, для элемента PLANE2D должен быть активизиро-
ван осесимметричный вариант (для элемента SHELLAX не требуется активизирова-
ния дополнительных опций). 

2. Команды расчета: 

a. В данном случае выбор гармоник (синусные или косинусные) не имеет значения. 
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Используйте любой вариант. 

b. Выбор гармоники определяется только начальной (началом диапазона), поэтому для 
конечной гармоники (конца диапазона) используйте значение по умолчанию. 

Указанные диапазон и шаг углов влияют на результаты для записи в файл или отобра-
жения. Если необходимо учитывать геометрическое изменение жесткости, то прило-
женная нагрузка должна быть осесимметричной, как в обычных статических задачах 
(см. нижеприведенный пример). 

В команде A_FREQUENCY (Analysis > FREQUENCY/BUCKLING > Frequency Options) 
задаются настройки расчета, такие как метод извлечения собственных значений, чис-
ло форм мод, сдвиг частот, геометрическое изменение жесткости и прочее. Однако в 
этом случае введенный номер гармоники игнорируется. 

Возможно рассчитать напряжения для всех форм мод, выполнив команду R_STRESS 
(Analysis > STATIC > Run Stress Analysis), после чего максимальные значения на-
пряжений по окружностям записываются в файл вывода и становятся доступны для 
отображения. 

3. Команды просмотра: 

Команда "A_LIST, FREQ" (Analysis > List Analysis Option) используется для вывода на-
строек частотного расчета, включая указанные в команде A_ASYM (Analysis > 
STATIC > Asymmetric Load Options). Для проверки приложенных нагрузок, если ис-
пользуется геометрическое изменение жесткости, используются команды FLIST 
(LoadsBC > STRUCTURAL > FORCE > List) или PLIST (LoadsBC > STRUCTURAL > 
PRESSURE > List). 

4. Команда PRINT_OPS: 

Если в этой команде активизировать признак подробного вывода результатов (detailed 
print option) (если установлен признак форм мод в команде A_FREQUENCY), то про-
грамма запишет максимальное значение формы моды на каждой окружности (узле) 
для каждой запрошенной моды, в противном случает будут записаны только дейст-
вующие формы мод на окружностях для каждого запрошенного угла. 

Нижеприведенный пример, а также проверочные задачи F25 и F26, демонстрируют 
использование команд расчета неосесимметричных форм мод. 

Пример 5: Частотный расчет круглого котла 
В данном примере вычисляются первые пять частот и форм мод второй гармоники (с 
учетом геометрического увеличения жесткости). 
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Рис. 13-16. 

Дано: 

E = 30,000 ksi 

r = 10 in. 

Отношение Пуассона = 0.3 

Команды GEOSTAR  

Создание модели задачи выполняется следующими командами. 
(Control Panel: Propsets > Element Group) 
EGROUP,1,SHELLAX,0,0,0,0,0,0,0, 
(Задание группы элементов) 
(Control Panel: Propsets > Material Property) 
MPROP,1,EX,3.E7,NUXY,.3,DENS,0.1, 
(задание свойств материала) 
(Control Panel: Propsets > Real Constant) 
RCONST,1,1,1,1,0.1, 
(Задание толщины оболочки) 
(Control Panel: Geometry > GRID > Plane) 
PLANE,Z,0,1, 
(Установка проекции на плоскость XY) 
VIEW,0,0,1,0, 
(Control Panel: Geometry > POINTS > Define) 
PT,1,0,0,0, 
PT,2,10,0,0, 
(Control Panel: Geometry > CURVES > CIRCLES > Circle in Plane) 
CRPCIRCLE,1,1,2,10,60.,1, 
(Создание геометрии) 
(Control Panel: Meshing > PARAMETRIC MESH > Curves) 
M_CR,1,1,1,2,30,1, 
(Создание 30 элементов) 
(Control Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define Nodes) 
DND,1,ALL,0,1,1, 
DND,2,RY,0,31,1,RX,, 
(Приложение ограничений по перемещениям) 
(Автоматическое масштабирование) 
SCALE,0, 
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(Control Panel: Analysis > OUTPUT OPTIONS > Set Print Options) 
PRINT_OPS,1,0,0,1,0,1,0,0,1,0, 
(Запрос подробного вывода результатов) 
(Control Panel: Analysis > FREQUENCY/BUCKLING > Frequency Options) 
A_FREQ,5,S,16,,,,1,,,,,,,, 
(Найти первые 5 частот по методу подпространственной итерации с учетом геометрического из-
менения жесткости) 
(Control Panel: LoadsBC > STRUCTURAL > FORCES > Define Nodes) 
FND,31,FY,100,31,1 
(Задание осесимметричной нагрузки по направлению оси) 

Команды для нахождения несимметричных форм мод  
Control Panel: Analysis > STATIC > Asymmetric Load Options 
Asymmetric loading option >Yes 
(Активизирование несимметричного режима) 
Harmonic type >GEN 
(Не играет роли, используйте значение по умолчанию) 
Beginning Harmonic number >3 
(Использовать вторую гармонику) 
Ending Harmonic number >3 
(Не играет роли, используйте значение по умолчанию) 
Starting angle for output >0 
(Начиная с угла 0 градусов) 
Ending angle for output >360 
(До угла 360°) 
Increment angle for output >10 
Control Panel: Analysis > FREQUENCY/BUCKLING > Run Frequency 
(Выполнение частотного расчета) 
Control Panel: Analysis > STATIC > Run Stress Analysis 
(Вычисление напряжений для форм мод) 

Также вычисляются и записываются в файл вывода максимальные напряжения (по ка-
сательному направлению) для каждой моды. Эти значения представляют коэффици-
енты гармоник каждой моды, что соответствует максимальному значению гармоники 
на каждой окружности. 

Трехмерные графики  

Интервал, используемый для построения графиков, задается в команде A_ASYM 
(Analysis > STATIC > Asymmetric Load Options). Для отображения первой моды ис-
пользуется следующая последовательность команд: 
(Control Panel: Meshing > ELEMENTS > Set Element Plot) 
SETEPLOT, , , 1; 
(С помощью кнопки View установите изометрическую проекцию) 
VIEW, 1, 1, 1, , 
(Control Panel: Results > PLOT > Deformed Shape) 
DEFPLOT, 1; 
(Используйте автоматическое изменение масштаба) 
PSCALE; 
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Рис. 13-17. Первая мода третьей гармоники  

Третья мода отображается следующим образом: 
(Control Panel: Results > PLOT > Deformed Shape) 
DEFPLOT, 3; 

 

Рис. 13-18. Третья мода третьей гармоники  

Первая мода круглого котла, показанная на рис. 13-17, в некотором роде аналогична  
первой моде консольной балки. Однако по касательному направлению котел дефор-
мируется в трех ясно различимых модах, что означает присутствие третьей гармони-
ки. Более четко это видно на проекции на плоскость XZ (VIEW, 0, 1, 0;). 

Из рис. 13-18 видно, что котел деформируется (в меридиональном направлении) ана-
логично третьей моде консольной балки, хотя три отчетливых колебания по каса-
тельному направлению остаются. 

Неосесимметричный расчет устойчивости  
Расчет устойчивости осесимметричных конструкций применим только к  осесиммет-
ричным нагрузкам. Программа вычисляет нагрузки и моды устойчивости для гармо-
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ник начиная с указанной младшей гармоники, пока не будет найдена та, которая име-
ет минимальное значение нагрузки устойчивости. В файл вывода записываются 
множитель нагрузки устойчивости и соответствующая форма моды (в запрошенных 
точках), а также максимальное значение формы моды в каждой окружности (узле).  

Если установлен признак подробного вывода результатов в команде PRINT_OPS 
(Analysis > OUTPUT OPTIONS > Set Print Options), то программа рассчитывает все 
гармоники в указанном диапазоне и записывает результаты в файл вывода. 

Программа вычисляет первое числовое собственное значение для каждой гармоники, 
которые соответствуют минимальной нагрузке устойчивости. Действительная на-
грузка устойчивости находится умножением вычисленного значения на приложен-
ную нагрузку. 

Ниже приведены команды, необходимые для выполнения неосесимметричного расче-
та устойчивости. Предполагается, что модуль уже создана. 

1. Команда EGROUP: 

Также, как и в статическом расчете, для элемента PLANE2D должен быть активизиро-
ван осесимметричный вариант (для элемента SHELLAX не требуется активизирова-
ния дополнительных опций). 

2. Команды расчета: 

Команда A_ASYM (Analysis > STATIC > Asymmetric Load Options) выполняет ту же 
функцию, что и в статическом расчете, за исключением: 

a. Выбор гармоники в данном случае не важен. Используйте значение по умолчанию. 

b. Начальная и конечная гармоники задают диапазон гармоник для расчета устойчиво-
сти. 

Диапазон и интервал углов влияют на результаты, записываемые в файл вывода. 

3. Команды просмотра: 

Для просмотра настроек расчета устойчивости, включая заданные в команде  A_ASYM, 
используйте команду "A_LIST, BUCKL" (Analysis > List Analysis Option). Для просмотра 
приложенных нагрузок устойчивости используйте команды FLIST или PLIST 
(LoadsBC > STRUCTURAL > FORCE, PRESSURE > List). 

4. Команда PRINT_OPS: 

Активизирование признака подробного вывода результатов указывает программе вы-
числять нагрузки устойчивости (и соответствующие формы мод) для всех гармоник в 
указанном диапазоне и заносить результаты в файл вывода; в противном случае про-
грамма останавливается при нахождении минимальной нагрузки устойчивости и в 
файл вывода будут записаны результаты только для этой гармоники.  
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В отличие от статического расчета, в расчете устойчивости нет необходимости ис-
пользовать команды ACTSET (Control > ACTIVATE > Set Entity) (для опций FCOS, 
FSIN и FCOEF) и CURDEF (LoadsBC > FUNCTION CURVE > Time/Temp Curve). 

Использование команд для неосесимметричного расчета устойчивости продемонстри-
ровано в проверочных задачах B14 и B15. 

Трехмерные графики 

Отображение мод устойчивости в трех измерениях производится аналогично приме-
рам, приведенным ранее. Единственное отличие состоит в том, что все графики соот-
ветствуют частоте по направлению оси и первое приглашение в команде DEFPLOT 
(Results > PLOT > Deformed Shape) соответствует номеру гармоники. 
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Приложение A. 
Единицы измерения 
Введение 

В данном приложении приведено краткое описание двух наиболее часто используе-
мых систем единиц измерения: международная система единиц (SI) и традиционная 
система единиц США. В COSMOS/M вы можете использовать любую систему еди-
ниц, включая нестандартные. Однако единицы должны быть совместимы и вы долж-
ны интерпретировать результаты соответственно используемой системе. Использо-
вание несовместимых единиц может привести к неправильным результатам. 

ПРИМЕЧАНИЕ: В данном приложении описаны только единицы, используемые в 
Основной Системе. Единицы измерения, используемые в других расчетах приведены 
в Приложении B Руководства пользователя COSMOS/M. 

Международная система единиц  
Основными единицами в этой системе являются единицы длины, массы и времени: 
метр (m), килограмм (kg) и секунда (s) соответственно. Другие единицы являются 
производными от основных. Главные единицы SI, используемые в конструкционной 
механике, приведены в таблице. 

Таблица A-1. Главные единицы SI, используемые в конструкционной механике  

Величина Единица Символ 
Длина Метр m 
Масса Килограмм kg 
Время Секунда s 
Площадь Метр квадратный m2 
Объем твердых тел  Метр кубический m3 
Объем жидких тел  Литр  L=10-3 m3 
Скорость Метр в секунду m/s 
Ускорение Метр в секунду за секунду (m/s2) 
Угол Радиан rad 
Угловая скорость Радиан в секунду rad/s 
Угловое ускорение Радиан в секунду за секунду rad/s2 
Плотность Килограмм на метр кубический kg/m3 
Сила Ньютон N=kg m/s2 
Момент силы  Ньютон-метр N m 
Напряжения и давление Паскаль Pa=N/m2 
Частота Герц Hz=cycle/s 
Импульс Ньютон-секунда N s 
Работа Джоуль J=N m 
Мощность Ватт W=J/s 
Теплопроводность (K)  Ватт на метр на градус Цельсия  W/m °C 
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Удельная теплота (C)  Джоуль на килограмм на градус 
Цельсия  

J/kg °C 

Пленочный коэффициент конвекции Ватт на метр квадратный на градус 
Цельсия  

W/m2 °C 

Генерация теплоты в узле (Q)  Ватт W 
Тепловой поток (генерация теплоты 
на единицу площади)  

Ватт на метр квадратный W/m2 

Генерация теплоты на единицу объ-
ема (QE)  

Ватт на метр кубический W/m3 

Традиционная система единиц США  
Основными единицами в данной системе являются фут (ft) для длины, фунт (lb) для 
веса и секунда (s) для времени. В этой системе основной величиной является вес (не 
масса), в отличие от системы SI. Эта система гравитационная (и не абсолютная), по-
скольку вес зависит от величины ускорения свободного падения. Например, вес тела 
изменяется в пределах Земли и вес тела на Земле примерно в шесть раз больше веса 
этого тела на Луне. Фунт определяется как вес платинового стандарта, называемого 
стандартным фунтом, на уровне моря на широте 45 градусов. 

В то время как фунт используется в качестве единицы массы в коммерческих сделках, 
в инженерной работе применять его таким образом не следует. Единицей измерения 
массы в традиционной системе единиц США является фунт-сила (slug). Фунт-сила 
определяется как масса, получающая единичное ускорение (ft/s2), будучи подвергну-
той действию единичной силы (lb). Главные традиционные единицы США, исполь-
зуемые в конструкционной механике, и их эквиваленты в системе SI приведены в 
таблице. 

Таблица A-2. Таблица перевода единиц традиционной системы США в SI  

Величина  Традиционная единица Эквивалент в SI  
Длина  ft 0.3048 m 
 in 25.40 mm 
 mi 1.609 km 
Площадь ft2 0.0929 m2 
 in2 645.2 mm2 
Объем твердых тел ft3 0.02832 m3 
 in3 16.39 cm3 
Объем жидких тел gal 3.785 L 
 qt 0.9464 L 
Скорость ft/s 0.3048 m/s 
 in/s 0.0254 m/s 
 mi/h (mph) 0.4470 m/s 
 mi/h 1.609 km/h 
Ускорение  ft/s2 0.3048 m/s2 
 in/s2 0.0254 m/s2 
Масса oz mass 28.35 g 
 lb mass 0.4536 kg 
 slug 14.59 kg 
 ton 907.2 kg 
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Сила  kip 4.448 kN 
 lb weight 4.448 N 
 oz weight 0.2780 N 
Момент силы  lb ft 1.356 N m 
 lb in 0.1130 N m 
Момент инерции сече-
ния  

in4  0.4162 x 106 mm4 

Момент инерции массы lb ft s2  1.356 kg m2 
Напряжение или  lb/ft2 47.88 Pa 
давление lb/in2 (psi)  6.895 kPa 
Работа или энергия  ft lb  1.356 J 
Импульс или момент  
движения 

lb s  4.448 N s 

Мощность ft lb/s  1.356 W 

Инженерные приставки  
В таблице приведены часто используемые в инженерной практике кратные и дольные 
единицы. 

Таблица A-3. Инженерные приставки 

Множитель Приставка Символ 
1012  tera  T 
109  giga  G 
106  mega  M 
103  kilo  k 
102 hekto  h 
101  deka  da 
10-1  deci  d 
10-2  centi  c 
10-3  milli m 
10-6  micro  m 
10-9  nano  n 
10-12  pico  p 
10-15  femto  f 
10-18  atto  a 

Совместимые единицы  
В таблице A-4 приведены совместимые единицы, используемые в Основной Системе. 

Таблица A-4. Совместимые единицы измерения для линейного статического расчета  

Описание Имя в COSMOS  *FPS1 (грави-
тационная)  

*SI2 (абсо-
лютная)  

*MKS3 (гра-
витационная)  

CGS4 (абсо-
лютная) 

Размеры 
Длина X, Y, Z  in  m  cm  cm 
Свойства материала 
Модуль упругости EX, EY, EZ  lbs/in2  Newton/m2 kg/cm2  dyne/cm2 
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или Pascal  
Поперечный модуль GXY, GYZ, GXZ  lbs/in2  N/m2 или Pa  kg/cm2  dyne/cm2 
Отношение Пуассона NUXY, NUYZ, 

NUXZ 
in/in (безраз-
мерная)  

m/m (безраз-
мерная)  

cm/cm (без-
размерная)  

cm/cm (без-
размерная) 

Плотность массы  DENS  lbs sec2/in4  kg/m3  kg sec2/cm4  g/cm3 
Коэффициент терми-
ческого расширения  

ALPX, ALPY, ALPZ in/(in °F)  m/(m °K)  cm/(cm °C)  cm/(cm °K) 

Угол материала  Beta  degree  degree  degree  degree 
Константы матрицы 
жесткости анизотроп-
ного материала (вари-
ант 1)  

MC11, .... , .... , 
MC66 (Всего 21)  

lbs/in2  N/m2 или Pa  kg/cm2  dyne/cm2 

Константы матрицы 
жесткости анизотроп-
ного материала (вари-
ант 2)  

MC11, .... , .... , 
MC66 (Всего 21)  

in2/lbs  m2/Newton  cm2/kg  cm2/dyne 

Константы матрицы 
пьезоэлектрического 
материала  

PC11, .... , PC63 
(Всего 18) 

� Volt/m � volt/cm 

Константы диэлектри-
ческой матрицы мате-
риала 

DC11, .... , DC33 
(Всего 6) 

� Farad/m � 10-13 
Farad/cm 

Нагрузки и Граничные условия  
Температура Temp  °F  °K  °C  °K 
Линейные перемеще-
ния  

UX, UY, UZ  in  m  cm  cm 

Угловые перемещения  RX, RY, RZ  radians  radians  radians  radians 
Силы (узловые)  FX, FY, FZ  lbs  Newton  kg  dyne 
Моменты (узловые)  MX, MY, MZ  in lbs  m N  cm kg  cm dyne 
Давление P  lbs/in2  N/m2 или Pa  kg/cm2  dyne/cm2 
Распределенная на-
грузки на балку  

PB  lbs/in  N/m  kg/cm  dyne/cm 

Линейное ускорение  ACEL  in/sec2  m/sec2  cm/sec2  cm/sec2 
Угловая скорость  OMEGA, 

CGOMEGA  
rad/sec  rad/sec  rad/sec  rad/sec 

Угловое ускорение  DOMEGA, 
DCGOMEGA 

rad/sec2 rad/sec2 rad/sec2 rad/sec2  

Результаты 
Силы реакции  RFX, RFY, RFZ, 

RFRES  
lbs  Newton  kg  dyne 

Моменты реакции  RMX, RMY, RMZ, 
RMRES  

in lbs  m N  cm kg  cm dyne 

Перемещения  UX, UY, UZ, RES  in  m  cm  cm 
Напряжения  SX, SY, SZ, TXY, 

TYZ, TXZ, P1, P2, 
P3, VON, INT  

lbs/in2  N/m2 или Pa  kg/cm2  dyne/cm2 

Деформации  EPSX, EPSY, EPSZ, 
GMXY, GMYZ, 
GMXZ, ESTRN  

in/in (безраз-
мерная)  

m/m (безраз-
мерная)  

cm/cm (без-
размерная)  

cm/cm (без-
размерная) 

* Единицы совместимы с базой данных материалов COSMOS/M (PICK_MAT).  
1 : FPS означает традиционную систему единиц США.  
2 : SI означает Международную систему единиц.  
3 : MKS означает Метрическую систему единиц.  
4 : CGS означает французскую систему единиц. 
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Приложение B. 
Сводка команд 
Введение 

В данном приложении приведено краткое описание команд, используемых для выпол-
нения линейного статического, модального расчетов и расчета устойчивости. Полное 
описание команд приведено в Справочнике команд COSMOS/M. 

Описания приводятся в следующей форме: 
Краткое имя 
команды 

Меню Описание 

ACEL   LoadsBC   >    STRUCTURAL   >   GRAVITY   
> Define Acceleration   

Команда, задающая ускорение. 

ACTDIS   Results   >   PLOT   > Displacement   Команда для загрузки указанного компонента 
перемещений в буфер чертежа. 

Все команды приведены полужирным шрифтом, а соответствующие меню, в которых 
находятся данные команды, разделены символом «>». 

Краткое имя 
команды 

Меню Описание 

A_BUCKLING   Analysis   >   FREQUENCY/BUCKLING   > 
Buckling Options   

Команда установки настроек расчета устой-
чивости. 

A_FREQUENCY Analysis   >   FREQUENCY/BUCKLING   > 
Frequency Options   

Команда установки настроек частотного рас-
чета. 

A_LIST   Analysis   > List Analysis Option   Команда просмотра настроек различных ти-
пов расчета. 

A_STATIC   Analysis   >   STATIC   > Static Analysis Op-
tions   

Команда установки настроек статического 
расчета. 

A_STRESS   Analysis   >   STATIC   > Stress Analysis Op-
tions   

Команда установки настроек расчета напря-
жений. 

ACEL   LoadsBC   >    STRUCTURAL   >   GRAVITY   
> Define Acceleration   

Команда, задающая ускорение. 

ACTDIS   Results   >   PLOT   > Displacement   Команда для загрузки указанного компонента 
перемещений в буфер чертежа. 

ACTPOST   Results   >   SET UP   > Set Postprocess Type   Команда, определяющая тип расчета для 
постпроцессинга. 

ACTSTN   Results   >   PLOT   > Strain   Команда, загружающая указанный компонент 
деформаций в буфер чертежа. 

ACTSTR   Results   >   PLOT   > Stress   Команда, загружающая указанный компонент 
напряжений в буфер чертежа. 

ACTUSRPLOT   Display   >   XY PLOTS   > Activate User Plot   Активизирует пользовательский чертеж для 
постпроцессинга. 

ADAPTIVE   Analysis   >   STATIC   > Adaptive Method   Команда выбора метода (H, P, or HP) стати-
ческого расчета. 

ANIMATE   Results   >   PLOT   > Animate   Команда, выполняющая анимацию деформа-
ций и форм мод конструкции. 

ASMESECDEF   Analysis   >   STATIC   >   ASME CODE   > Команда, задающая сечения для оценки на-
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Define ASME Section   пряжений в соответствии с кодом ASME. 
ASMESECDEL   Analysis   >   STATIC   >   ASME CODE   > 

Delete ASME Section   
Команда, удаляющая заданные сечения 
ASME. 

ASMESECLIST   Analysis   >   STATIC   >   ASME CODE   > List 
ASME Section   

Команда, выводящая заданные сечения 
ASME. 

AVERAGE   Results   > Average Nodal Stress   Команда, вызывающая процедуру вычисле-
ния средних значений напряжений в узлах. 

BEAMRESLIS   Results   >   LIST   > Beam End Force   Команда вывода списка узловых сил, момен-
тов и напряжений для балочных элементов. 

BEAMRESMAX   Results   >   EXTREMES   > Beam End Force   Команда вывода крайних узловых сил и на-
пряжений  для балочных элементов. 

BMSECDEF   Propsets   > Beam Section   Команда, определяющая размеры стандарт-
ных балочных поперечных сечений и вещест-
венные константы. 

BMSECLIST   Edit   >   LIST   > Beam Sections   Команда удаления стандартных балочных 
сечений и связанных вещественных констант.

BONDDEF   LoadsBC   >    STRUCTURAL   >   BONDING   
> Define Bond Parameter   

Команда «скрепления» различных типов кон-
струкционных элементов. 

CGLOC   LoadsBC   >    STRUCTURAL   >   GRAVITY   
> Orig of Inertial Sys   

Команда задания точки отсчета инерциально-
го базового каркаса. 

CGOMEGA   LoadsBC   >    STRUCTURAL   >   GRAVITY   
> Avg. Vel. of GL CS   

Команда задания угловой скорости глобаль-
ной Декартовой системы. 

CPCNS   LoadsBC   >    STRUCTURAL   >   COUPLING  
> Define Constraint Set   

Команда задания ограничений точка-(точка, 
кривая, поверхность). 

CPCNSDEL   LoadsBC   >    STRUCTURAL   >   COUPLING  
> Delete Constraint Set   

Команда удаления ограничений точка-(точка, 
кривая, поверхность). 

CPCNSLIST   LoadsBC   >    STRUCTURAL   >   COUPLING  
> List Constraint Set   

Команда вывода списка ограничений точка-
(точка, кривая, поверхность), заданных ко-
мандой CPCNS. 

CPDOF   LoadsBC   >    STRUCTURAL   >   COUPLING  
> Define DOF Set   

Команда задания шаблона зависимых степе-
ней свободы. 

CPDOFDEL   LoadsBC   >    STRUCTURAL   >   COUPLING  
> Delete DOF Set   

Команда удаления шаблонов зависимых сте-
пеней свободы. 

CPDOFLIST   LoadsBC   >    STRUCTURAL   >   COUPLING  
> List DOF Set   

Команда вывода списка шаблонов зависимых 
степеней свободы. 

CPDOFPLOT   LoadsBC   >    STRUCTURAL   >   COUPLING  
> Plot DOF Set   

Команда отображения на экране шаблонов 
зависимых степеней свободы. 

CPEQN   LoadsBC   >    STRUCTURAL   >   COUPLING  
> Define Constraint Eq. 

Команда задания уравнения ограничений. 

CPEQNDEL   LoadsBC   >    STRUCTURAL   >   COUPLING  
> Delete   

Команда удаления уравнений ограничений. 

CPEQNLIST   LoadsBC   >    STRUCTURAL   >   COUPLING  
> List Constraint Eq. 

Команда вывода уравнений ограничений, 
заданных командой CPEQN. 

CPEQNVAL   LoadsBC   >    STRUCTURAL   >   COUPLING  
> Constr Eq. Constant   

Команда задания правой части уравнения 
ограничений. 

CRACK   Analysis   >    STATIC   >   CRACK   > Define 
Crack   

Команда задания набора трещин и соответст-
вующих узлов. 

CRACKDEL   Analysis   >    STATIC   >   CRACK   > Delete 
Crack   

Команда удаления шаблона наборов трещин. 

CRACKLIST   Analysis   >    STATIC   >   CRACK   > List 
Crack   

Команда вывода списка шаблонов наборов 
трещин и соответствующих узлов 

CURDEF   LoadsBC   >    FUNCTION CURVE   > 
Time/Temp Curve   

Команда задания кривых (времени, темпера-
туры, или B-H). 

CURDEL   LoadsBC   >    FUNCTION CURVE   > Delete 
Time/Temp Curve   

Команда удаления кривых. 

CURLIST   LoadsBC   >    FUNCTION CURVE   > List Команда вывода списка ранее заданных кри-
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Time/Temp   вых. 
DATA_CHECK Analysis   > Data Check   Команда проверки групп элементов, наборов 

свойств материала вещественных констант. 
DCDEL   LoadsBC   >    STRUCTURAL   >   

DISPLACEMENT   > Delete Curves   
Команда удаления перемещений во всех уз-
лах, связанных с КРИВЫМИ. 

DCGOMEGA   LoadsBC   >    STRUCTURAL   >   GRAVITY   
> Ang. Acc. of GL CS   

Команда задания углового ускорения гло-
бальной Декартовой системы. 

DCR   LoadsBC   >    STRUCTURAL   >   
DISPLACEMENT   > Define Curves   

Команда задания перемещений во всех узлах, 
связанных с КРИВЫМИ. 

DCT   LoadsBC   >    STRUCTURAL   >   
DISPLACEMENT   > Define Contours   

Команда задания перемещений в узлах, свя-
занных с КОНТУРАМИ. 

DCTDEL   LoadsBC   >    STRUCTURAL   >   
DISPLACEMENT   > Delete Contours   

Команда удаления перемещений в узлах, свя-
занных с КОНТУРАМИ. 

DEFPLOT   Results   >   PLOT   > Deformed Shape   Команда отображения деформированной 
формы. 

DISLIST   Results   >   LIST   > Displacement   Команда вывода списка компонентов пере-
мещений. 

DISMAX   Results   >   EXTREMES   > Min/Max Dis-
placement   

Команда вывода списка экстремальных зна-
чений смещений. 

DISPLOT   Results   >   PLOT   > Displacement   Команда отображения  компонентов 
перемещений. 

DLIST   LoadsBC   >    STRUCTURAL   >   
DISPLACEMENT   > List   

Команда вывода списка предписанных узло-
вых перемещений на экран. 

DND   LoadsBC   >    STRUCTURAL   >   
DISPLACEMENT   > Define Nodes   

Команда задания перемещений в шаблоне 
(массиве) узлов. 

DNDEL   LoadsBC   >    STRUCTURAL   >   
DISPLACEMENT   > Delete Nodes   

Команда удаления предписанных перемеще-
ний в шаблоне (массиве) узлов. 

DOMEGA   LoadsBC   >    STRUCTURAL   >   GRAVITY   
> Angular Acceleration   

Команда задания углового ускорения. 

DPDEL   LoadsBC   >    STRUCTURAL   >   
DISPLACEMENT   > Delete Points   

Команда удаления перемещений в узлах, свя-
занных с КЛЮЧЕВЫМИ ТОЧКАМИ. 

DPLOT   LoadsBC   >    STRUCTURAL   >   
DISPLACEMENT   > Plot   

Команда отображения предписанных узловых 
перемещений. 

DPT   LoadsBC   >    STRUCTURAL   >   
DISPLACEMENT   > Define Points   

Команда задания перемещений в узлах, свя-
занных с КЛЮЧЕВЫМИ ТОЧКАМИ. 

DRDEL   LoadsBC   >    STRUCTURAL   >   
DISPLACEMENT   > Delete Regions   

Команда удаления перемещений во всех уз-
лах, связанных с ОБЛАСТЯМИ. 

DRG   LoadsBC   >    STRUCTURAL   >   
DISPLACEMENT   > Define Regions   

Команда задания перемещений в узлах, 
связанных с ОБЛАСТЯМИ. 

DSDEL   LoadsBC   >    STRUCTURAL   >   
DISPLACEMENT   > Delete Surfaces   

Команда удаления перемещений во всех уз-
лах, связанных с ПОВЕРХНОСТЯМИ. 

DSF   LoadsBC   >    STRUCTURAL   >   
DISPLACEMENT   > Define Surfaces   

Команда задания смещений в узлах, связан-
ных с ПОВЕРХНОСТЯМИ. 

EGDEL   Edit   >   DELETE   > Element Groups   Команда удаления групп элементов из базы 
данных. 

EGLIST   Edit   >   LIST   > Element Groups   Команда вывода списка  заданных групп эле-
ментов на экран. 

EGROUP   Propsets   > Element Group   Команда задания группы элементов. 
EM_MODEL   Analysis   >    ELECTRO MAGNETIC   > Con-

ductor Model   
Команда задания неподвижных или равно-
мерно движущихся проводников. 

EM_OUTPUT   Analysis   >    ELECTRO MAGNETIC   > Out-
put Options   

Команда задания интервалов для печати ре-
зультатов. 

EMFREAD   LoadsBC   >    LOAD OPTIONS   > Read EMag 
Force   

Команда считывания магнитоконструкцион-
ного связывания. 

EPROPCHANGE Propsets   > Change El-Prop   Команда смены связи наборов свойств с эле-
ментами 
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EPROPSET   Propsets   > New Property Set   Команда назначения атрибутов элементам, 
созданным на основе существующих. 

FCDEL   LoadsBC   >    STRUCTURAL   >   FORCE   > 
Delete Curves   

Команда удаления сил во всех узлах, связан-
ных с КРИВЫМИ. 

FCR   LoadsBC   >    STRUCTURAL   >   FORCE   > 
Define Curves   

Команда задания сил во всех узлах, связан-
ных с КРИВЫМИ. 

FCT   LoadsBC   >    STRUCTURAL   >   FORCE   > 
Define Contours   

Команда задания сил во всех узлах, связан-
ных с КОНТУРАМИ. 

FCTDEL   LoadsBC   >    STRUCTURAL   >   FORCE   > 
Delete Contours   

Команда удаления сил во всех узлах, связан-
ных с КОНТУРАМИ. 

FLIST   LoadsBC   >    STRUCTURAL   >   FORCE   > 
List   

Команда вывода списка заданных узловых 
сил на экран. 

FLOWLIST   Results   >   LIST   > Flow Result   Команда вывода списка чисел, связанных с 
расчетом течения жидкости. 

FLOWMAX   Results   >   EXTREMES   > Min/Max Flow   Команда вывода списка экстремальных зна-
чений компонентов течений. 

FLOWPLOT   Results   >   PLOT   > Fluid Flow   Команда отображения компонента течения, 
загруженного в буфер чертежа. 

FLOWPROP   Results   >   LIST   > Flow Properties   Команда расчета и вывода списка пленочных 
коэффициентов и темпа течения масс. 

FND   LoadsBC   >    STRUCTURAL   >   FORCE   > 
Define Nodes   

Команда задания сил в шаблоне узлов. 

FNDEL   LoadsBC   >    STRUCTURAL   >   FORCE   > 
Delete Nodes   

Команда удаления сил в шаблоне узлов. 

FPDEL   LoadsBC   >    STRUCTURAL   >   FORCE   > 
Delete Points   

Команда удаления сил в узлах, связанных с 
КЛЮЧЕВЫМИ ТОЧКАМИ. 

FPLOT   LoadsBC   >    STRUCTURAL   >   FORCE   > 
Plot   

Команда отображения заданных узловых сил 
на экране. 

FPT   LoadsBC   >    STRUCTURAL   >   FORCE   > 
Define Points   

Команда задания сил в узлах, связанных с 
КЛЮЧЕВЫМИ ТОЧКАМИ. 

FRDEL   LoadsBC   >    STRUCTURAL   >   FORCE   > 
Delete Regions   

Команда удаления сил во всех узлах, связан-
ных с ОБЛАСТЯМИ. 

FREQLIST   Results   >   LIST   > Natural Frequency   Команда вывода списка собственных частот 
модели. 

FRG   LoadsBC   >    STRUCTURAL   >   FORCE   > 
Define Regions   

Команда задания сил во всех узлах, связан-
ных с ОБЛАСТЯМИ. 

FSDEL   LoadsBC   >    STRUCTURAL   >   FORCE   > 
Delete Surfaces   

Команда удаления сил во всех узлах, связан-
ных с ПОВЕРХНОСТЯМИ. 

FSF   LoadsBC   >    STRUCTURAL   >   FORCE   > 
Define Surfaces   

Команда задания сил во всех узлах, связан-
ных с ПОВЕРХНОСТЯМИ. 

GRVLIST   LoadsBC   >    STRUCTURAL   >   GRAVITY   
> List Gravity Load   

Команда вывода списка компонентов грави-
тационной и центробежной нагрузки. 

IDRESULT   Results   >   PLOT   > Identify Result   Команда показа расположения и значения 
отображенной величины. 

INITXYPLOT   Display   >   XY PLOTS   > Initialize   Команда восстановления установок по умол-
чанию для XY-графиков. 

ISOPLOT   Results   >   PLOT   Команда отображения изоплоскостей различ-
ных величин. 

LCCOMB   Results   > Combine Load Case   Команда комбинирования реакция для тре-
буемых вариантов нагрузки. 

LCLIST   Analysis   >   STATIC   > List Load Case   Команда вывода списка вариантов нагрузки. 
LCSET   Analysis   >   STATIC   > Activate Load Case   Команда активизирования вариантов нагруз-

ки для статического расчета. 
LSECPLOT   Results   >   PLOT   > Path Graph   Команда вычерчивания графиков изменения 

величины вдоль пути. 
MAKE_CYCLIC   LoadsBC   >    FUNCTION CURVE   > Repeat Команда повтора шаблона кривых (времени, 
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Time/Temp   температуры, B-H). 
MASSPROP   Control   >   MEASURE   > Find Mass Property  Команда вывода информации о свойствах 

массы для шаблона элементов. 
MPDEL   Edit   >   DELETE   > Material Props   Команда удаления наборов свойств материа-

ла из базы данных. 
MPLIST   Edit   >   LIST   > Material Props   Команда вывода списка заданных наборов 

свойств материала на экран. 
MPROP   Propsets   > Material Property   Команда задания набора свойств материала. 
NTCDEL   LoadsBC   >    THERMAL   >   

TEMPERATURE   > Delete Curves   
Команда удаления температур во всех узлах, 
связанных с КРИВЫМИ. 

NTCR   LoadsBC   >    THERMAL   >   
TEMPERATURE   > Define Curves   

Команда задания температур во всех узлах, 
связанных с КРИВЫМИ. 

NTCT   LoadsBC   >    THERMAL   >   
TEMPERATURE   > Define Contours   

Команда задания температур во всех узлах, 
связанных с КОНТУРАМИ. 

NTCTDEL   LoadsBC   >    THERMAL   >   
TEMPERATURE   > Delete Contours   

Команда удаления температур во всех узлах, 
связанных с КОНТУРАМИ. 

NTLIST   LoadsBC   >    THERMAL   >   
TEMPERATURE   > List   

Команда вывода списка предписанных узло-
вых температур. 

NTND   LoadsBC   >    THERMAL   >   
TEMPERATURE   > Define Nodes   

Команда задания температуры в шаблоне 
узлов. 

NTNDEL   LoadsBC   >    THERMAL   >   
TEMPERATURE   > Delete Nodes   

Команда удаления предписанной температу-
ры в шаблоне узлов. 

NTPDEL   LoadsBC   >    THERMAL   >   
TEMPERATURE   > Delete Points   

Команда удаления температур в узлах, свя-
занных с КЛЮЧЕВЫМИ ТОЧКАМИ. 

NTPLOT   LoadsBC   >    THERMAL   >   
TEMPERATURE   > Plot   

Команда вывода символа во всех узлах с за-
данными температурами. 

NTPT   LoadsBC   >    THERMAL   >   
TEMPERATURE   > Define Points   

Команда задания температур в узлах, связан-
ных с КЛЮЧЕВЫМИ ТОЧКАМИ. 

NTRDEL   LoadsBC   >    THERMAL   >   
TEMPERATURE   > Delete Regions   

Команда удаления температур в узлах, свя-
занных с ОБЛАСТЯМИ. 

NTRG   LoadsBC   >    THERMAL   >   
TEMPERATURE   > Define Regions   

Команда задания температур в узлах, связан-
ных с ОБЛАСТЯМИ. 

NTSDEL   LoadsBC   >    THERMAL   >   
TEMPERATURE   > Delete Surfaces   

Команда удаления температур в узлах, свя-
занных с ПОВЕРХНОСТЯМИ. 

NTSF   LoadsBC   >    THERMAL   >   
TEMPERATURE   > Define Surfaces   

Команда задания температур в узлах, связан-
ных с ПОВЕРХНОСТЯМИ. 

NTVDEL   LoadsBC   >    THERMAL   >   
TEMPERATURE   > Delete Volumes   

Команда удаления температур в узлах, свя-
занных с ОБЪЕМАМИ. 

NTVL   LoadsBC   >    THERMAL   >   
TEMPERATURE   > Define Volumes   

Команда задания температур в узлах, связан-
ных с ОБЪЕМАМИ. 

OMEGA   LoadsBC   >    STRUCTURAL   >   GRAVITY   
> Angular Velocity   

Команда задания угловой скорости. 

PBEDEL   LoadsBC   >    STRUCTURAL   >   PRESSURE  
> Delete Beam Elem Load   

Команда удаления нагрузки на балочный эле-
мент. 

PBEL   LoadsBC   >    STRUCTURAL   >   PRESSURE  
> Define Beam Elem Load   

Команда задания нагрузки на балочный эле-
мент. 

PBELIST   LoadsBC   >    STRUCTURAL   >   PRESSURE  
> List Beam Elem Load   

Команда вывода списка нагрузок на балоч-
ные элементы. 

PCDEL   LoadsBC   >    STRUCTURAL   >   PRESSURE  
> Delete Curves   

Команда удаления давления на все элементы, 
связанные с КРИВЫМИ. 

PCR   LoadsBC   >    STRUCTURAL   >   PRESSURE  
> Define Curves   

Команда задания давления на все элементы, 
связанные с КРИВЫМИ. 

PEDEL   LoadsBC   >    STRUCTURAL   >   PRESSURE  
> Delete Elements   

Команда удаления давления в шаблоне эле-
ментов. 

PEL   LoadsBC   >    STRUCTURAL   >   PRESSURE  
> Define Elements   

Команда задания давления на элементы. 
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PICK_MAT   Propsets   > Pick Material Lib   Команда выбора материала из библиотеки 
материалов COSMOS/M. 

PICK_SEC   Propsets   > AISC Sect. Table   Команда выбора стандартного сечения из 
таблиц AISC. 

PLIST   LoadsBC   >    STRUCTURAL   >   PRESSURE  
> List   

Команда вывода списка предписанных дав-
лений на экран. 

PPLOT   LoadsBC   >    STRUCTURAL   >   PRESSURE  
> Plot   

Команда прорисовки предписанных давлений 
на экране. 

PRDEL   LoadsBC   >    STRUCTURAL   >   PRESSURE  
> Delete Regions   

Команда удаления давления на все элементы, 
связанные с ОБЛАСТЯМИ. 

PRG   LoadsBC   >    STRUCTURAL   >   PRESSURE  
> Define Regions   

Команда задания давления на все элементы, 
связанные с ОБЛАСТЯМИ. 

PRINT_ELSET Analysis   >   OUTPUT OPTIONS   > Set Ele-
ment Range   

Команда задания групп элементов для оценки 
напряжений. 

PRINT_NDSET   Analysis   >   OUTPUT OPTIONS   > Set Nodal 
Range   

Команда задания групп узлов для оценки ре-
зультатов. 

PRINT_OPS   Analysis   >   OUTPUT OPTIONS   > Set Print 
Options   

Команда контроля за записью результатов в 
файл вывода. 

PSDEL   LoadsBC   >    STRUCTURAL   >    PRESSURE 
> Delete Surfaces   

Команда удаления давления на все элементы, 
связанные с ПОВЕРХНОСТЯМИ. 

PSF   LoadsBC   >    STRUCTURAL   >    PRESSURE 
> Define Surfaces   

Команда задания давления на все элементы, 
связанные с ПОВЕРХНОСТЯМИ. 

R_BUCKLING   Analysis   >   FREQUENCY/BUCKLING   > 
Run Buckling   

Команда выполнения расчета устойчивости. 

R_CHECK Analysis   > Run Check   Команда проверки атрибутов элемента. 
R_FREQUENCY Analysis   >   FREQUENCY/BUCKLING   > 

Run Frequency   
Команда выполнения модального расчета. 

R_STATIC   Analysis   >   STATIC   > Run Static Analysis   Команда выполнения статического линейного 
расчета. 

R_STRESS   Analysis   >   STATIC   > Run Stress Analysis   Команда выполнения расчета напряжений 
для линейных статических задач. 

RCDEL   Edit   >   DELETE   > Real Constants   Команда удаления наборов вещественных 
констант из базы данных. 

RCLIST   Edit   >   LIST   > Real Constants   Команда вывода списка заданных наборов 
вещественных констант на экран. 

RCONST   Propsets   > Real Constant   Команда задания набора вещественных кон-
стант. 

REACTION   Analysis   > Reaction   Команда запроса расчета сил реакции во всех 
узлах. 

RESULTS? Results   > Available Results   Выводит результаты, доступные для пост-
процессинга. 

SECPLOT   Results   >   PLOT   Команда отображения графиков-сечений. 
SETERASE   Results   >   SET UP   > Set Clear Screen Options Команда задания настроек очистки экрана 

перед выводом новых графиков. 
SETPLOT   Results   >   SET UP   > Color/Value Range   Команда задания типа графика и настроек 

экстремальных значений. 
SETXYPLOT   Display   >   XY PLOTS   > Set Plot Parameter   Команда установки признаков и параметров 

для XY-графиков. 
SMLIST   Results   >   LIST   > Shear/Moment Value   Команда вывода списка поперечных усилий и 

изгибающих моментов для балочных элемен-
тов. 

SMMAX   Results   >   EXTREMES   > Shear/Moment   Команда вывода списка экстремальных на-
пряжений (по всей длине) для балочных эле-
ментов. 

SMPLOT   Results   >   PLOT   > Shear Diagram   Команда отображения эпюр сил и моментов 
для балочных элементов. 
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SPDEL   Analysis   >   STATIC   >   SUBSTRUCTURE   
> Delete Super Element   

Команда удаления суперэлементов из базы 
данных. 

SPELE   Analysis   >   STATIC   >   SUBSTRUCTURE   
> Define Super Element   

Команда задания связности для суперэлемен-
та. 

SPLIST   Analysis   >   STATIC   >   SUBSTRUCTURE   
> List Super Element   

Команда вывода списка суперэлементов и их 
суперузлов. 

SPROT   Analysis   >   STATIC   >   SUBSTRUCTURE   
> Rotate Super Element   

Команда вращения суперэлемента в глобаль-
ной Декартовой системе. 

SPSTR   Analysis   >   STATIC   >   SUBSTRUCTURE   
> Set SubStr Analysis   

Команда создания суперэлемента и задания 
типа расчета. 

STNLIST   Results   >   LIST   > Strain Component   Команда вывода списка компонентов дефор-
маций. 

STNMAX   Results   >   EXTREMES   > Min/Max Strain   Команда вывода списка экстремальных зна-
чений деформаций. 

STNPLOT   Results   >   PLOT   > Strain   Команда отображения компонента деформа-
ций. 

STRAIN_OUT   Analysis   >   OUTPUT OPTIONS   > Set Strain 
Output   

Команда управления записью компонентов 
деформаций в файл вывода. 

STRESS   Analysis   >   STATIC   > Activate Stress Calc   Команда запуска расчета напряжений в ста-
тическом модуле. 

STRLIST   Results   >   LIST   > Stress Component   Команда вывода списка компонентов напря-
жений. 

STRMAX   Results   >   EXTREMES   > Min/Max Stress   Команда вывода списка экстремальных зна-
чений напряжений. 

STRPLOT   Results   >   PLOT   > Stress   Команда отображения компонента напряже-
ний. 

SUBMODEL   Analysis   >   STATIC   > Define SubModel   Команда задания области как подмодели. 
TEMPREAD   LoadsBC   >    LOAD OPTIONS   > Read Temp 

as Load   
Команда использования информации из тер-
мального в линейном статическом расчете. 

TREF   LoadsBC   >    LOAD OPTIONS   > Reference 
Temp   

Команда задания базовой температуры для 
модели. 

TUNIF   LoadsBC   >    LOAD OPTIONS   > Uniform 
Temp   

Команда задания единой температуры для 
всех узлов в модели. 

USER_MAT   Propsets   > User Material Lib   Команда выбора материала из пользователь-
ской библиотеки материалов. 

USRPLOT   Results   >   PLOT   > User Result   Команда отображения пользовательского 
графика. 

XYIDENTIFY   Display   >   XY PLOTS   > Identify Point   Команда определения координат точки в 
диапазоне графика. 

XYLIST   Display   >   XY PLOTS   > List Info   Команда вывода списка доступной информа-
ции для построения XY-графиков. 

XYPLOT   Display   >   XY PLOTS   > Plot Curves   Команда отображения временных графиков. 
XYPTLIST   Display   >   XY PLOTS   > List Points   Команда вывода шаблона точек для загру-

женных графиков.  
XYRANGE   Display   >   XY PLOTS   > Set Plot Range   Команда задания диапазонов графиков и ко-

эффициентов масштаба. 
XYREFLINE   Display   >   XY PLOTS   > Set Reference Line  Команда отображения базовой линии, парал-

лельной оси X или Y. 
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Приложение C. 
Краткое описание теоретических 
основ для оценки кода ASME 
Введение 

В данной главе приведена дополнительная информация по вычислению напряжений  
кода ASME секции III. 

Ориентация сечения в соединениях  
Для сечений в соединениях рациональные плоскости изгиба должны быть аппрокси-
мированы таким образом, что они становятся перпендикулярными средней плоско-
сти и имеют одинаковый угол, равный углу между сечением и поверхностями по 
обеим сторонам. Это выполняется построением равнобедренного треугольника, ос-
нованием которого является сечение, а высота определяется как показано на рисунке. 
Одна из сторон треугольника является касательной к криволинейной поверхности в 
одной из точек сечения. 

 

Рис. C-1. Задание сечения в неправильной области  

Линеаризация напряжений 
Для задач на плоские напряжения, плоские деформации и осесимметричных задач в 
сечении выполняется линеаризации напряжений. Сечение определяется узлами N1 и 
Nn, как показано на рис. C-2.  Программа размещает n-2 равномерно распределенных 
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точек интегрирования между узлами N1 и Nn. Для каждой точки ищется элемент в 
конструкции, содержащий эту точку. Как только такой элемент находится, напряже-
ний в этой точке находятся линейной интерполяцией значений в угловых узлах эле-
мента. Эти напряжений называются действующими. 

Эквивалентные линеаризованные напряжения находятся вычислением по одной из 
двух нижеприведенных методик мембранных и изгибающих напряжений в сечении. 

Декартова формулировка (Аппроксимация) 

Эта формулировка применима к задачам на плоские напряжения, плоские деформации 
а также к осесимметричным задачам, в которых зависимость от радиуса пренебре-
жимо мала. Для осесимметричных задач зависимость от радиуса вызывается тем 
фактом, что материала с большим радиусом больше, чем с малым. Эта опция задает-
ся указанием в приглашении "curvature_radius" в команде ASMESECDEF (Analysis > 
STATIC > ASME CODE > Define ASME Section) нулевого значения (Определение ра-
диуса кривизны приведено в описании осесимметричной формулировки). 

 

Рис. C-2. Сечение с n равномерно распределенными точками  

Мембранные компоненты напряжений находятся интегрированием по сечению: 

 (C-1) 

где верхние индексы m и a означают мембранные и действующие напряжения, соот-
ветственно, l � длина сечения, x и y � локальные координаты (см. рис. C-3), точка от-
счета которых находится в средней плоскости, X, Y и Z � глобальные Декартовы ко-
ординаты. Мембранные напряжения предполагаются постоянными. 

Изгибающий компонент напряжений в точке x вычисляется по формуле: 
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 (C-2) 

где верхний индекс обозначает изгибающие напряжения. 

 

Рис. C-3. Локальная координатная система сечения  

Линеаризованные напряжения в любой точке равны сумме мембранных и изгибающих 
напряжений. 

Осесимметричная формулировка  

В этом случае особенности осесимметричных моделей представлены более точно, чем 
в случае Декартовой формулировки. Данная формулировка используется, если в при-
глашении "curvature_radius" (радиус кривизны) в команде ASMESECDEF (Analysis > 
STATIC > ASME CODE > Define ASME Section) было указано ненулевое значение. 
Радиус кривизны соответствует радиусу кривизны средней линии стенки в плоскости 
xy и обозначается "ρ" (см. рис. C-4). Большое значение радиуса кривизны (или -1) со-
ответствует прямым стенкам (например цилиндр или конус). 



 281

 

Рис. C-4. Радиус кривизны средней линии стенки  

Чтобы найти линеаризованные напряжения, сначала необходимо найти силы и момен-
ты, приложенные к сечению. На рисунке показана диаграмма сил и моментов в сече-
нии. FN и  FT соответствуют плоскостным нормальной и поперечной силам, по на-
правлениями y и x, а MZ � изгибающему моменту. 

 

Рис. C-5. Силы и моменты в сечении  

Силы и момент в сечении на малом секторе (∆θ) определяются по следующей форму-
ле: 

 (C-3) 

где σy
a и σxy

a � действующие напряжения в сечении в локальных координатах, X � гло-
бальная координата (или радиус) интегрируемой точки, а xf � расстояние между ней-
тральной оси сектора и средней линии в локальных координатах. 

Из FN, вычисленной из предыдущего уравнения, вычисляются средние нормальные 
мембранные напряжения по нижеприведенной формуле (Xc � глобальная координата 
средней линии). 
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 (C-4) 

Влияние MZ на нормальные изгибающие напряжения по направлению y вычисляются 
с применением обычного отношения s = MZ(x-xf)/I, где I � момент инерции сектора. 

 (C-5) 

Средние мембранные поперечные напряжения (компонент xy) вычисляются делением 
FT (из уравнения C-3) на площадь сектора, при этом предполагается что влияние, 
оказываемое компонентом xy изгибающих поперечных напряжений пренебрежимо 
мало (поскольку распределение поперечных напряжения предполагается параболи-
ческим и равным нулю в концах поверхности). 

 (C-6) 

Средние мембранные напряжения вычисляются усреднением действующих напряже-
ний в сечении: 

 (C-7) 

Изгибающие напряжения по направлению x игнорируются, если в команде 
ASMESECDEF (Analysis > STATIC > ASME CODE > Define ASME Section) соответст-
вующий признак был установлен равным единице, в противном случае они аппрок-
симируются в двух концах как разность между действующими и мембранными на-
пряжениями. Касательные мембранные и изгибающие напряжения вычисляются по 
небольшому сектору (∆θ) в плоскости XY. Интегрируя суммарную нормальную силу 
в секторе и усредняя ее по соответствующей площади, средние мембранные напря-
жения (касательные) вычисляются по формуле: 

 (C-8) 

Для прямых стенок, когда ρ стремится к бесконечности, уравнение (C-8) принимает 
обычную форму. 

Касательные изгибающие напряжения вычисляются через нахождение  приложенного 
к сектору изгибающего момента. Когда изгибающий момент найден, касательные из-
гибающие напряжения находятся также как и изгибающие напряжения по направле-
нию y. 
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 (C-9) 

Как было упомянуто ранее, в любой точке линеаризованные напряжения равны сумме 
мембранных и изгибающих напряжений. 
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Часть 2. 
Проверочные задачи  

Введение  
Программные модули COSMOS/M находятся в постоянном процессе разработки, тес-
тирования и проверок качества. Новые возможности, появляющиеся в системе, тща-
тельно проверяются на проверочных примерах и собственных задачах проверки ка-
чества. Все проверочные задачи поставляются с программным пакетом, и обычно 
находятся в папке или директории COSMOS/M. Для расчетных модулей Основной 
Системы доступно свыше 100 проверочных задач.  

Данный раздел преследует две цели: предоставить задачи, проверяющие различные 
возможности Основной Системы COSMOS/M, и на тех же задачах продемонстриро-
вать возможности моделирования и расчета. В первой части настоящего Руководства 
из-за ограничений по объему материала были приведены только несколько подробно 
описанных и проиллюстрированных примеров, демонстрирующих некоторые воз-
можности моделирования и расчета. Примеры, приведенные в этой части, демонст-
рируют почти все возможности моделирования и расчета в Основной Системе. 

Файлы исходных данных для всех проверочных задач приведены либо в сжатом виде, 
либо в развернутом, в зависимости от типа вашего компьютера. На компьютерах Ap-
ple Macintosh задачи обычно поставляются в развернутом виде (папка "Example Prob-
lems"), а на рабочих станциях Unix и IBM PC задачи находятся в сжатом файле 
PROBLEMS.EXE, находящемся в директории COSMOS/M. Для того, чтобы развер-
нуть этот файл создайте новую директорию (например PROBS), скопируйте в нее 
этот файл и запустите его. Имя файла проверочной задачи начинается с префикса, 
соответствующего типу расчета: 
Префикс Тип расчета 

G Примеры моделирования в GEOSTAR  
B Линейный расчет устойчивости  
D Линейный расчет динамического отклика  

EM Электромагнитный расчет 
F Частотный (модальный) расчет 

FS Расчет течения жидкости (устойчивое состояние) 
FT Расчет течения жидкости (переходное состояние) 

FTG Расчет усталости  
ND Нелинейный динамический расчет 
NS Нелинейный статический расчет 
S Линейный статический расчет напряжений  

TL Термальный расчет (линейный) 
TN Термальный расчет (нелинейный) 

Для использования проверочных задач запустите GEOSTAR и выполните команду 
Load... (FILE), находящуюся в меню File. В нижеприведенных таблицах перечислены 
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проверочные задачи в соответствии с типом расчета и типом элемента. 

Классификация по типу расчета  

Тип расчета Модуль Название задачи 
Линейный статиче-
ский расчет 

Основная Система S1, S10A, S10B, S11, S12, S13, S14A ,S14B, S15, S16A, S16B, 
S17, S18, S19, S31A, S32A, S32B, S32C, S32D, S32M, S33A, 
S33M, S34, S35A, S35B, S36A, S46A, S46B, S47, S47A, S47B, 
S48, S49A, S49B, S5, S50A, S50B, S50C, S50D, S9A, S9B, 

Расчет устойчивости  Основная Система B8, B9 
Модальный расчет  Основная Система F4, F5, F6, F7, F8, F9 

Классификация по типу элемента 

Элемент Тип расчета Название задачи 
BEAM2D  Расчет устойчивости  B10, B11, B13 
 Линейный статический S24, S41, S46, S47, S51, S52, S53, S54, S75, S76, S9A, 

S9B 
BEAM3D  Расчет устойчивости  B1, B2, B3, B6, B9 
 Модальный расчет  F12, F17, F3, F4, F5 
 Линейный статический S22, S23, S26, S27, S28, S33A, S33M, S34, S39, S43, S45, 

S55, S7 
BOUND  Линейный статический Нет 
ELBOW  Линейный статический S15, S16A, S16B 
GAP  Линейный статический S75, S76 
GENSTIF  Все Нет 
MASS  Модальный расчет  F1, F5, F6 
 Линейный статический S39 
PIPE  Модальный расчет  F6 
 Линейный статический S16A, S16B 
PLANE2D  Модальный расчет  F2, F20A, F20B, F21, F23 
 Линейный статический S17, S19, S2, S38, S46, S46A, S48, S49A, S5, S50A, S50B, 

S50C, S6, S61, S62, S65, S66, S67, S68, S70, S76, S82, 
S83, S86 

RBAR  Линейный статический F28 
SHELL3  Расчет устойчивости  B5 
 Модальный расчет  F11 
 Линейный статический S30, S33A, S3A, S3B, S8 
SHELL3L  Линейный статический NONE 
SHELL3T  Модальный расчет  F16A, F8 
SHELL4  Расчет устойчивости  B4, B7, B9 
 Модальный расчет  F10, F18, F7, F9, F27A, F27B 
 Линейный статический S20, S25, S33A, S33M, S36A, S36M, S42, S44A, S44B, 

S85 
SHELL4L  Линейный статический S21A, S31, S43, S59B, S71 
SHELL4T  Модальный расчет  F16B 
 Линейный статический S50C 
SHELL9  Линейный статический S46B, S56, S57, S58, S59A, S60 
SHELL9L  Линейный статический S21B, S29A, S31A, S59A 
SHELLAX  Расчет устойчивости  B8, B14, B15 
 Модальный расчет  F19, F25, F26 
 Линейный статический S18, S37, S79, S80, S81 
SOLID  Модальный расчет  F13, F20E, F20F, F22 
 Линейный статический S10A, S10B, S11, S35A, S47, S47B, S49B, S50F, S50G, 

S77 
SHELL6  Расчет устойчивости  B5B, B7B 
 Модальный расчет  F7B, F11B, F20H 
 Линейный статический S6B, S20B, S42B, S50I 
SOLIDL  Линейный статический S29, S35B, S59C 
SOLIDPZ  Модальный расчет  F24 
SPRING  Модальный расчет  Нет 
TETRA10  Модальный расчет  F20D 
 Линейный статический S50E 
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TETRA4  Линейный статический Нет 
TETRA4R  Линейный статический S50H, S58B, S74 
 Модальный расчет  F20G 
TRIANG  Модальный расчет  F20C 
 Линейный статический S50D, S64A, S64B, S68, S69, S78, S84 
TRUSS2D  Расчет устойчивости  B6 
 Модальный расчет  F14 
 Линейный статический S32A, S32B, S32C, S32D, S32M, S4, S40, S63, S76 
TRUSS3D  Модальный расчет  F1 
 Линейный статический S1, S12, S13, S14A, S14B, S22, S26, S33A, S33M 
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Линейный расчет  
S1: Ферма на болтовых соединениях  
Тип: 

Статический расчет, элемент стержня (TRUSS3D). 

Литература: 

Beer, F. P., and Johnston, E. R., Jr., "Vector Mechanics for Engineers: Statics and Dynam-
ics," McGraw-Hill Book Co., Inc. New York, 1962, p. 47. 

Задача: 

Нагрузка в 50 lb поддерживается тремя стержнями, прикрепленными к потолку как 
показано на рисунке. Найти напряжения в каждом стержне. 

Дано: 

Площадь каждого  стержня = 1 in.2 

E = 30 x 106 psi 

Сравнение результатов: 

 σ1-4, psi  σ2-4, psi  σ3-4, psi 
Теория 10.40 31.20 22.90 
COSMOS/M  10.39 31.18 22.91 

 

Рис. S1-1 
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S2: Длинный толстостенный цилиндр  
Тип: 

Статический расчет, двухмерные осесимметричные элементы (PLANE2D). 

Литература: 

Timoshenko, S. P. and Goodier, J., "Theory of Elasticity," McGraw-Hill, New York, 1951, 
pp. 58-60. 

Задача: 

Рассчитать радиальные напряжения в бесконечно длинном толстостенном цилиндре, 
подвергающегося действию внутреннего давления p. 

Дано: 

a = 100 in 

b = 115 in. 

p = 1000 psi 

E = 30 x 106 psi 

ν = 0.3 

Советы по моделированию: 

КЭ-сеть имеет вид сетки 3х3 элемента. 

Сравнение результатов: 
r (Радиус) (in.) Радиальные напряжения σr (psi) 

Теория 
Радиальные напряжения σr (psi) 

COSMOS/M 
102.5 (Элемент 1)  - 802.40 - 802.50 
107.5 (Элемент 2)  - 447.75 - 447.80 
112.5 (Элемент 3)  - 139.34 - 139.40 
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Рис. S2-1 

S3A, S3B: Прямоугольная плита на опорах  
Тип: 

Статический расчет, 3-узловой элемент тонкостенной оболочки (SHELL3). 

Литература: 

Timoshenko, S. P. and Woinowsky-Krieger, "Theory of Plates and Shells," McGraw-Hill 
Book Co., 2nd edition. pp. 143-120, 1962. 

Задача: 

Рассчитать отклонение и напряжения в центре плиты, лежащей на опорах и подвер-
гающейся действию (A) сосредоточенной силы F, (B) равномерной распределенной 
нагрузки P. 

Дано: 

E = 30,000,000 psi 

ν  = 0.3 

h = 1 in. 

a = b = 40 in. 

F = 400 lb 

p = 1 psi 
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Советы по моделированию: 

Поскольку в задаче присутствует двойная симметрия, смоделирована будет только 
четверть плиты. 

Сравнение результатов: 
Вари-
ант 

X (in.) Y (in.) Wmax в узле 25 (in.)  
Теория 

Wmax в узле 25 (in.) 
COSMOS/M 

A 20 20 0.0270230 0.027123 
B 20 20 3.78327 x 10-3 3.7915 x 10-3 

 

Рис. S3-1 

S4: Расчет термальных напряжений в ферме  
Тип: 

Линейный расчет термальных напряжений, элементы стержня (TRUSS2D). 

Литература: 

Hsieh, Y. Y. "Elementary Theory of Structures," Prentice-Hall, Inc., 1970, pp. 200-202. 

Задача: 

Найти силы в звеньях фермы, показанной на рисунке, если температура в верхнем 
поясе (элементы 13 и 14) увеличилась на 50° F. 

Дано: 

E = 30 x 106 psi 

Коэффициент расширения = α  = 0.65 x 10-5/ °F 

L(ft )/A(in.2) = 1 (Для всех звеньев) 
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Сравнение результатов: 
Силы в звеньях (kips) 

Звено Теория COSMOS/M Звено Теория COSMOS/M 
1 0 0 8 35.1 35.1 
2 0 0 9 0 0 
3 - 21.1 - 21.1 10 0 0 
4 0 0 11 + 35.1 + 35.1 
5 0 0 12 0 0 
6 - 28.1 - 28.1 13 0 0 
7 - 28.1 - 28.1 14 - 21.1 - 21.1 

 

Рис. S4-1 

S5: Расчет термальных напряжений двухмерной конструкции  
Тип: 

Линейный расчет термальных напряжений, двухмерные элементы (PLANE2D в режи-
ме плоских деформаций). 

Задача: 

Найти перемещения и напряжения в задаче на плоские деформации, показанной на 
рисунке, вызванные увеличением температуры, равномерным по всей конструкции. 

Дано: 

E = 30 x 106 psi 

α  = 0.65 x 10-5 /°F 

ν  = 0.25 

T = 100° F 
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L = 1 in. 

Сравнение результатов: 

Перемещения в узлах (2, 4 и 6) 
 Теория COSMOS/M 
Перемещения по направлению Y (in.)  0.001083  0.001083 
Компонент напряжений XX (psi)  - 26000.0  - 26000.1 

 

Рис. S5-1 

S6A, S6B: Отклонения консольной балки  
Тип: 

Статический расчет, элемент PLANE2D в режиме плоских напряжений и элемент 
SHELL6. 

Задача: 

К свободному концу консольной балки приложена сосредоточенная нагрузка. Найти 
перемещения в свободном конце и поперечные напряжения. 

Дано: 

E = 30 x 106 psi 

L = 10 in. 

h = 1 in. 

A = 0.1 in.2 

ν  = 0 

P = 1 lb 
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Сравнение результатов: 
 Макс. отклонение (in.)  Поперечные на-

пряжения (psi) 
Теория - 0.001333 - 10.0 
COSMOS/M, элемент PLANE2D  - 0.001341 - 10.0 
COSMOS/M, элемент SHELL6  - 0.00139 - 10.0 

 

Рис. S6-1 

S7: Напряжения и отклонения балки  
Тип: 

Статический расчет, балочные элементы (BEAM3D). 

Литература: 

Timoshenko, S. P., "Strength of Materials, Part 1, Elementary Theory and Problems," 3rd 
Ed., D. Van Nostrand Co., Inc., New York , 1965, p. 98. 

Задача: 

Стандартная двутавровая 30" балка лежит на опорах, как показано на рисунке, и под-
вергается действию равномерной распределенной нагрузки величиной 10 000 lb/ft. 
Найти максимальные напряжения в средней части балки и отклонение в центре бал-
ки. 

Дано: 

Площадь = 50.65 in.2 

E = 30 x 106 psi 

p = 10,000 lb/ft 
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Советы по моделированию: 

Используйте совестимые единицы длины. Поскольку модель симметрична, то была 
использована половина модели. Вместо распределенной нагрузки в узле 2 были при-
ложены результирующая сила и момент. 

Сравнение результатов: 

В середине пролета (узел 3): 

 σmax, psi δ, in. 
Теория 11400.0 0.182 
COSMOS/M  11400.0 0.182 

 

Рис. S7-1 

S8: Перемещения в круглой балке 
Тип: 

Статический расчет, 3-узловой тонко- или толстостенной оболочки (SHELL3). 

Литература: 

Warren C. Young, "Roark's Formulas for Stress and Strain," Sixth Edition, McGraw Hill 
Book Company, New York, 1989. 

Задача: 
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Найти отклонения круглой балки, закрепленной в одном конце и свободной в другом, 
по направлениям X и Y, если в свободном конце приложена сила по направлению X. 

Дано: 

E = 30E6 psi 

ν  = 0 

b = 4 in. 

h = 1 in. 

R = 10 in. 

F = 200 lb 

Сравнение результатов: 

В нагруженном конце: 
 Перемещения по оси X (in.)  Перемещения по оси Y (in.) 
Теория 0.712E-2 0.99E-2 
COSMOS/M  0.718E-2 0.99E-2 

 

Рис. S8-1 

S9A: Сжатая балка, подвергающаяся вынужденным перемещени-
ям  
Тип: 

Статический расчет, балочные элементы (BEAM2D). 

Литература: 

Gere, J. M. and Weaver, W. Jr., "Analysis of Framed Structures," D. Van Nostrand Co., 
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1965. 

Задача: 

Определить силы в концах сжатой балки, вызываемые перемещением правого конца 
на  1 дюйм. 

Дано: 

E = 30 x 106 psi 

l = 80 in. 

A = 4 in.2 

I = 1.33 in.4 

h = 2 in. 

Аналитическое решение: 

Сила реакции: R = -12EI/L3 

Момент: M = 6EI/L2 

Сравнение результатов: 
 Теория COSMOS/M 
Перемещение (in.)  - 1.0 - 1.0 
Поперечная сила (lb)  - 937.5 - 937.5 
Момент (lb-in.)  37,500.0 37,500.0 

 

Рис. S9A-1 



 299

S9B: Сжатая балка, подвергающаяся вынужденному вращению  
Тип: 

Статический расчет, балочные элементы (BEAM2D). 

Литература: 

Gere, J. M. N. and Weaver, W. Jr., "Analysis of Framed Structures," D. Van Nostrand Co., 
1965. 

Задача: 

Найти силы в концах сжатой балки, вызванные вращением правого конца на 1 радиан. 

Дано: 

E = 30 x 106 psi 

L = 80 in. 

A = 4 in.2 

I = 1.3333 in.4 

h = 2 in. 

Аналитическое решение: 

Сила реакции: R = -6EI/L2 

Момент: M = 4EI/L 

Сравнение результатов: 
 Теория COSMOS/M 
Вращение (1 rad)  1 1 
Сила - 37,500 - 37,500 
Момент - 2,000,000 - 2,000,000 

 

Рис. S9B-1 
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S10A, S10B: Изгиб балки  
Тип: 

Статический расчет, элемент SOLID. 

Литература: 

Roark, R. J., "Formulas for Stress and Strain," 4th Edition, McGraw-Hill Book Co., New 
York, 1965, pp. 104-106. 

Задача: 

Балка длиной L и высотой h закреплена на одном конце, а на свободном приложена 
(A) поперечная сила F, (B) момент M. Найти отклонение в свободном конце. 

Дано: 

L = 10 in. 

h = 2 in. 

E = 30 x 106 psi 

ν = 0 

F = 300 lb 

M = 2000 in-lb 

Советы по моделированию: 

Были использованы два варианта нагрузки (S10A, S10B). 

1. Четыре силы, каждая равная F/4, были приложены в узлах 21, 22, 23 и 24 по направ-
лению z (S10A). 

2. Две пары, равные M/2 были приложены в узлах 21, 22, 23 и 24 (S10B). 

Сравнение результатов: 

Перемещения по направлению Z (in.) (узлы 21-24): 
 S10A S10B 
Теория 0.00500 - 0.00500 
COSMOS/M  0.00507 - 0.00495 
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Рис. S10A-1 

S11: Расчет термальных напряжений трехмерной конструкции  
Тип: 

Линейный расчет термальных напряжений, элемент SOLID. 

Задача: 

Найти перемещения трехмерной конструкции, вызванные равномерным по всей кон-
струкции повышением температуры. 

Дано: 

E = 3 x 107 psi 

α = 0.65 x 10-5/°F 

ν  = 0.25 

T = 100° F 

L = 1 in. 

Сравнение результатов:  
 Перемещения по оси X  

(Узлы 5, 6, 7, 8) 
Перемещения по оси X  

(Узлы 9, 10, 11, 12) 
Теория 0.000650 0.001300 
COSMOS/M  0.000650 0.001300 



 302

 

Рис. S11-1 

S12: Отклонения подвеса на шарнирах  
Тип: 

Статический расчет, элемент стержня (TRUSS3D). 

Литература: 

Timoshenko, S. P., and MacCullough, Glesson, H., "Elements of Strength of Materials," D. 
Van Nostrand Co., Inc., 3rd edition, June 1949, p. 13. 

Задача: 

Конструкция, состоящая из двух одинаковых стальных стержней длиной 15 с шарни-
рами на концах подвергается действию вертикальной силы P. Определить силы в 
звеньях AB и BC и вертикальное отклонение точки B. 

Дано: 

P = 5000 lbs 

θ = 30° 

Площадь поперечного сечения = 0.5 in.2 

AB = BC = 15 ft 

E = 30 x 106 psi 

Сравнение результатов: 
 Теория COSMOS/M 



 303

Вертикальное отклонение B (in)  0.12 0.12 
Силы в звеньях AB и BC (lbs) 5000 5000 

 

Рис. S12-1 

S13: Вычисление статически неопределимых сил реакции  
Тип: 

Статический расчет, элементы стержня (TRUSS3D). 

Литература: 

Timoshenko, S. P., "Strength of Materials, Part 1, Elementary Theory and Problems," 3rd 
edition, D. Van Nostrand Co., Inc., 1956, p. 26. 

Задача: 

Призматический стержень, зафиксированный в обоих концах, подвергается действию 
сил F1 и F2, приложенных по направлению оси в двух поперечных сечениях. найти 
силы реакции R1 и R2. 

Дано: 

a = b = 0.3 L 

L = 10 in. 

F1 = 2F2 = 1000 lb 

E = 30 x 106 psi 

Сравнение результатов: 
 R1, lbs. R2, lbs 
Теория 900 600 
COSMOS/M  900 600 
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Рис. S13-1 

S14A, S14B: Трехмерная ферма, нагруженная вертикально  
Тип: 

Статический расчет, элементы стержня (TRUSS3D). 

Литература: 

Timoshenko, S. P. and Young, D. H. "Theory of Structures," end Ed., McGraw-Hill, New 
York, 1965, pp. 330-331. 

Задача: 

Ферма, показанная на рисунке, состоит из двух панелей, ABCD и ABEF, и прикрепле-
на к вертикальной стене в точках C, D, E и F; панель ABCD лежит в горизонтальной 
плоскости. се стержни имеют одинаковую площадь поперечного сечения A, и одина-
ковый модуль упругости E. 

Найти: 

1. Продольные силы, вызываемые в избыточном стержне AD вертикальной нагрузкой 
P = 1 kip, приложенной в точке A (S14A). 

2. Силы, вызванные в стержне AD равномерным по всей конструкции повышением 
температуры на 50° F (S14B). 

Дано: 

E = 30 x 106 psi 

α = 6.5 x 10-6/°F 
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A = 1 in2 

L = 4 ft 

Сравнение результатов: 

Для элемента 2: 
 S14A S14B 
Теория 56.0 lb -1259.0 lb 
COSMOS/M  55.92 lb -1292.4 lb 

 

Рис. S14A-1 

S15: Внеплоскостной изгиб криволинейного бруса  
Тип: 

Статический расчет, элемент изогнутой трубы (ELBOW). 

Литература: 

Timoshenko, S. P., "Strength of Materials, Part 1, Advanced Theory and Problems," 3rd Edi-
tion, D. Van Nostrand Company, Inc., New York, 1956, p. 412. 

Задача: 

К части горизонтального кольца, закрепленной в точке A, приложена нагрузка P в 
конце B. Кольцо имеет сплошное круглое сечение диаметра d. Найти отклонение в 
конце B и максимальные поперечные напряжения. 

Дано: 

P = 50 lb 

r = 100 in. 

d = 2 in. 
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E = 30 x 106 psi 

θ = 90° 

ν = 0.3 

Советы по моделированию: 

В COSMOS/M отсутствует элемент изогнутой балки, хотя он появится в ближайшее 
время. Следовательно необходимо использовать элемент изогнутой трубы, при этом 
указав толщину стенки равной радиусу стержня. 

Сравнение результатов: 

 δz, in.  σBend, psi 
Теория - 2.648  6366.0 
COSMOS/M  - 2.650  6366.2 

 

Рис. S15-1 

S16A, S16B: Отклонение изогнутой трубы  
Тип: 

Статический расчет, элемент изогнутой трубы (ELBOW). 

Литература: 

Blake, A., "Design of Curved Members for Machines," Industrial Press, New York, 1966. 

Задача: 

Рассчитать отклонения изогнутой трубы, показанной на рисунке, по направлениям x и 
y если она подвергается действию следующих нагрузок: 

1. Момент MZ = 3 x 106 и внутренне давление p = 900 psi (S16A). 
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2. Внутреннее давление p = 900 psi (S16B). 

Дано: 

E = 30 x 106 psi 

ν = 0.3 

Внешний диаметр трубы = 20 in. 

Толщина = 1.031 in. 

R = 72 in. 

Сравнение результатов: 

Блейк получил следующие результаты для участка изогнутого звена в 90 градусов. 
Сюда не входит действие искажения поперечного сечения и внутреннего давления. 

δx = MZ R2/EI = 0.187039 in. 

δy = MZ R2/EI (P/2-1) = 0.106761 in. 

Фактор гибкости трубы равен: 

Kp = 1.65/h{1 + 6P/Eh) (R/t)4/3}, где h = tR/r2 

для p = 900 psi, KP = 1.8814761 

Для получения узловых отклонений для варианта нагрузки необходимо отклонения, 
полученные по формуле Блейка умножить на KP и прибавить к отклонениям, вызван-
ным внутренним давлением. 

S16A 

 δx, in. δy, in. 
Теория 0.37035 0.20515 
COSMOS/M  0.37034 0.20515 

 

S16B 

 δx, in. δy, in. 
Теория 1.84356 x 10-2 4.2873 x 10-3 
COSMOS/M  1.84355 x 10-2 4.28043 x 10-3 
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Рис. S16A-1 

S17: Прямоугольная плита под треугольной термальной нагруз-
кой  
Тип: 

Линейный расчет термальных напряжений, двухмерные элементы (PLANE2D в режи-
ме плоских напряжений). 

Литература: 

Johns, D. J., "Thermal Stress Analysis," Pergamon Press, Inc., 1965, pp. 40-47. 

Задача: 

В конечной прямоугольной плите температура распространяется только в одном на-
правлении, как показано на рисунке. Найти нормальные напряжения в точке A. 

Дано: 

a = 15 in. 

b = 10 in. 

T0 = -100 °F 

t = 1 in. 

E = 30 x 106 psi 

αc= 0.65 x 10-5 in./in./°F 

Советы по моделированию: 
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Поскольку в геометрии и нагрузке присутствует двойная симметрия, расчет выпол-
нялся только для четверти модели. 

Сравнение результатов: 

 σxx/(EαTo) (Узел 45) 
Первый метод в литературе  0.42 
Второй метод  0.40 
COSMOS/M 0.43 

 

Рис. S17-1 

S18: Сферический купол с моментом, приложенным к свободному 
краю  
Тип: 

Линейный статический расчет, элемент осесимметричной оболочки (SHELLAX). 

Литература: 

Zienkiewicz, O. C. "The Finite Element Method," Third edition, McGraw-Hill Book Co., 
New York, 1983, p. 362. 

Задача: 

Найти горизонтальные перемещения сферической оболочки, подвергающейся дейст-
вию равномерно распределенного момента на свободном крае. 

Дано: 

R = 100 in. 

r = 50 in. 

E = 1 x 107 psi 
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ν = 0.33 

t = 1 in. 

M = 1 in. lb/in. 

Советы по моделированию: 

На рисунке показано распределение узлов. Для удобства создания узлов была выбрана 
цилиндрическая координатная система. Важно заметить, что нагрузка должна быть 
задана в единицах на радиан, в данном случае � 50 in. lb./rad. 

Сравнение результатов: 
 Горизонтальное перемещение (Узел 

29) 
Reference  1.58 E-5 in. 
COSMOS/M  1.589 E-5 in. 

 

Рис. S18-1 

S19: Полый толстостенный цилиндр, подвергающийся действию 
температуры и давления  
Тип: 

Статический расчет, двухмерные элементы (PLANE2D в осесимметричном режиме). 

Литература: 

Timoshenko, S. P. and Goodier, "Theory of Elasticity," McGraw-Hill Book Co., New York, 
1961, pp. 448-449. 

Задача: 

Полый цилиндр подвергается действию двух независимых нагрузок. 
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1. Внутренне давление. 

2. Осесимметричное распределение температуры устойчивого состояния, задаваемое 
уравнением: 

T(r) = (Ta/ln(b/a)) � ln(b/r) 

где Ta � температура внутренней поверхности, а T(r) � температура на радиусе r. 

Дано: 

E = 30 x 106 psi 

a = 1 in. 

b = 2 in. 

ν = 0.3 

α = 1 x 10-6 1/deg 

Pa = 100 psi 

Ta = 100 deg 

Сравнение результатов: 

В r = 1.2875 in. (элементы 13, 15). 

 σr, psi  σθ, psi 
Теория - 398.34  - 592.47 
COSMOS/M  - 398.2  - 596.5 

 

Рис. S19-1 

S20A, S20B: Цилиндрическая крыша  
Тип: 

Статический расчет, элементы оболочки (SHELL4, SHELL6). 
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Литература: 

Pawsley, S. F., "The Analysis of Moderately Thick to Thin Shells by the Finite Element 
Method," Report No. USCEM 70-l2, Dept. of Civil Engineering, University of California, 
1970. 

Задача: 

Найти вертикальные отклонения в среднем сечении крыши, прогибающейся по собст-
венным весом. Размеры и граничные условия приведены на рисунке. 

Дано: 

r = 25 ft 

E = 3 x 106 psi 

ν = 0 

Вес оболочки =  90lbs/sqft 

Советы по моделированию: 

Поскольку задача симметрична, расчет выполняется для четверти модели. Распреде-
ленная нагрузка (вес) заменена сосредоточенными силами, приложенными в узлах. 

Сравнение результатов: 

Вертикальное отклонение свободного края в сечении (узел 25): 

 δx, (in.) 
Теория 0.3024 
COSMOS/M SHELL4  0.3036 
COSMOS/M SHELL6  0.2999 
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Рис. S20-1 

 

Рис. S20-2 

S21A, S21B: Антисимметричная поперечно-слоистая плита 
(SHELL4L) 
Тип: 

Статический расчет, элемент составной оболочки (SHELL4L, SHELL9L). 

Литература: 

Jones, Robert M., "Mechanics of Composite Materials," McGraw-Hill, New York, l975, p. 
256. 

Задача: 
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Вычислить максимальное отклонение антисимметричной поперечно-слоистой плиты, 
лежащей на опорах, и подвергающейся действию нагрузки, распределенной по сину-
соиде. Плита состоит из 6 слоев, материал каждого слоя ортотропный. 

Дано: 

a = 100 in. 

b = 20 in. 

h = 1 in. 

Для каждого слоя распределенная нагрузка равна cos(πx/a).cos(πy/b) 

Ea = 40E6 psi 

Eb = 1E6 psi 

νab = 0.25 

Gab = Gac = Gbc = 5E5 psi 

Советы по моделированию: 

Поскольку задача симметрична, расчет выполняется для четверти модели. 

Сравнение результатов: 
 Wmax (in.) 
Теория 0.105E-2 
COSMOS/M 4-node  0.102E-2 
COSMOS/M 9-node  0.109E-2 

 

Рис. S21-1 
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S22: Подвес с термальной нагрузкой  
Тип: 

Статический расчет термальных напряжений, стержневые и балочные элементы 
(TRUSS3D, BEAM3D). 

Литература: 

Timoshenko, S. P., "Strength of Materials, Part l, Elementary Theory and Problems," 3rd 
Ed., D. Van Nostrand Co., Inc., l956, p. 30. 

Задача: 

Найти напряжения в конструкции из медных и стальных тросов, показанной на рисун-
ке. К конструкции приложена нагрузка Q и увеличение температуры на 10° F. 

Дано: 

Площади поперечных сечений = 0.l in.2 

Q = 4000 lb 

αc = 92 x 10 in./in. - °F 

αs = 70 x 10 in./in. - °F 

Ec = 16 x 106 psi 

Es = 30 x 106 psi 

Советы по моделированию: 

Длина и расстояние между тросами выбираются произвольно. Для элементов l, 2 и 3 
используется элемент стержня, для элементов 4 и 5 � балочный. Тип и материал бал-
ки выбираются произвольно. 

Сравнение результатов: 

 σs, psi  σc, psi 
Теория 19695.0  10152.0 
COSMOS/M  19704.2  10147.9 
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Рис. S22-1 

S23: Расчет термальных напряжений рамы 
Тип: 

Линейный расчет термальных напряжений, балочные элементы (BEAM3D). 

Литература: 

Rygol, J., "Structural Analysis by Direct Moment Distribution," Gordon and Breach Science 
Publishers, New York, 1968, pp. 292-294. 

Задача: 

Неправильная рама подвергается изменению температуры. Найти моменты в концах 
звеньев. 

Характеристики звеньев  

Звено d (ft) b (ft) Ar-r (ft) lt-t (ft) 
1 1.5 1.5 2.25 0.422 
2 2.25 1.25 2.8125 1.187 
3 2.0 1.5 3.0 1.0 
4 2.5 1.25 3.125 1.628 
5 2.0 1.5 3.0 1.0 

Дано: 

E = 192857 tons/ft2 

α = 0.00001 ft/ft°C 

Сравнение результатов: 

Моменты (lb-in): 
Звено COSMOS/M Теория 

1 - 17.96 - 17.96 
2 + 17.96 + 17.96 
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- 42.87 - 42.96 
3 + 38.73 

- 41.92 
+ 38.64 
- 41.96 

4 + 84.79 
- 82.61 

+ 84.92 
- 82.61 

5 - 57.50 
+ 82.61 

- 57.40 
+ 82.61 

 

Рис. S23-1 

 

Рис. S23-2 

S24: Расчет термальных напряжений простой рамы  
Тип: 

Линейный расчет термальных напряжений, балочные элементы (BEAM2D). 

Задача: 

Найти перемещения и силы в концах рамы, показанной на рисунке, вызванные увели-
чением температуры в узлах; градиенты температуры в звеньях приведены ниже. 
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Дано: 

E = 30,000 kips/in.2 

α = 0.65 x 10-5 in./in./°F 
 Элемент 1 Элемент 2 
Разность температур по направлению S  72° F 0 
Разность температур по направлению T  0 13.5° F 

Сравнение результатов: 

Перемещения в узле 2 (in.): 

 δx  δy 
Теория - 0.0583  0.1157 
COSMOS/M  - 0.0583  + 0.1168 

 

Рис. S24-1 

S25: Вращение квадратной полой балки  
Тип: 

Статический расчет, элементы оболочки (SHELL4). 

Литература: 

Timoshenko, S. P., and Goodier, J. N., "Theory of Elasticity," McGraw-Hill, New York, 
1951, p. 299. 

Задача: 

Найти поперечные напряжения и угол поворота балки с полым квадратным сечением, 
к которой приложен крутящий момент T. 

Дано: 

E = 7.5 psi 
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ν = 0.3 

t = 3 in. 

a = 150 in. 

L = 1500 in. 

T = 300 lb in. 

Сравнение результатов: 
 Поперечные напряжения τ lb/in. Вращения θ, rad 
Теория 0.00222 0.0154074 
COSMOS/M  0.00222 (ср.) 0.01503 

 

Рис. S25-1 

S26: Балка на упругих опорах с шарниром  
Тип: 

Статический расчет, балочные и стержневые элементы (TRUSS3D, BEAM3D). 

Литература: 

Beaufait, F. W., et. al., "Computer Methods of Structural Analysis," Prentice-Hall, Inc., New 
Jersey, 1970, pp. 197-2l0. 

Задача: 

Необходимо найти отклик в концах звеньев и реакции опор от приложенной нагрузки. 
Конструкция показана на рисунке. В месте соединения балки с колонной (точка 3) 
балка непрерывна, а колонна соединена с балкой с помощью болта. 

Дано: 

Площади поперечного сечения балок = A1 = A2 = 0.125 ft2 

Моменты инерции балок = I1 = I2 = 0.263 ft4 

Площадь поперечного сечения колонны = A3 = 0.175 ft2 

Момент инерции колонны = I3 = 0.193 ft4 

E = 1.44 x 104 kip/ft2 

K (жесткость пружины) = 1200 kips/ft 

Сравнение результатов: 
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 Узел 2 Узел 4 Узел 5 
Теория 
δx (10-3 ft.) 1.0787 1.0787 1.0787 
δy (10-3 ft.) 1.7873 - 4.8205 - 0.1803 
θz (10-3 rad) 0.0992 0.3615 - 0.4443 
COSMOS/M 
δx (10-3 ft.) 1.0794 1.0794 1.0794 
δy (10-3 ft.) 1.7869 - 4.8205 - 0.1803 
θz (10-3 rad) 0.0992 0.3615 - 0.4443 

 

Рис. S26-1 

 

Рис. S26-2 

S27: Расчет рамы с комбинированными нагрузками  
Тип: 
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Статический расчет, балочные элементы (BEAM3D). 

Литература: 

Laursen, Harold I., "Structural Analysis," McGraw-Hill Book Co., Inc., New York, 1969, pp. 
310-312. 

Задача: 

Найти силы в балочных элементах, вызванные нагрузками, показанными на рисунках. 
В задаче используются два отдельных варианта нагрузки, представляющие распреде-
ленную нагрузку и сосредоточенную силу. Сначала расчет выполняется для каждого 
варианта в отдельности, потом результаты комбинируются для получения общего ре-
зультата. 

Дано: 

Iyy = Izz = 0.3215 ft4 

I = 0.6430 ft4 

A1 = 3.50 ft2 

A2,3 = 4.40 ft3 

A4 = 2.79 ft2 

E = 432 x 104 K/ft2 

Площади звеньев были увеличены по сравнению с действительными, чтобы эффект 
продольной деформации был пренебрежимо мал. 

Сравнение результатов: 

Результаты показаны на рисунке, значения в скобках представляют результаты, полу-
ченные в COSMOS/M. 
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Рис. S27-1 

 

Рис. S27-2 

S28: Консольная несимметричная балка  
Тип: 

Статический расчет, трехмерный балочный элемент (BEAM3D). 

Литература: 

Boresi, A. P., Sidebottom, O. M., Seely, F. B., Smith, J. O., "Advanced Mechanics of Mate-
rials," John Wiley and Son, Third Edition, 1978. 

Задача: 

Несимметричная консольная балка подвергается действию сосредоточенной силы, 
приложенной в свободном конце. Найти перемещения в свободном конце балки, си-
лы в зажатом конце и напряжения в координатах y = 8, z = -2. 

Дано: 

E = 2 x 107 N/cm2 

Fy = -8 N 

h1 = 4 cm 

b1 = 2 cm 
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L = 500 cm 

Fz = -4 N 

h2 = 8 cm 

b2 = 6 cm 

A = 19 cm2 

Iyy = 100.3 cm4 

Izz = 278.3 cm4 

Iyz = 97.3 cm4 

Ixx = J = 6.333 cm4 

t = 1 cm 

Сравнение результатов: 
 Теория COSMOS/M 
Узел 6 
Перемещения по оси Y (cm)  - 0.1347 - 0.1346 
Перемещения по оси Z (cm) - 0.2140 - 0.21364 
Вращения вокруг оси X (rad)  0 0 
Узел 1 
Момент вокруг оси Y (N-cm)  - 2000.0 - 2000.0 
Поперечная сила по оси Z (N)  4.0 4.0 
Напряжения в Y = 8, Z = 2 155.74 раст. 155.8 раст. 

 

Рис. S28-1 
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S29A, S29B: Квадратная составная плита под воздействием сину-
соидальной нагрузки 
Тип: 

Статический расчет, элементы составной оболочки (SHELL9L) и составные объемные 
элементы (SOLIDL). 

Литература: 

Jones, Robert M., "Mechanics of Composite Materials," McGraw-Hill, N. Y., l975, p. 258. 

Задача: 

Вычислить максимальное отклонение квадратной слоистой плиты, лежащей на опорах 
и подвергающейся действию нагрузки, распределенной по синусоиде. Плита состоит 
из 6 слоев, причем оси материала верхнего слоя повернуты на 45 градусов. Для зада-
ния граничных условий необходимы 2 слоя составных объемных элементов (каждый 
состоит из 3 слоев с различной ориентацией материала). 

Дано: 

a = b = 20 in. 

Ea = 40E6 psi 

h = 0.01 in. 

Eb = 1E6 psi 

ν = 0.25 

Gab = Gac = Gbc = 5E5 psi 

p = cos (πx/a) cos (πy/b) 

po = 1E-3 

Сравнение результатов: 
 Макс. отклонение 
Теория 0.256 
COSMOS/M SOLIDL  0.258 
COSMOS/M SHELL9L  0.258 
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Рис. S29-1 

S30: Действие поперечного среза на максимальные отклонения  
Тип: 

Статический расчет, элементы оболочки (SHELL3). 

Литература: 

Pryor, Charles W., Jr., and Barker, R. M., "Finite Element Bending Analysis of Reissner 
Plates," Engineering Mechanics Division, ASCE, EM6, December, l970, pp. 967-983. 

Задача: 

Найти действие поперечного среза на максимальные отклонения изотропной плиты, 
лежащей на опорах и повергающейся действию постоянной распределенной нагрузки 
q. 

Дано: 

a = b = 24 in. 

E = 30E6 psi 

H = изменяется пропорционально толщине (H/a) 

ν = 0.3 

q = 30 psi 

Советы по моделированию: 

Исходные данные соответствуют h = 0.1008, другие исходные данные могут быть по-
лучены, если изменить толщину в данных исходных данных. Поскольку задача сим-
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метрична, расчет выполняется только для четверти модель. 

Сравнение результатов: 
Отношение толщи-

ны H/a 
Коэффициент β● 

Теория Рейзне-
ра  

Коэффициент 
β●  

COSMOS/M 

Ошибка (%) 

0.000042 0.04436 0.04437 0.02 
0.00042 0.04436 0.04438 0.05 
0.0042 0.04436 0.04436 0 
0.05 0.044936 0.04452 ** 0.98 
0.1 0.046659 0.04625 * 0.88 

0.15 0.049533 0.04914 * 0.79 
0.2 0.049533 0.05320 * 0.67 

0.25 0.058727 0.05841 * 0.54 
0.3 0.065048 0.064774 * 0.42 

●β = Wmax/qa4 
* Тонкостенная оболочка 
** Толстостенная оболочка 

 

Рис. S30-1 

 

Рис. S30-2 

S31, S31A: Квадратная составная плита под воздействием сину-
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соидальной нагрузки  
Тип: 

Статический расчет, элементы составной оболочки (SHELL4L, SHELL9L). 

Литература: 

Jones, Robert M., "Mechanics of Composite Materials," McGraw Hill, N. Y., l975, p. 258. 

Задача: 

Вычислить максимальное отклонение составной плиты, лежащей на опорах и подвер-
гающейся действию синусоидальной нагрузки. Плита состоит из 4 слоев, причем оси 
материала верхнего слоя повернуты на 15 градусов. 

Дано: 

a = b = 20 in. 

h = 1 in. 

Ea = 40E6 psi 

Eb = 1E6 psi 

ν = 0.25 

Gab= Gac = Gbc = 5E5 psi 

p = cos(πx/a)cos(πy/b) 

Сравнение результатов: 
 Wmax (in.) 
Теория 4.24E-4 
COSMOS/M SHELL4L  4.40E-4 
COSMOS/M SHELL9L  4.48E-4 
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Рис. S31-1 

S32A, S32B, S32C, S32D, S32M: Подконструкции башни  
Тип: 

Статический расчет, подконструкции и стержневые элементы (TRUSS2D). 

Задача: 

С использованием многоуровневых подконструкций найти отклонения башни , нагру-
женной на верху. 

Дано: 

E = 10 x 106 psi 

P = 1000 lb 

h = 100 in. 

L = 30 in. 

Площадь поперечного сечения вертикальных и горизонтальных стержней = 1 in.2 

Площадь поперечного сечения диагональных стержней = 0.707 in.2 

Сравнение результатов: 
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1 1(A) 0 0 0 0 
2 5(A) 7.9761 9.1679 7.9761 9.1678 
9 5(B) 14.6226 25.3632 14.6226 25.3631 

13 5(C) 19.9360 46.8896 19.9359 46.8893 
17 5(M) 23.9168 71.9909 23.9167 71.9905 
21 3(D) 26.5878 99.3979 26.5877 99.3973 
4 4(A) - 2.1815 3.4329 - 2.1815 3.4328 
6 2(B) - 4.0240 8.9940 - 4.0239 8.9940 

10 2(C) - 6.7108 25.1829 - 6.7108 25.1828 
14 2(M) - 8.0642 46.7075 - 8.0641 46.7072 
18 6(M) - 8.0834 71.7683 - 8.0833 71.7678 
22 4(D) - 6.7458 98.0790 - 6.7457 98.0784 

 

Рис. S32A-1 
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S33A, S33M: Подконструкции самолета (крыло) 
Тип: 

Статический расчет, подконструкции с использованием элементов оболочки, балок и 
стержней (SHELL4, BEAM3D, TRUSS3D). 

Задача: 

Используя подконструкции, найти отклонения в конструкции самолета. 

Сравнение результатов: 
Номер узла  Отклонение (ось Z) (in.) 

COSMOS/M, полная конструкция  
Отклонение (ось Z) (in.) 

COSMOS/M, подконструкции  
16 10.100 10.178 
17 8.0671 8.1024 
18 13.800 13.894 
19 10.666 10.708 
20 8.7693 8.9513 
21 12.276 12.958 

 

 

Рис. S33A-1 

S34: Анкерный стержень с боковой нагрузкой  
Тип: 

Статический расчет, увеличение жесткости, вызванной напряжениями, балочные эле-
менты (BEAM3D). 

Литература: 
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Timoshenko, S. P., "Strength of Materials, Part II, Advanced Theory and Problems," 3rd 
Edition, D. Von Nostrand Co., Inc., New York, l956, p.42. 

Задача: 

Анкерный стержень подвергается действию растягивающей силы S и равномерной 
распределенной боковой нагрузки q. Найти максимальное отклонение z, угол накло-
на в левом конце. Кроме этого, определить те же величины для стержня с нормаль-
ной жесткостью (S = 0). 

Дано: 

L = 200 in. 

E = 30E6 psi 

S =21,972.6 lb 

q = 1.79253 lb/in. 

b = h = 2.5 in. 

Вычисляемые данные: 

Площадь = 6.25 in.2 

I = 3.2552 in.4 

Советы по моделированию: 

Поскольку модель симметрична, расчет выполняется только для половины стержня. 

Сравнение результатов: 

S <> 0 (Изменение жесткости) 
 Zmax,  in. θ, rad 
Теория - 0.2 0.0032352 
COSMOS/M  - 0.19701 0.0031776 

S = 0 (Нормальная жесткость) 
 Zmax,  in. θ, rad 
Теория - 0.382406 0.006115 
COSMOS/M  - 0.37763 0.0060229 
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Рис. S34-1 

S35A, S35B: Сферическая крышка с распределенной нагрузкой  
Тип: 

Статический расчет, объемные и составные объемные элементы (SOLID, SOLIDL). 

Литература: 

Reddy, N. J. "Exact Solutions of Moderately Thick Laminated Shells," J. Eng. Mech. Div. 
ASCE, Vol. 110, (1984), pp. 794-809. 

Задача: 

Рассчитать отклонения в центре сферической крышка, лежащей на опорах и подвер-
гающейся действию распределенной нагрузки (q = 1.), приложенной нормальной по-
верхности крышки. Для приложения граничных условий объемными элементами, не-
обходимы 2 слоя элементов. 

Проверяются два типа материалов, каждому соответствует свой тип объемных эле-
ментов. 

A. Изотропный материал, которому соответствует элемент SOLID (S35A). 

B. Составной материал, состоящий из 4 слоев с ориентацией материала 0°/90°/90°/0°, 
которому соответствует элемент SOLIDL (S35B). Нижний слой элементов моделиру-
ется 2 слоями 2 с ориентацией материала 0°/90°, а верхний � с ориентацией 90°/0°. 

Для сохранения геометрии криволинейной поверхности при генерации КЭ-сети, необ-
ходимо использовать как минимум 8 элементов на сторону. Используемая ниже мо-
дель состоит из 8x8x2 элементов. 
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Дано: 

Геометрия: 

R = 96 

Длина стороны = a = b = c = d = 32 in. 

h = 0.32 in. 

Свойства материала: 

1. S35A: изотропный  

E = 1E7 psi 

ν = 0.3 

2. S35B: Составной 0°/90°/90°/0° 

Ex = 25E6 psi 

Ey = Ez = 1E6 psi 

νxy = 0.25 

νyz = νxy = 0 

Gyz = 0.2E6 psi 

Gxy = Gxz = 0.5E6 psi 

Советы по моделированию: 

Граничные условия  

Поскольку задача симметрична : 

1. Для всех узлов в плоскости A Uy = 0 

2. Для всех узлов в плоскости B Ux = 0 

Опоры: 

1. Для всех узлов на стороне C радиальные перемещения = 0, перемещения на плоско-
сти C = 0 

2. Для всех узлов на стороне D радиальные перемещения = 0, перемещения на плоско-
сти D = 0 

Сравнение результатов: 
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  Wmax (in.) 
Элемент:  
(1) Изотропный 

Теория  
SOLID  

0.3139E-2  
0.3232E-2 

Элемент:  
(2) Составной 

Теория 
SOLIDL  

0.199E-1  
0.2007E-1 

 

Рис. S35A-1 

S36A, S36M: Подконструкции плиты, лежащей на опорах  
Тип: 

Статический расчет, подконструкции и элементы плиты (SHELL4). 

Литература: 

Timoshenko, S., "Theory of Plates and Shells," McGraw-Hill, New York, 1940, p. 113-198. 

Задача: 

Используя подконструкции, вычислить отклонения плиты из изотропного материала, 
лежащей на опорах и подвергающейся действию распределенной нагрузки p. Узлы с 
11 по 15 являются суперузлами. 

Дано: 

E = 30 x 10 psi 
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ν = 0.3 

h = 0.5 in. 

p = 5 psi 

a = 16 in. 

b = 10 in. 

Советы по моделированию: 

Поскольку задача симметрична, расчет выполняется только для четверти модели. 

Сравнение результатов: 

Тимошенко предложил выражения для отклонения w по направлению z, если точка 
отсчета лежит в углу плиты. 

 X (in.) Y (in.) W (in.) Теория W (in.) COSMOS/M 
Узел 1  0 0 0.0012103 0.00121329 
Узел 2  2 0 0.0011338 0.00113636 
Узел 3  4 0 0.0009043 0.00090247 
Узел 4  6 0 0.0005150 0.00051044 

 

Рис. S36A-1 

S37: Гиперболическая оболочка  
Тип: 

Статический расчет, элементы осесимметричной оболочки (SHELLAX). 
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Литература: 

William Weaver, Jr., and Paul R. Johnston, "Finite Elements for Structural Analysis," Pren-
tice-Hall, Inc., l984, p. 275. 

Задача: 

Найти горизонтальные перемещения гиперболической оболочки, подвергающейся 
действию равномерной кольцевой нагрузки, приложенной к свободному краю. 

Дано: 

R0 = 600 in. 

R1 = l200 in. 

H = 2400 in. 

H0 = l500 in. 

t = 8 in. 

E = 3000 kip/sq in. 

ν = 0.3 

P = l kip/in. 

Уравнение гиперболы: 

X2 = 0.48(Y - H0)2 + R2 

Советы по моделированию: 

Узлы на верху оболочки должны располагаться с меньшим интервалом, поскольку та 
приложена нагрузка. Используются следующие интервалы между узлами: 

Узлы DY (in) 
1-11  10 
11-21  20 
21-29  75 
29-39  150 

Следует заметить, что нагрузка должна быть задана на длину дуги в 1 радиан; по-
скольку радиус в верху оболочки равен 865.3323, прикладываемая величина нагрузки 
равна 865.33 kip/rad. 

Сравнение результатов: 
 Максимальное перемещение в узле 41 
Теория - 0.904 in. 
COSMOS/M - 0.89705 in. 
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Рис. S37-1 

S38: Вращающийся объемный диск  
Тип: 

Статический расчет, осесимметричные элементы PLANE2D, центробежная нагрузка. 

Литература: 

S. P. Timoshenko and J. N. Goodier, "Theory of Elasticity," McGraw-Hill, New York, l970, 
p. 80. 

Задача: 

Объемный диск вращается вокруг центра 0 с угловой скоростью ω. Найти распределе-
ние напряжений в диске. 

Дано: 

E = 30 x 106 psi 

DENS = 0.02 lb sec2/in.4 

ν = 0.3 

h = 1 in. 

ω = 25 rad/sec 

R = 9 in. 

Сравнение результатов: 
 Location Element 1 (r = 0.5 in.)  Location Element 9 (r = 8.5 in.) 
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Stress  σr psi σθpsi σr psi σθpsi 
Теория 416.37 416.91 45.12 203.16 
COSMOS/M  416.82 416.82 46.18 202.03 

 

Рис. S38-1 

S39: Несбалансированный вращающийся маховик  
Тип: 

Статический расчет, центробежная нагрузка, элементы балок и массы (BEAM3D, 
MASS). 

Задача: 

Модель, показанная на рисунке, вращается вокруг оси y с постоянной угловой скоро-
стью 25 rad/sec. Найти продольные силы и изгибающие моменты в поддерживающих 
балках и колоннах, вызванные собственным весом и инерцией вращения. 

Дано: 

Свойства элементов: 

A = 100 in.2 

Iyy = Izz = 1000 in.4 

Ixx = 2000 in.4 

E = 30 x 106 psi 

G = 10 x 106 psi 

ρ = 0.01 lb-sec2 /in.4 

Свойства инерции: 

m3 = m4 = 10 
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ay = -l00 in./sec2 

ω  = 25 rad/sec 

Сравнение результатов: 
 Теория  COSMOS/M 
Элемент 2, узел 2 
Продольная сила 58,800 58,800 
Момент 412,000 412,000 
Элемент 3, узел 2 
Продольная сила 61,200 61,200 
Момент 388,000 388,000 

 

Рис. S39-1 

S40: Ферма, подвергающаяся действию сосредоточенной нагрузки  
Тип: 

Статический расчет, элементы стержня (TRUSS2D). 

Литература: 

Hsieh, Y. Y., "Elementary Theory of Structures," Prentice-Hall Inc., l970, pp. l62-l63. 

Задача: 

Вычислить реакции и вертикальное отклонение точки 2 фермы, показанной на рисунке 
и повергающейся действию сосредоточенной нагрузки. 

Дано: 

E = 30,000 kips/in.2 

L (ft)/A(in.) = 1 для всех звеньев  

P = 64 kips 

Сравнение результатов: 
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 Теория COSMOS/M 
Отклонение точки 2  0.006733 in. 0.006733 in. 
Реакция в узле 1  48 K 48 K 
Реакция в узле 5  16 K 16 K 

 

Рис. S40-1 

S41: Реакции в раме  
Тип: 

Статический расчет, балочный элемент (BEAM2D). 

Литература: 

Hsieh, Y. Y., "Elementary Theory of Structures," Prentice-Hall Inc., l970, pp. 258-259. 

Задача: 

Найти реакции в раме, показанной на рисунке. 

Дано: 

E = 30 x 106 psi 

A = 0.1 in.2 

Относительные значения 2EI/L: 

для элемента 1 = 1 lb-in. 

для элементов 2, 3 = 2 lb-in. 

Сравнение результатов: 

Результаты показаны на рисунке, значения в скобках соответствуют результатам, по-
лученным в COSMOS/M. 
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Рис. S41-1 

 

Рис. S41-2 

S42A, S42B: Реакции и отклонения консольной балки  
Тип: 

Статический расчет, элементы оболочки (SHELL4, SHELL6). 

Задача: 

Рассчитать реакции и отклонения консольной балки, нагруженной в свободном конце. 

Дано: 

E = 30E6 psi 

h = 1 in. 

L = 10 in. 

W = 4 in. 

P = 8 lb 
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Сравнение результатов: 
 Теория COSMOS/M 

SHELL4 
COSMOS/M 

SHELL6 
Отклонение (Узел 33)  2.667 x 10-4 2.667 x 10-4 2.683 x 10-4 
Сила реакции  8 lb 8 lb 8 lb 
Момент реакции  80 lb- in. 80 lb-in. 80 lb-in. 

 

Рис. S42-1 

S43: Изгиб тавровой балки  
Тип: 

Статический расчет, элемент оболочки, балочный элемент с эксцентриситетом 
(SHELL4L, BEAM3D). 

Задача: 

Рассчитать отклонения и напряжений консольной тавровой балки, нагруженной в сво-
бодном конце. 

Дано: 

L = 2000 in. 

y = 49 in. 

I = 480833.33 in.4 

E = 10E10 psi 

Dy = -24 in. 
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Аналитическое решение: 

δ = PL3/3EI 

θ = PL2/2EI 

σ = Mc/I 

Сравнение результатов: 

 Теория COSMOS/M 
Свободный конец (в узле 12) 
Перемещение по оси Y (in.) 5.546E-6 5.588E-6 
θz  Вращение  4.159E-9 4.161E-9 
Сжатый конец  
σx верх (psi)  4.5736 4.375 
σx низ (psi)  20.3813 21.30 

Примечание: 

Для элементов SHELL4L по умолчанию напряжения выводятся в локальной коорди-
натной системе; результаты, приведенные в таблице, получены в глобальной коорди-
натной системе. 

 

Рис. S43-1 

S44A, S44B: Изгиб круглой плиты с отверстием в центре  
Тип: 

Статический расчет, элементы оболочки (SHELL4), зависимые точки  (файл S44A) 
и/или уравнения ограничений (файл S44B). 
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Литература: 

Timoshenko, S., "Strength of Materials, Part II, Advanced Theory and Problems," 3rd Edi-
tion, D. Van Nostrand Co., Inc., New York, l956. 

Задача: 

Круглая плита с отверстием в центре зафиксирована по внутренней грани и свободна 
на внешней. К внешнему краю плиты приложен момент M. Найти максимальное от-
клонение и угол наклона плиты. Кроме этого найти момент и соответствующие на-
пряжения в центрах первого и последнего элементов. 

Дано: 

E = 30E6 psi 

ν = 0.3 

h = 0.25 in. 

b = 10 in. 

a = 30 in. 

M = 10 in lb/in. 

θ = 10° 

Вычисленные исходные данные: 

M1a = 10 in-lb./in = 52.359 in lb./10° сегмент. 

Советы по моделированию: 

Поскольку задача осесимметрична, необходим только небольшой сектор элементов. 
Для аппроксимации круглой границы прямым элементом используется малый угол θ. 
Используется радиальная сетка с неравномерным интервалом (3:l). Нагрузка прикла-
дывается к внешним узлам. Для обеспечения симметрии используются зависимые 
узлы (CPDOF) и/или уравнения ограничений (CEQN) в вариантах S44A и S44B соот-
ветственно. Заметьте, что все ограничения и нагрузки приложены в цилиндрической 
координатной системе. 

Сравнение результатов*: 

На внешнем крае (узел 14). 

Таблица 1 

 σz in. θy rad 
Теория 0.0490577 - 0.00045089 
COSMOS/M  0.0492188 - 0.00452573 
Ошибка  0.3% 1.1% 
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* Результаты получены в варианте S44A. Для задачи S44B 
результаты идентичны. 

Таблица 2 

 X = 10.86 in. (Первый элемент) X = 27.2 in. (Шестой элемент) 
 Момент in. - lb/in. σr psi Момент  in. - lb/in. σr psi 
Теория - 13.7 1319 - 10.1 971.7 
COSMOS/M  - 13.7 1313 - 10.1 972.7 
Ошибка  0% 0.45% 0% 0.10% 
* Результаты получены в варианте S44A. Для задачи S44B результаты идентичны. 

 

Рис. S44-1 

S45: Рама с эксцентриситетом  
Тип: 

Статический расчет, балочные элементы (BEAM3D) и ограничения точка-точка (ко-
манда CPCNS). 

Литература: 

Laursen H. I., "Structural Analysis," McGraw-Hill, l969. 

Задача: 

Две вертикальных и три горизонтальных балки образуют раму с эксцентриситетом. 
Найти деформации, вызванные горизонтальными силами. 

Дано: 

h = 1 in. 

W = 1 in. 

L = 10 in. 

S = 2.5 



 346

I = 1/12 in.4 (вокруг осей y и z) 

E = 1E6 psi 

P = 1 lb 

Советы по моделированию: 

Используются ограничения точка-точка (точки 2-3, 3-4 и 4-5) для обеспечения жестко-
сти рамы 2-3 - 4-5 при приложении горизонтальных сил. Деформации каждой из ба-
лок (l) и (2) показаны на рисунке: 

Сравнение результатов: 

Отклонение по оси X в точках A и B: 
 δx (in.) 
Теория 1.0000E-3 
COSMOS/M  1.0104E-3 
Difference  1% 

 

Рис. S45-1 
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Рис. S45-2 

S46, S46A, S46B: Изгиб консольной балки  
Тип: 

Статический расчет, элементы PLANE2Dв режиме плоских напряжений, балочные 
элементы (BEAM2D), элементы оболочки (SHELL9) и элементы ограничений. 

Задача: 

Вычислить максимальное отклонение и максимальный угол поворота консольной бал-
ки, если на свободном конце приложена поперечная сила. 

Дано: 

h = 1 in. 

L = 10 in. 

I = 1/12 in.4 

E = 1E6 psi 

ν = 0.3 

p = -1 lb 

Советы по моделированию: 

Граничные условия: 

Задача 1 (S46): 

Плоские элементы определяются узлами с 1 по 12. Балочный элемент определяется 
узлами 13 и 14. Каждый плоский элемент теоретически эквивалентен балочному 
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элементы, причем I = 1/12 in.4. Узел 14 прикреплен к линии 11-12, так что перемеще-
ния и вращения совместимы. 

Задача 2 (S46A): 

Две группы 8-узловых элементов PLANE2D в режиме плоских напряжений связаны, 
как показано на рис. S46-2, причем геометрия и свойства материала те же, что и в за-
даче 1. Интерес представляет ограничение тело-тело и положение первичной точки, 
которая располагается не в середине 3-точечной КРИВОЙ, а в произвольной точке. 

Задача 3 (S46B): 

Две группы элементов SHELL9 связаны как показано на рис. S46-3, причем геометрия 
и свойства материала те же, что и в задачах 1 и 2. Первичная деформация располага-
ется в плоскости xy. Задача предлагается для проверки точности ограничений конст-
рукция-конструкция. 

Аналитическое решение: 

δy = -pL3/3EI 

θx = -pL2/2EI 

Сравнение результатов: 

В свободном конце: 

 δy in. θz rad 
Теория - 4.000E-3 - 6.000E-4 
Балочный элемент - 4.000E-3 - 6.000E-4 
Плоский элемент  - 4.006E-3 - 6.000E-4 
Балочные/плоские элементы 
(S46)  

- 4.008E-3 - 6.000E-4 

Плоские элементы/плоские эле-
менты (S46A)  

- 4.009E-3 - 5.985E-4 * 

Элементы SHELL9/SHELL9 
(S46B)  

- 4.014E-3 - 5.990E-4 * 

* Вычислены с использованием перемещений в свободном конце. 
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Рис. S46-1 

 

Рис. S46-2 

 

Рис. S46-3 

S47, S47A, S47B: Изгиб консольной балки  
Тип: 

Статический расчет, элементы SOLID, TETRA10, балочные элементы и ограничения 
точка-поверхность (присоединение). 

Задача: 

Вычислить максимальное отклонение и максимальный угол поворота консольной бал-
ки, если на свободном конце приложена поперечная сила. 

Дано: 

h = 1 in. 

w = 1 in. 

L = 10 in. 

I = 1/12 in.4 (вокруг осей y и z) 
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E = 1E6 psi 

ν = 0 

p = 1 lb 

Советы по моделированию: 

Граничные условия  

Задача 1 (S47): 

Объемные элементы задаются узлами с 1 по 24. Балочный элемент задается узлами 25 
и 26. Каждый объемный элемент теоретически эквивалентен балочному элементу, 
причем I = 1/12 in.4 вокруг осей y и z. Узел 25 соединен с ПОВЕРХНОСТЬЮ 21-22-
24-23, так что перемещения и вращения совместимы. 

Задача 2 (S47A): 

Две группы 20-узловых элементов SOLID соединяются как показано на рис. S47-2, 
причем геометрия и свойства материала те же, что и в задаче 1. Интерес представляет 
отграничение тело-тело и местоположение первичной точки, которая теперь распола-
гается не в середине 8-точечной поверхности, а в произвольном месте. 

Задача 3 (S47B): 

Две группы элементов TETRA10 соединяются как показано на рис. S47-3, причем гео-
метрия и свойства материала те же, что и в задачах 1 и 2. Данная задача приводится 
для проверки точности ограничений тело-тело, если первичная точка находится в 
произвольном месте 6-точечной поверхности. 

Аналитическое решение: 

δ = -Pl3/3EI 

θ = -Pl2/2EI 

Сравнение результатов: 

В свободном конце. 
 Отклонение δ, in. Вращение θ, rad 
Теория - 4.000E-3 - 6.000E-4 
Балочный элемент  - 4.000E-3 - 6.000E-4 
Плоские элементы  - 4.010E-3 - 6.000E-4 
Балочные/объемные элементы (S47)  - 4.005E-3 - 6.000E-4 
Объемные/объемные элементы (S47A)  - 3.986E-3 - 5.962E-4 * 
Элементы TETRA10/TETRA10 (S47B)  - 3.969E-3 - 5.950E-4 * 
* Вычислены с использованием перемещений в свободном конце. 
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Рис. S47-1 

 

Рис. S47-2 

 

Рис. S47-3 

S48: Вращение бака с жидкостью  
Тип: 

Статический расчет, элемент PLANE2D в осесимметричном режиме. 

Литература: 

Brenkert, Jr., K., "Elementary Theoretical Fluid Mechanics," John Wiley and Sons, Inc., 
New York, 1960. 

Задача: 
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Большой цилиндрический бак частично заполнен несжимаемой жидкостью. Бак вра-
щается с постоянной угловой скоростью вокруг своей вертикальной оси, как показа-
но на рисунке. Найти высоту подъема поверхности жидкости относительно центра на 
различных радиальных расстояниях. Также найти давление в жидкости p нижнем уг-
лу бака. 

Дано: 

w = 1 rad/sec 

r = 48 in. 

h = 20 in. 

ρ = 0.9345E-4 lb-sec2/in.4 

g = 386.4 in./sec2 

b = 30E4 psi 

где: 

b = модуль массы  

g = ускорение свободного падения  

ρ = плотность 

Сравнение результатов: 
 Перемещения * 

δy in. (в узле 4) 
Перемещения * 
δy in. (в узле 7) 

Перемещения *  
δy in. (в узле 11) 

Давление, psi  
(в элементе 60) 

Теория 0.1863354 0.7453416 2.070380 - 0.6953986 
COSMOS/M *  0.1968 0.75575 2.0800 - 0.6952 
Ошибка 5.6% 1.4% 0.46% 0% 
* Значения получены после вычитания из перемещения в узле 1 (-1.4798 in.) 

 

Рис. S48-1 
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S49A, S49B: Ускорение бака с жидкостью  
Тип: 

Статический расчет, плоские (PLANE2D) или объемные (SOLID) элементы. 

Литература: 

Brenkert, K., Jr., "Elementary Theoretical Fluid Mechanics," John Wiley and Sons, Inc., 
New York, 1980. 

Задача: 

Большой прямоугольный бак частично заполнен несжимаемой жидкостью. Танк дви-
жется с постоянным ускорением, как показано на рисунке. Найти высоту подъема 
жидкости относительно состояния покоя на различных расстояниях по оси Y. Также 
найти наклон поверхности и давление в жидкости p в правом нижнем углу бака. 

Дано: 

a = 45 in./sec2 

b = 48 in. 

h = 20 in. 

g = 386.4 in./sec2 

p = 30E4 psi 

ρ = 0.9345E-4 lb-sec2/in.4 

где: 

b = модуль массы  

g = ускорение свободного падения  

ρ = плотность 

Сравнение результатов: 
 δy, in. 

(в узле 3) 
δy , in. 

(в узле 7) 
δy , in. 

(в узле 11) 
P, psi 

(в элементе 60) 
Теория - 1.86335 0 + 1.86335 0.74248 
COSMOS/M *  - 1.8627 0 + 1.8627 0.7425 
Ошибка 0.036% 0% 0.03% 0.03% 
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Рис. S49A-1 

S50A, S50B, S50C, S50D, S50F, S50G, S50H, S50I: Отклонения изо-
гнутой балки  
Тип: 

Статический расчет, 4-узловые элементы PLANE2D, 8-узловые PLANE2D, SHELL4T, 
6-узловые TRIANG, 8-узловые SOLID, 20-узловые SOLID, TETRA4R и SHELL6. 

Литература: 

Roark, R. J., "Formulas for Stress and Strain," 4th Edition, McGraw-Hill Book Co., New 
York, 1965, pp. 166. 

Задача: 

Изогнутая балка зажата в одном конце и подвергается действию поперечной силы, 
приложенной на свободном конце. Найти отклонения в свободном конце. 

Дано: 

E = 10E6 psi 

ν = 0.25 

R1 = 4.12 in. 

R2 = 4.32 in. 

t = 0.1 in. 

p = 1 lb 

Сравнение результатов: 

Из теоретического решения отклонения в свободном конце равны 0.08854 in. 
Элемент COSMOS/M δy in.2 Ошибка (%) 
PLANE2D (4-узловой) (S50A)  0.08761 1.05% 
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PLANE2D (8-узловой) (S50B)  0.08850 0% 
SHELL4T (S50C)  0.08827 0.26% 
TRIANG (6-узловой) (S50D)  0.07830 11.6% 
TETRA4R (4-узловой) (S50H)  0.08785 0.8% 
SOLID (8-узловой) (S50F)  0.08726 1.45% 
SOLID (20-узловой) (S50G)  0.08848 0.07% 
SHELL6 (6-узловой) (S50I)  0.08658 2.21% 

 

Рис. S50-1 

S51: Двускатная рама на шарнирных опорах 
Тип: 

Статический расчет, балочные элементы (BEAM2D). 

Литература: 

Valerian Leontovich, "Frames and Arches," McGraw-Hill Book Co., Inc., New York, l959, 
pp. 68. 

Задача: 

Найти реакции опор рамы, показанной на рисунке. 

Дано: 

L = 16 ft 

h = 8 ft 

E = 4.32E6 lb/ft2 

f = 6 ft 

q = 10 lb/ft 

I12 = I23 = I34 = I45 
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A12 = A23 = A34 = A34 = A45 

Полная нагрузка = 4 lbs 

Советы по моделированию: 

Найти интенсивность нагрузки в раме  

W = (полная нагрузка)/q = 4 lb/ft 

После этого использовать команды задания балочной нагрузки для решения задачи  

Сравнение результатов: 

Реакции (lb.): 
Номер 
узла 

Theory 
FX 

Theory 
FY 

Theory 
MZ 

COSMOS/M 
FX 

COSMOS/M 
FY 

COSMOS/M 
MZ 

1 4.44 30.00 0 4.40 30.00 0 
5 - 4.44 10.00 0 - 4.40 10.00 0 

 

Рис. S51-1 

S52: Реакции опоры балки  
Тип: 
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Статический расчет, балочные элементы (BEAM2D). 

Литература: 

Morris, C. H. and Wilbur, J. B., "Elementary Structural Analysis," McGraw-Hill Book Co., 
Inc., Second Edition, New York, 1960, pp. 93-94. 

Задача: 

Найти реакции опор балки с промежуточными силами и моментами, лежащей на опо-
рах.  

 

Рис. S52-1 

Дано: 

A = 0.3472 ft2 

Iy = Iz = 0.02009 ft4 

Ix = 0.04019 ft4 

E = 4320 x 103 K/ft 

Примечание: 

Нагрузки имеют знаки, соответствующие локальной координатной системе балки (за-
дается узлами I, J и K). 

Сравнение результатов: 
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Рис. S52-2 

Примечание: 

Результаты, полученные в COSMOS/M, сравниваются с результатами, приведенными 
в литературе. Значения в скобках получены в COSMOS/M. 

S53: Расчет балки с промежуточными нагрузками  
Тип: 

Статический расчет, балочные элементы (BEAM2D). 

Литература: 

Norris, C. H., and Wilbur, J. B., "Elementary Structural Analysis," 2nd ed., McGraw-Hill 
Book Co., Inc., 1960, pp. 99. 

Задача: 

Найти реакции опор, силы и моменты в балке. 

 

Рис. S53-1 

Дано: 

Iyy = Izz = 1 ft4 
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Ixx = 2 ft4 

A = 3.464 ft2 

E = 432 x 104 k/ft2 

Примечание: 

Нагрузки имеют знаки, соответствующие локальной координатной системе балки (за-
дается узлами I, J и K). 

Сравнение результатов: 

 

Рис. S53-2 

Примечание: 

Значения в скобках получены в COSMOS/M. 

S54: Расчет плоской рамы с балочными нагрузками  
Тип: 

Статический расчет, балочные элементы (BEAM2D). 

Литература: 

Weaver, Jr., W., and Gere, J. M., "Matrix Analysis of Framed Structures," 2nd ed., D. Van 
Nostrand Company, New York, 1980. pp. 280, 486. 

Задача: 

Найти деформации и силы в плоской раме с промежуточными силами и моментами. 
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Рис. S54-1 

Дано: 

Ax = 0.04 m2 

Iy = Iz = 2 x 103 m4 

Ix = 4 x 103 m4 

E = 200 x 106 KN/m2 

L = 3m 

P1 = 30 x 2(1/2) KN 

P2 = 60 KN 

M = 180 KN-m 

Сравнение результатов: 

 

Рис. S54-2 

S55: Сужающаяся балка с боковой нагрузкой  
Тип: 

Статический расчет, балочные элементы (BEAM3D). 

Литература: 

Crandall, S. H., and Dahl, N. C., "An Introduction to the Mechanics of Solids," McGraw-Hill 
Book Co., Inc., New York, 1959, pp. 342. 

Задача: 

Высота консольной балки, имеющей ширину b и длину L, равномерно изменяется от d 
на свободном конце до 3d в месте крепления. Балка нагружена в свободном конце 
силой P. Найти максимальное изгибающее напряжение в точке x = L (середина бал-
ки). 
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Дано: 

P = 4000 lb 

L = 50 in. 

d = 3 in. 

b = 2 in. 

E = 30E6 psi 

Сравнение результатов: 

 σx (psi) (в узле 2) 
Теория 8333 
COSMOS/M  8333 

 

Рис. S55-1 

S56: Круглая плита с сосредоточенной силой 
Тип: 

Статический расчет, 9-узловые элементы оболочки (SHELL9). 

Литература: 

Hughes, T. J. R., Taylor, R. L., and Kanoknukulchai, W. A., "Simple and Efficient Finite 
Element for Plate Bending," I.J.N.M.E., 11, 1529-1543, 1977. 

Задача: 

Круглая плита зажата на границе, в ее центре приложена сосредоточенная сила. Найти 
поперечные перемещения на различных радиальных расстояниях r. 

Дано: 

E = 1.09E6 
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ν = 0.3 

t = 2  in. (толщина) 

P = 4 lb 

R = 5 in. 

Сравнение результатов: 
Узел r (in) Wmax(in.) x 10-6 

Теория 
Wmax(in.) x 10-6 

COSMOS/M 
1 0.0 ---- - 6.469 
2 .625 4.185 - 4.242 
3 1.250 3.1670 - 3.166 
4 1.875 2.3474 - 2.349 
5 2.500 1.6366 - 1.637 
6 3.125 1.0316 - 1.033 
7 3.750 0.5458 - 0.5465 
8 4.375 0.1962 - 0.1968 

 

Рис. S56-1 

S57: Сжатый цилиндр с диафрагмой  
Тип: 

Статический расчет, 9-узловой элемент оболочки (SHELL9). 

Литература: 

Dvorkin, E. N., and Bathe, K. J., "A Continue Mechanics Based Four Node Shell Element 
for General Nonlinear Analysis," Engineering Computations, 1, 77-78, 1984. 

Задача: 

Цилиндрическая оболочка, оба конца которой закрыты жесткими диафрагмами, раз-
решающими перемещения только в направлении оси цилиндра, подвергается дейст-



 363

вию сосредоточенной силы, приложенной в центре, как показано на рисунке. Найти 
радиальное отклонение точки P. 

Дано: 

R = 300 in. 

L = 600 in. 

E = 3E6 psi 

ν = 0.3 

h = 3 in. (толщина) 

P = 1 lb 

Советы по моделированию: 

Поскольку задача симметрична, расчет выполняется только для одной восьмой моде-
ли. Для моделирования жесткой диафрагмы на границе цилиндра (z = 0) ограничено 
вращение вокруг осевого направления цилиндра (ось z). 

Сравнение результатов: 
 δx (in.) 
Теория 0.18248E-4 
COSMOS/M  0.17651E-4 

 

Рис. S57-1 

S58, S58B: Отклонение перекрученной балки  
Тип: 
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Статический расчет, 9-узловые элементы оболочки (SHELL9), 4-узловые четырех-
гранные элементы (TETRA4R). 

Литература: 

MacNeal, R. H. and Harder, R. L., "A Proposed Standard Set of Problems to Test Finite 
Element Accuracy," F. E. in Analysis and Design, pp. 3-20, 1986. 

Задача: 

В свободном конце перекрученной балки приложена сосредоточенная сила, направ-
ленная либо в плоскости, либо вне плоскости. Найти отклонения для каждой из сил. 

Дано: 

L = 12 in. 

W = 1.1 in. 

h = 0.32, 0.0032 in. (толщина) 

F = 1 lb (для h = 0.32) 

F = 1E-6 lb (для h = 0.0032) 

E = 29E6 psi 

ν = 0.22 

Сравнение результатов: 
Толщина (in.)  Направление 

силы 
Теория COSMOS/M 

h = 0.32 (S58)  В плоскости 
Вне плоскости 

0.524E-2 
0.1754E-2 

0.540E-2 
0.1737E-2 

h = 0.0032 (S58B)  В плоскости 
Вне плоскости 

0.5256E-2 
0.1794E-2 

0.4751E-2 
0.1788E-2 
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Рис. S58-1 

S59A, S59B, S59C: Слоистая квадратная плита с распределенной 
нагрузкой  
Тип: 

Статический расчет, 4- и 9-узловые элементы составной оболочки (SHELL4L, 
SHELL9L), объемные составные элементы (SOLIDL). 

Литература: 

Chang, T. Y., and Sawamiphakdi, K., "Large Deformation Analysis of Laminated Shells by 
Finite Element Method," Computers and Structures, Vol. 13, pp. 331-340, 1981. 

Задача: 

Квадратная слоистая плита, состоящая из двух одинаковых внешних слоев и ячеистого 
алюминиевого внутреннего слоя, подвергается действию равномерной распределен-
ной нагрузки как показано на рисунке. Найти отклонение плиты в точке A. 

Дано: 

Внешние слои: 

E = 10.5E6 ksi 

ν = 0.3 

hf = 0.015 in. (толщина) 

Внутренний слой: 

E = 0 ksi 

a = 25 in. 

Gxz = Gyz = 50 ksi 

P = 9.2311 psi 

hc = 1 in. (толщина) 

Советы по моделированию: 

Поскольку задача симметрична, расчет выполняется только для четверти модели. Для 
обеспечения устойчивости при вычислениях для внутреннего слоя используется ма-
лый модуль упругости (E = 1.0E-12). 

Сравнение результатов: 
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 Wmax 
в центре 

Теория 
SHELL4L (S59B)  0.846 
SHELL9L (S59A)  0.868 
SOLIDL (S59C)  0.849 
COSMOS/M 
SHELL4L (S59B) 0.851 
SHELL9L (S59A) 0.866 
SOLIDL (S59C)  0.849 

 

Рис. S59A-1 

S60: Зажатая квадратная плита с распределенной нагрузкой  
Тип: 

Статический расчет, 9-узловой элемент оболочки (SHELL9). 

Литература: 

Timoshenko, S. P. and Woinowsky-Krieger, S., "Theory of Plates and Shells," 2nd Ed., 
McGraw Hill, New York, 1959. 

Задача: 

Найти максимальное отклонение (в точке A) зажатой плиты, показанной на рисунке и 
подвергающейся действию равномерно распределенной нагрузки. В модели исполь-
зуется скошенная КЭ-сеть. Исследуются различные соотношения длина/высота. 

Дано: 

E = 1E7 psi 

υ = 0.3 

a = 2 in. 
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q = 1 psi 

t = 0.2, 0.02, 0.002 и 0.0002 in. (толщина) 

Советы по моделированию: 

Поскольку задача симметрична, расчет выполняется только для четверти модели. 

Аналитическое решение: 

Ua = .00126 qa4/D 

где 

D = Et3/12(1 - υ 2) 

Сравнение результатов: 
Соотношение дли-
на/толщина * 

Отклонение (in.) 
Теория 

Отклонение (in.) 
COSMOS/M 

10 0.2752E-5 0.3476E-5 
100 0.2752E-2 1.2792E-2 

1,000 2.752 2.576 
10,000 2752 2353.5 

* В предоставляемом файле исходных данных (S60.GEO) используется 
соотношение 10. Для других отношений необходимо задать другое зна-
чение толщины командой RCONST. 

 

Рис. S60-1 

S61: Изгиб тела с одной трещиной  
Тип: 

Статический расчет, фактории интенсивности напряжений в трещине, 8-узловой пло-
ский элемент (PLANE2D). 
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Литература: 

Brown, W. F.,Jr., and Srawley, J. E., "Plane Strain Crack Toughness Testing of High 
Strength Metallic Materials," ASTM Special Technical Publication 410, Philadelphia, PA, 
1966. 

Задача: 

Найти фактор интенсивности напряжений трещины в теле, испытываемом на изгиб, с 
трещиной с одной стороны. 

Дано: 

E = 30 x 106 psi 

υ = 0.3 

Толщина = 1 in. 

a = 2 in. 

b = 4 in. 

L = 32 in. 

P = 1 lb 

Сравнение результатов: 
 KI 
Теория 10.663 
COSMOS/M  9.855 
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Рис. S61-1 

S62: Плита с трещиной в центре  
Тип: 

Статический расчет, фактории интенсивности напряжений в трещине, 8-узловой пло-
ский элемент (PLANE2D). 

Литература: 

Cook, Robert D., and Cartwright, D. J., "Compendium of Stress Intensity Factors," Her Maj-
esty's Stationary Office, London, 1976. 

Задача: 

Найти фактор интенсивности напряжений плиты с трещиной в центре. 

Дано: 

E = 30 x 106 psi 

υ = 0.3 

Толщина = 1 in. 
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W = 20 in. 

a = 2 in. 

p = 1 lb/in. 

Сравнение результатов: 
 KI 
Теория 2.5703 
COSMOS/M  2.668 

 

Рис. S62-1 

S63: Расчет шестиугольной рамы с циклической симметрией  
Тип: 

Статический расчет, циклическая симметрия, стержневые элементы (TRUSS2D). 

Литература: 

Cook, Robert D., "Concepts and Applications of Finite Element Analysis." 2nd Edition, John 
Wiley & Sons, New York, 1981. 

Задача: 

Шестиугольная рама с болтовыми соединениями подвергается действию равных сил 
P, каждая из которых направлена от центра 0. Все линии идентичны. Найти радиаль-
ное перемещение в типичном узле. 

Дано: 

r = 120 in. 

L = 120 in. 
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A = 10 in.2 

P = 3000 lb 

E = 30E6 psi 

Советы по моделированию: 

Поскольку в задаче присутствует циклическая симметрия и радиальные перемещения 
во всех шести узлах будут одинаковы, можно выполнить расчет только для одного 
элемента, если ввести зависимость для радиальной степени свободы в цилиндриче-
ской координатной системе. 

Сравнение результатов: 

Радиальные перемещения = 2PL/AE = (3000)(120)/(10)(30E6) = 0.0012 in. 
 Радиальные  

перемещения 
Теория 0.0012 in. 
COSMOS/M  0.0012 in. 

 

Рис. S63-1 

S64A, S64B: Циклическая симметрия  
Тип: 

Статический расчет, циклическая симметрия, 3-узловые треугольные элементы 
(TRIANG). 

Литература: 

Cook, Robert D., "Concepts and Applications of Finite Element Analysis." 2nd Edition, John 
Wiley & Sons, New York, 1981. 

Задача: 
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К плите шестиугольной формы приложены радиальные силы, как показано на рисун-
ке. Рассчитать деформации конструкции в точках приложения нагрузки. Плита рас-
сматривается как задача на плоские напряжения и моделируется 3-узловыми плоски-
ми элементами. 

Дано: 

R = 10 in. 

t = 1 in. 

P = 3000 lb 

E = 30E6 psi 

Советы по моделированию: 

Плита составляется из 6 подконструкций, повернутых на 60 градусов относительно 
друг друга. Для расчета можно использовать одну подконструкцию, поскольку в за-
даче присутствует циклическая симметрия. Заметьте, что в подконструкции переме-
щения по радиальному направлению в узлах вдоль линий A-A и B-B должны совпа-
дать. То есть для этих узлов необходимо ввести зависимости в цилиндрической 
координатной системе. Все степени свободы по касательному направлению должны 
быть зафиксированы. 

Сравнение результатов: 

Расчет выполняется для полной конструкции и для подконструкции, для которой были 
введены зависимости узловых перемещений. 
Перемещения в точке A  X-компонент Y-компонент 
Полная модель (S64A) - 9.445E-5 - 1.636E-4 
Подконструкция (S64B)  - 9.450E-5 - 1.637E-4 

 

Рис. S64-1 
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S65: Взаимодействие жидкости и тел, вращение бака с жидкостью  
Тип: 

Статический расчет, осесимметричные элементы тел (PLANE2D) и жидкости 
(PLANE2D). 

Литература: 

S. Timoshenko and S. Woinowsky-Kreiger, "Theory of Plates and Shells," 2nd Edition, 
McGraw Hill, New York, 1959, pp. 485-487. 

Задача: 

Большой цилиндрический бак наполнен несжимаемой жидкостью. Бак вращается с 
постоянной скоростью вокруг совей вертикальной оси. Найти отклонения стенки ба-
ка и поперечные напряжения внизу стенки бака. 

Дано: 

r = 48 in. 

h = 20 in. 

t = 1 in. 

Жидкость: 

ρ = 0.9345E-4 lb-sec2/in.4 

b = 30E4 psi 

Бак: 

E = 3E7 psi 

υ = 0.3 

ω = 1 rad/sec 

g = 386.4 in./sec2 

где 

b = модуль массы  

g = ускорение свободного падения  

ρ = плотность 

E = модуль Юнга 
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υ = отношение Пуассона 

Примечание: 

Для моделирования взаимодействия жидкости и стенки бака необходимо использовать 
команды задания зависимых точек (CP), чтобы по направлению, нормальному по-
верхности взаимодействия условия совместимости выполнялись; по касательному 
направлению к жидкости и стенке бака никакие ограничения не прикладываются. 

Аналитическое решение: 

1. Отклонение w(y): 

 

2. Концевой момент M0: 

 

3. Концевая сила Q0: 

 

Сравнение результатов: 

Таблица 1 

  Deflection in x-direction (10-6 in.) 
Y (in.) Point Теория COSMOS/M 

20 A 7.381 8.269 
16 B 19.544 18.854 
12 C 27.805 26.870 
8 D 27.161 26.578 
4 E 13.604 13.700 
0 F 0 0 

Таблица 2 

 Теория COSMOS/M 
σyy, (max), psi  52.24 40.34 
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Q0, lb./in.  3.76 3.20 

 

Рис. S65-1 

S66: Взаимодействие жидкости с телом, ускорение  бака с жидко-
стью  
Тип: 

Статический расчет, плоские элементы (PLANE2D) и плоские элементы жидкости 
(PLANE2D). 

Литература: 

Timoshenko, S. P., and Gere, James M., "Mechanics of Materials," McGraw Hill, New 
York, 1971, pp. 167-211. 

Задача: 

Большой прямоугольный бак заполнен несжимаемой жидкостью. Баку сообщено по-
стоянное ускорение, направленное вправо, как показано на рисунке. Найти отклоне-
ние стенок бака и изгибающие и поперечные напряжения внизу стенки бака. 

Дано: 

b = 48 in. 

h = 20 in. 

t = 1 in. 

Жидкость: 

ρ = 9345E-4 lb-sec2/in.4 

b = 30E4 psi 
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Бак: 

E = 3E7 psi 

υ = 0.3 

a= 45 in./sec2 

g = 386.4 in./sec2 

где 

b = модуль массы  

g = ускорение свободного падения  

ρ = плотность 

E = модуль Юнга 

υ = отношение Пуассона 

Примечание: 

Для моделирования взаимодействия жидкости и стенки бака необходимо использовать 
команды задания зависимых точек (CP), чтобы по направлению, нормальному по-
верхности взаимодействия условия совместимости выполнялись; по касательному 
направлению к жидкости и стенке бака никакие ограничения не прикладываются. 

Аналитическое решение: 

1. Отклонения правой стенки WR(y) и левой стенки WL(y) 

 

2. Концевой момент M0 

 

3. End Shear Force V0 
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Сравнение результатов: 

Таблица 1 

Точка Y (in.) WR (in.) 
Теория 

WR (in.)  
COSMOS/M 

WL (in.) 
Теория 

WL (in.)  
COSMOS/M 

A 20 2.137E-3 2.150E-3 6.667E-4 6.761E-4 
B 16 1.591E-3 1.602E-3 5.120E-4 5.193E-4 
C 12 1.054E-3 1.062E-3 3.552E-4 3.605E-4 
D 8 5.564E-4 5.619E-4 1.989E-4 2.024E-4 
E 4 1.662E-4 1.689E-5 6.348E-4 6.512E-5 
F 0 0 0 0 0 

Table 2 

 Теория COSMOS/M 
σyy, (max), psi (y = 0)  410.02 386.39 
V0, lb./in. (y = 0)  9.24 8.84 

 

Рис. S66-1 

S67: Тест МакНила-Хардера  
Тип: 

Статический расчет, 8-узловой четырехугольный p-элемент PLANE2D в режиме пло-
ских напряжений со степенью полинома, равной 5. 

Задача: 

Вычислить максимальное отклонение консольной балки, если в свободном конце при-
ложена сосредоточенная сила. 

Дано: 

Геометрические свойства: 



 378

h = 0.2 in. 

t = 0.1 in. 

L = 6 in.  

I = 2/3 x 10-4 in. 4 

Свойства материала: 

E = 1 x 107 psi 

υ = 0.3 

Нагрузка: 

P = 1 lb 

Сравнение результатов: 
 Теория COSMOS/M (PORD = 5) 
Перемещения 
свободного конца  

0.1081 in. 0.10807 

 

Рис. S67-1 

S68: Расчет квадратной плиты с отверстием p-методом  
Тип: 

Статический расчет, плоские квадратные (8-узловые PLANE2D) и треугольные (6-
узловые TRIANG) p-элементы со степенью полинома, равной 5. 

Задача: 

Вычислить максимальное напряжение в плите с круглым отверстием, подвергающейся 
действию равномерно распределенной растягивающей нагрузки. 

Дано: 

Геометрические свойства: 

L = 12 in. 
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d = 1 in. 

t = 1 in. 

Свойства материала: 

E = 30 x 106 psi 

υ = 0.3 

Нагрузка: 

p = 1000 psi 

Сравнение результатов: 
 Теория COSMOS/M (PORD = 5) 
Макс. напряжение по оси X  3018 3058 psi 

 

Рис. S68-1 

S69: Расчет эллиптической мембраны под давлением p-методом  
Тип: 

Статический расчет, плоский треугольный p-элемент (6-узловой TRIANG). 

Литература: 

Barlow, J., and Davis, G. A. O., "Selected FE Benchmarks in Structural and Thermal Analy-
sis," NAFEMS Rept. FEBSTA, Rev. 1, October, 1986, Test No. LG1. 

Задача: 

Вычислить напряжения в точке D эллиптической мембраны, подвергающейся дейст-
вию равномерно распределенной нагрузки, направленной наружу. 

Дано: 
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E = 210 x 103 MPa 

υ = 0.3 

t = 0.1 

p = 10 MPa 

Сравнение результатов: 
 σy, в точке D 
Теория 92.7 
COSMOS/M  92.6 

 

Рис. S69-1 

S70: Термальный расчет со свойствами материала, зависимыми 
от температуры  
Тип: 

Линейный расчет термальных напряжений, плоские элементы (PLANE2D). 

Задача: 

Плоская плита обладает различными свойствами материала. Найти отклонения и тер-
мальные напряжения, вызванные равномерным по всей модели увеличением темпе-
ратуры на 100° F и 200° F. 

Дано: 

t = 0.1 in. 

x = 0.00001 in./in./°F 

υ = 0 
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E = 30,000 ksi 

Сравнение результатов: 
 σx для всех элементов 

T = 100° F * 
σx для всех элементов 

T = 200° F 
Теория - 30 ksi - 48 ksi 
COSMOS/M  - 30 ksi - 48 ksi 
* Температура, используемая в файле исходных данных, соответствует T = 200° 
F. Необходимо удалить узловые температуры командой NTNDEL и приложить 
температуру 100° F командой NTND. 

 

Рис. S70-1 

S71: Слоистая балка с сосредоточенной нагрузкой  
Тип: 

Статический расчет, элементы составной оболочки (SHELL4L). 

Задача: 

Найти полное отклонение слоистой плиты, подвергающейся действию сосредоточен-
ной нагрузки. 

Дано: 

Et = 7000 n/mm2 

t = 3 mm 

L = 1000 mm 
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Ec = 20 N/mm2 

c = 25 mm 

b = 100 mm 

Gc = 5 N/mm2 

d = 28 mm 

W = 250 N 

Аналитическое решение: 

D = ETbt3/6 + ETbtd2/2 + ECbc3/12 = 8.28 X 106 N·mm 

δ = WL3/48D + WLc/4bd2G = 6.2902 + 3.986 = 10.276 mm 

Сравнение результатов: 
 Отклонение в центре (mm) 
Теория 10.276 
COSMOS/M  10.323 

 

Рис. S71-1 

S74: Тест плиты с постоянными напряжениями  
Тип: 

Статический расчет, четырехгранные элементы (TETRA4, TETRA4R). 

Задача: 

Ограничьте перемещения в одном конце плиты и задайте вынужденные перемещения 
на другом, чтобы установилось состояние постоянных напряжений, причем σx = 
0.1667E5 и σy = σz = τxy = τyz = τzx = 0. 

Выполните расчет. 

Дано: 

Ex = 1E8 

υ = 0.25 
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δx = 0.4E-2 

t = 0.024 

a = 0.12 

b = 0.24 

Результаты: 

Все элементы выдерживают тест. Значения узловых перемещений показывают, что σx 
= 0.1667E5 и σy = σz = τxy = τyz = τzx =  0. 

 

Рис. S74-1 

S75: Расчет консольной балки с зазорами при различных услови-
ях нагружения  
Тип: 

Линейный статический расчет, элементы балки и зазора (BEAM2D, GAP). 

Задача: 

Балка моделируется с использованием элементов BEAM2D. Используются 5 элемен-
тов GAP с нулевыми величинами зазора. Были заданы два варианта нагрузки, после 
чего был выполнен расчет. 

Дано: 

Ebeam = 30 x 106 psi 

b = 1.2 in. 

h = 10 in. 

L1 = 100 in. 
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L2 = 50 in. 

Сравнение результатов: 

Состояние деформации зазоров для каждого варианта нагрузки соответствует дефор-
мациям балки для соответствующего варианта нагрузки. Результаты можно сравнить 
с результатами, полученными при линейном статическом расчете модели, в которой 
элементы GAP убраны, а узлы, соединенные с закрытыми зазорами, зафиксированы. 

Полученные результаты: 
  Силы в зазорах  
Приложены 

силы 
Вариант 
нагрузки GAP 1 GAP 2 GAP 3 GAP 4 GAP 5 

Fa = - 1000 
Fc = - 2000 1 - 361.84 - 1197.4 - 842.11 0 0 

Fa = - 1000 
Fb = - 1000 2 - 1206.3 - 275.0 0 0 0 

 

Рис. S75-1 

S76: Балка, лежащая на опорах, подвергающаяся действию рас-
пределенной нагрузки от жесткого параболического поршня  
Тип: 

Линейный статический расчет, балочные, плоские элементы и элементы зазора 
(BEAM2D, PLANE2D, TRUSS2D и GAP). 

Задача: 

Форма поршня была смоделирована с помощью элементов GAP с различными вели-
чинами зазоров. Чтобы избежать единичной матрицы жесткости, были введены два 
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мягких стержня, поддерживающие поршень. Расчет выполнялся с двумя различными 
значениями распределенной нагрузки. 

Дано: 

Величины зазоров: 

g1 = g7 = 0.027 in. 

g2 = g6 = 0.001 in. 

g3 = g5 = 0.008 in. 

g4 = 0 in. 

h= 10 in. 

b = 1.2 in. 

k = 1 lb/in. 

E = 30 x 106 psi 

Вариант нагрузки 1: P = 52.5 psi 

Вариант нагрузки 2: P = 90.8 psi 

Сравнение результатов: 

Силы в зазорах совпадали с полной силой, приложенной к поршню. Деформации бал-
ки для каждого варианта нагрузки соответствовала силам и положению закрытых за-
зоров для этого варианта нагрузки. 

Полученные результаты: 
Силы в зазорах (lb)  

Число закрытых 
зазоров Нагрузка Силы Сумма Сумма 

(Теория) 

4 p = 52.5 

215.5 
215.5 

1668.0 
1668.0 

3767 3780 

2 p = 90.8 3259.0 
3259.0 6518 6540 
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Рис. S76-1 

S77: Изгиб балки с вводом матрицы материала  
Тип: 

Статический расчет, непосредственный ввод свойства материала, шестигранные объ-
емные элементы (SOLID). 

Литература: 

Roark, R.J. "Formulas for Stress and Strain", 4th Edition, McGraw-Hill Book Co., New 
York, 1965, pp. 104-106. 

Задача: 

Балка длиной L, шириной b и высотой h закреплена в одном конце, в другом приложе-
на поперечная сила F. Найти отклонения в свободном конце. 

Дано: 

L = 10 in 

E = 30E6 psi 

b = 1 in. 

υ = 0.3 
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h = 2 in. 

F = 300 lb 

Советы по моделированию: 

Вместо указания упругих свойств материала E и υ здесь используется непосредствен-
ный ввод ненулевых членов матрицы упругости [D],  показанной ниже. 

 

Сравнение результатов: 

Перемещения в свободном конце по направлению Z, полученные при задании E и 
υ, сравниваются с полученными при непосредственном вводе матрицы жесткости 
[D]. 

 E и υ Непосредственный ввод 
матрицы 

Теория 0.005 0.005 
COSMOS/M  0.00496 0.00496 

 

Рис. S77-1 

S78: Расчет квадратной плиты с отверстием адаптивным p-
методом  
Тип: 

Адаптивный p-метод, плоский треугольный p-элемент (TRIANG). 

Задача: 

Вычислит максимальное напряжение в плите с круглым отверстием, подвергающейся 
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действию равномерно распределенной нагрузки. 

Дано: 

Геометрические свойства: 

L = 200 in 

d = 20 in 

E = 30 x 106 psi 

t = 1 in 

Нагрузка: 

p = 1 psi 

Сравнение результатов: 

Узлов: 33, элементов: 12, допустимая ошибка локальных перемещений: 5%. 
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1 1 1 16 1.692 3.468 1.586 -- 22 
2 2 2 56 1.701 3.480 2.418 29.544 16 
3 2 3 85 1.704 3.489 2.692 12.844 8 
4 2 4 100 1.704 3.490 2.817 1.083 0 

Теория 4 4 133 1.706 3.502 2.994   

 

Рис. S78-1 
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Рис. S78-2 

S79: Сферическая оболочка, подвергающаяся действию момента  
Тип: 

Статический линейный расчет, элементы осесимметричной оболочки (SHELLAX). 

Литература: 

Zienkiewicz, O. C., "The Finite Element Method," 3rd Edition, McGraw Hill Book Co., p 
362. 

Задача: 

Найти радиальные перемещения сферической оболочки, подвергающейся действию 
момента, приложенного на свободном крае. 

 

Рис. S79-1 
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Дано: 

R = 100 in. 

υ(NUXY) = 0.33 

r = 50 in. 

t = 2 in. 

E = 1E7 psi 

M = l in.-lb/in. 

Советы по моделированию: 

Необходимо учитывать, что нагрузка, прикладываемая к узлу, должна задаваться из 
расчета на один радиан, в данном случае �50 in.-lb/rad. 

 (Mt = Mx·Arcx = Mx·Rx·ψ = 1(50)·(1) rad = 50) 

где 

ψ = горизонтальный угол  

Сравнение результатов: 
 Радиальные перемещения в узле 31 
Теория 1.58E-5 in. 
COSMOS/M  1.589E-5 in. 

S80: Осесимметричная гиперболическая оболочка, подвергаю-
щаяся действию косинусной гармонической нагрузки  
Тип: 

Статический линейный расчет, элементы осесимметричной оболочки (SHELLAX). 

Литература: 

NAFEMS, BranchMark Magazine, November, 1988. 

Задача: 

Найти напряжения в осесимметричной гиперболической оболочки, подвергающейся 
действию нагрузки F = cos2φ, приложенной к внешней стороне, y = 1. 
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Рис. S80-1 

Дано: 

R1 = 1 m 

H = 1 m 

tan φ = 2(-1/2) 

R2 = 2(1/2) m 

E = 210E3 MPa 

υ(NUXY) = 0.3 

Thickness = 0.01 

Советы по моделированию: 

Поскольку задача симметрична, расчет выполняется только для половины модели. Ко-
синусная нагрузка будет разложена на компоненты по осям x и y. 

Сравнение результатов: 

Результаты, приведенные в таблице, соответствуют компоненту напряжений NXZ для 
элемента 1. 

 Поперечные напряжения 
(y = 0, φ = 45°) 

Теория 81.65 MPa 
COSMOS/M  79.63 MPa 

S81: Круглая плита, подвергающаяся действию неосесимметрич-
ной нагрузки  
Тип: 
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Статический линейный расчет, элементы осесимметричной оболочки с неосесиммет-
ричной нагрузкой (SHELLAX). 

Задача: 

Для сравнения используются элементы SHELL4. 

 Круглая плита с внутренним и внешним радиусами 3 in. и 10 in., соответственно, под-
вергается действию неосесимметричной нагрузки, действующей на интервале θ =        
-54° до θ = 54° перпендикулярно поверхности плиты. Величина нагрузки изменяется 
по формуле: 

F (θ) = 5.31 [1 + cos(10 θ/3)]*103 

 

Рис. S81-1 

Дано: 

Ri = 3 in. 

R0 = 10 in. 

E = 3E7 psi 

t = 1 in. 

υ(NUXY) = 0.3 

Советы по моделированию: 

В данном примере используется семь элементов. Поскольку нагрузка симметрична от-
носительно оси x, она будет задана только на интервале между θ = 0° и θ = 54° с ин-
тервалом 3° с использованием четных (косинусных) членов ряда Фурье. Учитывают-
ся только первые шесть косинусных членов ряда. 

Сравнение результатов: 
 Перемещения по направлению оси на внешнем крае (θ = 180°) 
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SHELLAX  5.80 x 10-4 in. 
SHELL4  5.62 x 10-4 in. 

S82: Кручение длинного стержня  
Тип: 

Статический расчет, элемент PLANE2D с несимметричной нагрузкой. 

Литература: 

Timoshenko, S., "Strength of Materials," 3rd Edition, D. Van Nostrand Co., Inc., New York, 
1956. 

Задача: 

Длинный круглый стержень закреплен в одном конце и подвергается действию кру-
тящего момента в другом конце. Найти максимальное поперечное напряжение τmax в 
стенке, вызванное  моментом. 

 

Рис. S82-1 

Дано: 

E = 30E6 psi 

L = 24 in. 

d = 1 in. 

M = -200 in.-lb 

Советы по моделированию: 
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Поскольку модель обладает освой симметрией относительно оси y, для расчета будет 
использоваться КЭ-модель, показанная а рисунке. Действие приложенного момента 
представлено через касательные силы, приложенные по окружности стержня. 

 

Рис. S82-2 

Аналитическое решение: 

 

Нагрузка приложена в узле 63 по направлению z (касательное). Ограничения на ком-
понент перемещений UX в стенке (радиальное направление) не накладываются, что-
бы допустить свободные деформации поперечного сечения, которые соответствуют 
предположению «пренебрежимых поперечных» (negligible shear), приведенному в 
литературе. 

Сравнение результатов: 

В зажатом конце (узел 3) 
 Max Shear Stress (psi) τ13 
Теория 1018.4 
COSMOS/M  1018.4 

S83: Изгиб длинного стержня  
Тип: 

Статический расчет, элемент PLANE2D с несимметричной нагрузкой. 

Литература: 



 395

Timoshenko, S., "Strength of Materials," 3rd Edition, D. Van Nostrand Co., Inc., New York, 
1956. 

Задача: 

Длинный круглый стержень закреплен в одном конце, в другом конце приложена вер-
тикальная сила. Найти максимальное продольное напряжение σy в стенке, вызванное 
силой.  

 

Рис. S83-1 

Дано: 

E = 30E6 psi 

L = 24 in. 

d = 1 in. 

F = -25 lb 

Советы по моделированию: 

Поскольку модель обладает освой симметрией относительно оси y, для расчета будет 
использоваться КЭ-модель, показанная а рисунке. Сила, прикладываемая в узле 63, 
вычисляется  через синусный ряд Фурье. 
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Рис. S83-2 

Аналитическое решение: 

 

Нагрузка приложена по направлению z (касательное). Ограничения на компонент пе-
ремещений UX в стенке (радиальное направление) не накладываются, чтобы допус-
тить свободные деформации поперечного сечения, которые соответствуют предпо-
ложению «пренебрежимых поперечных» (negligible shear), приведенному в 
литературе. 

Сравнение результатов: 

В элементе 1 и φ = 90° 
 Макс. продольное на-

пряжение (σy psi) 
y = 0 (узел 3) 

Макс. продольное на-
пряжение (σy psi) 
y = 1 in. (узел 5) 

Теория 6111.6 5856.9 
COSMOS/M  6115.1 5856.8 

S84: Использование подмоделей при расчете плиты  
Тип: 

Статический расчет, элементы TRIANG, подмоделирование. 

Задача: 

Вычислить максимальное напряжение по фон Мизесу в плите, подвергающейся дейст-
вию сосредоточенной силы, приложенной в одном из углов. Сравнить результаты, 
полученные при использовании частой КЭ-сети, грубой КЭ-сети и грубой КЭ-сети с 
подмоделированием. 
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Дано: 

a = 25 in. 

E = 30 E6 psi 

b = 25 in. 

t = 0.1 in. 

Fx = Fy = 1000 lbs 

 

Рис. S84-1 

Сравнение результатов: 
Тип  КЭ-сети Макс. отклонение в узле 1 Макс. напряжение 
Грубая 0.00131 3810 
Грубая + подмоделирование 0.00156 7626 
Частая и Теория 0.00156 7620 

S85: Плита на упругом основании  
Тип: 

Статический расчет, элементы SHELL4 на упругом основании. 

Задача: 

Плита, лежащая на упругом основании, подвергается действию равномерно распреде-
ленной нагрузки P. Для малой жесткости (flexural rigidity) вычисленная распределен-
ная нагрузка, приложенная к плите от основания, приближается к приложенной 
внешней нагрузке. Жесткость (flexural rigidity) уменьшается с уменьшением Толины 
и модуля упругости. 

Дано: 

E = 30 x 10 psi 

υ = 0.3 
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h = 0.01 in 

a = 10 in. 

b = 10 in. 

P = 10 psi 

 

Рис. S85-1 

Сравнение результатов: 
 Нагрузка от основания на элемент 200 
Теория -10.0 
COSMOS/M  -10.0 

Примечание: 

Нагрузка от основания записывается в файл вывода для каждого элемента в последнем 
столбце напряжений в элементах. 

S86: Плита с зависимыми степенями свободы  
Тип: 

Статический расчет, элемент PLANE2D, зависимые степени свободы. 

Задача: 

Найти перемещения плиты, показанной на рисунке, причем перемещения по направ-
лению Y зависимы в узлах 5, 10 и 15. 

Дано: 

EX = 3.0E10, 3.0E09 и 3.0E8 psi 

υ = 0.25 
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Рис. S86-1 

Сравнение результатов: 

Перемещения для зависимых степеней свободы. 
 Модуль 

Юнга 
U5 (перемещение 
по оси Y в узле 5) 

U10 (перемещение 
по оси Y в узле 10) 

U15 (перемещение 
по оси Y в узле 15) 

U10/U5 

Теория 
COSMOS/M  

3.0E10 5.33333E-7 
5.33333E-7 

5.33333E-7 
5.33333E-7 

5.33333E-7 
5.33333E-7 

1.000 
1.000 

Теория 
COSMOS/M  

3.0E09 5.33333E-6 
5.33333E-6 

5.33333E-6 
5.33333E-6 

5.33333E-6 
5.33333E-6 

1.000 
1.000 

Теория 
COSMOS/M  

3.0E08 5.33333E-5 
5.33333E-5 

5.33333E-5 
5.33333E-5 

5.33333E-5 
5.33333E-5 

1.000 
1.000 

Аналитическое решение: 

U10 = U5 = FL/AE 

S87: Гравитационная нагрузка на элемент ELBOW  
Тип: 

Линейный статический расчет, элемент ELBOW, гравитационная нагрузка. 

Задача: 

Вариант A: Уменьшенная гравитационная нагрузка (не учитываются моменты с за-
фиксированном конце) 

Вариант B: Совместимая гравитационная нагрузка (моменты в зафиксированном кон-
це учитываются) 

Дано: 

g = -32.2 in./sec2 

EX = 3.0E7 psi 
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ρ = 7.82 

Толщина стенки = 0.1 in. 

Внешний диаметр = 1.0 in. 

Радиус кривизны = 10.0 in. 

 

Рис. S87-1 

Сравнение результатов: 
 Перемещение по оси Y в узле 51 
Case A  -7.42E-3 
Case B  -6.41E-3 
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Частотный (модальный) расчет  
F1:Собственные частоты системы из пружины и двух масс  
Тип: 

Расчет частот и форм мод, элементы стержня и массы (TRUSS3D, MASS). 

Литература: 

Thomson, W. T., "Vibration Theory and Application," Prentice-Hall, Inc., Englewood Cliffs, 
New Jersey, 2nd printing, 1965, p. 163. 

Задача: 

Найти нормальные моды и собственные частоты системы, показанной на рисунке, при 
данных значениях массы и жесткости пружин. 

Дано: 

m2 = 2m1 = 1 lb-sec2/in. 

k2 = k1 = 200 lb/in. 

kc = 4k1 = 800 lb/in. 

Советы по моделированию: 

В качестве пружин используются стержневые элементы с нулевой плотностью. В уз-
лах 2 и 3 заданы две динамические степени свободы; массы задаются как сосредото-
ченные массы в тех же узлах. 

Сравнение результатов: 
 F1, hz F2, hz 
Теория 2.581 8.326 
COSMOS/M  2.581 8.326 
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Рис. F1-1 

F2: Частоты консольной балки  
Тип: 

Расчет частот и форм мод, плоский элемент (PLANE2D). 

Литература: 

Flugge, W., "Handbook of Engineering Mechanics," McGraw-Hill Book Co.,Inc., New 
York, 1962, pp. 61-6, 61-9. 

Задача: 

Найти основную частоту f консольной балки с поперечным сечением A. 

Дано: 

E = 30 x 106 psi 

L = 50 in. 

h = 0.9 in. 

b = 0.9 in. 

A = 0.81 in.2 

υ = 0 

ρ = 0.734E-3 lb sec2/in.4 

Сравнение результатов: 
 F1, Hz F2, Hz F3, Hz 
Теория 11.79 74.47 208.54 
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COSMOS/M  11.72 73.29 205.81 

 

Рис. F2-1 

F3: Частоты балки, лежащей на опорах  
Тип: 

Расчет частот и форм мод, балочный элемент (BEAM3D). 

Литература: 

Thomson, W. T., "Vibration Theory and Applications," Prentice-Hall, Inc., Englewood 
Cliffs, New Jersey, 2nd printing, 1965, p. 18. 

Задача: 

Найти основную частоту f балки с поперечным сечением A, лежащей на опорах. 

Дано: 

E = 30 x 106 psi 

L = 80 in. 

ρ = 0.7272E-3 lb.-sec2/in.4 

A = 4 in.2 

I = 1.3333 in.4 

h = 2 in. 

Аналитическое решение: 

Fi = (iπ)2 (EI//mL4)(1/2) 
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i = номер частоты 

Сравнение результатов: 
 F1, Hz F2, Hz F3, Hz 
Теория 28.78 115.12 259.0 
COSMOS/M  28.78 114.31 242.7 

 

Рис. F3-1 

F4: Собственные частоты консольной балки  
Тип: 

Расчет частот и форм мод, балочный элемент (BEAM3D). 

Литература: 

Thomson, W. T., "Vibration Theory and Applications," Prentice-Hall, Inc., Englewood 
Cliffs, New Jersey, 2nd printing, 1965, p. 278, Ex. 8.5-1, and p. 357. 

Задача: 

Найти первые три собственные частоты f консольной балки. 

Дано: 

E = 30 x 106 psi 

I = 1.3333 in.4 

A = 4 in.2 

h = 2 in. 

L = 80 in. 

ρ = 0.72723E-3 lb. sec2/in.4 
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Сравнение результатов: 
 F1, Hz F2, Hz F3, Hz 
Теория 10.25 64.25 179.9 
COSMOS/M  10.24 63.95 178.5 

 

Рис. F4-1 

F5: Частоты консольной балки с сосредоточенной массой  
Тип: 

Расчет частот и форм мод, элементы балки и массы (BEAM3D, MASS). 

Литература: 

William, W. Seto, "Theory and Problems of Mechanical Vibrations," Schaum's Outline Se-
ries, McGraw-Hill Book Co., Inc., New York, 1964, p. 7. 

Задача: 

Стальная консольная балка длиной 10 in. имеет квадратное поперечное сечение 1/4 x 
1/4 in. В свободном конце приложен вес 10 lbs.. Найти собственные частоты системы, 
если массу переместить на небольшое расстояние и отпустить. 

Дано: 

E = 30 x 106 psi 

W = 10 lb. 

L = 10 in. 

Сравнение результатов: 
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 F, Hz 
Теория 5.355 
COSMOS/M  5.359 

 

Рис. F5-1 

F6: Динамический расчет трехмерной конструкции  
Тип: 

Расчет частот и форм мод, элементы трубы и массы (PIPE, MASS). 

Литература: 

"ASME Pressure Vessel and Piping 1972 Computer Programs Verification," Ed. by I. S. 
Tuba and W. B. Wright, ASME Publication I-24, Problem 1. 

Задача: 

Найти собственные частоты и формы мод трехмерной конструкции, приведенной ни-
же. 

Дано: 

Каждое звено является трубой. 

Внешний диаметр = 2.375 in. 

Толщина = 0.154 in. 

E = 27.9 x 106 psi 

υ = 0.3 

Массы представлены сосредоточенными массами, как показано на рисунке. 
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M1 = M2 =M4 = M6 = M7 = M8 = M9 = M11 = M13 = M14 = 0.00894223 lb. sec2/in. 

M3 = M5 = M10 = M12 = 0.0253816 lb. sec2/in. 

Сравнение результатов: 
 F1, Hz F2, Hz F3, Hz F4, Hz F5, Hz 
Теория 111.5 115.9 137.6 218.0 404.2 
COSMOS/M  111.2 115.8 137.1 215.7 404.2 

 

Рис. F6-1 

F7: Динамический расчет плиты, лежащей на опорах  
Тип: 

Расчет частот и форм мод, элемент оболочки (SHELL4). 

Литература: 

Leissa, A.W. "Vibration of Plates," NASA, sp-160, p. 44. 

Задача: 

Найти первую собственную частоту плиты, лежащей на опорах. 

Дано: 

E = 30,000 kips 

υ= 0.3 

h = 1 in. 
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a = b = 40 in. 

ρ = 0.003 kips sec2/in.4 

Примечание: 

Поскольку и задача, и требуемая форма моды обладают двойной симметрией, расчет  
выполняется для четверти модели. 

Сравнение результатов: 
 F, Hz 
Теория 5.94 
COSMOS/M  5.93 

 

Рис. F7-1 

F8: Зажатая круглая плита  
Тип: 

Расчет частот и форм мод, элемент толстостенной оболочки (SHELL3T). 

Литература: 

Leissa A.W., "Vibration of Plates," NASA sp-160, p. 8. 

Задача: 

Найти первые три собственные частоты. 

Дано: 

E = 30 x 106 psi 

υ = 0.3 

ρ = 0.00073 (lb/in4) sec2 
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R = 40 in. 

t = 1 

Примечание: 

Поскольку для расчета используется четверть модели, вторая собственная частота не-
симметрична (s = 0, n = 1) и не будет вычислена. Данный пример показывает, что 
симметрию следует использовать осторожно. 

Сравнение результатов: 
Частота s * n * Теория (Hz) COSMOS/M (Hz) 

1 0 0 62.30 62.39 
2 0 2 212.60 212.415 
3 1 0 242.75 240.28 

* s � число узловых окружностей, n � число узловых диаметров. 

 

Рис. F8-1 

F9: Частоты цилиндрической оболочки  
Тип: 

Расчет частот и форм мод, элемент оболочки (SHELL4). 

Литература: 

Kraus, "Thin Elastic Shells," John Wiley & Sons, Inc., p. 307. 

Задача: 

Найти первые три собственные частоты. 

Дано: 

E = 30 x 106 psi 
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υ = 0.3 

ρ = 0.00073 (lb-sec2) /in.4 

L = 12 in. 

R = 3 in. 

t = 0.01 in. 

Примечание: 

Поскольку геометрия и формы мод первых трех собственных частот, для расчета ис-
пользуется 1/8 цилиндра. 

Сравнение результатов: 
 F1, Hz F2, Hz F3, Hz 
Теория 552 736 783 
COSMOS/M  553.69 718.50 795.60 

 

Рис. F9-1 

F10: Симметричные моды и собственные частоты кольца  
Тип: 

Расчет частот и форм мод, элементы оболочки (SHELL4). 

Литература: 

Flugge, W. "Handbook of Engineering Mechanics," First Edition, McGraw-Hill, New York, 
p. 61-19. 

Задача: 

Найти первые две собственные частоты кольца. 
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Дано: 

E = 30E6 psi 

υ = 0 

L = 4 in. 

h = 1 in. 

R = 1 in. 

ρ = 0.25E-2 (lb sec2)/in.4 

Сравнение результатов: 
 F1, Hz F2, Hz 
Теория 135.05 134.92 
COSMOS/M  134.92 723.94 

 

Рис. F10-1 

F11A, F11B: Собственные значения треугольного крыла  
Тип: 

Расчет частот и форм мод, треугольные элементы оболочки (SHELL3 и SHELL6). 

Литература: 

"ASME Pressure Vessel and Piping 1972 Computer Programs Verification," ed. by I. S. 
Tuba and W. B. Wright, ASME Publication I-24, Problem 2. 

Задача: 

Вычислить собственные частоты треугольного крыла, показанного на рисунке. 
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Дано: 

E = 6.5 x 106 psi 

υ = 0.3541 

ρ = 0.166E-3 lb. sec2/in.4 

L = 6 in. 

Толщина = 0.034 in. 

Сравнение результатов: 

Собственные частоты (Hz): 
Частота Теория COSMOS/M 

SHELL3 
COSMOS/M 

SHELL6 
1 55.9 55.8 56.106 
2 210.9 206.5 211.93 
3 293.5 285.5 297.73 

 

Рис. F11-1 

F12: Вибрации балки без опор  
Тип: 

Расчет частот и форм мод, моды жесткого тела, балочные элементы (BEAM3D). 

Литература: 

Timoshenko, S. P., Young, O. H., and Weaver, W., "Vibration Problems in Engineering," 
4th ed., John Wiley and Sons, New York, 1974, pp. 424-425. 

Задача: 

Найти моды вибрации упругого и жесткого тела балки без опор, показанной на рисун-
ке. 
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Дано: 

L = 100 in. 

E = 1 x 108 psi 

r = 0.1 in. 

ρ = 0.2588E-3 lb. sec2/in.4 

Аналитическое решение: 

Аналитическое решение получается из корней уравнения Cos KL Cosh KL = 1, частоты 
находятся по формуле: 

fi = Ki2 (EI/ρA)(1/2)/(2π) 

i = номер собственной частоты  

Ki = (i + 0.5) π/L 

A = площадь поперечного сечения  

ρ = плотность  

Сравнение результатов: 
 Мода 1 Мода 2 Мода 3 Мода 4 Мода 5 Мода 6 
Теория F, Hz  0 0 11.07 30.51 59.81 98.86 
Теория (ki)  (0) (0) (4.73) (7.853) (10.996) (14.137) 
COSMOS/M F, Hz  0 0 10.92 29.82 57.94 94.94 

Примечание: 

Первые две моды являются модами жесткого тела. 

 

Рис. F12-1 

F13: Частоты консольной балки  
Тип: 
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Расчет частот и форм мод, шестигранные объемные элементы (SOLID). 

Литература: 

Thomson, W. T., "Vibration Theory and Applications," Prentice-Hall, Inc., Englewood 
Cliffs, N. J., 2nd printing, 1965, p.275, Ex. 8.5-1, and p. 357. 

Задача: 

Найти первые три собственные частоты консольной балки. 

Дано: 

E = 30 x 106 psi 

a = 2 in. 

b = 2 in. 

L = 80 in. 

ρ = 0.00072723 lb.-sec.2/in.4 

Сравнение результатов: 
 F1, Hz F2, Hz F3, Hz 
Теория 10.25 64.25 179.91 
COSMOS/M  10.24 63.94 178.38 

 

Рис. F13-1 

F14: Собственные частоты жидкости  
Тип: 

Расчет частот и форм мод, стержневые элементы (TRUSS2D). 

Литература: 
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William,W.Seto,"Theory and Problems of MechanicalVibrations,"Schaum's Outline Series, 
McGraw-Hill Book Co., Inc., New York, 1964, p. 7. 

Задача: 

Манометр, используемый в лаборатории, имеет трубку постоянного сечения A. Найти 
собственные частоты, если столб жидкости с плотностью ρ длиной L приходит в дви-
жение. 

Дано: 

A = 1 in.2 

ρ = 9.614E-5 lb. sec2/in.4 

L = 51.4159 in. 

E = 1E5 psi 

Примечание: 

Масса жидкости сосредоточена в узлах с 2 по 28. Граничные элементы приложены к 
узлам с 6 по 24. 

Сравнение результатов: 
 F, Hz 
Теория 0.617 
COSMOS/M  0.617 

 

Рис. F14-1 

F16A: Вибрации зажатого клина  
Тип: 

Расчет частот и форм мод, элементы толстостенной оболочки (SHELL3T, SHELL4T). 
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Литература: 

Timoshenko, S., and Young, D. H., "Vibration Problems in Engineering," 3rd Edition, D. 
Van Nostrand Co., Inc., New York, 1955, p. 392. 

Задача: 

Найти основную частоту боковой вибрации клиновидной плиты. Плита имеет посто-
янную толщину t, размер основания 2b, и длину L. 

Дано: 

E = 30 x106 psi 

ρ = 7.28E-4 lb. sec2/in.4 

t = 1 in. 

b = 2 in. 

L = 16 in. 

Советы по моделированию: 

Рассматриваются только плоскостные (в плоскости xy) частоты по направлению y. 
Чтобы получить более точные результаты, внеплоскостные перемещения (по направ-
лению z) запрещены.  

Также рассматривается эффект от использования различных элементов и КЭ-сетей. 

Аналитическое решение: 

Первая плоскостная собственная частота вычисляется по формуле: 

 

Используя приближенный метод RITZ, получаем первую и вторую собственные час-
тоты: 

 

Сравнение результатов: 
 Частота (Hz)  

Первая 
Частота (Hz)  
Вторая 

Теория 
Точное решение 
Метод RITZ  

774.547 
775.130 

--- 
521.265 

COSMOS/M 
Частая сеть SHELL4T (F16B)  
Грубая сеть SHELL4T (F16A)  

789.12 
2309.5 

813.45 
2280.8 
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Рис. F16A-1 

F17: Боковые вибрации продольно нагруженного бруса  
Тип: 

Расчет частот и форм мод, плоскостные эффекты, балочные элементы (BEAM3D). 

Литература: 

Timoshenko, S., and Young, D. H., "Vibration Problems in Engineering," 3rd Edition, D. 
Van Nostrand Co., Inc., New York, 1955, p. 374. 

Задача: 

Найти основную частоту боковой вибрации бруса, показанного на рисунке. 

Дано: 

E = 30E6 psi 

ρ = 7.2792E-4 lb sec2/in.4 

g = 386 in./sec2 

b = h = 2 in. 

L = 80 in. 

P = 40,000 lb 

Сравнение результатов: 
 F1, Hz F2, Hz F3, Hz 
Теория 17.055 105.32 249.39 
COSMOS/M  17.055 105.32 249.34 
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Рис. F17-1 

F18: Прямоугольная плита, лежащая на опорах  
Тип: 

Расчет частот и форм мод, плоскостные эффекты, элементы оболочки (SHELL4). 

Литература: 

Leissa, A.W., "Vibration of Plates," NASA, p-160, p. 277. 

Задача: 

Найти основную частоту плиты, лежащей на опорах, с учетом плоскостных эффектов. 
В точках x = 0 и x = a приложена распределенная нагрузка Nx = 33.89 lb./in.. 

Дано: 

E = 30,000 psi 

υ = 0.3 

h = 1 in. 

a = b = 40 in. 

ρ = 0.0003 (lb sec2)/in.4 

P = 33.89 psi 

Примечание: 
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Поскольку геометрия, нагрузки и форма моды обладают двойной симметрией, расчет 
выполняется для четверти модели. 

Сравнение результатов: 
 F, Hz 
Теория 4.20 
COSMOS/M 4.19 

 

Рис. F18-1 

F19: Низшие частоты зажатой цилиндрической оболочки для 
гармоники №6 
Тип: 

Расчет частот и форм мод, элементы осесимметричной оболочки (SHELLAX). 

Литература: 

Leissa, A. W., "Vibration of Shells," NASA sp-288, p. 92-93 (1973). 

Задача: 

Найти низшую собственную частоту вибрации цилиндра, зафиксированного в обоих 
концах. 

Дано: 

R = 3 in. 

L = 12 in. 

t = 0.01 in. 

E = 30 x 106 psi 

υ = 0.35 
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ρ = 0.000730 lb. sec2/ in.4 

Диапазон гармоник (n) = от 4 до 7 

Советы по моделированию: 

Все узлы (21 узел) расположены на равных расстояниях. Необходимо указывать число 
гармоник для каждого частотного расчета. Ищется низшая гармоника. 

Сравнение результатов: 
Гармоника (n) Первая частота (Hz) 

Теория 
Первая частота (Hz) 

Эксперимент 
Первая частота (Hz) 

COSMOS/M 
(4) * 926 700 777.45 
(5) * 646 522 592.6 
(6) * 563 525 549.4 
(7) * 606 592 609.7 

* Необходимо каждый раз повторно выполнять расчет, указывая номер гармоники в команде 
A_FREQUENCY. Низшая частота �549.6 Hz, соответствующая гармонике № 6. 

 

Рис. F19-1 

F20A, F20B, F20C, F20D, F20E, F20F, F20G: Динамический расчет 
консольной балки  
Тип: 

Расчет частот и форм мод, 4- и 8-узловые элементы PLANE2D, элементы SHELL4T, 6-
узловые TRIANG, TETRA10, 8- и 20-узловые SOLID и элементы TETRA4R. 

Задача: 

Сравнить первые две собственные частоты консольной балки, смоделированной с ис-
пользованием различных элементов. 

Дано: 

E = 107 psi 
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ρ = 245 x 10-3 lb-sec2/in.4 

b = 0.1 in. 

h = 0.2 in. 

L = 6 in. 

n = 0.3 

 

Рис. F20-1 

Сравнение результатов: 

Теоретическое решения для первой и второй мод: 181.17 и 1136.29 Hz. 
Файл Элемент 1ая мода Ошибка (%) 2ая мода Ошибка (%) 
F20A PLANE2D 4-узловой  180.71 0.2 1127.96 0.7 
F20B PLANE2D 8-узловой 181.15 0.0 1153.52 1.53 
F20C TRIANG 6-узловой 183.35 1.2 1191.11 4.8 
F20D TETRA10  183.10 1.0 1184.85 4.3 
F20E SOLID 8-узловой 181.64 0.2 1137.17 0.1 
F20F SOLID 20-узловой 179.72 0.8 1111.16 2.21 
F20G TETRA4R  190.34 5.1 1188.97 4.6 

F21: Частотный расчет круглого канала с жидкостью переменной 
глубины  
Тип: 

Расчет частот и форм мод, движение жидкости, плоские элементы (PLANE2D). 

Литература: 

Budiansky, B., "Sloshing of Liquids in Circular Canals and Spherical Tank," J. Aerospace 
Sci, 27, p. 161-173, (1960). 

Задача: 

Круглый канал радиуса R наполовину заполнен несжимаемой жидкостью (см. рис. 
F21-1). Найти первые две собственные частоты с формами мод, несимметричными 
относительно оси Y. 
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Дано: 

R = 56.4 in. 

H/R = 0 

ρ = 0.9345E-4 lb sec2/in.4 

EX = 3E5 lb/in.2 

где 

EX = модуль массы  

Примечания: 

1. Для предотвращения численной неустойчивости используется малые поперечный 
модуль SXY = EX. 

2. Радиальный компонент перемещений (в локальной координатной системе) на кри-
волинейной границе зафиксирован, чтобы допустить движение жидкости. 

3. Ускорение свободного падения (команда ACEL) действует в отрицательном направ-
лении. 

4. Для расчета используются элементы PLANE2D в режиме плоских деформаций, по-
скольку формы мод не зависят от Z-координаты. 

5. При непрямоугольной геометрии есть вероятность получить собственные частоты с 
формами мод без значительных изменений в профиле уровня жидкости. Этот случай 
аналогичен модам жесткого тела твердотельной конструкции. Таким образом, реко-
мендуется задать отрицательное смещение ω2, чтобы избежать подобных мод. 

Сравнение результатов: 
Номер моды Теория (Hz) COSMOS/M (Hz) 

1 0.4858 0.4875 
2 Недоступно 0.7269 
3 0.9031 0.8976 
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Рис. F21-1 

F22: Частотный расчет прямоугольного бака с жидкостью пере-
менной глубины  
Тип: 

Расчет частот и форм мод, движение жидкости, шестигранный объемный элемент 
(SOLID). 

Литература: 

Lamb, H., "Hydrodynamics," 6th edition, Dover Publications, Inc., New York, 1945. 

Задача: 

Прямоугольный ба размерами A и B по осям X и Z, соответственно, частично запол-
нен несжимаемой жидкостью (см. рис. F22-1). Найти первые две собственные часто-
ты. 

Дано: 

A = 48 in. 

B = 48 in. 

H = 20 in. 

ρ = 0.9345E-4 lb. sec2/in.4 

EX = 3E5 lb./in.2 

где 

EX = модуль массы 
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Примечания: 

См. примечания к задаче F21. 

Сравнение результатов: 

Точные значения собственных частот получаются по формуле: 

 

где i и j представляют номера порядков по осям X и Z, соответственно. 

В таблице приведено сравнение точных  решения с полученными в COSMOS/M для 
различных значений i и j. 
Номер частоты 

I / J 
Теория (Hz) COSMOS/M (Hz) 

1 / 0 ----- ----- 
0 / 1 0.7440 0.7422 
1 / 2 0.9286 0.9199 

 

Рис. F22-1 

F23: Собственные частоты жидкости в манометре  
Тип: 

Расчет частот и форм мод, fluid sloshing, плоские элементы (PLANE2D). 

Литература: 

William, W. Seto, "Theory and Problems of Mechanical Vibrations," Schaum's Outline Se-
ries, McGraw-Hill Book Co., Inc., New York, 1964, p. 7. 
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Задача: 

Трубка манометра, используемого в лаборатории, имеет постоянное поперечное сече-
ние A. Найти частоты движения, если столб жидкости длиной L и плотностью ρ при-
водится в движение, как показано на рисунке. 

Дано: 

A = 0.5 in.2 

ρ = 0.9345E-4 lb sec2/in.4 

L = 26.4934 in. (длина жидкости в манометре) 

EX = 3E5 lb./in.2 

где 

EX = модуль массы 

Примечание: 

Для предотвращения численной неустойчивости используется малые поперечный мо-
дуль SXY = EX. Для предотвращения утечки жидкости накладываются локальные и 
глобальные ограничения нормально границе. В задачах, в которых присутствует уро-
вень жидкости, ускорение свободного падения должно действовать в отрицательном 
направлении y. 

Сравнение результатов: 
 F, Hz 
Теория*  0.8596 
COSMOS/M *  0.8624 

 

Рис. F23-1 

F24: Модальный расчет пьезоэлектрического тела  
Тип: 
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Расчет частот и форм мод, пьезоэлектрический объемный элемент (SOLIDPZ). 

Литература: 

J. Zelenka, "Piezoelectric Resonators and their Applications", Elsevier Science Publishing 
Co., Inc., New York, 1986. 

Задача: 

К концам пьезоэлектрического преобразователя, поляризованного по длине, подсое-
динены электроды. Оба электрода заземлены для имитирования короткого замыка-
ния. Все не ограниченные степени свободы вольтажа сжимаются после составления 
матрицы жесткости. В данной задаче рассматривается продольная мода вибрации. 

Примечания: 

Для ограничения степеней свободы вольтажа для пьезоэлектрических задач в коман-
дах введения ограничений (DND, DCR, DSF и т.д.) используется компонент перемеще-
ний RX. В COSMOS/M у элементов SOLID отсутствуют угловые степени свободы. 

Дано: 

L = 80 mm 

b = h = 2 mm 

Плотность = 727 Kg/m3 

 

Рис. F24-1 

Сравнение результатов: 

Для шестой моды вибрации (продольная мода): 
 Частота 
Теория 690 Hz 
COSMOS/M  685 Hz 

F25: Частотный расчет растянутой круглой мембраны  
Тип: 
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Частотный расчет, несимметричные формы мод, элемент SHELLAX. 

Литература: 

Leissa, A. W., "Vibration of Shells," NASA-P-SP-288, 1973. 

Задача: 

Найти первые три частоты растянутой круглой мембраны. 

 

Рис. F25-1 

Дано: 

R = 15 in. 

E = 30E6 psi 

T = 100 lb/in. 

t = 0.01 in. (Толщина) 

ρ = 0.0073 lb-sec2/in.4 

Советы по моделированию: 

Используются 9 элементов. Растягивающая нагрузка величиной 1500 lb на радиан 
приложена с включенными признаком учета плоскостных эффектов при вычислении 
частот. Все частоты найдены для гармоники номер 0. 

Сравнение результатов: 
Частота Теория (Hz) COSMOS/M (Hz) Ошибка (%) 

1 94.406 93.73 0.72 
2 216.77 212.95 1.76 
3 339.85 329.76 2.97 

F26: Частотный расчет сферической оболочки  
Тип: 
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Частотный расчет, несимметричные формы мод, элемент SHELLAX. 

Литература: 

Krause, H., "Thin Elastic Shells," John Wiley, Inc., New York, 1967. 

Задача: 

Найти первые восемь частот сферической оболочки, показанной на рисунке, для гар-
моники номер 2. 

 

Рис. F26-1 

Дано: 

R = 10 in. 

E = 1E7 psi 

υ(NUXY) = 0.3 

t (Толщина) = 0.1 in. 

ρ = 0.0005208 lb-sec2/in.4 

Сравнение результатов: 
Частота Теория (Hz) COSMOS/M (Hz) Ошибка (%) 

1 1620 1622 0.12 
2 1919 1923 0.20 
3 2035 2044 0.44 
4 2093 2110 0.81 
5 2125 2153 1.32 
6 2145 2188 2.00 
7 2159 2224 3.01 
8 2168 2262 4.34 
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F27A, F27B: Собственные частоты квадратной плиты, лежащей 
на опорах  
Тип: 

Частотный расчет, редукция по методу Ги, элементы SHELL4. 

Вариант A: Редукция по методу Ги 

Вариант B: Консистентные массы  

Задача: 

Рассчитываются собственные частоты плиты, лежащей на опорах. Поскольку задача 
симметрична, расчет выполняется дл четверти модели; вычисляются первые три 
симметричные моды вибрации. Масса равномерно сосредоточена в главных степенях 
свободы. 

 

Рис. F27-1 

Дано: 

L = 30 in. 

h = .1 in. 

ρ = 8.29 x 10-4(lb.sec2)/in.4 

υ = 0.3 

E = 30.E6 psi 

Аналитическое решение: 

Точное решение получается из следующего уравнения: 

ωmn = r2D/L2U·(m2 + n2) 

где 



 430

D = Eh3/12(1 - υ2) 

U = ρh 

Сравнение результатов: 
 Первая 

частота  
Вторая 
частота 

Третья 
частота 

Теория 5.02 Hz 25.12 Hz 25.12 Hz 
Вариант A  5.03 Hz 25.15 Hz 25.19 Hz 
Вариант B  5.02 Hz 25.11 Hz 25.11 Hz 

Полная масса = ρ·V = 8.29·10-4·.1·30·30 = .07461 

Сосредоточенная масса в главных узлах = .07461/64 = 1.16E-3 

F28: Цилиндрическая оболочка крыши  
Тип: 

Расчет частот и форм мод, элементы оболочки, жесткого бруса. 

Задача: 

Найти первую частоту и форму моды оболочки, показанной на рисунке. 

Дано: 

r = 25 ft 

E = 4.32E12, 4.32E11 и 4.32E10 psi 

υ = 0 

Советы по моделированию: 

Поскольку задача симметричная, расчет выполняется для четверти модели. Узлы 8 и 
12 соединены жестким брусом. 

Сравнение результатов: 

Нормализованные перемещения формы моды для узлов, соединенных жестким бру-
сом. 
Метод Модуль  

Юнга 
Вращение вокруг оси Z 

в узле 8 (R8) 
Вращение вокруг оси Z в 

узле 12 (R12) 
R8/R12 

Теория 
COSMOS/M  

4.32E12 -0.5642901E-2 
-0.5642901E-2 

-0.5642901E-2 
-0.5642901E-2 

1.000 
1.000 

Теория 
COSMOS/M  

4.32E11 -0.5654460E-2 
-0.5654460E-2 

-0.5654460E-2 
-0.5654460E-2 

1.000 
1.000 

Теория 
COSMOS/M  

4.32E10 -0.5693621E-2 
-0.5693621E-2 

-0.5693621E-2 
-0.5693621E-2 

1.000 
1.000 
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Рис. F28-1 
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Расчет устойчивости  
B1: Устойчивость колонн  
Тип: 

Расчет устойчивости, балочный элемент (BEAM3D). 

Литература: 

Brush, D. O., and Almroth, B. O., "Buckling of Bars, Plates, and Shells," McGraw-Hill, Inc., 
New York, 1975, p. 22. 

Задача: 

Найти нагрузку устойчивости и моду деформации колонны, лежащей на опорах. 

Дано: 

E = 30 x 106 psi 

h = 1 in. 

L = 50 in. 

I = 1/12 in.4 

Аналитическое решение: 

Pcr = π2EI/L2 = 9869.6 lb. 

Сравнение результатов: 
 Теория COSMOS/M 
Pcr 9869.6 lb 9869.6 lb 
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Рис. B1-1 

B2: Устойчивость колонн  
Тип: 

Расчет устойчивости, балочный элемент (BEAM3D). 

Литература: 

Brush, D. O., and Almroth, B. O., "Buckling of Bars, Plates, and Shells," McGraw-Hill, Inc., 
New York, 1975, p. 22. 

Задача: 

Найти нагрузку устойчивости и моду деформации колонны, зажатой в обоих концах. 

Дано: 

E = 30 x 106 psi 

h = 1 in. 

L = 50 in. 

I = 1/12 in.4 

Аналитическое решение: 

Pcr = 4π2EI/L2 = 39478.4 lb. 

Сравнение результатов: 
 Теория COSMOS/M 
Pcr  39478.4 lb 39478.8 lb 
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Рис. B2-1 

B3: Устойчивость колонн  
Тип: 

Расчет устойчивости, балочный элемент (BEAM3D). 

Литература: 

Brush, D. O., and Almroth, B. O., "Buckling of Bars, Plates, and Shells," McGraw-Hill, Inc., 
New York, 1975, p. 22. 

Задача: 

Найти нагрузку устойчивости и моду деформации колонны, зажатой в одном конце. 

Дано: 

E = 30 x 106 psi 

h = 1 in. 

L = 50 in. 

I = 1/12 in.4 

Аналитическое решение: 

Pcr = π2EI/(4L2) = 2467.4 lb. 

Сравнение результатов: 
 Теория COSMOS/M 
Pcr  2467.4 lb 2467.4 lb 
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Рис. B3-1 

B4: Прямоугольная плита, лежащая на опорах  
Тип: 

Расчет устойчивости, элемент оболочки (SHELL4). 

Литература: 

Timoshenko, and Woinosky-Krieger, "Theory of Plates and Shells," McGraw-Hill Book Co., 
New York, 2nd Edition, p. 389. 

Задача: 

Найти нагрузку устойчивости изотропной плиты, лежащей на опорах, подвергающей-
ся действию равномерно распределенной нагрузки p, приложенной в x = 0 и x = a. 

Дано: 

E = 30,000 psi 

υ = 0.3 

h = 1 in. 

a = b = 40 in. 

p = 1 lb/in. 

Примечание: 

Поскольку геометрия и нагрузки задачи обладают двойной симметрией, расчет вы-
полняется для четверти модели. 

Сравнение результатов: 



 436

 Теория COSMOS/M 
Pcr  67.78 lb 67.85 lb 

 

Рис. B4-1 

B5A, B5B: Устойчивость кольца  
Тип: 

Расчет устойчивости, элементы оболочки (SHELL3, SHELL6). 

Литература: 

Brush, D. O., and Almroth, B. O., "Buckling of Bars, Plates, and Shells," McGraw-Hill, Inc., 
New York, 1975, p. 139. 

Задача: 

Найти нагрузку устойчивости и моду деформации кольца. 

Дано: 

E = 10 x 106 psi 

R = 5 in. 

h = 0.1 in. 

b = 1 in. 

I =0.001/12 in.4 

Аналитическое решение: 

Используются аппроксимации Доннела. 

Pcr = 4EI/R3 = 26.667 lb./in. 
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Сравнение результатов: 
 Теория COSMOS/M SHELL3 COSMOS/M SHELL6 
Pcr  26.667 lb 26.674 lb 26.658 lb 

 

Рис. B5-1 

B6: Расчет устойчивости рамы 
Тип: 

Расчет устойчивости, элементы стержня (TRUSS2D) и балки (BEAM3D). 

Литература: 

Timoshenko, S. P., and Gere, J. M., "Theory of Elastic Stability," 2nd ed., McGraw-Hill 
Book Co., New York, 1961, p. 45. 

Дано: 

L = 20 in. 

AB = 4 in.2 

AT = 0.1 in.2 

E = EB = ET = 30E6 psi 

IB = 2 in.4 

Аналитическое решение: 

Точные результаты получаются из формул: 

P1cr = ATE Sinα Cos2α/(1 + (AT/AB) Sinα) 

P2cr = π2EIB/L2 
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Сравнение результатов: 
 Теория COSMOS/M 
Pcr 1  1051.392 lb 1051.367 lb 
Pcr 2  1480.44 lb 1481.20 lb 

Формы мод: 

 

Рис. B6-1 

 

Рис. B6-2 

B7A, B7B: Устойчивость рам  
Тип: 

Расчет устойчивости, элементы оболочки (SHELL4 и SHELL6). 

Литература: 

Brush, D. O., and Almroth, B. O., "Buckling of Bars, Plates, and Shells," McGraw-Hill, Inc., 
New York, 1975, p.29. 

Задача: 
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Найти нагрузку устойчивости и моду деформации рамы, показанной на рисунке. 

Дано: 

E = 30 x 106 psi 

h = 1 in. 

L = 25 in. 

I = 1/12 in.4 

Аналитическое решение: 

Pcr = 1.406π2EI/L2 = 55506.6 lb. 

Сравнение результатов: 
 Теория COSMOS/M SHELL4 COSMOS/M SHELL6 
Pcr  55506.6 lb 56283 lb 59359 lb 

 

Рис. B7-1 

B8: Устойчивость цилиндра  
Тип: 

Расчет устойчивости, элемент осесимметричной оболочки (SHELLAX). 

Литература: 

Brush, D. O., and Almroth, B. O., "Buckling of Bars, Plates, and Shells," McGraw-Hill, Inc., 
New York, 1975, p. 164. 

Задача: 

Найти нагрузку устойчивости и моду деформации цилиндрической оболочки, подвер-
гающейся действию равномерно распределенной боковой нагрузки. 
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Дано: 

E = 10 x 106 psi 

h = 0.2 in. 

R = 20 in. 

L = 20 in. 

υ = 0.3 

Аналитическое решение: 

 

Сравнение результатов: 
 Теория COSMOS/M 
Pcr  106 psi  113.97 psi 

 

Рис. B8-1 

B9: Плита с увеличенной жесткостью  
Тип: 

Расчет устойчивости, элементы оболочки (SHELL4) и балки (BEAM3D). 

Литература: 

Timoshenko, S. P., and Gere, J. M., "Theory of Elastic Stability," 2nd edition, McGraw-Hill 
Book Co., Inc., New York, p. 394, Table 9-16. 
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Задача: 

Плита, с жесткостью, увеличенной балкой прямоугольного сечения, лежит на опорах. 
Плита подвергается действию распределенной нагрузки, приложенной в x = 0 и x = a. 
Найти нагрузку устойчивости. 

Дано: 

E = 30,000 kip/in.2 

υ = 0 

hp = 1 in. 

a = b = 42 in. 

bb = 42 in. 

hb = 10 in. 

Аналитическое решение: 

 

Сравнение результатов: 
 Теория COSMOS/M Difference 
Pcr  223.80 kip/in. 232.53 kip/in. 3.9% 

 

Рис. B9-1 
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B10: Устойчивость прямоугольной рамы  
Тип: 

Расчет устойчивости, балочные элементы (BEAM2D). 

Литература: 

Timoshenko, S. P. and Gere J. M., "Theory of Elastic Stability," McGraw-Hill Book Co., 
New York, 1961. 

Дано: 

L = b = l00 in. 

A = 1 in.2 

h = 1 in. (высота поперечного сечения балки) 

I = 0.0833 in.4 

E = 1 x 107 psi 

P = 100 lb 

Аналитическое решение: 

Pcr = 16.47EI/L2 = 1372.4451 lb. 

Сравнение результатов: 
 Теория COSMOS/M 
Pcr  1372.45 lb 1371.95 lb 

 

Рис. B10-1 
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B11: Устойчивость ступенчатой колонны  
Тип: 

Расчет устойчивости, балочные элементы (BEAM2D). 

Литература: 

Roark, R. J. and Young, Y. C., "Formulas for Stress and Strain," McGraw-Hill, New York, 
l975, pp. 534. 

Задача: 

Найти критическую нагрузку и формы деформации ступенчатой колонны, показанной 
на рисунке. 

Дано: 

L = 1000 mm 

A1 = 10,954 mm2 

A2 = 15,492 mm2 

E1 = E2 = 68,950 MPa 

υ1 = υ2 = 0.3 

I1 = 1 x 107 mm4 

I2 = 2 x 107 mm4 

P1/P2 = 0.5 

Аналитическое решение: 

P1cr = 0.326π2E1I1/(2L)2 = 554,600 N 

Сравнение результатов: 
 Теория COSMOS/M 
Pcr  554.60 KN 554.51 KN 
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Рис. B11-1 

B12: Устойчивость составной плиты  
Тип: 

Расчет устойчивости, элемент составной оболочки (SHELL4L). 

Литература: 

Jones, "Mechanics of Composite Material," McGraw-Hill Book Co., New York, p. 269. 

Задача: 

Найти нагрузку устойчивости для составной плиты с несимметричным расположени-
ем слоев; направления материала расположены под углами [45,-45,45,-45]. На плиту 
действует распределенная нагрузка p. 

Дано: 

a = b = 40 in. 

h = Σhi = 1 in. 

Ex = 400,000 psi 

Ey = 10,000 psi 

υxy = 0.25 

Gxy = Gyz = Gxz = 5,000 psi 

p = 1 lb/in.2 

Аналитическое решение: 

Приблизительное решение находится на графике 5-16 в источнике. 
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Сравнение результатов: 
 Теория COSMOS/M 
Pcr  334.0 lb/in.  345.46 lb/in. 

 

Рис. B12-1 

B13: Устойчивость сужающейся колонны  
Тип: 

Расчет устойчивости, балочный элемент (BEAM2D). 

Литература: 

Timoshenko, S. P., and Gere, J. M., "Theory of Elastic Stability," McGraw-Hill Book Co., 
New York, 1961, pp. 125-128. 

Дано: 

b1 = 1 in. 

b2 = 4 in. 

b/b1 = (x/a)2 

I1 = 1 in.4 

I2 = 4 in.4 

I1/I2 = 0.25 

L = 100 in. 

a = 100 in. 

E = 1 x 107 psi 
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h = 1 in. 

Аналитическое решение: 

Pcr = 1.678EI2/L2 = 6712 lb. 

Сравнение результатов: 

Критическая нагрузка: 
 Теория COSMOS/M 
Pcr  6712 lb  6718 lb 

 

Рис. B13-1 

B14: Устойчивость зажатой цилиндрической оболочки  
Тип: 

Расчет устойчивости, элемент осесимметричной оболочки (SHELLAX), несимметрич-
ные моды устойчивости. 

Литература: 

Sobel, L. H., "Effect of Boundary Conditions on the Stability of Cylinders Subject to Lateral 
and Axial Pressures," A1AAJ., Vol. 2, No. 8, August, 1964, pp 1437-1440. 

Задача: 

Найти нагрузку устойчивости зажатой осесимметричной оболочки, показанной на ри-
сунке. 



 447

 

Рис. B14-1 

Дано: 

R = 1 in. 

υ = 0.3 

L = 4 in. 

E = 107 psi 

t = 0.01 in. 

Советы по моделированию: 

Цилиндрическая оболочка смоделирована 20 элементами равного размера. Расчет на-
чинается с гармоники 1, заканчивается на гармонике 5, в которой найдена минималь-
ная нагрузка устойчивости. 

Сравнение результатов: 
 Теория COSMOS/M 
Гармоника 5.0 5.0 
Критическая нагрузка 33.5 psi 35.0 psi 

B15A, B15B: Устойчивость цилиндрической оболочки 
Тип: 

Расчет устойчивости, элемент осесимметричной оболочки (SHELLAX), несимметрич-
ные моды устойчивости. 

Литература: 

Timoshenko, S. P., and Gere, J. M., "Theory of Elastic Stability," McGraw-Hill Book Co., 
1961. 
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Задача: 

Найти нагрузку устойчивости цилиндрической оболочки, показанной на рисунке. 

 

Рис. B15-1 

Дано: 

R = 10 in. 

L = 16 in. 

υ(NUXY) = 0.3 

E = 107 psi 

t = 0.1 in. 

Советы по моделированию: 

Цилиндрическая оболочка смоделирована 60 элементами равного размера. Расчет на-
чинается с гармоники 1, решение останавливается на гармонике 2, в которой найдена 
минимальная нагрузка устойчивости. В данной задаче число итераций для извлече-
ния собственных значений равно 100. 

Сравнение результатов: 
 Гармоника B15A Критическая 

нагрузка (SHELLAX) 
B15B Критическая 
нагрузка (PLANE2D) 

Теория 2 6.05 x 104 lb/rad 6.05 x 104 lb/rad 
COSMOS/M  2 6.07x 104 lb/rad 6.02x 104 lb/rad 
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